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CHAPTER 1 
 

Introduction 
 
The U.S. Army Corps of Engineers (USACE) operates about 700 storage reservoir and lock and 
dam projects constructed under the USACE's Civil Works water resources program.  The 
USACE water management mission is to regulate river flow with these projects to provide 
national benefits of flood control, navigation, hydroelectric power generation, water supply, 
irrigation, erosion control, water quality, environmental enhancement, and other authorized 
purposes.  For USACE offices the Corps Water Management System (CWMS) software was 
developed to aide in addressing real-time decision.  CWMS expanded and enhanced the data and 
information available to USACE staff members who must make decisions about the operation of 
Federal water management facilities or who must monitor and approve such decisions made by 
operation partners.  The data and information made available through CWMS includes 
precipitation data and forecasts as well as data and information about the current state of 
watersheds, likely future state of watersheds, and consequences of management actions.  The 
data and information help water managers and others make informed operation decisions. 
 
The Hydrologic Engineering Center's (HEC) Real Time Simulation (HEC-RTS) software is 
based on the CWMS software for use by non-USACE offices.  HEC-RTS still provides the same 
data and information that CWMS provides, HEC-RTS just performs these functions in a different 
manner than CWMS.  This document is the User's Manual for Version 3.0 of the HEC-RTS 
software.  This manual describes the capabilities of the software and illustrates its graphical user 
interface (GUI).  The manual details how HEC-RTS is configured to use analysis software that is 
part of the system.  The manual explains the flow of data and information between analysis 
software and the data components used within HEC-RTS. 
 
1.1 Data and Information Needed by Water Managers 
 
To make informed operation decisions, water managers need: 
 

• Current and potential future scenarios of precipitation. 
• Data that describes the current state of watersheds, channels, and water management 

facilities, including reservoirs, diversions, and other controllable features of the system. 
• Information about the likely future state (e.g., one hour to two weeks) of the watersheds, 

channels, and management facilities. 
• Information about the consequences of management actions that alter future states of the 

natural and managed systems. 
 
Data that describes the current state of the system comes from a network of environmental 
sensors.  These sensors, which are owned and operated by Federal, state, and local government 
agencies, utility companies, and commercial enterprises, measure: 
 

• Weather conditions, including air temperature, precipitation depths and rates, and 
evaporation depths and rates. 
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• Watershed states, including snow accumulation. 
• Depth, velocity, and other conditions in streams, rivers, canals, and other waterways. 
• Lake or reservoir level (from which storage volume may be inferred), rates of release of 

water through outlets, settings of spillway gates, and other conditions of lakes, 
reservoirs, and diversions. 

 
Data from sensors are transmitted by radio, satellite, telephone, the Internet, and other media to 
receiving sites, and then to water managers.  There, the data are decoded, transformed, checked 
for quality (validated), and stored in databases.  With these data, water managers have near-real-
time reports on the current state of the watersheds, channels, and management features. 
Using the environmental data from the databases, as well as forecasts, as inputs to models of 
watershed and channel processes, water managers can forecast future availability of water.  A 
water manager can predict the runoff from a watershed hours or even days into the future as a 
consequence of estimated rain and rain falling now or in the past in the watershed.  To do so, the 
water manager uses a mathematical model that simulates infiltration, overland flow, baseflow, 
channel flow, and other relevant watershed and channel processes. 
 
With models of water control facilities, water managers can simulate and assess the impact of 
operation alternatives.  For example, a water manager can determine which of two operation 
alternatives will more likely result in higher downstream water levels due to a large storm.  The 
forecast of future inflow, combined with a mathematical model of the behavior of the reservoir 
and the downstream channel, makes this possible. 
 
One operation alternative could be to release water now from a rapidly filling reservoir to 
accommodate future inflows.  Another alternative could be to delay release in anticipation that 
inflows will diminish and large releases will not be required.  The manager has, with analysis 
software, the capability to compare these operation alternatives in a quantitative manner.  
Information from the simulation permits the manager to assess the economic, environmental, life 
safety, and other consequences of the operation alternatives.  This information will lead to better-
informed decisions. 
 
1.2 HEC-RTS Overview 
 
HEC-RTS provides data and information needed to water managers readily through DSS (Data 
System Storage) files, and to a database system that the user creates.  The graphical user 
interface (GUI) provides a user with the ability to configure watersheds, view and edit 
data/information, create and run forecasts, and view results.  The functions of HEC-RTS are 
organized into four groups, or modules: Setup, Acquisition, Visualization, and Modeling. 
 

 

The Setup Module is the grouping of commands for watershed setup.  These are commands for 
configuring inputs, models, and outputs that describe a watershed's behavior.  The user develops 
a visual representation of the watershed to display in the GUI that is map-based. 
 

An HEC-RTS watershed is a set of data, information, models, and images that 
represent watershed lands and the channels, gages, and water control features within 
the watershed. 

Tip 
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The Acquisition Module is the commands for acquisition of data are provides.  These are 
commands for monitoring receipt of data from DSS (HEC Data Storage System) files, validating 
the quality of incoming data, transforming the data (e.g., stage to flow), and editing the data, as 
required. 
 
The Visualization Module provides commands for data visualization, like commands for 
displaying observed and forecast data to evaluate the hydrometeorological state of the watershed.  
Water managers may need to review hourly data from hundreds of gages as they make decisions.  
In the Visualization Module, HEC-RTS provides tools to facilitate review of large amounts of 
data, including summaries presented as graphs, tables, spreadsheets, charts, river profiles, maps, 
or sometimes a combination of these.  Within the Visualization Model, the summaries are 
linked to a watershed map, so that a user can click on an icon and immediately view the data 
associated with that location or also view computational results. 
 
The Modeling Module is the grouping of commands for model execution.  These commands 
assist with setting up and executing the analysis software for forecasting and viewing results.  
HEC-RTS links the analysis software so that individual models are executed in an orchestrated 
manner.  Data and other inputs are passed to each piece of software with the DSS data exchange 
software. 
 

 

HEC-RTS analysis software meets modern software standards, includes an easy-to-use graphical 
user interface, and executes within current operating systems.  The main analysis software are: 
 

HEC-MetVue Processes observed meteorological data for input to HEC-HMS 
(Hydrologic Modeling System).  Inputs are either point or gridded 
estimates of meteorological data such as precipitation and 
temperature.  Outputs are observed meteorological time series 
formatted for compatibility with HEC-HMS. 
 

MFP Meteorologic Forecast Processor.  Processes meteorological forecasts 
for input to HEC-HMS.  Inputs are forecasted meteorological data 
such as precipitation and temperature.  The user can enter these 
forecasts manually or obtain them from external sources such as NWS 
(National Weather Service). 
 

HEC-HMS Simulates watershed response to precipitation.  Inputs may include 
observed or forecasted precipitation, temperature, snowpack, and 
other environmental conditions.  Outputs include flows throughout the 
watershed, including inflows to reservoirs and local flows below the 
reservoirs. 
 

A forecast is a simulation of watershed processes and consequences of flooding based on 
input data and information and hydrologic, reservoir operation, hydraulic, and impact 
analysis models. Forecast results include flow and stage in the channel from watershed 
runoff, reservoir release schedules, floodplain inundation maps, floodplain consequence 
reports, and reports listing actions for emergency responders to take. These results inform 
water management decision making. 

Tip 
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HEC-ResSim Reservoir System Simulation.  Simulates behavior of reservoirs and 
linking channels, following user-specified operations for reservoir 
release decision making.  Inputs include flows into reservoirs and 
unregulated flows downstream of reservoirs (from HEC-HMS).  
Outputs include reservoir releases, downstream regulated flows, and 
reservoir storage conditions. 
 

HEC-RAS River Analysis System.  Simulates behavior of channels and adjacent 
floodplains.  Simulation of channels is in one dimension, and 
simulation of adjacent floodplains is in one or two dimensions.  The 
output from HEC-RAS permits determination of water surface 
elevations corresponding to flows computed by HEC-HMS or HEC-
ResSim.  Inputs include flows, and outputs include water surface 
elevations, depth grids, and inundation maps. 
 

HEC-FIA Flood Impact Analysis.  Estimates the consequences of flow or water 
surface elevations in the system.   Inputs include computed or 
observed flows or water surface elevations throughout the flood plain.  
Outputs include economic, life loss, or other measures of impact, or 
optionally, information on actions to be taken in response to flows or 
water surface elevations that will be experienced. 

 
HEC-RTS ensures that those who need to know the current state of the defined watershed and 
likely future states have ready access to that information.  The capability to access this 
information is accomplished using information sharing technology, including specially designed 
websites for display.   Figure 1.1  display the HEC-RTS workflow. 
 
1.3 What’s New about HEC-RTS Version 3.0? 
 
HEC-RTS Version 3.0 has been enhanced from previous versions.  Version 3.0 has the following 
new features: 
 

• Improvements to the GUI.  The GUI has been redesigned to simplify use.  The 
interface between the GUI and analysis software is more direct, making watershed 
configuration and forecasting more efficient. 

 
• HEC-MetVue.  This meteorological preprocessor generates meteorological (e.g., 

precipitation) input for HEC-HMS.  HEC-MetVue can be used to create plausible 
rainfall scenarios by translating historical or hypothetical precipitation evens.  The 
Meteorologic Forecast Processor [MFP] generates forecasted meteorological input.  
HEC-MetVue is designed to display, verify, manipulate, and edit spatial data by 
interactive/visual means. 

 
• RAS Mapper.  RAS Mapper is tool that is included in the HEC-RAS software (Version 

5.0) that allows a user to create and visualize floodplain geospatial information along 
with HEC-RAS analysis results. 
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• Model parameter editors have been enhanced.  For example, HEC-HMS model 
parameters may now be adjusted "on the fly" using a graphical editor.  This capability 
allows a user to adjust parameters and quickly see results without needing to re-compute 
the entire forecast. 

 
1.4 Organization of User's Manual 
 
This manual is generally organized in parallel with the HEC-RTS workflow.  The User's Manual 
is separated into three sections as described in Figure 1.2.  The section focused on using HEC-
RTS precedes the section focused on configuration because using HEC-RTS is a routine task 
while setting up watersheds is an infrequent task.  Appendices are also included in the manual 
for supplemental topics and where more detail is needed. 
 
Screenshots were captured using example watersheds.  In the GUI, some dialog titles and menu 
options correspond with the names of items that a user might have specified in the watershed 
created by a user.  Thus, dialog titles and menu options shown in the user's watershed may vary 
from what is shown here. 
 

 
Figure 1.1  Content of Each Section of the HEC-RTS User's Manual 
 
1.5 Additional Documentation 
 
This user's manual is the first volume in a series of HEC-RTS documentation.  In addition to this 
manual, other HEC-RTS documentation includes: 

  

HEC-RTS Quick Start 
Guide 

Steps the user through the development of 
an HEC-RTS watershed. 
 

Section I: The Basics
(Ch. 2-5)

• Useful for all staff.
• Overview of the basic 

HEC-RTS 
"infrastructure."

• CAVI walkthrough and 
introduction to layers.

Section II: Using HEC-RTS
(Ch. 6-13)

• Targeted toward 
operations staff.

• How to specify data 
streams.

• How to view and 
monitor data.

• How to validate and edit 
data.

• How to run a forecast.
• How to view, manage, 

and post results.

Section III: Configuring 
HEC-RTS

(Ch. 14-25)

• Targeted toward 
modeling staff.

• How to configure a 
watershed.

• How to configure model 
alternatives.

• How to configure 
forecast alternatives.

• How to edit model 
parameters.
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HEC-RTS Applications 
Manual 

This document is a combined engineering 
applications/technical reference manual 
intended to assist engineers in the 
development of models and the 
implementation of HEC-RTS. 
 

Analysis Software 
Documentation 
 
 

Documentation on the analysis software 
that is part of the system, such as HEC-
HMS, HEC-ResSim, HEC-RAS, and 
HEC-FIA, are available on HEC's 
website: http://www.hec.usace.army.mil/. 
 
However, Version 3.0 may include 
versions of the analysis software that have 
not been released to the public.  For those, 
version-specific documentation is 
available from HEC upon request. 

 

http://www.hec.usace.army.mil/
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CHAPTER 2 
 

HEC-RTS Interface 
 
Chapter 1 described how HEC-RTS creates data and information readily available to water 
managers and introduced the analysis software.  As described in Chapter 1, the GUI is the 
steering wheel of HEC-RTS.  The GUI features graphical menus and tools organized by 
function, or modules.  The four modules include:  
 

• Setup for watershed configuration. 
• Acquisition for data acquisition, monitoring, validation, and editing. 
• Visualization for viewing data. 
• Modeling for setting up and executing analysis software for forecasting and viewing 

results. 
 
This chapter provides an overview of the GUI and basic functions.  Here are three navigation 
tips: 
 

• For simplicity, the GUI "hides" commands that are not applicable to the module or 
element the user is working on.  Thus, if an option appears to be missing, make sure that 
the correct module or element has been selected and that the option is applicable for that 
selection. 

• Directory trees list elements configured in the watershed.  When a user configures a new 
element, it will be added to the directory tree. 

• Commands related to a selected element are typically accessible by right-clicking on the 
element. 

 
 Starting HEC-RTS 

 
When starting HEC-RTS, double-click the HEC-RTS icon on a user's desktop, or from the 
taskbar click Start, point to All Programs, point to HEC, point to HEC-RTS, and click HEC-
RTS.  The HEC-RTS splash dialog box appears for a few seconds, and then the main window of 
HEC-RTS displays.  The user is now ready to start using HEC-RTS. 
 

 Opening an Existing Watershed 
 
In HEC-RTS, a watershed is a set of data, information, models, and images that represent 
watershed lands and the channels, gages, and water control features within the watershed.  A user 
may open an existing watershed from any of the modules.  (If the user needs to create a new 
watershed, refer to Section 15.2).  There are two methods available to open a watershed.  First, if 
the user has opened the watershed before, the user can select the watershed from the File menu, 
point to Recent Watersheds, and click on the watershed name.  The second way to open a 
watershed follows: 
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1. First the user must tell HEC-RTS where watersheds are located.  From the Tools menu, 
click Options, the Options dialog box will open.  Click Model Directories.  From this 
tab the user will create watershed locations, click Add Location.  The Add Watershed 
Location dialog box will open.  Enter a name for the watershed location in the Name 
field.  In the Location field the user can either enter a directory or click Browse. A 
Select Watershed Location browser will open and the user can browse to the 
appropriate location. Click Open, the Select Watershed Location browser will close, the 
selected location will now appear in the Location field on the Add Watershed Location 
dialog box. Click OK, the Add Watershed Location dialog box will close, and the 
defined watershed location will appear on the Model Directories tab of the Options 
dialog box.  Click OK, the Options dialog box will close. 

 
2. From the File menu click Open Watershed.  The Open Watershed dialog box will open 

(Figure  2.1). 
 

 
Figure 2.1  Open Watershed Dialog Box 

 
3. Select the watershed name listed in the Available Watersheds box.  (A new location 

can be added by clicking Edit; see Step 1)  Click OK, the Open Watershed dialog box 
will close, and the selected watershed will appear in the HEC-RTS main window. 

 

 

 
 

There can only be one watershed open at a time. Therefore, if a watershed is 
open and an attempt is made to open another watershed, HEC-RTS will close the 
initially opened watershed. HEC-RTS first prompts the user to save the 
watershed. 

Tip 
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 HEC-RTS Main Window 

 
The HEC-RTS main window is shown in Figure 2.2 (only part of the window is shown for ease 
of viewing).  Each module in HEC-RTS - Setup, Acquisition, Visualization, and Modeling - 
has menus, tools, and a map window specific to each function. 
 

 
Figure 2.1  CAVI Main Window 
 

 
These are the basic elements of the main window: 
 

Title Bar Displays the name of the active watershed. 
Menu Bar Contains general and module-specific menus. 
Main Toolbar Contains shortcut icons for menu commands. 
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Module Tabs Each is a tabbed menu that houses module-specific commands.  
Clicking a module tab opens that module in HEC-RTS. 

Watershed Pane The area where the module tabs are located. 
Map Window Used to setup and display the watershed representation, which is 

geographically-referenced (geo-referenced). 
Map Window 
Toolbar 

Houses tools used to setup and navigate within the map window. 
 
 

Messages Window Displays a scrolling list of messages.  System output log information 
appears in this window from the time HEC-RTS is started and when 
the software is exited.  Messages related to incoming data are colored 
coded based on the quality of the data.  Messages may also report a 
problem with a system component; problems with field equipment; a 
caution, warning, or flood event; or other critical situations. 
 

Status Bar Displays map coordinates when the select tool is hovering over a 
location in the map window. 

 
 Menu Bar 

 
The File, View, Maps, Tools, Window, and Help menus (Figure 2.2) contain commands you 
can access from all four modules.  Some of these menus also contain module-specific commands 
that appear only within individual modules. 
 
The following are descriptions of the commands and options that are common to all four 
modules. 
 

File From this menu, the user can create, open, close, upload, or download a 
watershed, save data associated with the watershed, view watershed properties, 
print the map window, and exit HEC-RTS.  In addition, most recently opened 
watersheds are located at the bottom of the File menu.  Available commands 
are: New Watershed, Open Watershed, Close Watershed, 
Upload/Download Watershed, Save Watershed, Save Watershed As, 
Watershed Properties, Print Map, Recent Watersheds, and Exit. 
 

Edit This menu will appear in all modules and is module specific.  Typically, the 
edit options will be relevant to data element(s) for a specific module. 

View This menu is used to add or remove screen items (toolbar icons, the watershed 
pane, the messages bar, and the status bar); see what units, which time zone, 
and which coordinate system are being used for viewing; save, restore and 
manage layouts; choose whether or not to display the default computation point 
layer within the map window; select which modules tabs will be shown in the 
watershed pane; and view a list of watershed files (primarily in the folders: 
maps, study, and HEC-RTS). 
 

Reports This menu is module specific and provides access to reports produced for that 
module. 
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Scripts This menu allows you to execute existing scripts, create, test new scripts and 
run scripts. Available commands are: Script Editor, Schedule, Script Job 
Status, and Run. 
 

Tools This menu allows the user to access data (HEC-DSSVue), set options for the 
software, specify plug-in editor locations to use, view the "console.log" file, 
view the "HEC-DSS.log" file, and view memory usage.  Available commands 
are: HEC-DSSVue, Options, Install Location Editor, Console Output, 
HEC-DSS Log, and Memory Monitor. 
 

Window This menu allows the user to select how to view and select multiple windows, 
which modules the user wants to view.  Available commands are: Duplicate 
Window, Detach Window, New Map Window, Map Window Properties, 
Sync Map Window, Tile, Cascade, Next Window, and Previous Window. 
 

Help Displays current version information about HEC-RTS. 

 Map Window Toolbar 
 
The primary set of tools in the map window toolbar includes the Select Tool, Zoom Tool, and 
Time Series Icon Tool.  The tools change the appearance and functionality of your mouse.  
Other tools appear in the toolbar depending on which module you are in.  Their functions are 
described in context in other chapters of the manual. 
 
 Select Tool 

The Select Tool allows the user to select elements in the map window.  Also, after zooming 
in, the user can use the Select Tool to pan. 
 

 Zoom Tool 
The Zoom Tool allows the user to zoom in and out of the map window.  To zoom in, hold 
the mouse button down and outline the area to be enlarged.  Right-click to zoom out. 
 
Time Series Icon Tool 
The Time Series Icon Tool allows the user to select time series icons (Chapter 18 and 19) 
on the map window.  To select multiple icons, hold down the SHIFT key, and click on the 
time series icons that are to be selected.  The user can access commands related to a time 
series icon by right-clicking the appropriate time series icon. 

 
 Time Series Icon Controls 

 
Time Series Icon Controls (Figure 2.3) allow the user to select the attributes for the time series 
layers that are displayed within the watershed.  In order for the tab to appear, a time series layer 
must be created and data must be available for at least one of the time series icons associated 
with a time series layer (Chapter 19).  The tab is available in all modules, except the Setup 
Module.  There are three attributes available - Icon Type, Value, and Layer. 
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Figure 2.2  Time Series Icon Controls 
 

Icon Type The Icon Type forces all icons within the map window to display as the 
selected Icon Type in the list.  Selecting the Default option in the list will 
display the icons as they were set in the Time Series Icon Editor. 
 

Value Value allows the user to display the time series icon's data as labels (Figure 
2.4), which displays next to or on the location of the associated time series 
icon.  For example, the user can choose to display the data's total, minimum, 
and maximum values as labels.  Multiple values can be selected at once 
. 

Layer Layer allows the user to select which layer or layers are visible in the map 
window.  Multiple layers can be selected at once. 
 

 
Figure 2.3  Value Labels 
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 Map Window Elements 
 
Map Window elements allow the user to represent watershed data visually in a geo-referenced 
context and interact with associated data.  The user can create elements and edit the element 
properties in the Setup Module (Chapter 15).  In the Acquisition, Visualization, and Modeling 
modules, you can plot and tabulate data and results associated with the elements.  Additional 
commands are available according to module and are discussed throughout this manual. 
 

 Viewing of Data and Results 
 
Data can be viewed from both the Acquisition and Visualization modules.  Data are viewed 
from plots or tables. 
 
Results are viewed from the Modeling Module through plots and reports.  (Reports available in 
the Setup Module provide the user with information on the display elements that have been 
defined for the watershed.) 
 

 Features of Plots 
 
HEC-RTS plots offer data and results specific to the active module.  The data that a user can 
view were defined in the Setup Module at the time series icon locations (Chapter 18).  Modeling 
results can also be viewed at the time series icons or at individual modeling elements (e.g., 
reservoirs).  For example, in the Acquisition Module, the plot for one time series icon might 
open a two-dimensional graph of incoming data at a specific location, while, in the Modeling 
Module, the same time series icon might plot reservoir modeling results at that location (Figure 
2.5). 
 

 
Figure 2.4  Sample Plot: Reservoir Modeling Results 
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The plot displays the location name in the title bar and has axis labels and a color-coded legend 
for the data contained in the plot.  When a plot depicts results of a model alternative, as in Figure 
2.5, a dashed vertical line represents the time of forecast.  The Zoom Tool from the plot window 
operates the same as described in Section 2.3.2. 
 
The user can customize the appearance of plots through the use of several editors.  To access 
these editors, use the Select Tool and right-click on different elements of the plot (e.g., lines, 
axis).  The user can also access these editors through the Edit and View menus in the Plot dialog 
box (Figure 2.5).  The following provides an overview of the different editors (see Appendix I 
for more details on customizing plots): 
 

Curve Properties Right-clicking on a plot curve or point allows the user to open a curve 
properties editor where curve colors, styles, and weights as well as 
labels and quality symbols can be edited. 

Viewport Properties Right-clicking on the viewport of a plot allows the user to open an 
editor where the border, background, and gridlines of the plot can be 
customized. 

Title Properties Right-clicking on a plot axis allows the user to open a title properties 
editor where the title of a plot can be customized. 

Axis Properties Right-clicking on a plot axis allows the user to open an axis 
properties editor where the axis scale and tic marks can be 
customized. 

Legend Properties Right-clicking on the legend of a plot allows the user to open an 
editor where the user can add a title and add icons and text to the left 
and right blocks of a plot. 

Label Properties Right-clicking on an axis label or plot legend allows the user to open 
a label properties editor where the user can add or change the 
background color of labels or add a border to the labels. 

Spacer Properties If multiple plots are available in the plot window, the user can right-
click on the space between the plots to access the Space Properties 
Editor.  From the Space Properties Editor adjustments can be made 
to the space between plots. 

Polygon Properties Right-clicking on a polygon allows the user to open a polygon 
properties editor where borders and backgrounds can be customized. 

 
 Features of Tables 

 
The same data and information viewed from a plot can also be viewed in tabular form (Figure 
2.6).  As with plots, the type of data and results displayed depends on the properties the user 
defined for each time series icon. 
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Figure 2.5  Data in Tabular Form 
 
The appearance of tables can be customized through the use of commands available from the 
menu bar of the table window.  The user can add commas, separate date/time into two separate 
columns, make the year four digits, specify the decimal precision of the data, show the quality of 
the data, show missing data as a value (e.g., -901.0), copy selected cells or the whole table, print, 
plot, resize the columns of the table, and export the table to an ASCII file. 
 

 Printing and Exporting Plots and Tables 
 
Plots and tables can be printed, copied and pasted into other applications, and specify export 
options for plots.  For a more detailed description of printing and exporting, see Appendix J. 
 

 Features of Photos and Webcam Images 
 
Photos, webcam images, web pages, or documents can be assigned to time series icons.  By 
adding images to an icon in the Setup Module, the user can then access images in the 
Visualization, Acquisition, and Modeling modules through the icon shortcut menu.  Images 
and webcams can be viewed in their own separate dialog or as icons on the map window.  Figure 
2.7 shows a satellite image that can be viewed from a time series icon.  If a time series icon 
represents a dam, links can be assigned to the icon that might be a webcam that displays a real-
time video of an actual outlet on that dam.  It could also have access to pictures of the dam and 
reports providing details about the dam.  For more information on how to set these features up 
see Chapter 18. 
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Figure 2.6 Viewing an Image from a Time Series Icon 
 

 Running Scripts from Icons 
 
Scripts can be assigned to individual time series icons.  The scripts can be used to update the data 
at given intervals, compute other information from the data, or complete other tasks.  Scripts are 
assigned to the icons in the Setup Module, through the Time Series Icon Editor.  Scripts can 
also be created in the provided Script Editor frame.  For more detailed information on assigning 
and using scripts, see Appendix H. 
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CHAPTER 3 
 

Understanding Layers 
 
Layers in the HEC-RTS interface are like transparencies laid one on top of the other.  Each 
includes representations of physical images such as roads, county and state boundaries, rivers, 
and subbasins.  These are layered in the map window as color pictures.  Each of these images, 
along with its associated data, is a layer.  This chapter describes how to create and manage layers 
so that required data and information are easily viewed. 
 
There are two types of layers: primary layers (Chapter 4) and map layers (Chapter 5).  Primary 
layers are automatically generated when a new watershed is created and are present in all HEC-
RTS watersheds (although some primary layers may be empty in some watersheds).  Map layers 
are optional and are loaded into the watershed by the user. 
 
HEC-RTS creates primary layers when a stream alignment, time series icons, map window 
elements, and gridded precipitation data are created.  (A time series icon is a symbol in the map 
window that provides quick access to time-series data and information that has been assigned to 
the icon.)  HEC-RTS also creates a primary layer when a forecast alternative has been selected 
for computation.  Primary layers are module specific.  Map layers are physical images, which 
help visualize the watershed.  Map layers can be loaded in several formats, which are discussed 
in Chapter 5.  This includes maps from the Internet, such as a Google street map.  With the 
Display Map Coordinates function in the Maps menu, the user can set which coordinates the 
Map Window will use (watershed or loaded Internet map). 
 
All layers are hierarchical.  Primary layers can contain sub-layers.  For example, the Time Series 
Icons Layer (Chapter 19) can have several user-defined sub-layers that represent various types 
of data and information such as flow and precipitation. 
 
3.1 Map Layers Editor 
 
The Map Layers Editor (Figure 3.1) allows the user to add map layers, organize layers, view all 
the layers associated with the watershed, and add sub-layers to primary layers.  The Map Layers 
Editor can be accessed from any of the modules.  From the Maps Menu, click Map Layers.  
The Map Layers Editor will open (Figure 3.1).  The following sections describe the commands 
available in the Map Layers Editor. 
 
3.1.1 Menu Bar 
 
The menu bar of the Map Layers Editor contains commands for managing watershed layers.  
The following is a summary of the available menus and the commands associated with each one. 
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Figure 3.1  Map Layers Editor 
 

Layers From this menu, map layers can be added, images imported, and map layers 
removed.  The Close command from this menu closes the Map Layers Editor. 
 

Edit From this menu, after selecting a map layer from the Currently Opened Maps 
box, the user can rearrange and access the properties of the selected layer. 
 

View This menu has one command, Always On Top, which keeps the Map Layers 
Editor on top of all other HEC-RTS forms when checked. 

 
3.1.2 Layer Tree 
 
The Map Layers Editor contains a tree for controlling the display of layers in the watershed.  
The tree represents the hierarchical arrangement of layers.  The top level of the tree is the Map 
Layers Folder (Figure 3.1), which contains all of the layers in the watershed.  Beneath the Map 
Layers Folder is a branch for each primary or map layer.  When a plus sign (expands) is 
displayed, the user can click the plus sign, which expands the selected branch and display.  
Either sub-layers appear or a legend for the layer appears.  When a minus sign (collapses) is 
displayed, clicking the minus sign collapses the branch.  By double-clicking on a layer, the user 
can expand/collapse the branch and also opens the selected layers Properties Editor.  Figure 3.2 
shows the Map Layers Editor with the Study Layer expanded. 
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Figure 3.2  Map Layers Editor with the Study Layer Expanded 
 
The checkbox turns display of a layer or sub-layer on or off.  If a layer is unchecked, its sub-
layers will not display, even if they are checked. 
 
3.1.3 Layer Organization 
 
Layers in the Map Window can be organized with the Map Layers Editor.  By default, the 
primary layers are at the top of the tree.  Map layers are added to the bottom of the tree.  Layers 
are drawn as shown in the Map Layer Editor.  So typically background images are on the 
bottom, and layers containing smaller, more-detailed items such as time series icons, gages, and 
rivers are on top. 
 
To rearrange the order of layers: 
 

1. Select the layer that will be rearranged in the Layer Tree of the Map Layers Editor.  
From the Edit menu or from the layer's shortcut menu, choose Move Up or Move Down.  
Other available commands are Move to Top (moves the selected layer to the top of the 
tree) and Move to Bottom (moves the selected layer to the bottom of the tree). 
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2. Continue to change the position of each layer until the necessary features are visible on 
the map window. 

 
3. Click OK, and the Map Layers Editor closes. 

 
3.2 Time Series Icon Controls 
 
The Time Series Icon Controls in the Visualization, Acquisition, and Modeling modules 
allows the user to change the Time Series Icons Layers visible within the map window quickly.  
The following actions can occur: set specific sub-layers to display, select different value labels 
(captions such as Name, Average, Min, Max, etc., are displayed next to the time series icons), 
and display only icons with similar properties.  Also, display graphics such as pictures that are 
updated from websites as well as documents can be displayed.  For more on setting up sub-layers 
under the Time Series Icons Layer see Chapter 19.  Chapter 18 describes how to set up Time 
Series Icons. 
 
3.3 Layer Visualization Scaling 
 
Layers may be set to become visible or invisible as zooming in or out occurs in a Map Window 
(see Chapter 4 and 5).  This provides for the ability to display finer levels of detail as zooming in 
on regions occurs in the map window, and avoids clutter when displaying the full area.  This 
might include time series icons not appearing for less significant gages, detailed map layers 
becoming visible, and raster or other images appearing that are not as distinguishable at a coarser 
zoom level.  All layers can have visualization scales set, except for the Study and Modeling 
layers. 
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CHAPTER 4 
 

Primary Layers 
 
4.1 Overview 
 
Primary Layers include the Stream Alignment layer, the Time Series Icons layer, and the 
Study layer (Computation Points, Reservoirs, Impact Areas, and other watershed configuration 
element types).  The layers appear in the Map Layers editor (Figure 4.1) accessible from the 
Maps Menu.  (If a Primary Layer is not displayed, double-click the corresponding node in the 
Setup tab to make the layer appear in the Map Layers editor.  For example, to bring up the 
Stream Alignment Layer in the Map Layers editor, double-click the Stream Alignment Node 
in the Setup tab.) Layers can be turned on and off by clicking the checkbox next to the layer in 
the Map Layers editor. 
 
Primary Layers are automatically generated when a new watershed is created.  Primary 
Layers are present in all CAVI watersheds (although some layers may be empty in some 
watersheds) and are foundational to CAVI (whereas Map Layers are optional, see Chapter 5).  
This chapter describes how they are configured and managed. 
 

 
Figure 4.1  Map Layers Editor 
 
4.2 Time Series Icon Layer 
 
The Time Series Icons Layer includes all of the time series icons that you have defined for your 
watershed.  The icons are available in all modules.  For more details on creating Time Series 
Icons Layers see Chapter 19. 
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4.3 Study Layer 
 
The Study Layer appears in the Setup Module only.  The Study Layer has sub-layers for each 
configuration element type.  Expanding the Study Layer Node in the Map Layers editor 
(Figure 4.2) displays its sub-layers.  CAVI creates these sub-layers before any configuration 
elements have been defined. 
 

 
Figure 4.2  Study Layer in the Map Layers Editor 
 
4.3.1 Study Layer Properties 
 
The user can change the appearance of some of the configuration elements in the Study Layer.  
To do this: 
 

1. In the Map Layers editor, right-click Study in the layer tree. 
 

2. Select Properties in the shortcut menu.  The Drawing Properties Editor (Figure 4.3) 
opens.  The Drawing Properties Editor has six tabs, which represent the configuration 
element types available in your watershed. 

 
3. Depending on the configuration element type (e.g., reservoirs, levees), you can change 

the color of the element, the size of the element, whether the element is displayed, 
whether the label of the element is drawn, and what size and type of font the label of the 
element is displayed in. 

 
For example, from the Reservoir tab, the user can set the width and colors of the different 
elements that make up a reservoir, whether to display the reservoir polygon (triangle), whether to 
display the reservoir label, and set the font for the reservoir label.  By default, the labels for the  
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Figure 4.3  Drawing Properties Editor 
 
reservoirs appear in the map window.  If the user does not want to display the labels, uncheck 
Draw Reservoir Name, and click Apply.  To change the appearance of the reservoir name, use 
the options in the Font Chooser (Figure 4.4).  From the Drawing Properties Editor, click 
Apply and the reservoir labels will appear in the font and size you chose.  The other 
configuration element types in the Drawing Properties Editor have similar properties. 
 

 
Figure 4.4  Font Chooser 
 
4.4 Stream Alignment Layer 
 
The Stream Alignment Layer is available in the Setup Module.  This layer has sub-layers for 
each stream alignment element.  Expanding the Stream Alignment Layer Node in the Map 
Layers editor (Figure 4.5) displays its sub-layers (Stream Junctions, Streams, and Stream 
Nodes). 
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Figure 4.5  Map Layer Editor - Stream Alignment Layer 
 
4.4.1 Stream Alignment Layer Properties 
 
The user can change the appearance of streams and their labels, change the appearance of stream 
junctions and stream nodes, and set the visualization scale for the Stream Alignment Layer.  To 
do this, right-click the Stream Alignment Layer in the Map Layers editor.  From the shortcut 
menu, click Properties.  The Stream Alignment Properties dialog (Figure 4.6) opens.  How to 
change properties is described in the following sections. 
 

 
Figure 4.6  Stream Alignment Properties Dialog 
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4.4.2 Stream Alignment Sub-Layer – Streams 
 
The following are instructions for changing the appearance of the Streams in the Stream 
Alignment: 
 

1. The user can set the width of the lines that represent streams with the Stream Width List 
(Figure 4.7). 

 

 
Figure 4.7  Stream Alignment Properties – Streams 

 
2. The user can select the color of the lines that represent the streams with the Stream 

Color List.  The default color is orange.  There are several colors to choose from.  The 
user can also create custom colors.  From the Stream Color List, click Custom.  The 
Choose A Color dialog (Figure 4.8) opens.  See Appendix E for further details on the 
color chooser. 

 

 
Figure 4.8  Choose A Color Dialog 

 
3. A preview of the stream color changes is shown (Figure 4.9) in the Stream Alignment 

Properties dialog.  Click Apply to apply the changes. 
 

 
Figure 4.9  Preview Stream Color Changes 
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4. By default, stream labels appear in the Map Window.  If the user does not want the 

labels displayed, uncheck Show Stream Name, and click Apply. 
 

5. To change the font of the stream labels, click Choose Font next to Show Stream Name.  
The Font Chooser dialog (Figure 4.4) opens.  Select the font type from the Type list, and 
select a size using the Size slider.  Click OK.  The Font Chooser dialog will close.  Click 
Apply on the Stream Alignment Properties dialog.  All the stream labels will appear in 
the font and size you choose. 

 
Tic marks appear on a stream representing the stream stationing.  There are two types of tic 
marks, minor and major.  The following are instructions for changing the appearance of tic 
marks: 
 

1. If the user does not want to display the tic marks, uncheck Draw Station Tics (Figure 
4.10), and click Apply. 

 

 
Figure 4.10  Stream Alignment Properties - Tic Marks 

 
2. From the Tic Length List, the user can set the length of the minor tic marks.  To change 

the length of the major tic marks, use the Major Tic Length List.  Click Apply, and the 
Map Window updates. 

 
3. By default, the labels for the tic marks appear in the map window.  If the user does not 

want the labels to display, uncheck Draw Tic Labels and click Apply. 
 

4. To change the font of the tic mark labels, click Choose Font next to Draw Tic Labels.  
The Font Chooser dialog (Figure 4.4) opens.  Select the font type from the Type list, and 
select a size using the Size slider.  Click OK, and The Font Chooser dialog closes.  Click 
Apply on the Stream Alignment Properties dialog.  All the tic mark labels will appear 
in the font and size you chose. 

 
4.4.3 Stream Alignment Sub-Layer – Stream Nodes 
 
The following are instructions for changing the appearance of all Stream Nodes in the Map 
Window: 
 

1. If the user does not want to display the Stream Nodes, uncheck Draw Stream Nodes 
(Figure 4.11), and click Apply. 
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Figure 4.11  Stream Alignment Properties - Stream Nodes 

 
2. The user can select the color of the Stream Nodes from the Node Color List (Figure 

4.11).  The default color is green.  Similar to streams, you can also create a custom color 
(Section 4.5.2). 

 
3. The user can select the color of the outline of Stream Nodes from the Node Outline 

Color List.  The default color is dark green.  Similar to streams, the user can also create a 
custom color (Section 4.5.2). 

 
4. The width of Stream Nodes can be set from the Node Width list. 

 
4.4.4 Stream Alignment Sub-Layer – Stream Junctions 
 
The following are instructions to change the appearance of all Stream Junctions in the Map 
Window: 
 

1. If the user does not want to display Stream Junctions, uncheck Draw Junctions (Figure 
4.12), and click Apply. 

 
2. The user can select the color of Stream Junctions from the Junction Color List (Figure 

4.12).  The default color is dark green.  Similar to streams, a custom color can be created 
(Section 4.5.2). 

 
3. Set the width of Stream Junctions from the Junction Width List (Figure 4.12). 

 

 
Figure 4.12  Stream Alignment Properties - Stream Junctions 

 
4.4.5 Scale 
 
The visualization Scale feature allows the user to customize stream alignment display settings as 
they zoom in and out on the Map Window.  The following are instructions to set the 
visualization scale for the Stream Alignment Layer: 
 

1. To set the visualization scale for the stream alignment to a default, click the Scale Menu 
in the Stream Alignment Properties dialog.  Select Set to Defaults.  The visualization 
scale is set automatically. 
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2. To create a scale factor, on the Scale Menu, click New.  The Create New Scale dialog 

(Figure 4.13) opens.  In the Scale Cell, enter values for the scale factor. 
 

 
Figure 4.13  Create New Scale Dialog 

 
3. Click OK.  This creates a new tab in the Stream Alignment Properties dialog in which 

the user can configure the stream alignment’s appearance. 
 
4.5 Gridded Data Layer 
 
The Gridded Data Layer (Figure 4.14) is available in the Visualization and Modeling 
Modules.  Gridded Data Layer is only available when gridsets are included or computed for 
the watershed.  A gridset is a sequence or time series of precipitation grids.  The Gridded Data 
Layer contains the gridsets for the watershed that have been created outside of CAVI using the 
HEC-GridUtil program and Gridded Data calculated by the HEC-MetVue model.  Appendix G 
describes precipitation grids, gridsets, and the HEC-GridUtil program. 
 

 
Figure 4.14 Gridded Data Layer 
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4.5.1 Gridded Data Properties 
 
For the Gridded Data Layer (Figure 4.14), the user can configure the appearance of the gridset 
(Appendix G) being used by the watershed.  To configure these properties:  
 

1. On the Maps menu, click Map Layers, and the Map Layer dialog will open (Figure 4.1) 
 

2. From the tree, right-click Gridded Data.  From the shortcut menu, click Properties.  The 
Grid Display Options dialog will open, as shown in Figure 4.15. 

 

  
Figure 4.15 Grid Display Options Dialog 

 
4.5.2 Properties 
 
From the Grid Display Options dialog (Figure 4.15) you can choose a color contour scheme 
(default is Precipitation), tic interval, and override the minimum/maximum values for the 
contour limits. 
 
There are several advanced features.  These features are accessed by clicking the advanced 
button which expands the Grid Display Options dialog.  The advanced options are: 
 

• Brightness: The relative lightness or darkness of a color, from full color to black. 
 
• Saturation: The relative intensity of the color, from white to full color. 
 
• Transparency: The relative opacity of the color from opaque to translucent to 

transparent. 
 
• Aspect Shading: Enabling this feature causes the display color to change based on the 

viewing angle. 
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• Adjust Color Scale to Clipping Area: Enabling this feature causes the displayed color 
ramp to rescale to the maximum and minimum clipping thresholds. 

 
• Maximum Clipping: Enabling this feature causes the data above the specified threshold 

to be displayed as the defined color. 
 

• Minimum Clipping: Enabling this feature causes the data below the specified threshold 
to be displayed as the defined color. 

 
4.5.3 Scale 
 
To set the visualization scale for the Gridded Data Layer: 
 

1. On the Maps menu, click Map Layers, and the Map Layer editor will open (Figure 
4.1). 

 
2. From the tree, right-click Gridded Data.  From the shortcut menu, click Properties, the 

Grid Display Options dialog (Figure 4.15) will open. 
 

3. Click the Scale tab (Figure 4.16).  Both zoom-in and zoom-out scale factors can be set 
from the Grid Display Options dialog.  By default the Gridded Data Layer is set for 
Always show layer.  To set visualization scales click show layer in the following scale 
range. 

 

 
Figure 4.16 Grid Display Options Dialog Box - Scale Tab 

 
4. To set the scale so that the Gridded Data Layer becomes visible as the user zooms-in, 

set the scale to the current scale by clicking Set to Current.  If the user wishs to enter a 
value, in the Only visible below 1: box enter the scale factor. 

 
5. To set the scale so that the Gridded Data Layer becomes visible as the user zooms-out, 

set the scale to the current scale by clicking Set to Current.  If the user wishs to enter a 
value, in the Only visible above 1: box enter the scale factor. 
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6. Click OK, the Grid Display Options dialog closes (Figure 4.16), and the visualization 
scale is set for the gridded data layer. 

 
7. Click OK, the Layer Selector dialog closes. 

 
4.6 Model Schematic Layer 
 
Once the user has opened a forecast and made a forecast alternative active, the Model Schematic 
Layer, shown in Figure 4.17, becomes available in the Modeling Module.  The Model 
Schematic Layer contains graphic representations of computational models for the active 
forecast alternative.  Chapter 12 contains detailed information on a forecast, a forecast 
alternative, and the different computational models represented in the Model Schematic Layer. 
 
When the Study Tree is expanded, the different sub-layers for some of the models is displayed.  
Therefore, if the user does not want to see the impacts for the HEC-FIA model, clear FIA, and 
the impact areas from the HEC-FIA model will no longer be visible on the map window.  To 
view the impact areas, click FIA.  This procedure applies to all of the sub-layers. 
 

  
Figure 4.17  Model Schematic Layer 
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4.7 Shortcut Menu for Primary Layers 
 
This shortcut menu is accessed by a right-click on primary layers in the Map Layers editor.  It 
provides several ways to manipulate the primary layers.  The available commands are: 
 

Move to Top Move the layer to the top of the tree. 
Move Up Move the layer up the tree one position. 
Move Down Move the layer down the tree one position. 
Move to Bottom Move the layer to the bottom of the tree. 
Properties Display the properties of the layer.  This opens a dialog.  Depending on the 

format of the layer, this dialog may be editable or not.  See Appendix D for 
further information on the available map editors. 

Import Import to layer.  Applicable for Stream Alignment layer. 

Export Export from layer.  Applicable for Stream Alignment layer. 

Add Icon Layer Applicable for Time Series Icons layer. 
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Map Layers 
 
 

 Overview 
 
To help visualize a watershed, HEC-RTS has the capability to display various maps of watershed 
features.  The maps display as color pictures, are layered one over the other like transparencies.  
These Map Layers also provide a geographical reference for the watershed.  This chapter 
describes the formats of Map Layers and shows how the layers are configured and managed. 
 
Chapter 4 described Primary Layers, such as the stream alignment, time series icons, and 
computation point layers, which are required.  Map Layers are optional layers. 
 

 Map Layer Formats 
 
Map Layer formats that HEC-RTS can read and display are listed in Table 5.1. 
 
Table 5.1  Map Layer Formats Supported by HEC-RTS 

Description Common Filename 
Extension 

ArcGIS® shapefile .shp 
AutoCAD® DXF .dxf 
Raster image .png, .gif, .jpg, .bmp, .tif 
USGS digital line graph .dlg 
USGS DEM .dem, .flt 
ArcGIS® DEM .asc 
HEC-FIA SMRMP .smrmp 
ASCII NetTIN .net 
LizardTech® MrSID® .sid 
OpenStreetMap .osm 

 
5.2.1 ArcGIS® Shapefiles (.shp) 
 
Shapefiles are the native data structure for the ArcGIS® program.  Shapefiles store non-
topological geometry and attribute information for the spatial features of a data set in a particular 
format.  Usually there are three component files associated with a shapefile: .dbf, .shp, and .shx.  
The .shp file contains the shapes (points, polylines, or polygons) that are displayed in the layer.  
Each shape has a record in the .dbf file containing descriptive data called "attributes". The .shx 
file contains an index that links each shape to its record in the .dbf file.  For more information on 
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shapefiles, see the ESRI Shapefile Technical Description available here: 
http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf 
 
5.2.2 AutoCAD® DXF (.dxf) 
 
A Drawing Interchange File (.dxf) is created by a Computer-Aided Design (CAD) package, 
AutoCAD®.  This format is a tagged-data representation of an AutoCad® drawing file.  Tagged 
data refers to each data element being preceded by a group code.  A group code is an integer 
indicating the type of data element.  The file created is a vector-based graphic.  The DXF format 
is commonly used for data exported from other CAD and GIS (Geographic Information Systems) 
programs. 
 
5.2.3 Raster Image Types 
 
The raster image formats supported by HEC-RTS are: JPEG format (.jpg or .jpeg), Graphics 
Interchange Format (.gif), Portable Network Graphic (.png), bitmat (.bmp), and Multi-resolution 
Seamless Image Database (MrSID or .sid).  For HEC-RTS to access these file types, an ASCII 
text file with an .img extension must be created.  The .img file needs to contain the position of 
the image on the map and the location of the image file, as shown in Figure 5.1.  These 
coordinates need to be given in the watershed's coordinate system, as stated in the Map 
Coordinate Information dialog (Figure 5.7).  This .img file should not be confused with the 
format for raster images used by the ERDAS (eEarth Resources Data Analysis System) Imagine 
image processing program.  CAVI cannot display files in the ERDAS Imagine .img format. 
 

 
Figure 5.1  Raster Image File 
 
5.2.4 USGS Digital Line Graph (.dlg) 
 
U.S. Geological Survey (USGS) Digital Line Graphs (DLGs) are created from two sources using 
manual and automated digitizing methods.  The two sources are aerial photographs or 
cartographic sources.  DLG files are vector representations of the data.  When HEC-RTS 
interacts with a .dlg file it automatically creates a .dlgbin file for use. 
 
5.2.5 USGS DEM (.dem) 
 
USGS publishes the file format USGS DEM.  A raster file format, .dem files usually contain 
terrain elevations, but the file format can be used for representing any surface.  The format 
allows for internal documentation of the coordinate system, date of publication, etc.  These 

Image West=2051443. 
Image North=355443. 
Image East=2054925.6 
Image South=351947.4 
 
 
Image URL = path and filename of raster image 
  (i.e., maps/lh_2m.gif) 

These are image boundaries that are 
determined by you using a program 
such as ArcGIS®.  

http://www.esri.com/library/whitepapers/pdfs/shapefile.pdf
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values are referenced horizontally either to a Universal Transverse Mercator (UTM) projection 
or to a geographic coordinate system. 
 
5.2.6 ArcGIS® Grid Exports (.asc, .flt) 
 
The .asc file is an ASCII file format representation of a grid generated by ArcGIS®.  The file 
consists of keywords followed by values defining the number of columns, number of rows, lower 
left corner, cell size, no data value, and each cell value.  The .flt file is a similar format, but split 
into two files: an ASCII header (.hdr) file and a .flt file which contains binary representations of 
the cell values. 
 
5.2.7 HEC-FIA SMRMP (.smrmp) 
 
HEC-FIA Segmented Multi-Resolution Multi-Parameter (SMRMP) file created to operate 
gridded data (namely, digital terrain grids, inundation depth grids, and arrival time grids) more 
efficiently. 
 
5.2.8 ASCII NetTIN (.net) 
 
An ASCII file format used to represent a triangulated irregular network (TIN).  TIN data is 
stored in a simple format that defines the nodes, edges, and triangles contained in the TIN.  This 
format is common for transferring TIN data between software. 
 
5.2.9 LizardTech® MrSID® (.sid) 
 
The MrSID® (multi-resolution seamless image database) is a propriety geo-referenced image file 
format developed by LizzardTech® for use with GIS.  This format compresses large raster 
images files like aerial photographs or satellite imagery for easier viewing.  Some MrSID® 
images contain geo-referencing and positioning information and can be placed in the watershed 
through the Import Image option under the Layers menu.   
 
5.2.10 OpenStreetMap (.osm) 
 
An XML file created in the OpenStreetMap (OSM) file format, which is used for saving street 
map information.  This file is generated by HEC-RTS in the watershed's map folder.  The 
OpenStreetMap should not be placed or edited by the user. 
 

 Adding Map Layers 
 
The user can add as many types of map layers as needed.  In HEC-RTS Version 3.0, it is no 
longer necessary that all map layers be in the same coordinate system.  HEC-RTS can transform 
coordinates "on-the-fly" if the coordinate systems are defined properly in ways that HEC-RTS 
can read, for example an ESRI projection (.prj) file.  A map projection uses mathematical 
formulas to relate spherical coordinates on the globe to flat, planar coordinates. 
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Map layers are added from the Maps Menu in any of the modules.  When a map layer is added 
to the watershed, HEC-RTS reads the coordinates of points, lines, and polygons on the map layer 
and resets the geographic extents of the watershed equal to the smallest rectangle that will 
contain all objects in the map layer.  When adding more than one map layer, the user must ensure 
that each map layer is projected in the same coordinate system (Appendix C) as the watershed.  
For example, if an ArcGIS® shapefile (.shp) is added as a map layer that displays the major 
streams in an area, the geographic extents will change according to the projection of that 
shapefile.  If the shapefile is projected in State Plane Coordinates in feet, HEC-RTS will set the 
geographic extents accordingly, and the units of the stream alignment will be in feet. 
 
To add map layers: 
 

1. Open the Map Layers editor from the Maps Menu. 
 

2. Click the Layers Menu item in the Map Layers editor (Figure 5.2). 
 

 
Figure 5.2  Layers Menu in Map Layers Editor 

 
3. Click Add Maps, and the Select Map to Add dialog (Figure 5.3) will open. 
 
4. Select the desired map layer format from the Files of Type list.  Select the filename, and 

click Open.  The map layer will appear under the Maps Folder in the Setup tab. 
 
When enabled, the Create Copy checkbox (at the upper right of the dialog) causes the selected 
map layer to be copied to the watershed’s maps folder and then adds the map layer.  By default 
Create Copy is enabled.  If left unchecked, the map layer is added from the current location. 
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Figure 5.3  Select Map to Add Dialog 
 

 Removing Map Layers 
 
To remove map layers: 
 

1. Open the Map Layers editor from the Maps Menu. 
 

2. Click Remove Map Layer from the Layers Menu item in the Map Layers Editor. 
 

3. The Remove Map Layers from Watershed dialog will open (Figure 5.4).  Select the 
map layer to remove.  You will be asked if this is really what you want to do.  Click Yes. 

 

 
Figure 5.4  Remove Map Layers from Watershed Dialog 
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 Shortcut Menu for Map Layers 
 
Right-clicking a map layer (non-primary) in the Map Layers editor (Maps > Map Layers) opens 
a shortcut menu (Figure 5.5).  The shortcut menu provides several ways to manipulate a map 
layer. 
 

 
Figure 5.5  Map Layers Shortcut Menu 
 
The available commands are: 
 

Move to Top Move the layer to the top of the tree. 
 

Move Up Move the layer up the tree one position. 
 

Move Down Move the layer down the tree one position. 
 

Move to Bottom Move the layer to the bottom of the tree. 
 

Show Legend Show the legend for the layer. 
 

Hide Legend Hide the legend for the layer. 



HEC-RTS User's Manual Chapter 5 – Map Layers 

5-7 

 
Change Label Change the label of the layer in the Map Layers editor.  

This does not change the filename of the layer. 
 

Properties Display the properties of the layer.  This opens a dialog.  
Depending on the format of the layer, this dialog may be 
editable or not.  See Appendix D for further information 
on the available map editors. 
 

Set Scale for Zoom-in Set the zoom-in visualization scale for the layer as 
detailed in Section 5.8. 
 

Set Scale for Zoom-out Set the zoom-out visualization scale for the layer as 
detailed in Section 5.8. 
 

Remove Scale Factors Disable or clear all scale settings for the layer as detailed 
in Section 5.8. 
 

Copy To Copy the layer to another folder. 
 

Attributes Table Opens the Query Window.  The Query Window 
displays attributes of the map layer. 

 
 Geographic Reference for Map Layers 

 
To maintain a geographic reference (also called a geo-reference), HEC-RTS uses a user-selected 
and customizable coordinate system, called the World Coordinate System (WCS).  This 
superimposes a grid on layer features to establish x and y coordinates in WCS for each point on 
the layer.  The x-coordinate is referred to as "easting", and the y coordinate is referred to as 
"northing". The user can select the extent of this grid, the dimensions of the cells of the grid, the 
units of measurement of the grid, and the location of the origin of the grid.  Because of this 
flexibility, the user can specify and use virtually any grid coordinates convenient for CAVI 
model integration.  To do so: 
 

1. On the Maps Menu, click Default Map Properties.  The Default Map Properties 
dialog box (Figure 5.6) will open. 

 
2. The Default Map Properties dialog box contains two tabs: Map Extents and Default 

Map Layers. 
 
The Map Extents tab includes: 
 

Coordinate System This field identifies the established coordinate system for the watershed.  
To edit the coordinate system, click Edit.  The Map Coordinate 
Information dialog box (Figure 5.7) will open.  See Appendix C for 
details on editing the coordinate system.  Remember that all layers must 
exist in one unified coordinate system. 
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Figure 5.6  Default Map Properties Dialog Box 
 
 

 
Figure 5.7  Map Coordinate Information Dialog Box 
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Extents: Easting Minimum and These values indicate the location of the left, right, 
Maximum, and Northing bottom and top borders (respectively) of the grid in 
Minimum and Maximum the map window (Figure 5.8). 
 

 
Figure 5.8  Example of Geographic Extents and Equivalent Coordinates 

 
Set Map Extents to Display This will set the limits of the map window.  When zooming 

in on an area, click Set Map Extents to Display, the extents 
on the Default Map Properties dialog box (Figure 5.6) will 
change to the zoomed area. 

 
Grow to Map Extents When this check box is selected, HEC-RTS automatically sets the 

geographic extents to define the smallest rectangle that encompasses 
all the objects in the watershed. 

 
The geographic extents of layers must be selected carefully to ensure that the entire watershed is 
included.  In HEC-RTS Version 3.0, it is no longer necessary that all map layers be in the same 
coordinate system.  HEC-RTS can transform coordinates "on-the-fly" if the coordinate systems 
are defined properly in ways that HEC-RTS can read, for example an ESRI® projection (.prj) 
file.  Therefore, the user may need to use GIS tools to identify or transform the layers from one 
coordinate system to another before using them with CAVI.  
 
The Default Map Layers tab includes a list of map layers that are shown in the map window.  
The user use check boxes in this tab to show or hide layers. 
 

 Map Layer Properties 
 
As described in Section 5.2, HEC-RTS supports several map layer formats, each with its own 
properties.  To edit those properties: 
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3. Click Maps > Map Layers.  Select the layer you wish to edit. 
 

4. Right-click and select Properties.  Figure 5.9 is an example properties dialog.  Here, the 
user can specify the visual style for the layer and its labels.  Properties dialogs vary 
depending on the type of layer you are editing. 

 

 
Figure 5.9  Example Layers Properties Dialog 

 
 Setting the Visualization Scale 

 
The easy way to set the visualization scale for map layers is outlined below: 
 

1.  Click Maps Menu > Map Layers.  The Map Layers Editor will open. 
 

2. Go to the map window and zoom in to the point at which the map layer becomes visible. 
 

3. Right-click the map layer in the layer tree of the Map Layers Editor.  From the shortcut 
menu, click Set Scale for Zoom-in.  This sets the visualization scale for the map layer.  
If the user goes to the map window and zoom out, the layer will no longer appear. 

 
4. Inversely, if the user wants the layer to become visible as the user is zooming out, from 

the shortcut menu, click Set Scale for Zoom-out. 
 

5. Visualization scale settings can be cleared or disabled.  From the shortcut menu, click 
Remove Scale Factors.  The visualization scale for the layer is cleared. 

 
6. Click OK.  The Map Layers Editor will close. 

 



HEC-RTS User's Manual Chapter 6 – Using HEC-RTS - Overview 

6-1 

CHAPTER 6 
 
 

Using HEC-RTS – Overview 
 
 
Section II of the HEC-RTS User's Manual describes configure an HEC-RTS watershed.  This 
chapter describes the typical workflow involved in the routine use of HEC-RTS to support the 
water management process.  This chapter will provide information on running models, analyzing 
results, and, providing information to the user on how to run models when an extreme event 
occurs. 
 
At this point, the user has the ability to configure a watershed (described in Section III chapters) 
and the user is ready for the routine tasks of running forecast models; viewing and analyzing 
results; and, revising model data, as needed. 
 
6.1 Managing Data for HEC-RTS 
 
Data streams in the watershed that need to be monitored will be selected from the time series 
icon layers, which have already been configured (Chapters 18 and 19).  The time series icons 
will be placed at locations in the watershed that correspond with the data streams, and will be 
organized into layers (groups), which will make the data streams readily visible.  The time series 
icons are available in the Acquisition, Visualization, and Setup modules in HEC-RTS and 
provide access to functions related to the data streams.  This includes acquiring, monitoring, 
validating, and editing data by using the Acquisition tab (Chapters 7 through 9).  The 
Visualization tab (Chapter 10) provides a flexible set of tools that allows visualization of 
incoming data (i.e., gridded precipitation data).  These visualization tools help the user evaluate 
the current state of the watershed by comparing the incoming data to threshold values that define 
normal conditions.  For example, let's say an upper threshold value for precipitation data of 3-
inches has been defined.  If an incoming precipitation value is 4-inches and HEC-RTS has been 
configured to provide alerts through messages and alarms, the user will be alerted to the 
abnormal value. 
 
6.1.1 Acquiring Data 
 
From the Acquisition tab, the user will retrieve time-series data from gages.  These data will 
typically include precipitation, river flows and stages, temperature, and reservoir releases and 
elevations.  The real-time data can be viewed by defining a time window that is relative to the 
current time by setting look back and look ahead times (in days or hours).  Also, historical data 
can be viewed by specifying a starting and ending date and time.  Figure 6.1 shows an example 
time window being defined relative to current time. 
 
Refer to Chapter 7 for additional details for data acquisition. 
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Figure 6.1  Acquisition Tab – Time Window 
 
6.1.2 Monitoring and Validating Data 
 
In the Acquisition tab, time-series data is monitored and validated.  Several tools are available to 
show the quality and quantity of the data.  Quality color bars (Figure 6.2) and thumbnail plots 
(Figure 6.3) provide a quick overview of the acquisition processes by displaying the quality 
(missing values needing to be filled-in) and quantity (magnitude of data and possible data 
outliers) of the data. 
 

 
Figure 6.2  Quality Color Bars Showing Data Gaps 
 
If the quality color bar or thumbnail plot for a location indicates that the data are questionable, 
then the user can check the data using plots (Figure 6.4) and tables (Figure 6.5). 
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Figure 6.3  Thumbnail Plots Showing Flows and Stages 
 
 

 
Figure 6.4 Sample Plot Showing Gap in the Data 
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Figure 6.5 Sample Table of Historical Data 
 
The Data Status Summary (Figure 6.6) report allows the user to view groups of data (e.g., all 
precipitation data or all flow data).  Also, activity of data streams can be checked in this report. 
 

 
Figure 6.6  Data Status Summary 
 
Refer to Chapters 7 and 8 for additional details for monitoring and validating data. 
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6.1.3 Editing Data 
 
When checking the validity of data to verify its accuracy, the user might need to edit 
questionable data and fill-in missing data.  The Data Validation Editor (Figure 6.7) in the 
Acquisition tab, will allow the user to edit time-series data. 
 

 
Figure 6.7  Data Validation Editor 
 
The Data Validation Editor allows editing of the data by text-entry or graphical.  When there are 
data gaps (i.e., missing data), this tool is also convenient for estimating values using the 
graphical editor or the table of data values.  After editing the data, the user can choose to accept 
the changes and store the revised data values back to the HEC-DSS file. 
 
Refer to Chapter 9 for additional details for editing data. 
 
6.1.4 Visualizing Data 
 
The Visualization tab allows for viewing current conditions in a watershed and the associated 
hydrometeorological data in a geo-referenced context (e.g., gridded precipitation), as shown in 
Figure 6.8. 
 



Chapter 6 – Using HEC-RTS - Overview HEC-RTS User's Manual 

6-6 

 
Figure 6.8  Gridded Precipitation Data in Visualization Tab 
 
The grid animation controls provide a view of precipitation grids for the time window chosen for 
the Visualization tab.  These controls (Figure 6.9) behave very much like the controls of  a video 
player. 
 

 
Figure 6.9  Grid Animation Controls in Visualization Tab 
 
Similar to the quality color bars used in the Acquisition tab (Section 6.1.1), the threshold color 
bars (Figure 6.10) in the Visualization tab can be used to compare current data against threshold 
values that have been set for a location.  For example, in the Acquisition Module the user may 
wish to display quality color bars to identify missing data, while in the Visualization Module, 
the threshold color bars or thumbnail plots are used to understand a watershed's 
hydrometeorological conditions.  As part of the monitoring and validation routine, the user 
should review threshold color bars to determine if the incoming data is good and which data 
needs to be validated.  Thumbnail plots and tables can also be used to visualize time-series data. 
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Figure 6.10  Threshold Color Bars in Visualization Tab 
 
Refer to Chapter 10 for additional details for visualizing data. 
 
6.2 Running Forecast Models 
 
Now that the quality of the time-series data has been validated, the user is ready to create an 
HEC-RTS Forecast (Chapter 12).  An HEC-RTS forecast is a simulation of watershed 
processes and consequences of potential flooding from various applications configured in HEC-
RTS.  The hydrologic application, HEC-HMS, computes flow from forecasted and observed 
meteorological time-series.  The reservoir operation application, HEC-ResSim, computes flow 
and release schedules.  The hydraulic application, HEC-RAS, computes stage and inundation 
maps.  The impact analysis application, HEC-FIA, computes flood consequences and action 
reports. 
 
Prior to this routine HEC-RTS forecasting, the will have already configured the HEC-RTS 
watershed.  Specifically, Model Alternatives will have been configured, Model Alternative 
Keys (Chapter 20) assigned, Program Order (Chapter 16) and Forecast Runs defined, and 
Model Linking (Chapter 11) configured. 
 
An HEC-RTS forecast might be configured using a typical forecast run that includes something 
similar to the following model alternatives: normal conditions (for HEC-HMS), normal reservoir 
operations (for HEC-ResSim), normal river conditions (for HEC-RAS), and no flooding 
consequences (for HEC-FIA). 
 
If a high rainfall event is forecasted, an HEC-RTS forecast might be created using a forecast run 
with model alternatives similar to the following: wet basin conditions (for HEC-HMS), restricted 
downstream channel capacity (for HEC-ResSim), high channel flow (for HEC-RAS), and 
evacuate with warning (for HEC-FIA). 
 
In the Modeling Module (Chapter 11), the user will specify a forecast time window, create and 
manage forecast extract and post lists, extract time-series data for the forecast, create and manage 
forecast alternatives, edit model parameters, and run the models.  Figure 6.11 shows the data 
flow concepts through the six standard HEC-RTS analysis applications (HEC-MetVue, MFP, 
HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA). 
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Figure 6.11 Data Flow Between Models 
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6.2.1 Hydrologic Modeling (HEC-MetVue, MFP, and 

HEC-HMS) 
 
The meteorological preprocessors HEC-MetVue and MFP will be used to combine observed 
precipitation data and future precipitation information into a single precipitation dataset that can 
be used by the watershed runoff model, HEC-HMS. 
 
Using the observed and future precipitation data, HEC-HMS computes runoff, including 
uncontrolled local flows that are typically used by HEC-ResSim. 
 
The types of data typical that need to be changed for a forecast are loss rates and baseflow. 
 
6.2.2 Reservoir Simulation (HEC-ResSim)  
 
After the upstream boundary flows and uncontrolled local flows have been computed by HEC-
HMS, the reservoir simulation application HEC-ResSim will use the HMS flows during the 
operation of the reservoirs to compute regulated flows.  Reservoir operations might include 
zones and rules for day-to-day operations, along with zones and rules for extreme events. 
 
The types of data that might typically be changed for a forecast are the starting conditions for 
reservoirs.  As long as the reservoir starting conditions are linked to real-time data (starting 
elevations or storages, reservoir or outlet releases, and any other boundary conditions needed by 
the model), then the user shouldn’t have to make any revisions to the HEC-ResSim model in 
order to run routine HEC-RTS forecasts. 
 
6.2.3 River Analysis (HEC-RAS)  
 
Regulated flows computed by HEC-ResSim are typically used as boundary conditions to the 
hydraulic routing model, HEC-RAS.  Computed flows from HEC-HMS or supplemental models 
can also be used as input to HEC-RAS.  In turn, HEC-RAS computes stage, which is input to 
HEC-FIA. 
 
The types of data that might typically be changed for a forecast are n values at selected cross 
sections to match profile information better throughout the lookback period. 
 
6.2.4 Impact Analysis (HEC-FIA) 
 
HEC-FIA analyzes impacts within inundated areas based on computed hydrographs from HEC-
ResSim and stages from HEC-RAS.  HEC-FIA calculates flood damage determined by rising 
stage in a stream, river, lake, or reservoir.  HEC-FIA also computes action reports that tell 
responders what actions need to done based on the computed stage values. 
 
The types of data that might typically be changed for a forecast are adjustments to the levee 
failure stages to see the associated damage and impacts during an event. 
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6.3 Viewing and Analyzing Results 
 
Viewing of modeling results occurs from the Modeling tab by using plots and reports.  The user 
can view results at individual modeling elements (e.g., computation points, reservoirs, impact 
areas, etc.).  Typical results include: tabulated subbasin precipitation depths, subbasin 
hyetographs, stage and flow hydrographs, reservoir release decisions, hydraulic plots and tables, 
floodplain inundation maps, and impact reports.  Refer to Chapter 13 for more details on results.   
 
6.4 Editing Model Data 
 
After application results have been reviewed, revisions might be needed to model data.  The 
active forecast alternative in the Modeling tab, indicates which applications are being used in the 
forecast.  For each application, the user can edit some of the data by clicking on the appropriate 
application layer in the forecast tree and using the buttons located in the Actions tab.  
Alternately, the user can click on the appropriate application icon in the Modeling module's 
toolbar to open that application's native interface. 
 
For example, if the user wants to change the lookback storage (i.e., starting condition) for a 
reservoir, the user will edit the HEC-ResSim alternative being used in the forecast alternative.  In 
the forecast tree, click on the HEC-ResSim layer.  Now; in the Actions tab (see bottom of the 
Modeling tab), click Edit Alternatives.  At this point, the user now has access to HEC-ResSim's 
Alternative Editor, the Lookback tab contains the reservoir starting storage (and elevation) 
values (among other initial conditions).   
 

 
Figure 6.12  Example of Editing Model Data (HEC-ResSim Alternative Editor) 
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Be sure to save model revisions.  If revisionsare made using the layers in the Forecast Tree, 
then the revisions are only applicable for the forecast alternative contained in the opened 
forecast.  Other forecast alternatives (as well as other forecasts that have been run with the 
selected forecast alternative) will not contain the revisions.  If the user wants revisions to be 
available for subsequent forecasts, then save the revisions to the "base" data.  To save "base 
data", select a forecast alternative, click Save To Base (located on the Actions tab). 
 
6.5 Posting or Saving Forecast Results 
 
Now that a forecast has been run, and the results are satisfactory, the user will want to post 
(save/store) modeling results to the HEC-RTS DSS file.  From the Setup tab in the Models 
menu, select Edit Post (Figure 6.13).  There are many options for selecting which model output 
data to post.   
 

 
Figure 6.13  Edit Post 
 
As an example, the user might want to only store the reservoir elevation and release time-series 
values (remember, this is just a simple example).  To do so, the user will bring up the Edit Post 
from the Setup menu, select the appropriate lines for reservoir elevation, and click Add To 
Group.  After the post group is created click Run Post in the Modeling tab. Figure 6.14 shows 
an example process of posting forecast results. 
 
Figure 6.13 shows the initial Edit Post process in the Setup tab, while Figure 6.14 provides the 
steps to Run Post in the Modeling tab. 
 
Refer to Chapter 12 for additional details for posting forecast results. 
 



Chapter 6 – Using HEC-RTS - Overview HEC-RTS User's Manual 

6-12 

 

 
Figure 6.14  Example Process of Posting Forecast Results.  
 



HEC-RTS User's Manual Chapter 7 – Acquisition Module 

7-1 

CHAPTER 7 
 

Acquisition Module 
 
 
The Acquisition Module allows the user to examine ongoing data acquisition, evaluate the 
quality of incoming data, quickly identify problem locations, and validate questionable data.  
HEC-RTS can be configured to receive incoming data from gages in the field via data streams 
from networks, including DROT (Domestic Satellite Receive-only Terminals), National Weather 
Service feeds, and other sources.  When data arrive, HEC-RTS automatically compares the 
received values to preset quality and threshold values and translates the data into a user-readable 
format.  There are three automated transformation processes: 
 

• An optional on-the-fly transformation process carries out a rudimentary comparison of 
raw data against preset ranges before storing it in an HEC-RTS DSS file. 

 
• For more complex data operations, HEC-RTS executes a selective comprehensive 

validation/transformation process within a few minutes of data arrival.  This includes, for 
example, validating cumulative precipitation against a subsequent value and duration test 
then computing hourly incremental precipitation. 

 
• Finally, at fixed times during the day, HEC-RTS revalidates and recalculates/transforms 

data over a longer period, for example, a week. 
 
Because of these automated transformation and validation processes, the HEC-RTS DSS fioles 
contains both raw and revised observed data. 
 
While the automated transformation and validation processes happen behind the scenes, HEC-
RTS keeps you apprised of the quality of incoming observed data in the database.  First, HEC-
RTS can display color bars and thumbnail plots that dynamically convey the quality of data at 
individual locations where data are being collected.  Second, plots and tables provide detailed 
views of incoming data.  Thirdly, gages can be viewed in groups (such as precipitation or flow) 
and see details for more or fewer gages than appear in the geo-referenced map display.  Fourth, 
color-coded buttons display the status of individual data streams and allow the user to view 
specific information about individual data stream components (for example, a data stream’s 
"heartbeat" and other alarms).  See Chapter 8 for further details.  These features help assess 
incoming data, ascertain that the incoming data streams are operational, and identify specific 
locations where problems may exist in data acquisition. 
 
Once problem gages have been identified, the Data Validation Editor can be used to validate 
data manually (Chapter 9).  The Data Validation Editor allows the user to select specific 
locations for validation (ad hoc mode) or to use pre-defined validation lists (list mode).  The 
Data Validation Editor can filter data to identify and display only those data time series with 
questionable, missing, and/or rejected data.  Additionally, the Data Validation Editor offers 
tools for both text-entry editing and graphical editing.  With the former, the user can enter  
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corrected values in a table.  With the latter, the user can use the mouse to create line segments in 
a plot to replace questionable or missing data.  Also, automated estimates can be used to edit 
data. 
 
7.1 Acquisition Module 
 
The acquisition module provides tools that facilitate monitoring and validating incoming data.  
The map window and components of the acquisition module are illustrated in Figure 7.1.  A 
detailed discussion of common screen components is presented in Chapter 2. 
 

 
Figure 7.1  Acquisition Module 
 
7.1.1 Menu Bar 
 
The following is an overview of the menu bar (Figure 7.1) when the acquisition module is 
selected (click the Acquisition tab).  The File, View, Tools, and Help menus are discussed in 
Chapter 2.  The commands available from the menus will facilitate the acquisition and 
management of time series data for a watershed. 
 
 Edit From this menu the user can edit color bar color settings, launch data validation, 

create a validation list from selected icon time series, edit location descriptive 
data, edit time series descriptive data, and edit time series data set values in the 
database.  Available commands are: Icon Quality Colors, Data Validation,  
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  Create Validation List, Delete Validation List, Locations in CWMS 

Database, Time Series Descriptions in CWMS Database, and Data 
Exchange in the CWMS Database. 

 
 Reports From this menu the user can view the quality of data sets in the form of color 

bar lists.  The user can select from existing files of color bar lists, or create new 
custom lists from the database, and save them in files for future use.  The only 
available command is Data Status Summary. 

 
7.1.2 Acquisition Module 
 
The Acquisition Module (Figure 7.1) contains buttons that execute commands specific to data 
acquisition.  These commands include setting up a time window, updating time series icons in 
the map window, checking data streams, and opening the data validation editor (Chapter 9). 
 
7.1.3 Map Window 
 
The map window (Figure 7.1) in the Acquisition Module contains map layers and layers of time 
series icons that allow viewing of data acquisition processes in a geo-referenced context.  The 
user can customize how time series icons appear according to the needs and objectives of the 
watershed being studies.  For example, time series locations that need to be evaluated daily for 
an individual watershed may appear as quality color bars to facilitate quick review of incoming 
data.  On the other hand, the use of time series icons to monitor data provides space-conserving 
graphical images on the schematic.  Customizing the time series icon layers is done in the Setup 
Module, which is described in Chapter 19. 
 
Quality color bars and/or thumbnail plots are normally used in the Acquisition Map Window 
because these item allow provide the capability to scan displayed gages quickly to determine 
where problems may exist.  Both of these icons can be set to update dynamically to reflect the 
relative quality of the incoming data. 
 
7.1.4 Time Series Icon Controls 
 

Time Series Icon Controls allow the user to select the Time Series Icon Layer attributes that 
are displayed within the watershed.  The Time Series Icon Controls are located on the 
Visualization, Acquisition, and Modeling tabs near the bottom of the Watershed Pane.  There 
are three attributes available: Icons Type, Value, and Layer (Figure 7.2). 
 

 
Figure 7.2  Time Series Icon Controls 
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 Icon Type Forces all icons within a map window to display as the selected Icon Type in 
the list.  Selecting the Default option in the list will display the icons as they 
were set in the Time Series Icon Editor dialog. 

 
 Values The Value selection allows time series icon data to be displayed as labels, 

which display next to or on the location of the associated time series icons.  For 
example, the user could choose to display the data's total, minimum, and 
maximums values as labels.  Multiple values can be selected at once. 

 
 Layer Layer allows the user to select the sub-layers that will be visible on a map 

window.  Multiple layers can be selected at once. 
 
By changing the attributes, the user can determine how time series icons will display data within 
the acquisition process.  For more detailed information on how to configure the properties that 
control the threshold color bar icons displayed (Chapter 19). 
 
7.2 Set Time Window 
 
The user can either set a specific (i.e., fixed) time window (for reviewing a historical event) or 
set a time window relative to the current time (the default setting, used for monitoring incoming 
data in real-time). 
 
To set or change the time window: 
 

1. In the Watershed Pane, click the Acquisition tab (Figure 7.3). 
 

2. By default, HEC-RTS assumes that incoming data will be monitored, so Relative to 
Current Time is selected.  To view historical data, select Specific Time Window 
(Figure 7.3). 
 

 
Figure 7.3  Acquisition Tab 
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3. To set the visualization relative to the current date and time, select the Relative to 
Current Time and enter the Look Back Time and select either Days or Hours as the 
time unit.  Normally, set the time window to extend backward one to thirty days from the 
current time.  Optionally, a Look Ahead Time can be entered, select either days or 
hours; this allows the software to look ahead at data. 

 
4. To visualize historical data, select Specific Time Window and enter the Start Date and 

Time of the time window and the End Date and Time of the time window. 
 

5. Click the Update Plot Icons button to complete the time window change. 
 
7.3 Time Series Icon Shortcut Menu 
 

In the Acquisition Module’s Map Window, the time series icons in the map window have a 
shortcut menu (Figure 7.4) that allows for viewing data associated with a selected time series 
icon either in a plot, table, or using Microsoft Excel®.  Also, from the shortcut menu the user can 
access the Data Validation Editor (Chapter 9) to edit the data associated with the selected time 
series icon.  Another option is the ability to view the legend of the selected time series icon.  The 
shortcut menu is the same for all of the available time series icons (i.e., for the color bars, 
thumbnail plots, graphics, or dots). 
 

 
Figure 7.4  Time Series Icon Shortcut Menu 
 
7.4 Monitoring Incoming Data Quality 
 
Monitoring the quality of incoming data is the primary task during the data acquisition process.  
There are four primary ways to assess the quality of incoming data, to ascertain that data streams 
are operational, and to identify specific locations with data problems. 
 
• Use of quality color bars and thumbnail plots.  HEC-RTS can display icons as color bars 

or thumbnail plots representing gages where data is being collected.  Quality color bars are 
color coded according to the quality of data at a location.  This allows a quick, visual 
overview of data acquisition processes in the watershed during the specified time window. 
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• Use of plots and tabular data.  When the user has identified locations where problems exist 

in data acquisition, plots and tables provide detailed views of incoming data, helping you 
determine the nature of the problem. 

 
• Use of Data Summary Lists.  Data Summary Lists allow for the viewing of gages in 

groups (such as all precipitation or all flow gages) and view details for more or fewer gages 
than appear in the geo-referenced map display.  (See Chapter 8 for further details.) 

 
• Data Stream Status Indicators.  Allow for monitoring the data streams of a watershed.  A 

color-coded button displays the status of each data stream, indicating whether it is both 
running and active.  Clicking on these buttons allows the user to view additional information 
about individual data stream components, such as heartbeat and any alarm conditions.  (See 
Chapter 8 for further details.) 

 
7.4.1 Using Quality Color Bars and Thumbnail Plots 
 
Quality color bars offer a quick overview of data acquisition processes in the watershed, 
dynamically reflecting the status of incoming data at each location as being acceptable, missing, 
or questionable.  HEC-RTS attaches quality flags to the incoming data based upon thresholds 
that have been set. 
 
Thumbnail plots provide a miniature plot of the actual data values, and allow the data manager to 
quickly see which gages are reacting to a hydrometeorological event and which gages are not.  
Both the quality color bars and the thumbnail plots allow the user to generate either a plot or a 
tabulation of the data for review. 
 
7.5 Quality Color Bars 
 
A quality color bar (Figure 7.5) is a thick, segmented line representing the history of the data 
quality at a specific location within a time window that has been established.  The name of the 
location appears adjacent to the color bar, and the length of the color bar represents a time line 
equal to the duration of the time window.  Segments along the color bar reflect time intervals, 
with colors corresponding to the data quality legend that has been defined.  The quality color 
bars are updated dynamically at the time interval entered in the Set Time Window (Section 7.2). 
 

 
 

Figure 7.5  Quality Color Bars 
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As part of a watershed daily routine, the user should review quality color bars to determine if the 
incoming data is good and which data needs to be validated.  To view the legend for quality 
color bars: 
 

1. Right-click on a time series icon in the Map Window. 
 

2. Choose Icon Legend from the shortcut menu and the Quality Color Bar Legend dialog 
(Figure 7.6) opens. 

 

 
Figure 7.6  Quality Color Bar Legend 

 
3. The legend shows the quality flags for the incoming data and the colors that represent 

each quality flag.  The user can change the color associated with the quality flags. 
 

4. From the Edit menu, click Icon Quality Colors, and the Quality Color Bar Editor 
(Figure 7.7) opens. 

 

 
Figure 7.7  Quality Color Bar Editor 
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5. To change the color of a quality flag, in the Color column of the table click the drop-
down list and a list of available colors appears. Click a new and the color appears in the 
cell of the Color column.  

 
6. Click OK, the Quality Color Bar Editor (Figure 7.7) closes, and the Map Window 

refreshes with the new color appearing in all of the quality color bars. 
 

7. The Show no report after flag (Figure 7.7) is a quality check for irregular time series 
data sets only.  The default is that if more than one hour goes by without data being 
received, then a No Report quality flag is triggered.  If the user receives most of the 
irregular data in three-hour chunks, then a change to increase this quality flag to three (3) 
hours might be required. Click Show no report after, and in the field type the number of 
hours. 

 
8. Click OK, the Quality Color Bar Editor (Figure 7.7) closes and the Map Window 

refreshes all of the quality color bars. 
 
7.6 Thumbnail Plots 
 
In some cases, the use of thumbnail plots might be required to represent gages and time series 
locations.  Thumbnail Plots (Figure 7.8) are miniature versions of the full-size plots available in 
HEC-RTS, showing data for the time window.  The name of the location appears adjacent to the 
thumbnail plot.  As the time window updates, HEC-RTS refreshes the data and updates the 
thumbnail plot.  
 

 
Figure 7.8  Thumbnail Plots 
 
To view the legend for thumbnail plots: 
 

1. Right-click a Thumbnail Plot and click Icon Legend.  The Thumbnail Plot Legend 
dialog (Figure 7.9) opens. 

 
2. The legend displays the pathname, the color of the curve, and the minimum and 

maximum values of the curve.  The Thumbnail Plot Legend dialog provides you with 
information, to edit the color of the curve shown in the thumbnail plot (Chapter 18). 
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Figure 7.9  Thumbnail Plot Legend Dialog 

 
7.6.1 Using Plots 
 
If the quality color bar or thumbnail plot for a location indicates that the incoming data is 
questionable or bad, viewing the data in a plot can help you to determine the nature of the 
problem. 
 
To access plots of incoming data: 
 

1. Right-click on a time series icon in Acquisition Model's Map Window.  From the 
shortcut menu, (Figure 7.4) click Plot. 

 
2. This opens a two-dimensional plot(s) that contains data for the selected location for the 

current time window.  Figure 7.10 shows sample plots for both flow and stage gages.  
Use the Zoom Tool to zoom in on a specific portion of the plot.  See Section 2.3.2 for a 
more detailed description of the Zoom Tool.  In addition, a more detailed description on 
the plots can be found in Section 2.5.1. 

 

 
Figure 7.10  Sample Plot 
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7.6.2 Using Tables 
 
If the quality color bar or thumbnail plot for a location indicates that the incoming data is 
questionable or bad, viewing the data in a table can help to determine the nature of the problem. 
 
To access tables of incoming data: 
 

1. Right-click on a time series icon and click Tabulate. 
 

2. This opens a table that contains data for that location for the current time window.  Figure 
7.11 shows a sample table of the data for a flow and stage gages. 

 

 
Figure 7.11  Sample Table 

 
3. With a plot open, the data displayed in the plot can also be tabulated from the Plot dialog. 

From the File menu, click Tabulate.  For more details on tabular data, see Section 
10.8.2.  For printing and exporting tabular data, see Appendix J. 
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CHAPTER 8 
 

Monitoring and Validating Incoming Data 
 
As explained in Chapter 7, the Acquisition Module allows the user to review ongoing data 
acquisition processes and validated of questionable data.   Monitoring data in HEC-RTS, 
requires setup and the use of the DATCHK software (under separate documentation.) 
 
Data status lists provide the capability to monitor time series datasets by groups (such as all 
precipitation or all flow gages) and see details for more or fewer time series datasets than appear 
in the geo-referenced map display.   Another way to monitor incoming data is through the data 
streams.  Color-coded buttons display the status of individual data streams and allow the user to 
view specific information about individual data stream components, (e.g., continuous 
functioning, other alarms).  These features can help assess incoming data, ascertain that the 
incoming data streams are actually operational, and to identify specific locations where problems 
may exist in data acquisition. 
 
Once the observed (raw) data is in DSS files, the validation of this this data (revised) can occur 
either automatically or manually.  The manual process requires the use of validation lists to 
organize the data for ease of editing and validating. 
 
8.1 Data Status Summary 
 
To manipulate data status lists, from the Acquisition tab, from the Reports menu, click Data 
Status Summary, the Data Status Summary dialog (Figure 8.1) will open.  If a data status list 
has been displayed before, the Data Status Summary dialog displays the previously viewed 
data status list. 
 

 
Figure 8.1  Data Status Summary Dialog 
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From the Data Status Summary dialog (Figure 8.1), the user can create data status lists, select 
data status lists, copy a data status list, review the quality color bars, review how many values are 
missing, and find the time and date of the last valid data value for that particular time series data 
set. 
 
The Data Status Summary dialog (Figure 8.1) displays quality color bars and additional 
summary information for a group of time series gages listed in data status lists.  The data status 
lists allow the user to organize lists of gages for specific needs.  For example, a data status list 
might be created that displays all precipitation gages, all stream gages, or a mix of precipitation 
and stream gages that are needed for a specific forecast.  A data status list contains datasets from 
DSS files.   
 
8.1.1 Menu Bar 
 
Following is an overview of the Menu Bar for the Data Status Summary dialog (Figure 8.1).  
The commands available are: 
 
File From this menu the user can create a data status list, open a data status list, save a 

data status list, or copy one data status list to another.  Available commands are: 
New, Open, Save, Save As, and Close. 
 

Edit From this menu the user can edit the table of information that represents a data 
status list.  Also, the user can insert and delete rows, and get data from the HEC-
RTS DSS files.  Available commands are: Insert Row(s), Delete Row(s), Browse 
CWMS Database, and Browse DSS. 
 

View From this menu the user can plot and tabulate specific datasets, view the missing 
data segments of a dataset, validate data associated with a dataset, view the quality 
color bar legend, and refresh the data when the time window for the Data Status 
Summary dialog has changed.  Available commands are: Plot, Tabulate, Missing 
Segments, Validate, Quality Color Legend, Time Window, and Refresh. 

 
8.1.2 Shortcut Menu 
 
From the table in the Data Status Summary dialog (Figure 8.1), select a time series dataset (a 
row in the table), then right-click on the selected time series dataset, a shortcut menu will be 
displayed (Figure 8.2).  From the shortcut menu the user can plot, tabulate, view missing data, or 
validate data for the selected time series data set. 
 

 
Figure 8.2  Shortcut Menu 
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8.1.3 Creating a Data Status List 
 
To create a new data status list: 
 

1. From the Data Status Summary dialog (Figure 8.1), from the File menu, click New.  
The table on the Data Status Summary dialog is blank.  Select data sets from the 
database as detailed in this section below. 

 
2. Once a data path(s) has been selected, click Set Selected Identifiers.  The Select 

Pathnames dialog closes and the pathname selections will fill the Data Status 
Summary dialog's table (Figure 8.1). 

 
3. The table on the Data Status Summary dialog (Figure 8.1) displays the selected time 

series datasets from the DSS files. 
 

4. From the File menu, click Save.  A Save File Browser (Figure 8.3) opens; in the File 
name field enter a filename for the data status list.  Click OK, and a confirmation 
message is displayed saying the file has been saved.  By default, the file will be saved to 
the shared directory of the watershed with the extension .dataStatus. 

 

 
Figure 8.3  Save File Browser 

 
8.1.4 Remove a Dataset from a Data Status List 
 
To remove a dataset from a data status list: 
 

1. Select the data set(s) that needs to be removed in the Data Status Summary dialog 
(Figure 8.1). 
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2. Click Delete Row(s) from the Edit menu.  When finished with editing, save your 
changes to the Data Status Summary. 

 
8.1.5 Adding DSS Datasets to a Data Status List 
 
To add a dataset from a DSS file: 
 

1. From the Edit menu, click Browse DSS, the Select Pathnames dialog (Figure 8.6) 
opens. 

 

 
Figure 8.4  Select Pathname Dialog 

 
2. From the File menu, click Open and navigate to the desired DSS file.  Select the file, and 

click Open.  If a DSS file has been opened previously the Select Pathname dialog will 
display the DSS file, otherwise the dialog will be blank. 

 
3. On the Select Pathnames dialog, the table displays all the available pathnames in the 

selected DSS file. 
 

4. To add time series data sets, highlight the data in the table by clicking on the row and 
then click Select located at the bottom left hand corner of the Select Pathname dialog.  
The selection will display in the selection field.  Continue adding pathnames by selecting 
them in the table and clicking Select. 

 
5. To remove a dataset, select the path(s) to be removed in the path selection table, then 

click De-Select.  To clear all the selected paths, click Clear Selections.  To restore the 
previously cleared and de-selected paths, use Restore Selections. 

 
6. When all pathnames have been selected, click Add Pathnames located at the bottom 

right of the Select Pathname dialog. 
 

7. To search the DSS file use the Search By Parts lists (Figure 8.5).  The data will be 
filtered by the HEC-DSS pathname parts. 
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8.1.6 Replacing DSS Datasets to a Data Status List 
 
To replace a DSS dataset in a data status list: 
 

1. From the Data Status Summary dialog, click Browse DSS from the Edit menu and the 
Select Pathname dialog opens (Figure 8.6). 

 
2. Select the pathnames(s) to be replaced and then click Select located at the bottom left 

hand corner of the Select Pathname dialog. 
 

3. When finished editing, click Replace Pathnames at the bottom right hand corner of the 
Select Pathname dialog. 

 
8.1.7 Open an Existing Data Status List 
 
To open an existing data status list: 
 

1. From the Data Status Summary dialog (Figure 8.1), on the File menu, click Open, and 
an Open File browser (Figure 8.7) opens.  Enter a filename in the File name field or 
from the Files list select a data status list from the available files. 

 

 
Figure 8.5  Open File Browser 

 
2. The table on the Data Status Summary dialog displays the associated time series 

datasets for the selected data status list. 
 

3. Review the data to determine the time window for a forecast, add or delete time series 
datasets to the data status list, and edit data specific to the time series datasets.  If any 
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changes have been made to the data status list, from the File menu, click Save.  A 
warning will appear asking the user do you really want to replace the existing data status 
list. 

 
8.1.8 Make a Copy of an Existing Data Status List 
 
To make a copy of an existing data status list: 
 

1. From the Data Status Summary dialog (see Figure 8.1), on the File menu, click Open, 
and an Open File browser (Figure 8.7) opens.  Enter a filename in the File name field or 
from the Files list select a data status list from the available files. 

 
2. The table on the Data Status Summary dialog displays the associated time series 

datasets for the selected data status list. 
 

3. From the File menu, choose Save As, and a Save File Browser (similar to Figure 8.6) 
opens. 

 
4. Enter a filename for the new data status list.  Click OK, and a confirm message is 

displayed letting the user know the file has been saved.  
 
8.1.9 View Missing Data Segments 
 
HEC-RTS offers another way to focus in on problem data by filtering missing data segments for 
individual time series datasets.  To view details about missing data segments for a time series 
dataset, select a time series dataset from a data status list that is displayed in the Data Status 
Summary dialog (Figure 8.1). 
 
Select a time series dataset from the table on the Data Status Summary dialog (Figure 8.1).  
From the View menu, click Missing Segments, and the Missing Data Segments dialog (Figure 
8.8) opens. 
 

 
Figure 8.6  Missing Data Segments Dialog 
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Another way to access the Missing Data Segments dialog (Figure 8.8) is to select a time series 
data set from the table on the Data Status Summary dialog (Figure 8.1).  Right-click a time 
series dataset, rom the shortcut menu click Missing Segments, the Missing Data Segment 
dialog will open (Figure 8.8). 
 
For the selected time series datasets, the Missing Data Segments dialog (Figure 8.8) reports 
internal missing gaps for each time series.  The missing gaps are periods in the time series 
datasets where data values were expected, but are not present, and data values are present before 
and after these periods to form each gap.  For time series datasets that are defined to have a 
regular interval (e.g., 1Hour) data values are expected at each interval.  For time series datasets 
with an undefined or irregular interval (i.e., the time series interval is set to 0) an interval will 
need to be defined.  From the Data Status Summary dialog (Figure 8.1), enter a value (in hours) 
in the Consider missing when no report after hours box. 
 
Missing data in critical time series datasets has an impact on HEC-RTS decision support 
activities.  After analyzing the information displayed on the Missing Data Segments dialog 
(Figure 8.8), the user may decide to open the Data Validation Editor for the analyzed 
information to appropriately edit/correct the missing data values (Chapter 9). 
 
8.2 Validating Data Concepts 
 
Data retrieved by the HEC-RTS data capture system passes through an automated validation and 
transformation process.  Arriving data, before any revisions are applied, are preserved in HEC-
RTS DSS file(s), and are identified as raw data.  Data that are automatically processed for 
validation and for transformation into additional data parameters are separately saved to the 
EHC-RTS DSS file(s), and are identified as potentially revised data. 
 
To edit or validate data manually, use the Data Validation Editor (Chapter 9).  From the Data 
Validation Editor the user can edit or validate data from the individual time series icons or 
through time series data sets.  The other way to edit data is through validation lists.  A validation 
list is a way to organize your data in the HEC-RTS DSS file(s) for editing or validation. 
 
8.2.1 Selecting Appropriate Data Sets of Validation Lists 
 
When setting up a validation list for manual review of quality and performing potential revisions, 
it is important to select datasets identified as revised.  The HEC-RTS standard for identifying the 
two classes of raw and revised data is to add a "-raw" or "-rev" to the end of the version 
component of the HEC-RTS dataset description.  For example, the raw and revised data sets for a 
sample time series of stage data are: 
 
 Sample Location.Stage.Inst.1Hour.0.GOES-raw 
 Sample Location.Stage.Inst.1Hour.0.GOES-rev 
 
The raw dataset should never be changed from its original captured value.  Therefore, dataset 
descriptions ending in "-raw" should not appear in the validation lists.  However, when you 
select dataset descriptions ending in "-rev" in validation lists, the Data Validation Editor 
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(Chapter 9) will automatically retrieve the "-raw" data as well allowing the user to view and 
compare both the raw and revised data for that dataset. 
 
The user should never include transformed datasets in validation lists.  For example, in the HEC-
RTS automated transformation process, the sample location stage from the previous example 
may be used with a rating table lookup to produce a new stream flow record: 
 
 Sample Location.Flow.Inst.1Hour.0.GOES-rev 
 
When editing flow data, and then storing that data to HEC-RTS DSS file(s), the data will 
probably remain out of sync with the stage dataset.  This occurs because transformations are one-
way only: i.e., the HEC-RTS transformation process correctly processes a revised stage into a 
new revised flow by the automated transformation processing, but not vice versa.  If transformed 
values are edited, then the captured data must be manually revised as well, in order to keep them 
in agreement. 
 
8.2.2 Creating Validation Lists from the HEC-RTS 
 
After reviewing the quality of incoming data, you will have identified locations reporting 
questionable or invalid data.  A validation list is a way to organize data in the HEC-RTS DSS 
file(s) for editing or validation.  To create a validation list from time series icons in the map 
window: 
 

1. By default, HEC-RTS will select the time series datasets associated with all of the 
defined time series icons in the map window. 

 
2. If the user just wants to select a set of times series datasets for a validation list, select the 

time series icons that are needed.  From the Acquisition Module (Chapter 7), from the 
map window, click the Time Series Icon tool, hold down the SHIFT key, and then click 
on the time series icons to be included in a validation list. 

 
3. From the Edit menu, click Create Validation List.  The Create Validation List dialog 

(Figure 8.9) will open. 
 

 
Figure 8.7  Create Validation List Dialog 
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4. The table on the Create Validation List dialog will display a list of the selected datasets. 

 
5. In the Save As box, enter a name.  Click OK, the Create Validation List dialog closes 

(Figure 8.9).  By default, the file will be saved to the watershed shared directory with the 
extension .validationEditor. 

 
8.2.3 Creating Validation Lists from Data Status Lists 
 
A useful way to create a validation list is from a data status list: 
 

1. From the shared directory of a watershed, copy a data status list (*.dataStatus) file to a 
validation list (*.validationEditor) file (i.e., cp FlowGages.dataStatus 
FlowGages.validationEditor). 

 
2. As stated in Section 8.2.1 validation lists should only contain "-rev" records.  For the 

Data Validation Editor (Chapter 9) to be able to edit records from a validation list, each 
record needs to begin with PRIMARY=.  So, for each record in a validation list file, 
make sure each records starts with PRIMARY=.  Figure 8.10 shows an example of a 
validation list file - FlowGages.validationEditor that has been edited. 

 

  
Figure 8.8  Validation List File 

 
3. If the validation list is to be a comparison dataset, add a record that does not include 

PRIMARY=.  Remember that the HEC-RTS will automatically include the "-raw" record 
when a "-rev" record is accessed in the Data Validation Editor (Chapter 9).  Figure 8.11 
is an example of a validation list file (FlowGages.validationEditor) that has been edited 
as a comparison data set. 

 

 
Figure 8.9  Validation List File - Comparison Data Set 

 
4. Save the file, the user now has a validation list that will allow easy validation of the 

selected datasets. 
 

File: FlowGages.validationEditor 

 
PRIMARY=Beech Creek Sta.Flow-Reg.Inst.0.0.DCP-rev 

 

  

File: FlowGages.validationEditor (comparison data set) 

 

PRIMARY=Beech Creek Sta.Flow-Reg.Inst.0.0.DCP-rev 

Beech Creek Sta.Flow-Reg.Inst.0.0.DCP-raw 

 

PRIMARY=Blanchard.Flow-Reg.Inst.0.0.DCP-rev 
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CHAPTER 9 
 

Data Validation Editor 
 
 
9.1 Data Validation Editor 
 
The Data Validation Editor (Figure 9.1) allows the user to select specific time series locations 
for validation (selected icons) or to use pre-defined validation lists (list mode).  See Section 9.2 
for further details.  Before manually validating data, filtering chosen time series datasets so that 
only those time series datasets with identified problems will be displayed, is a good idea.  
Additionally, the Data Validation Editor offers tools for both text-entry editing (corrected 
values in a table) and graphical editing (graphically changing values in a plot).  
 

 
Figure 9.1  Data Validation Editor 
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From the Selected Data Set list (Figure 9.2), a select the specific time series dataset will be 
viewed or modified. 
 

 
Figure 9.2  Selected Data Set List 
 
By default the Data Validation Editor (Figure 9.1) only allows the editing of data that has been 
marked as being rejected, questionable, or missing.  The R (rejected), Q (questionable), and M 
(missing) fields (Figure 9.3) are related to the quality flags of the data and show counts of the 
data values in the Original column of the tabular data area (Section 9.1.6) for the selected data 
set and time window.  To edit the data from the Data Validation Editor (Figure 9.1), click Edit 
All Data, or from the Options menu, click Edit All Data. 
 

 
Figure 9.3  Data Quality Flags 
 
To view comparison time series datasets from validation lists (Chapter 7), from the Data 
Validation Editor (Figure 9.1) click Show Comparison in Plot , or from the View menu, click 
Show Comparison Data. 
 
To save the revised data values to a DSS file click the      Save icon, or from the File menu, click 
Save.  To undo all of the changes made to either the graphical or tabular data areas since the last 
Save, click the Undo icon     . Note: Once Save has been clicked, the user cannot undo any 
previous changes.) 
 
9.1.1 Menu Bar 
 
Following is an overview of the Menu Bar for the Data Validation Editor (Figure 9.1).  The 
commands available are: 
 
File Provides options for printing and saving changes to the HEC-RTS DSS file(s), 

and closing the Data Validation Editor.  Available commands are:  Save, 
Print Table, Print Graph, Page Setup, and Close. 
 

Edit A command that allows original data values  to be restored when the session is 
started, a flag to automatically make an estimate for a missing data value, and 
add data.  Available commands are:  Restore Original Data, Always Estimate 
Missing, and Add Data. 
 

View Allows comparison data if a comparison time series dataset has been included 
in a validation list (Chapter 7), and specify the number of decimal places that 
will be displayed in the Data Validation Editor.  Available commands are:  
Show Comparison Data, and Show Decimal Places. 
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Options Commands from this menu include allow editing of all data, process data to 
DSS file(s) in the background, scale plot to data received directly from the data 
streams or data that has been validated/transformed, and specify how changes 
are saved to the DSS file(s).   Available commands are:  Edit All Data, Save in 
Background, Scale Plot to Raw Data, and Storage Rule. 
 

Edit All Data Allows editing of any of the displayed data. 
 

Save in 
Background 

When selected, after a Save, the user can continue working while HEC-RTS 
saves the data in the Revised column to DSS file(s).  When this option is not 
selected (as is the default), the user must wait for the operation to complete. 
 

Scale Plot to 
Raw Data 

Scales the plot display to make all data values received directly from the data 
streams (raw data) and validated and transformed data visible in the plot.  This 
option is active by default because raw data can contain erroneously large or 
small data values.  If the options is deselected, the plot window will scale to 
validated/transformed data, leaving any raw data outside the plot window. 
 

Storage Rule Submenu that allows the user to specify how changes will be saved to DSS 
file(s) and accommodates multiple user access.  Available commands are: 
Delete Insert removes all unprotected data from the incoming data's time 
window, merges incoming time values between protected data, and updates 
unprotected data at corresponding times with incoming data.  Incoming data is 
discarded when protected data exists at corresponding times. 
Replace All merges incoming time values between data and replaces 
unprotected data at corresponding times with incoming data.  Incoming data is 
discarded when there is protected data at corresponding times. 
Do Not Replace merges incoming time values between data and discards 
incoming data when there is existing data at corresponding times. 
Replace Missing Values Only merges incoming time values between data and 
replaces unprotected missing data at corresponding times with incoming data.  
Incoming data is discarded when protected data exists at corresponding times. 
Replace with Non Missing merges incoming time values between data and 
replaces unprotected data at corresponding times with non-missing incoming 
data.  Incoming data is discarded when protected data exists at corresponding 
times. 

 
9.1.2 Time Window 
 
The time window used by the Data Validation Editor (Figure 9.1) is the same time window that 
is set for monitoring data in the Acquisition Module.  See Chapter 6 for information on setting 
the time window. 
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9.1.3 Graphical Editing Area 
 
The graphical editing area (Figure 9.4) displays the selected data set graphically.  By default, a 
blue line represents data values that have been validated and transformed (i.e., revised data), and 
a green line represents data values received directly from the data streams (i.e., raw data). 
 

 
Figure 9.4  Graphical Editing Area 
 
By default, the data shown in the plot scales so that all raw data and validated/transformed data 
are visible in the plot, this is because raw data can contain erroneously large or small data values.  
If the user clears Scale Plot to Raw Data from the Options menu (Data Validation Editor), the 
plot window will scale to validated/transformed data, potentially leaving any raw data beyond 
the validated/transformed value bounds outside of the plot window. 
 
The data that is visible in the tabular data area (Section 9.1.6) is highlighted as a green-hatched 
column in the graphical editing area (Figure 9.4).  A vertical black line (Figure 9.4) in the 
graphical editing area or running through the green-hatched column in the graphical edit area 
indicates the specific record in the tabular data area you have selected. 
 
9.1.4 Graphical Editing Tools 
 
The Graphical Editing Tools on the Data Validation Editor (Figure 9.1) allow viewing and 
editing of data in the graphical editing area.  The available tools are: 
 
 Zoom Tool 

The Zoom Tool allows the user to magnify specific sections in the graphical editing area.  
To use it, click and drag a rectangle around the area to be magnified.  If the user needs to 
zoom out, right-clicking repeatedly will progressively reverse the zoom magnification. 

 
 Pointer/Selector Tool 

The Pointer/Selector Tool allows the user to navigate in the graphical editing area and 
move quickly through a large data set.  Select one data point then hold the shift key and 
select another point in the graphical editing area to select a range of data points. 

 
 Single Point Edit Tool 

The Single Point Edit Tool allows the user to select an individual or a range of data points 
, execute estimates , and to set quality flags in the graphical editing area. 
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 Multi-Point Edit Tool 

With the Multi-Point Edit Tool, the user can edit data by drawing new plot lines in the 
graphical editing area. 

 
9.1.5 Shortcut Menus 
 
The user can customize the appearance of the graphical editing area by using several properties 
editors (Figure 9.5).  These properties editors are accessed by right-clicking on the different 
elements of the plot, and from the shortcut menu, clicking Edit Properties.  The available 
shortcut menus and properties editors are listed below: 
 

 
Figure 9.5  Graphical Editing Area - Shortcut Menus 
 

Polygon Properties This editor will allow you to customize borders and 
backgrounds of polygons; in the Data Validation Editor 
(Figure 9.1 this properties editor is for editing the green-hatched 
column in the graphical edit area (G2dPolygon shortcut menu). 
 

Viewport Properties This editor will allow you to customize the border, background, 
and gridlines of the graphical edit area, and also add markers 
(Viewport shortcut menu). 
 

Axis Properties This editor will allow you to customize the axis scale, tic marks, 
and axis type (Axis Tics shortcut menu). 
 

Label Properties This editor will allow you to add backgrounds and borders to the 
labels (Axis Label shortcut menu). 
 

Legend Properties This editor will allow you to move the legend to the right of the 
plot or to the bottom of the plot, or hide the legend (Legend 
Panel shortcut menu). 

 
9.1.6 Tabular Data Area 
 
The tabular data area (Figure 9.6) is a table that allows you to do text-entry data editing.  The 
following is a description of the columns available from the table: 
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• The Date/Time column specifies the time zone for the data and lists the specific date and 
time for each data point. 

 
• The Raw column will display the data received directly from the data streams, along with 

any quality flags (Table 9.1). 
 

 
Figure 9.6  Tabular Data Area 

 
• The Original column contains the validated/transformed data that you are reviewing, 

again along with any quality flags. 
 
• The Estimate/Entry column allows you to modify data values.  When cells in this 

column are white, you may edit the data. When cells in this column are gray, the rows are 
protected as being acceptable, having passed validation testing.  To allow editing, select 
Edit Acceptable Data or select Edit Acceptable Data from the Options menu. 

 
• The Revised column displays the values you have accepted.  The corrected values appear 

in the Revised column, along with quality flags. 
 

Table 9.1  Quality Flags for Data Validation 
Quality Flag  

* no quality (data has not been validated) 
Q questionable 
P protected 
K keyboard entry 
E estimate (graphical) 
I interpolated estimate 

NI negative incremental (rate of change) 
R rejected 
M set to missing 
A explicit form of blank for manual entry of quality 
+ inserted value 
 blank; indicates value passed all tests 
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9.1.7 Inserting/Deleting Values 
 
To add or delete data values in the tabular data area, first select Edit ALL Data from the 
Options menu.  When selected the Add Data and Delete Data options become visible.  To 
insert a data value, click Add Data.  The Extend Data Set dialog (Figure 9.7) opens. 
 

 
Figure 9.7  Extend Data Set Dialog 
 
Through the Extend Data Set dialog the user can insert data into the time window before the 
time window dates or append data to the time window. 
 
Insert Before In the Insert Before DD MMM YYYY, HH:MM section of the Extend Data 

Set dialog, select the number of rows that need to be inserted before the time 
window start date using the Number Rows selector.  The Start Date and Time 
fields will adjust their values according to the number of rows inserted. Click 
OK, the Extend Data Set dialog closes, new rows will be generated and added 
to the beginning of the table.  Enter values in the table for the added time 
periods. 
 

Append After In the Append After DD MMM YYYY, HH:MM section of the Extend Data 
Set dialog, select the number of rows to append after the time window end date 
using the Number Rows selector.  The End Date and Time fields will adjust 
their values according to the number of rows entered in the Number of Rows 
selector. Click OK, the Extend Data Set dialog closes and new rows will be 
generated and added to the end of the table.  Enter values in the table for the 
added time periods. 
 

To delete a data value, select a row from the table, click Delete Data, the row will no longer 
appear in the table.  When deleting there will be no warning, so be sure that you want to delete 
the data value before clicking Delete Data. 
 
9.1.8 Editing Commands 
 
Estimate (Figure 9.8) will automatically compute a data value for selected rows based on 
acceptable surrounding data in the Original column.  Rows (tabular editing) or data values 
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(graphical editing) can be multi-selected for estimation, provided that the selected rows are 
bracketed by acceptable values.  Tthe Estimate All will apply the estimate to all applicable data 
within the table. 
 

 
Figure 9.8  Editing Commands 
 
Accept accepts the changes in selected rows and copies the information to the Revised column.  
Changes are stored in memory and are not yet saved to the HEC-RTS DSS file(s).  Additionally, 
the user can use Accept All to save and accept all applicable data within the table. 
 
9.2 Choosing a Validation Mode 
 
There are two data validation modes, the Icons mode and the List mode.  In the Icons mode, is 
where the selection of time series gages for manual validation occurs from the map window or 
from the color bars in the Data Status Summary dialog (Section 8.1).  In the validation List 
mode, a validation list file is being selected.  From the Select Data Validation Data Sets dialog 
(Figure 9.9) is where data validation mode selection is made.  In addition, the user can control 
whether a long list of time series datasets should be filtered to only include those time series 
datasets with specific data quality indicators.  These filters are available in the Display Options 
group of the Select Data Validation Data Sets dialog (Figure 9.9).  This dialog opens any time 
the validation of data occurs in the watershed. 
 
9.2.1 Icons mode 
 

1. By default, all the datasets associated with all of the defined time series icons in the map 
window will be selected. 

 
2. ITo a selected subset of datasets, simply select the time series icons to validate.  From the 

map window, hold down the SHIFT key, and then click on the time series icons will be 
manually validatef. 

 
3. From the Control Panel, click Data Validation. 

 
4. The Select Data Validation Data Sets dialog (Figure 9.9) opens. 
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Figure 9.9  Select Data Validation Data Sets Dialog 

 
5. If time series icons from the map window have been selected, Selected Icons will 

automatically be selected.  If using the default mode, the user will need to click Icons. 
 

6. Click OK; the Data Validation Editor (Figure 9.1) opens. 
 
9.2.2 List mode 
 

1. From the Select Data Validation Data Sets dialog (Figure 9.9), click List. 
 

2. From Selection List select an existing validation list. 
 

3. Click OK, and the Data Validation Editor (Figure 9.1) opens. 
 

 
 
9.3 Editing Data 
 
From the Data Validation Editor (Figure 9.1) the user can edit data graphically (graphical 
editing area); enter data in the table (tabular data area); have the program estimate data values 
based on surrounding data; and accept questioned or rejected data.  When finished editing data, 
save (i.e., commit) results back to the DSS file(s).  Whether editing the data graphically or via 

If you access the Select Data Validation Data Sets dialog (Figure 
9.9) from the Data Status Summary Dialog (Figure 8.1), only the 
Select Icons mode is available without comparisons. 

 

Tip 
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the tabular display, the HEC-RTS keeps the graphical and tabular areas synchronized as the user 
navigates and make changes. 
 
9.3.1 Graphical Editing 
 
Edit data graphically by using the Graphical Editing Tools.  Note, however, that the user cannot 
execute estimates for acceptable quality data with the Graphical Editing Tools (Section 9.1.3).  
Editing data graphically can also be accomplished by using the Single Point Edit Tool or the 
Multi-Point Edit Tool. 
 
To change an existing point with the Single Point Edit Tool        : 
 

1. If the Single Point Edit Tool is not selected, from the graphical editing tools, click the 
Single Point Edit Tool. 

 
2. Be sure to put the Data Validation Editor in Edit Mode, when needing to edit data, 

select Edit All Data from the Options menu. 
 

3. Point to a location in the graphical editing area and double-click, the point becomes a 
pink triangle. 

 
4. To move the point, select the Pointer/Selector Tool, click and drag the pink triangle.  

The point will only move up and down; as the point moves, the numerical value of the 
data point will change (see the tabular data area). 

 
5. locate the correct location for the data point, right-click on the pink triangle. From the 

shortcut menu, click Accept. The Quality Flag will automatically be set to estimate, and 
the data will be protected. 

 
6. A red line will be drawn where the old data value for the point was, and a blue line will 

connect to the new position of the point. 
 

7. If the new data value is correct, click     to save the new data value to the HEC-RTS DSS 
File(s). 

 
With the Multi-Point Edit Tool         , the user can produce estimates for data along multi-point 
lines: 
 

1. If the Multi-Point Edit Tool is not selected, from the graphical editing tools, click the 
Multi-Point Edit Tool. 

 
2. Be sure to put the Data Validation Editor in Edit Mode, when needing to edit data, 

select Edit All Data from the Options menu. 
 

3. Click the mouse where multiple new values need to be added along a line, movement will 
be progressively to the right, moving ahead in time. 
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4. At the end of the line, click and then right-click, a pink triangle will now display where 
the mouse was clicked. 

 
5. If the values are correct, click Accept.  The Quality Flag will automatically be set to 

estimate, and the data will be protected. 
 

6. A red line will be drawn where the old data values were, and a blue line will connect to 
the new position of the points. 

 
7. After verifying that the new data values are correct, click      to save the new data values 

to the DSS file(s). 
 
9.3.2 Tabular Editing 
 
When the Data Validation Editor opens, it jumps directly to the first problem data point, if any.  
In the tabular data area, the Estimate/Entry column allows the modification of numerical data 
values.  When cells in this column display with white backgrounds, data can be edited. 
 
To edit data in the table: 
 

1. Be sure to put the Data Validation Editor in Edit Mode, when needing to edit data that 
is flagged acceptable, select Edit All Data from the Options menu.. 

 
2. To edit data, enter values in the Estimate/Entry column (data is given a quality flag of 

keyboard), or select a cell and click Estimate (data is given a quality flag of estimate), 
this will create a data value that is based on the surrounding data values. 

 
3. If satisfied with the values, click Accept.  The new data value will appear in the Revised 

column with a Quality Flag of keyboard or estimate, and the data will be protected. 
 

4. A red line will be drawn where the old data values were, and a blue line will connect to 
the new position of the points. 

 
5. If the new data values are correct, click      to save the new data values to the HEC-RTS 

DSS file(s). 
 
The tabular data area has a shortcut menu (shown below) that allows the user to set quality flags 
on data, whether the data is protected or not, and, provides two ways to fill in data values on the 
table. 
 
Using Fill - Linear: 
 

1. This will produce a linear interpolation of values between two values in the 
Estimate/Entry column. 

 
2. Enter values in the first and last rows of the range of interest to create two base values (or 

use Estimate to create the new values). 
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3. Select the range of rows, starting with the first base value and ending with the second 
base value.  Select a range of rows either by clicking on a row and dragging, or by 
clicking one row and then selecting another by holding down the SHIFT key. 

 
4. Right-click, from the shortcut menu click Fill – Linear.  The cells in the Estimate/Entry 

column of the selected rows will now contain data values produce from a linear 
interpolation between the two base values. 

 
5. If satisfied with the values, click Accept.  The new data values will appear in the Revised 

column with a Quality Flag of keyboard or estimate, and the data will be protected. 
 

6. A red line will be drawn where the old data values were, and a blue line will connect to 
the new position of the points. 

 
7. If the new data values are correct, click      to save the new data values to the DSS file(s). 

 
Using Fill - Repeat: 
 

1. This will duplicate the selected value in all of the selected cells in the Estimate/Entry 
column. 

 
2. Enter a new value in the first row (or use Estimate to create the new value). 

 
3. Select the range of rows, starting with the base value.  Select a range of rows either by 

clicking on a row and dragging, or by clicking one row and then selecting another by 
holding down the SHIFT key. 

 
4. Right-click, from the shortcut menu click Fill – Repeat.  The cells in the Estimate/Entry 

column of the selected rows will now contain the same value as the data that was entered 
for the base value. 

 
5. If satisfied with the values, click Accept and the new data values will appear in the 

Revised column with a Quality Flag of keyboard or estimate, and the data will be 
protected. 

 
6. A red line will be drawn where the old data values were, and a blue line will connect to 

the new position of the points. 
 

7. If the new data values are correct, click      to save the new data values to the DSS file(s). 
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CHAPTER 10 
 

Visualization Module 
 
The Visualization Module displays observed data and results of computations, and allows the 
user to monitor and evaluate the current state of the watershed. Spatial data, such as contours or 
grid cells, and time series data, such as hydrographs, can also be displayed in the Visualization 
Map Window. As in the Acquisition Map Window, icons in the Map Window can be set up to 
change color, allowing visualization of the hydrology in the watershed as data arrives. 
 
Chapters 18 and 19, describe how to set up and configure a watershed's Visualization Map with 
the thumbnail plots and threshold bars for time series icon layers and time series icons.  The rest 
of this chapter provides information on the Visualization Module. 
 
10.1 Visualization Interface 
 
The Visualization Module provides visual information on the current conditions in a watershed 
and the associated hydrometeorological data in a geo-referenced context. From the Watershed 
Pane, click the Visualization tab (Figure 10.1). The Visualization Map Window and the 
different components for the Visualization Module are illustrated in Figure 10.1. A detailed 
discussion of common screen components is presented in Section 2.3. 
 

 
Figure 10.1  Visualization Module 
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10.1.1 Menu Bar 
 
Following is an overview of the Menu Bar (Figure 10.1) for the Visualization Module. The 
File, View, Tools, Window, and Help menus are discussed in Section 2.3.1. The commands 
available from the menus allow for viewing the current conditions in a watershed and the 
associated hydrometeorological data in a geo-referenced context. 
 

Maps and 
Window 

This menu contains items that allow the user to setup, configure, and edit 
map layers and their display properties. Includes adding a new shapefile, 
editing the display color(s) of a shapefile, remove a map layer from the 
Map Window. In addition, configuring the Map Window visualization 
extents, load a background map from the Internet, and set which 
coordinates the Map Window will use. Available commands in the 
Maps/Window menus are: Map Layers, Default Map Properties, 
Zoom To All, Duplicate Window, Detach Window, Add Map Layers, 
Remove Map Layers, Add Internet Map, Display Map Coordinates, 
New Map Window, Map Window Properties, Save Map Image, and 
Sync Map Windows. 
 

Data 
Visualization 

This menu provides access to the gridded data, which represents the 
precipitation for the watershed. The only available command is 
GriddedData, which is a sub-menu that allows the user to add or delete 
gridsets (a sequence or time series of grids) from the list of gridsets, 
update the data grid to display current data for the selected time window, 
and provides a list of gridsets, with the active gridset having a check 
mark. Available commands are: New Gridset, Edit Gridset, Delete 
Gridsets, Cumulative Display, Animation Delay, and None. Also, if 
any gridsets are created they will be listed in the GriddedData sub-
menu. 

10.1.2 Visualization Tab 
 
The Visualization tab (Figure 10.1) contains commands specific for the Visualization Module. 
These commands include setting up a time window, updating time series icons in the Map 
Window, and grid animation controls for visualizing gridded precipitation for the watershed. 
 
10.1.3 Map Window 
 
When the Visualization tab is selected (Figure 10.1), the Visualization Map Window is 
displayed. The Visualization Map Window contains map layers and time series icons for 
visualizing watershed processes in a geo-referenced context. The primary function of the 
Visualization Module is to provide a meaningful visual representation of observed data. 
Threshold color bars or thumbnail plots, which update dynamically to reflect current conditions, 
are usually used/configured for bserved data locations which are viewed daily and are of critical 
importance within a watershed. For other locations, time series icons might be used to display 
data as space-conserving graphical images or dots. Time series icons are setup in the Setup tab 
in the Watershed Pane, which is described in Chapter 19. 
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In most cases, for the Visualization Module, the user should configure time series icons to 
display as threshold color bars. Threshold color bars display current data into multi-colored 
strips, such as green, amber, and red (colors can be specified by the user), that provide a quick 
way to view locations that are exceeding critical threshold limits. 
 
10.1.4 Time Series Icon Controls 
 
The Time Series Icon Controls provide a mechanism to setup Time Series Icon Layer 
attributes that are displayed within the watershed. The Time Series Icon Controls are located on 
the Visualization, Acquisition, and Modeling tabs.  There are three attributes available: Icons 
Type, Value, and Layer (Figure 10.2). 
 

Icons Type Icon Type forces all icons within the Map Window to display as the selected 
Icon Type in the list.  Selecting the Default option in the list will display the 
icons as they were set in the Time Series Icon Properties Dialog. 
 

Value The Value selection provides a way to display time series icon data as labels. 
the labels will display next to or on the location of the associated time series 
icons.  For example, the user could choose to display the data's total, 
minimum, and maximums values as labels (multiple values can be selected). 
 

Layer Layer allows the user to select sub-layers that are visible in the Map Window 
(multiple layers can be selected). 

 
By selecting attributes for the time series icon layer(s), the user can change how all time series 
icons are displayed within the visualization process at once.  For more detailed information on 
how to configure the properties that control the threshold color bar icons displayed see Chapter 
19. 
 

 
Figure 10.2  Time Series Icon Controls 
 
10.2 Preparing to Monitor Current Conditions 
 
To begin monitoring current conditions in a watershed, the time window for viewing and 
updating the color bars and plot icons in the map display needs to be defined. 
 
10.2.1 Set Time Window 
 
HEC-RTS provides multiple options for defining time windows, set a specific (i.e., fixed) time 
window (used when reviewing a specific historical event); or, set a time window relative to the 
current time (which is the default setting, used to monitor incoming data in real-time). 
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To set or change the time window: 
 

1. Click Specific Time Window on the Visualization Tab (Figure 10.3). 
 

 
Figure 10.3  Setting the Specific Time Window. 

 
2. To set the visualization relative to the current date and time, select the Relative to 

Current Time and enter the Look Back Time and select either Days or Hours as the 
time unit.  Normally the time window would be set to extend backward one to thirty days 
from the current time.  Optionally, the user can enter a Look Ahead Time and select 
either days or hours; this allows HEC-RTS to look ahead at data (useful if looking at 
forecasted datasets). 

 
3. To set the visualization to a historical time window, select Specific Time Window and 

enter the Start Date and Time of the time window and the End Date and Time of the 
time window for the historic data. 

 
4. Click Update Plot Icons, and the Specific Time Window specifications will take effect. 

 
10.2.2 Time Series Icon Shortcut Menu 
 
In the Visualization Module, the time series icons in the Map Window have a shortcut menu 
(Figure 10.4) that provides the ability to view the data associated with a selected time series icon 
in a plot, tabulate table, or MS Excel®. Another option is that the user can view the legend of the 
selected time series icon (Section 10.3.1). The shortcut menu is available for all time series icons 
(i.e., for the color bars, thumbnail plots, graphics, or dots). 
 
10.3 Visualizing Incoming Data 
 
The Visualization Module provides tools for evaluating the current state of the watershed.  The 
module's main display has several visualization tools that help to identify whether critical 
conditions exist.  Icons, plots and graphs, the Alert Message Bar, and animated background 
images can all be used for monitoring observed data for a watershed. 
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Figure 10.4  Time Series Icon Shortcut Menu 
 
Icons in the Visualization Module provide a flexible set of tools to facilitate monitoring and 
evaluating the current state of the watershed.  To view current conditions at a glance, the user 
can replace graphical icons with dynamic thumbnail plots and threshold color bars that change 
color to reflect the status of various parameters at a particular location. 
 
10.3.1 Threshold Color Bars 
 
A Threshold Color Bar (Figure 10.5) is a thick, segmented line representing a linear histogram 
that compares current data against threshold values set for a location.  Because threshold color 
bars are location dependent, the values for each time series icon individually (Section 18.5) must 
be set.  The name of the location appears adjacent to the threshold color bar, and the length of the 
Threshold Color Bar represents a time line equal to the duration of the time window.  Segments 
along the color bar reflect time intervals, with colors corresponding to the limits that have been 
defined.  The threshold color bars are updated dynamically at the time interval that was entered 
in the Set Time Window dialog (Figure 10.3). 
 

 
Figure 10.5  Threshold Color Bars 
 
As part of daily routine of reviewing data in a watershed, the user should review threshold color 
bars to determine if the incoming data is good and which data needs to be validated.  To view the 
legend for threshold color bars: 
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1. Select either the Time Series Icon Tool or Selector Tool from the Map Window 
Toolbar. 

 
2. Right-click on a time series icon that has the icon type of a Threshold Color Bar, click 

Icon Legend from the shortcut menu, and the Threshold Legend dialog (Figure 10.6) 
opens. 

 

 
Figure 10.6  Threshold Legend Dialog 

 
3. The legend shows the threshold values for the current data and the colors that represent 

each threshold value. 
 
As conditions change at a location, the threshold color bar automatically changes colors.  For 
example, at a precipitation location, green might represent precipitation between .01 to .11 
inches, corresponding to normal conditions.  Orange might represent values greater than .51 
inches, but less than 1.0 inch, which indicate a flood warning level.  Red would represent values 
above 1.0 inch, signaling flows above flood stage. 
 
10.3.2 Thumbnail Plots 
 
In some cases, you may wish to use thumbnail plots to represent gages and time series locations.  
Thumbnail Plots (Figure 10.7) are miniature versions of the full-size plots, showing data for the 
duration of the time window.  The name of the location appears adjacent to the thumbnail plot.  
As the time window updates, the CAVI refreshes the data and updates the plot. 
 
To view the legend for thumbnail plots: 
 

1. Select either the Time Series Icon Tool or Selector Tool from the Map Window 
Toolbar. 

 
2. Right-click a thumbnail plot, click Icon Legend from the shortcut menu, and the 

Thumbnail Plot Legend dialog (Figure 10.8) opens. 
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Figure 10.7  Thumbnail Plots 

 

 
Figure 10.8  Thumbnail Plot Legend Dialog 

 
3. The legend displays the pathname, the color of the curve, and the minimum and 

maximum values of the curve.  To edit the color of the curve shown in the thumbnail 
plot, see Section 18.4. 

 
10.3.3 Using Plots 
 
If the threshold color bar or thumbnail plot for a location indicates that the incoming data is 
questionable or bad, viewing the data in a plot can help you to determine the nature of the 
problem. 
 
To access plots of incoming data: 
 

1. Select either the Time Series Icon Tool or Selector Tool from the Map Window 
Toolbar. 

 
2. Right-click on a time series icon, click Plot from the shortcut menu and a Plot dialog 

(Figure 10.9) opens. 
 

3. The Plot dialog displays a two-dimensional plot that contains data for that location for 
the current time window.  Use the Zoom Tool to zoom in on a specific portion of the 
plot.  See Section 2.3.2 for a more detailed description of the Zoom Tool.  In addition, a 
more detailed description on the plots can be found in Section 2.5.1. 
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Figure 10.9  Plot Dialog 

 
10.3.4 Using Tables 
 
If the color bar or thumbnail plot for a location suggests that the incoming data is atypical or 
unexpected, viewing the data in a table allows you to examine the data in finer detail. 
 
To access tables of incoming data: 
 

1. Select either the Time Series Icon Tool or Selector Tool from the Map Window 
Toolbar. 

 
2. Right-click on a time series icon, click Tabulate from the shortcut menu, and the Table 

dialog (Figure 10.10) opens. 
 

 
Figure 10.10  Table Dialog 
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From the Plot dialog (Figure 10.9), the user can also tabulate the data: 
 

1. Open a Plot dialog as shown in Section 10.3.3. 
 

2. From the File menu, click Tabulate, and the Table dialog (Figure 10.10) opens. 
 

3. For more details on tabular data, see Section 2.5.2.  For printing and exporting tabular 
data, see Appendix J. 

 
10.4 Precipitation Grids 
 
Precipitation data can be reviewed at the time series icons to examine individual gage reports, 
identify problems, and confirm the validity of the data.  The Visualization module also allows 
precipitation data to be viewed as grids (Figure 10.11), which gives a view of the precipitation 
over the whole watershed for an interval of time. 
 

 
Figure 10.11  Precipitation Grids 
 
Precipitation grids are created by interpolation between gages or by loading radar precipitation 
reports from the National Weather Service (NWS) or other external sources.  Individual 
precipitation grids are grouped into sequences called "gridsets" using the HEC-GridUtil program 
(Appendix G). To view gridsets you will use the grid animation controls in the Visualization 
Module. 



Chapter 10 – Visualization Module HEC-RTS User's Manual 

10-10 

 
10.5 Grid Animation Controls 
 
The grid animation controls allows the user to view precipitation grids for the time window that 
has been chosen. The controls are located on the Animate dialog (Figure 10.12) which is 
accessible from the Visualization Module. Choose Animate from the View menu to display the 
Animate dialog. The dates above the slider bar show the start and end time of the grids that are 
visible in the display window. The date and time shown beneath the centered controls indicate 
the date and time of the data currently being displayed. A slider bar and video-player-style 
buttons control animated playback. The slider perform navigation on the active precipitation 
gridset for a specific time during the time window. With these playback controls, the user can 
play an animation of the active precipitation gridset from the beginning to the end of the 
visualization time window. 
 

 
Figure 10.12  Animation Dialog 
 
The video-player-style buttons (Figure 10.12) function as follows: 

 Skip to Beginning Sets the slider at the beginning of the time window and displays 
the status of data at that time. 
 

 
Step Back Steps the image back one time interval. 

 

 
Pause Pauses playback. 

 
 Stop Stops playback. 

 

 
Play Plays the animation, one time interval at a time, starting at the 

location of the slider. 
 

 Step Forward Steps the image forward one time interval. 
 

 Fast Forward Plays through the animation in fast forward mode. 
 

 Skip to End Moves the slider and the image to the status at the end of the time 
window. 
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10.6 Precipitation Gridsets 
 
A gridset can be thought of as a sequence or time series of grids. Since a single DSS record of 
grid data contains data for only one time interval, gridsets must be created within the watershed 
before the viewing of precipitation grids changing through time over the watershed can occur. 
Gridsets are created by HEC-GridUtil. See Appendix G for more instructions on creating 
gridsets in HEC-GridUtil. 
 
10.6.1 Adding a Gridset 
 
Once a gridset has been created for the watershed, the grdiset needs to be added to the watershed 
through the Visualization Module for viewing in the Visualization Map Window. 
 
To add a gridset to the watershed: 
 

1. On the Data Visualization menu, point to GriddedData, click New GridSet (Figure 
10.13). 

 

 
Figure 10.13  Gridded Data Layer Selection 

 
2. The Create New GRID dialog will open. Enter a Name for the new gridset (required), 

and a description for the gridset is optional. The new gridesets Directory will be 
automatically generated, but can also be modified.  

 

In order for playback to occur, you must define the coordinate system for both the 
watershed layers and the gridset and there must be data present for the time window 
specified. If no grid is available for the time step, the label centered over the grid 
animation controls will end with No Data. 
 
Use CWMS-Vue to check for available grids in 
$CWMS_HOME/dated/db/grid/precip.YYYY.MM.dss. You may need to run gageInterp or 
your grid-loading program to populate the DSS files for this time interval. 

Tip 
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3. Click OK and the Create New GRID dialog will close. 
 

4. The Edit Grid Set dialog will open. Click Add File(s) and navigate to the available 
precipitation gridsets created in the HEC-GridUtil program. Next set each of the Grid Set 
Identifiers listed using the drop-down options.  

 
5. Click OK and the Edit Grid Set dialog will close. 

 
6. The available GriddedData sub-menu will list all of the available precipitation gridsets 

created from the HEC-GridUtil program. To be available to HEC-RTS, a gridset must be 
defined using the file selection method, and cannot be associated with a fixed time 
window. The gridsets listed, are the gridsets that have been selected for the watershed 
using the New GridSet (Figure 10.13) option in the GriddedData sub-menu. 

 
7. To remove gridsets from the watershed, from the GriddedData sub-menu select Delete 

Gridsets and the Delete Object dialog will open (Figure 10.13). 
  

8. Next select the gridsets to be deleted from the watershed. Click OK and the Delete 
Object dialog will close. 

 
10.6.2 Selecting a Gridset 
 
To select a gridset: 
 

1. On the Visualization menu, point to GriddedData. 
 

2. At the bottom of the submenu, the names of the gridsets that have been added will 
display. Select the gridset for viewing. None displays no precipitation grids in the Map 
Window. 

 
3. When a gridset is selected for viewing, a checkmark will appear beside its name in the 

list. 
 
10.6.3 Controlling Properties of a Gridset 
 
The user can control the visibility and color scheme of the gridset through the Map Layers 
dialog (Chapter 3). In the Visualization Module, the Map Layers dialog displays the selected 
gridset layer. In addition, the user can control the color scheme, tic intervals, and the 
minimum/maximum values for the contour limits from the Gridded Data layer. 
 
Changing a gridset's properties: 
 

1. From the Maps menu, click Map Layers and the Map Layers dialog (Section 3.1) 
opens. 

 
2. From the tree, right-click on a gridset layer, from the shortcut menu click Properties. 

The Grid Display Options dialog (Figure 10.14) opens. 
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Figure 10.14  Grid Display Options Dialog Box 

 
3. The name of the active gridset is displayed at the top of the Grid Display Options 

dialog. 
 

4. The list at the top left of the Grid Display Options dialog contains six pre-set color 
contour schemes, with the default being Precipitation. 

 
5. Set the tic interval by entering a value in the Tic Interval field.  

 
6. In the Contour Limits panel set the minimum and maximum contour values. By default, 

HEC-RTS automatically determines the minimum and maximum contour values. To 
enter these values manually, clear System Specified Min/Max Values. Then enter values 
in the Maximum and Minimum fields. 

 
7. For additonal settings, click Advanced. The Grid Display Options dialog expands 

(Figure 10.15) to include options for brightness, saturation, transparency, aspect shading, 
maximum clipping, and minimum clipping. 

 

 
Figure 10.15  Grid Display Options Dialog – Advanced 
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8. To control the Brightness (the amount of white, measured from 0.0 to 1.0), Saturation 

(the amount of black, measured from 0.0 to 1.0), and Transparency (the level of opacity 
or alpha, measured from 0.0 to 1.0) of the gridded data layer, moving the sliders or enter 
values into the text fields. The color scale to the right will update according to the 
selections made. 

 
9. When using elevation maps, the user may wish to choose Aspect Shading as the color 

contour scheme. Using Aspect Shading makes the elevation map appear in relief by 
placing an imaginary light source above the map and shading the elevation contours. 
When the Aspect Shading option is selected, use the Angle slider to adjust the angle of 
the light source. 

 
10. By default, the Maximum Clipping and Minimum Clipping options are deselected. If 

selected, the Value sliders and Color buttons become available. The Value sliders allow 
the user to specify the amount of clipping within the contour limits specified, or the user 
can enter values in the boxes. Click Color, the Color Chooser appears, for more 
information on the Color Chooser see Appendix E. 

 
10.6.4 Controlling the Scale of a Gridset 
 
To set the visualization scale for the gridded data layer: 
 

1. From the Maps menu, click Map Layers. The Map Layers dialog (Section 3.1) opens. 
 

2. From the tree, right-click on the gridset layer, from the shortcut menu, click Properties, 
the Grid Display Options dialog (Figure 10.16) opens. 

 

 
Figure 10.16  Grid Display Options Dialog - Scale Tab 

 
3. Click Scale (Figure 10.16). both zoom-in and zoom-out scale factors can be set from the 

Grid Display Options dialog. By default the Gridded Data Layer is set for Always 
show layer. To set visualization scales click Only show layer in the following scale 
range. 



HEC-RTS User's Manual Chapter 10 – Visualization Module 

10-15 

 
4. To set the scale so that the gridded data layer becomes visible when zooming-in, set the 

scale to the current scale by clicking Set to Current. If the user wishes to enter a value, 
from the Only visible below 1 field, enter the scale factor. 

 
5. To set the scale so that the gridded data layer becomes visible when zooming-out, set the 

scale to the current scale by clicking Set to Current. If the user wishes to enter a value, 
from the Only visible above 1 field enter the scale factor. 

 
6. Click OK, the Grid Display Options dialog (Figure 10.16) closes, and the visualization 

scale is set for the gridded data layer. 
 

7. Click OK, the Map Layers dialog (Section 3.1) closes. 
 
Alternatively, the scale can also be edited in the Edit Grid Set dialog (Figure 10.17). This Edit 
Grid Set dialog is accessed by selecting a gridset via the Edit Grid Set dialog from the Data 
Visualization tab, GriddedData menu, click Edit Grid 
 

 
Figure 10.17  Edit Grid Set Dialog - Scaling Limits 
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CHAPTER 11 
 

Modeling Module 
 
The Modeling Module in HEC-RTS is the grouping of commands for model execution.  These 
include commands for creating and managing forecast alternatives, editing selected model 
parameters, executing alternatives, and evaluating results. 
 
Figure 11.1 shows the flow of data and information through the software applications.  HEC-
RTS has six standard software applications available: the meteorological preprocessors HEC-
MetVue and MFP, the watershed runoff model HEC-HMS, the reservoir simulation model HEC-
ResSim, the hydraulic routing model HEC-RAS, and the flood consequences analysis model 
HEC-FIA.  These software applications and their inputs and outputs are described in Section 1.2. 
 
The meteorological preprocessors HEC-MetVue and MFP combine observed precipitation data 
and future precipitation information into a single precipitation dataset that can be used by the 
watershed runoff model (HEC-HMS).  Using the observed and future precipitation from a 
meteorological preprocessor (HEC-MetVue or MFP), HEC-HMS computes runoff.  HEC-
ResSim uses uncontrolled flows (typically computed by HEC-HMS) as input and simulates 
reservoir releases.  In turn, controlled flows (computed by HEC-ResSim) are used as boundary 
conditions to the hydraulic routing model HEC-RAS.  (HEC-RAS can also use flows computed 
by HEC-HMS or supplemental models as input).  HEC-RAS computes stage, which is input to 
HEC-FIA.  HEC-FIA analyzes flood consequences.  (HEC-FIA can also use flow computed by 
HEC-HMS, or HEC-ResSim as input.) 
 
Results include impact and action reports from HEC-FIA, inundations maps that can be viewed 
with an HEC-RAS Tool - RAS Mapper, and simulated release schedules from HEC-ResSim. 
 
The following is a typical workflow for forecasting: 
 

1. Check that critical data are available using the Acquisition Module (Chapter 7). 
 

2. Create a new Forecast.  A Forecast (Chapter 12) is a simulation of watershed processes 
and consequences of flooding based on input data and information and hydrologic, 
reservoir operation, hydraulic, and impact analysis applications configured.  During a 
Forecast, a Forecast Run is ran at a specific forecast time.  (Recall that, a Forecast Run 
is a single forecast scenario defined by a specific set of data, information, and forecast 
alternatives.) HEC-RTS copies all the necessary files to a dated forecast directory 
(Appendix B).  The user should check the data for errors and ensure that data was 
extracted properly. 

 
3.   Compute the forecast and check results.  Forecast results include flow and stage in the 

channel from watershed runoff, reservoir release schedules, floodplain inundation maps, 
floodplain consequence reports, and reports listing actions for emergency responders to 
take.  These results inform water management decision making. 
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Figure 11.1  Data Flow Between Models 
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View results tables and plots from the Modeling Module.  Compute messages provide 
information about each step of the computation process.  Model-specific reports provide 
details about the individual models.  The RAS Mapper Tool form HEC-RAS lets the user 
view inundation maps. To make adjustments to the models, HEC-RTS has access to model 
editors; Forecast Runs can be edited; and, override controls can be set.  These features are 
discussed in Chapter 20. 

 
4.  Manage forecast information.  When model results have been reviewed and validated, 

HEC-RTS provides tools to assist in managing information.  Forecast results and data can 
be posted to DSS file(s), save modeling data, and freeze a forecast to protect it from 
further editing. 

11.1 Modeling Module Interface 
The Modeling Module is the grouping of commands for model execution.  To access the 
Modeling Module, click the Modeling tab.  The Modeling Module is illustrated in Figure 11.2.  
A detailed discussion of common screen components is presented in Chapter 2. 

 

Figure 11.2  Models Module 
 

11.1.1 Menu Bar 
The following is an overview of the menu bar for the Modeling Module (Figure 11.2).  The File, 
View, Tools, and Help menus are discussed in Section 2.3.1. 
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Forecast From this menu the user can create, edit, open, save, delete and archive forecasts; 

review information about the active forecast; post active forecast results to the 
database; freeze a forecast so it cannot be edited by other users; and compute all 
models or compute individual models.  Available commands are: New, Open, 
Recent, Continue, Compute Selector, Run Selector, Run Extract, Edit Time 
Window, Information, Logs, Close, Save,  Archive, Delete, Restore, 
Upload/Download Forecast, Default Time Window, Model Linking, Schedule 
Forecast Setup, and Manage Scheduled Forecasts. 

Logs sub-menu From this sub-menu the user can view the log files from Extract, Post and 
Compute.  Available commands are: Extract, Post and Compute. 

The commands in the Forecast menu and Log sub-menu are discussed in Chapter 12. 
 

11.1.2 Modeling Tab 
The Modeling tab (Figure 11.2) displays the time window, current date and time of the active 
forecast.  Below these details is the Forecast Run tree, which allows the user to select 
alternatives.  In the bottom panel, there are five tabs which include Actions, Reports, Scripts, 
Icon Layers, and Workflow. 
 

11.1.3 Map Window 
In the Modeling Module, the Map Window contains the model schematic elements for the 
active forecast in a geo-referenced context.  In addition, time series icons are available that 
provide access to additional model data or other time series data.  Time series icons are setup in 
the Setup Module, which is described in Chapter 18. 

11.1.4 Time Series Icon Controls 
The Time Series Icon Controls allow you to select the Time Series Icon Layer attributes that 
are displayed within the Watershed.  The Time Series Icon Controls are located on the 
Visualization, Acquisition, and Modeling tabs.  There are three attributes available: Icons Type, 
Value, and Layer (Figure 11.3). 

 

Icons Type The Icon Type forces all icons within the Display Area to display as the 
selected Icon Type in the list.  Selecting the Default option in the list will 
display the icons as they were set in the Time Series Icon Properties dialog. 

Value The Value selection allows you to display the Time Series Icon’s data as 
labels, which display next to or on the location of their associated Time Series 
Icons.  For example, you can choose to display the data’s total, minimum, and 
maximums values as labels.  Multiple values can be selected at once. 
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Layer Layer allows you to select the Sub-Layers that are visible in the Display Area.  
Multiple layers can be selected at once. 

 
By selecting the attributes, you can change how all Time Series Icons are displayed within the 
Visualization process at once.  For more detailed information on how to configure the properties 
that control the threshold color bar icons displayed (Chapter 18). 
 

 
Figure 11.3  Time Series Icon Controls 

11.1.5 Time Series Icon Shortcut Menu 
In the Visualization Module, the time series icons in the Display Area have a shortcut menu 
(Figure 10.4) that allows you to view the data associated with a selected time series icon in a 
plot, tabulate table, or MS Excel.  Another option is that you can view the legend of the selected 
time series icon (Section 10.3.1).  The shortcut menu is available for all time series icons (i.e., 
for the color bars, thumbnail plots, graphics, or dots). 

11.2 Preparing to Forecast 
Before you forecast, you will need to set up the Program Order (Chapter 16), create Model 
Alternatives (Chapter 20), assign Model Alternative Keys (Chapter 20), and create at least one 
Forecast Run (Chapter 12).  You will also set the default time window for your forecast and 
ensure that data are available for your forecast.  Remember, it is essential that you setup the 
program order, before forecasting. 
 
Chapter 21 contains information on how to create MFP and HEC-MetVue model alternatives.  
For other programs, refer to the individual user documentation (HEC-HMS, HEC-ResSim, HEC-
RAS, and HEC-FIA). 

11.2.1 Setting the Default Time Window 
The CAVI allows you to set a default forecast period and lookback period for all forecasts you 
create.  If you do not specify a default time window, the CAVI assumes three days back and 
three days forward from the current day. 
 
To set the default time window: 

1. From the Forecast menu, click Default Time Window, and Default Time Window 
dialog (see Figure 11.4) opens. 
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Figure 11.4  Default Time Window Dialog 
 

2. In the Extract Period field, enter the number of days to extract for your forecast. 
3. In the Look Back Period field, enter the number of days to look back for your forecast. 
4. In the Forecast Length field, enter the number of days to forecast. 
5. If you want the lookback and end times to default to the start/end of the day, click 

Default Lookback/End times to start/end of day. 
6. Click OK, and the Default Time Window dialog closes. 
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CHAPTER 12   
 

Forecasts 
 

In HEC-RTS, a Forecast is made by using is a Forecast Run, at a specific time with boundary 
condition data available.  Forecasts are manipulated in the Modeling Module; see Chapter 11 for 
a detailed description on the Modeling Module and its Map Window.  Before beginning a 
forecast, critical data should be checked to ensure it is available for the time window of the 
forecast.  See Section 8.1 for details on checking critical data. 

12.1 Forecast Shortcut Menu 
In the Modeling Module in the Watershed Pane, from the Forecast menu, open a forecast.  
Then, in the Modeling tab, a shortcut menu (Figure 12.1) is available by right-clicking on the 
forecast run.  This shortcut allows the user to Compute the forecast, Display in Map the 
forecast results, View Log File and open the Forecast DSS File. 

 
Figure 12.1  Forecast Shortcut Menu 
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12.2 Creating a Forecast 
Creating a forecast: 

1. From the Forecast menu, click New, and the Create New Forecast dialog (Figure 12.2) 
opens. 

2. By default, HEC-RTS assigns the forecast a name based on the current date and time.  
The forecast name can be modified. In addition, the items in the Forecast Time box are 
based on the current date and time. 

 

Figure 12.2  Create New Forecast Dialog 
 

3. Enter a forecast date and time that was determined in the Acquisition module (Chapter 
7), this would be the latest time a complete set of reliable data is available.  For example, 
in Figure 12.2, a Forecast Date of 13Nov2013 has been entered along with a Forecast 
Time of 1300. 

4. Once the Forecast Date/Time has been entered the name of the forecast is set, which can 
be modified up until the user clicks the OK button.  As illustrated in Figure 12.2, the 
Name box, by default, contains the forecast name of 2013.11.13-1300. 

5. By default the combination of the forecast date and time is used in creating a forecast 
folder on the user’s computer system.  As illustrated in Figure 12.2, the forecasts Folder 
field contains the name of 2013.11.13-1300.  The Folder field is non-editable. 
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6. The selected Start Time and Extract Start dates should be far enough in the past to 
meet the following: 

a. Allow enough time steps to pass between the Start Time date and the Forecast Time 
date to allow routing reaches in the reservoir model to show correct flows at the time 
of forecast. 

b.   Generally, the Start Time and the Extract Start dates should be before the start of 
the event for calibration of loss rates for HEC-HMS.  If this is not practical, then a 
time after the initial losses have been satisfied should be chosen.  In most cases these 
dates and time are equal.  However, from time to time, the forecaster may wish to 
extract data prior to the simulation window or may wish to update only the last few 
hours of data (for example when re-computing a forecast later in the day after more 
observed data are available). 

7. The Extract Start, Start Time and End Time fields will default to dates based on 
information given in the Default Time Window dialog (Figure 12.3). 

 

Figure 12.3  Default Time Window Dialog 
 

8. From the Create New Forecast dialog (Figure 12.2) the default time window can be 
overridden.  Times for the corresponding dates will also need to be entered. 

9. From the Forecast Runs table (Figure 12.4) on the Create New Forecast dialog (Figure 
12.2) select the already defined forecast runs for the forecast that need to be simulated.   
Clicking the check box in the Selected column of the table selects a forecast run.  
Multiple forecast runs can be selected. 
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Figure 12.4  Forecast Runs Table 
 

10. Click OK, and the Create New Forecast dialog closes (Figure 12.2). 

11. HEC-RTS now copies files to the forecast area (Appendix A), the Creating Forecast 
status dialog will display the progress of the forecast being created.  HEC-RTS also 
retrieves (extracts) data from the database based on the entered times.  The data is copied 
to a HEC-DSS file (forecast.dss) for use by the models. 

12. Check the extract results log (Section 12.8). 

The Create New Forecast dialog has four options for forecast creation.  These options are 
available in the Select Type dropdown list, and include: 

• New Forecast.  This is the option described above in which the Forecast Time, Extract 
Start, Start Time, End Time and Forecast Run(s) used in the forecast are specified. 

• From Existing Forecast.  This option copies the Forecast Time, Extract Start, Start 
Time, End Time and Forecast Run(s) from a forecast already created.  Here, an existing 
forecast previously created and saved in the watershed can be selected. 

• From Archived Forecast.  This option copies the Forecast Time, Extract Start, Start 
Time, End Time and Forecast Run(s) from a forecast that has been archived.  Here, the zip 
file containing the archived forecast is selected.  For more information on archiving a 
forecast see Section 12.12.4. 

• From Imported Forecast.  This option copies the Forecast Time, Extract Start, Start 
Time, End Time and Forecast Run(s) from a forecast file stored to disk.  Here, the 
.forecast file to use is specified. 

12.3 Open a Forecast 
To open a forecast: 

1. From the Forecast menu, click Open, and the Open Forecast dialog (Figure 12.5) 
opens. 
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Figure 12.5  Open Forecast Dialog 
 

2. From the Existing list of available forecasts for the watershed, select the forecast to be 
opened. 

3. Click Open, and the Open Forecast dialog closes.  The program will load all of the 
information associated with the selected forecast.  In the Modeling tab (Figure 12.1), the 
top checkbox of the tree will display the name of the selected forecast and the forecast 
runs associated with the selected forecast.  The Map Window will display the model 
representations of the active forecast run. 

12.4 Delete a Forecast 
Delete a forecast: 

1. From the Forecast menu, click Delete, and the Delete Forecast dialog (Figure 12.6) 
opens. 
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Figure 12.6  Delete Forecast Dialog 
 

2. In the Existing group box is a list of the forecasts that have been created for the 
watershed.  Click a forecast in this list. 

3. Click Delete and a warning will appear asking the user if they really want to delete the 
forecast.  Click Yes, the warning dialog closes, and the forecast is removed from the 
watershed.  This process does not physically delete any files; it only deletes the reference 
of the forecast from the watershed. 

4. The other alternative is to delete the forecast directory. After selecting the forecast to be 
deleted, check the box next to Delete forecast directory in the Delete Forecast dialog. 
Using this option will delete the whole forecast directory. 

5. Click Delete and a warning will appear asking the user if they really want to delete the 
forecast.  Click Yes, the warning dialog closes, and the forecast and its directory will be 
removed from the watershed. 

12.5 Close the Active Forecast 
To close the active forecast: 

1. Click Close from the Forecast menu. 

2. The program will unload all of the information associated with the active forecast and the 
Modeling Module region will be blank. 

12.6 Edit the Active Forecast 
To edit the active forecast: 
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1. The forecast dates and time are located in the Modeling tab below the Time Window 
label (Figure 11.2). 

 

Figure 12.7  Forecast Time Window Dialog 
 

2. If any of the date and times need to be changed, from the Forecast menu, click Edit 
Time Window, and the Edit Time Window dialog (Figure 12.7) opens. In the Edit 
Time Window dialog, enter the new information in the corresponding date and time 
fields. 

3. Click OK, and the Edit Time Window dialog box will close. 

4. To retrieve data from the database again, click Run Selected Extracts. 

5. To add forecast runs to the selected forecast, from the Forecast menu, click Run 
Selector, and the Forecast Run Selector dialog (Figure 12.8) opens.  In the Forecast 
Run Selector dialog, select the defined forecast runs you wish to add to the forecast by 
clicking check boxes in the Selected column. 

 

Figure 12.8  Forecast Run Selector Dialog 
 

6. To remove a forecast run from a forecast, clear the check box in the Selected column 
next to the name of the forecast run you wish to remove from the active forecast. 
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7. Click OK, the Forecast Run Selector dialog closes, and the Progress (similar to Figure 
12.5) will notify the user of the progress of the update to the selected forecast. 

12.7 Save the Active Forecast 
To save the active forecast, from the Forecast menu, click Save, and the program will save 
information for the active forecast. 

12.8 Checking Data 
Now that a forecast has been created, the user ready to compute the forecast runs associated with 
that forecast.  Before doing a compute, check the data that was retrieved from the database that 
will be used during the compute. 

To check the retrieved data: 

1. From the Reports tab in the Modeling Tab Watershed Pane, click Extract Log, the 
Extract Report dialog (Figure 12.9) opens. 

 

Figure 12.9  Extract Report Dialog 
 

2. The Extract Report dialog displays the log file that was generated when the extract 
process was executed.  The name of the active forecast appears in the title bar of the 
Extract Reports dialog.  The location of the log file is displayed in the File bar at the top 
of the dialog. 

3. Displayed are the results from the retrieval of precipitation data and the data needed by 
the models.  The model data is displayed in the first part, with the precipitation data being 
display last. 
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4. If errors are shown, correct the data using HEC-DSSVue (Appendix F). Remember, data 
corrections or edits are only for the active forecast. 

5. When finished reviewing the extract results, click Close button, and the Extract Report 
dialog closes. 

12.9 Executing a Forecast 
Now one or more forecast runs associated with the active forecast are ready to be computed.  The 
Modeling tab (Figure 12.10) displays the time information associated with the active forecast, a 
list of forecast runs associated with the active forecast, and the command to execute the active 
forecast run. 

One or more forecast runs will be executed for the active forecast.  There are several ways to do 
this and the following sections describe in detail how to execute a single forecast run or execute 
multiple forecast runs. 

 
Figure 12.10  Modeling Tab 
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12.9.1 Forecast Run Shortcut Menu 
In the Modeling tab (Figure 12.10) the forecast run has a shortcut menu (Figure 12.11) that 
allows the user to compute a forecast run (Compute); display the forecast run in the map 
(Display in Map); Save forecast run to base (Save To Base); replace forecast run from base 
(Replace from Base); run the post (Run Post); compute the forecast log report (Compute Log); 
open the forecast DSS file (Forecast DSS File); and extract the forecast log report (Extract 
Log). 

  
Figure 12.11  Forecast Alternative Shortcut Menu 
 

12.9.2 Computing a Single Forecast Run 
When a forecast run is highlighted, click Compute in the Actions tab of the Modeling tab 
(Figure 12.10) will compute the highlighted forecast run. 

Optionally, from the forecast run shortcut menu (Figure 12.11) or from the Forecast menu, the 
Compute Manager (Figure 12.12) can be used to compute. 

 

Figure 12.12  Compute Manager Dialog 
 

To compute using the Compute Manager: 
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1. From the Forecast menu, click Compute Selector.  The Compute Manager dialog 
(Figure 12.12) opens. 

2. Select the check box next to the forecast run to compute. 

3. Click Compute and selected forecast run(s) will compute. 

4. Click Close and the Compute Manager dialog closes.  

The user can compute the entire forecast run (Compute); force a compute of the entire forecast 
(Force Recompute check box), or you can compute through a specific model.  For example to 
compute the forecast run through the HEC-RAS model, right-click the HEC-RAS sub-item.  
Now HEC-RTS will compute the HEC-MetVue, MFP, HEC-HMS, HEC-ResSim and HEC-
RAS model alternatives for the forecast run. 

When choosing to compute, the Compute Progress dialog (Figure 12.13) opens.  The Compute 
Progress dialog provides you information about the compute status at the bottom of the dialog.  
The dialog also echoes information, warnings and errors in a table at the top of the dialog.  When 
the compute is finished, the Compute Progress dialog displays "Compute Complete". 

 

Figure 12.13  Compute Progress Dialog 
 

12.9.3 Computing Multiple Forecast Runs 
HEC-RTS provides you a way to execute more than one forecast run at one time: 

1. From the Forecast menu, click Compute Selector.  The Compute Manage dialog 
(Figure 12.12) opens. 
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2. Select the check box(s) next to the forecast run(s) to compute.  Once the forecast runs are 
selected, click Compute. 

3. The Compute Progress dialog (Figure 12.13) opens and HEC-RTS computes of the 
forecast runs selected in the Compute Manager dialog. 

4. Click Close, and the Compute Progress dialog closes. 

5. Click Close, and the Compute Manager dialog closes. 

12.9.4 Re-Computing Forecast Runs 
When a forecast run is executed, HEC-RTS remembers what models executed for that forecast 
run.  If changes were made to a model in the forecast sequence, HEC-RTS will re-compute the 
model when you compute the sequence.  If no changes were made to a model and the model was 
previously computed, HEC-RTS will not recomputed the model in the sequence.  If for some 
reason the entire model sequence for a forecast run needs to be recomputed, from the Modeling 
Module, click the Force Recompute check box on the Action tab which will “force” a re-
compute when the Compute button in the Modeling tab is clicked.  The other way to re-
compute the entire model sequence for the active forecast run is hold down the CTRL key and 
click the Compute button in the Modeling tab (Figure 12.10).  The Compute Progress dialog 
(Figure 12.13) will open and all the models will be run. 

12.10 Viewing Results 
After the active forecast runs have been executed, the results may be reviewed in the Modeling 
tab in the Watershed Pane.  Results include the log files, which display computational messages 
from some of the programs, reports from the individual programs, and some of the programs 
have results available in a graphical form from the Map Window.  More detail on viewing 
results can be found in Chapter 13. 

12.11 Calibrating and Editing Models 
It may be desired to run the models individually for calibration before doing a full compute of 
the forecast run.  This is particularly important for HEC-HMS because there are event-dependent 
parameters (loss rate and baseflow) that will need to be adjusted for the forecast.  HEC-HMS 
will produce simulation hydrographs, which can be compared with observed hydrographs up to 
the time of forecast.  These comparisons will determine if the HEC-HMS model needs to be 
adjusted. 

In the case of HEC-ResSim, the simulated releases are used as a guide.  After reviewing the 
releases, it might be decided that the releases need to be adjusted to better simulate actual 
reservoir operations.  For HEC-RAS, profile information throughout the lookback period is 
checked; if results are not satisfactory, you can calibrate HEC-RAS by modifying "n-values" at 
selected cross sections.  In the case of HEC-FIA, the levee failure stages might need to be 
adjusted to see the associated damage and impacts during an event. 
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Each program has its own individual editor; these editors are described in detail in Chapter 23.  
For each program, there are only certain parameters that can be edited.  To make additional 
changes beyond those specific parameters, the model must be revised using the model’s 
standalone application, and re-imported to HEC-RTS. 

In Version 3.0, any of the model data can be edited because of the native module interface used.  
Care should be exercised when editing calibrated models configured to prevent models from 
“breaking.” 

12.11.1 Running a Forecast through Individual Models 
To run a forecast through an individual model: 

1. From the Modeling tab, right-click on a forecast run program and click Compute thru 
(model name).  Note that the models are computed in the same order as the Program 
Order (Chapter 16) that has been set up.  For example, to run the forecast run through 
the HEC-RAS model, click HEC-RAS. 

2. The Compute Progress dialog (Figure 12.13) opens and HEC-RTS begins execution of 
programs up to the model that has been chosen.  For example, to run through HEC-RAS, 
HEC-RTS will compute the MFP, HEC-HMS, HEC-ResSim, and HEC-RAS model 
alternatives. 

After the completion of the computation, review reports to help in model calibration.  Chapter 13 
describes in detail the available reports for each individual model. 

12.11.2 Editing Individual Model Parameters 
After making the initial run and reviewing the reports, it may be decided that parameters of an 
individual model need to be edited.  Each model has its own individual editor, which are 
described in detail in Chapter 20.  Accessing the editor for each individual model is the same: 

1. From the Modeling tab, right-click on a forecast run in Forecast tree. 

2. Depending on the forecast run clicked, the shortcut menu displays a range of editing 
options (Figure 12.14).  The editor associated with that forecast run, opens and the 
necessary parameters can be edited. 

 
Figure 12.14  Edit Shortcut Menu 
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12.12 Managing Forecast Data 
HEC-RTS facilitates archiving and sharing of forecast data through four different mechanisms.  
One way is to save changes to the model alternatives to the base directory to make them 
available for other forecasts.  Another way is to replace a model alternative for a specific forecast 
with the version in the base directory.  In addition, results can be posted to the DSS file to make 
them available to other users, and the forecast can be frozen to prevent additional computes and 
further editing of model alternatives. 

12.12.1 Saving Changes to the Base Directory 
When parameters have been edited, the changes apply only to an individual forecast run and are 
saved in the forecast directory (see Appendix A an overview of the directory structure).  To 
make changes available for subsequent forecasts, the changes will need to be saved back to the 
base directory. 

To save data to the base directory: 

1. From the Modeling tab, right-click on a forecast run. 

2. From the shortcut menu (Figure 12.11), click Save To Base.  The Save To Base dialog 
(Figure 12.15) opens. 

 

Figure 12.15  Save To Base Dialog 
 

3. The Save To Base dialog displays the name of the Forecast and Forecast Run that are 
active.  The table displays the Programs, Model Alternatives, and Model IDs that 
makeup the active forecast run. 

4. From the Copy Data column of the table, select the check boxes beside the Model 
Alternative to copy from the forecast directory to the base directory. 

5. When the appropriate Model Alternatives have been selected, click Save to Local (or 
Save to Local and Server if available and desired) (Figure 12.15).  HEC-RTS will now 
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save all files associated with the selected model alternative back to the base directory.  
When the program is finished, a confirmation message will appear stating that all selected 
model alternatives were successfully saved.  

Note that when you have edited model parameters, the Save To Base dialog (Figure 12.15) will 
also appear when leaving the current forecast by exiting HEC-RTS, creating a new watershed, 
creating a new forecast, opening an existing forecast, or closing the current forecast.  To make 
changes available for subsequent forecasts, the data will need to be saved back to the base 
directory.  To not save changes for later forecasts, click Save None. 

12.12.2 Replacing Data from the Base Directory 
If, while editing a model alternative, the user needs to revert to the original model alternative (or 
propagate modifications made through to the forecast), the changed model alternative in the 
forecast directory can be replaced with the model alternative from the base directory. 

To replace a model alternative from the base directory: 

1. From the Modeling tab, right-click a forecast run. 

2. From the shortcut menu (Figure 12.11), click Replace from Base, and the Replace From 
Base dialog (Figure 12.16) opens. 

 

Figure 12.16  Replace From Base Dialog 
 

3. The Replace From Base dialog displays the name of the Forecast and Forecast Run 
that are active.  The table displays the Programs, Model Alternatives, and Model IDs 
that makeup the active forecast run. 

4. From the Restore Data (Figure 12.16) column of the table, select the check boxes beside 
the Model Alternative to restore from the base directory to the forecast directory. 

5. When the appropriate Model Alternative has been selected, click Replace from Local 
(or Replace From Server) (Figure 12.16).  The program will now restore all files 
associated with the selected Model Alternative from the base directory to the forecast 
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directory.  When HEC-RTS is finished, a confirmation message will stating that all 
selected model alternatives were successfully replaced. 

12.12.3 Archive a Forecast 
Once you have a configured a forecast you may want to keep an archive your forecast for future 
retrieval. 

To archive a forecast: 

1. If you have the forecast you are going to archive open, close it by selecting Close from 
the Forecast menu.  

2. From the Forecast menu, click Archive, and the Select Forecast to Archive dialog 
(Figure 12.17) opens.  

 

Figure 12.17 Select Forcast to Archive dialog 
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CHAPTER 13   
 

Results 
 

After the active forecast runs have been executed, the results can be reviewed in the Modeling 
tab in the Watershed Pane.  Results include the log files, which display computational messages 
from some of the programs, reports from the individual programs, and some of the programs 
have results available in a graphical form from the Map window.  This includes results from 
HEC-MetVue, MFP, HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA.  If the HEC-RAS 
model included the creation of inundation data, this data can be viewed through RAS Mapper, 
available through the HEC-RAS software interface.  If time series icons have been set up to 
view model results, then data can be viewed in a tabular or graphical format on the time series 
icons. 

13.1 Viewing Model Results 
Make sure there is an active forecast, which means a forecast has one or more forecast runs and 
is displayed in the Forecast Panel.  The available reports are based on forecast runs, so the 
program needs to know which forecast runs are to be used for the reports and the order of the 
reports for comparison results.  

In the Forecast Panel (Figure 13.1), of the Modeling tab there is a Forecast Panel, which 
displays the active forecast and the available forecast runs.  Beside each forecast run is a 
checkbox.  The checkbox indicates whether the forecast run should be available for the model 
reports and results plots.  

To display the graphic elements of the model alternatives, right-click on the Forecast Run in the 
Forecast Tree and select Display in Map.  At this time, only one forecast run schematic can be 
displayed per map window.  However, multiple map windows can be opened to display multiple 
schematics. 

 

Figure 13-1 Forecast Panel 
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For example, in Figure 13.1, there are one forecast runs available for the active forecast.  
Summaries of forecast runs are accessed through right-clicking on the forecast run of interest. 

13.2 Log Reports 
Available log reports display computational messages for the execution of a forecast run.  

13.2.1 Compute Messages 
When an execution of a forecast run begins, the Compute Progress dialog (Figure 13.2) opens.  
This Compute Progress dialog contains information regarding the status of each step of the 
computation process.  The Message Output field contains information regarding the status of 
each step of the computation process.  In addition, if there are errors, warnings or any problems 
during the execution process. 

 

Figure 13-2  Compute Progress Dialog 

For each model alternative used in the forecast run being executed, HEC-RTS provides status 
information by model alternative.  The Message Bar indicates which model alternative is being 
executed, the Current Task Progress Bar indicates the percentage of completion for the current 
task, and the Overall Progress Bar indicates the percentage of completion of the compute.  For 
example, in Figure 13.2 the Message Bar indicates that the HEC-ResSim model alternative is 
being run, the Current Task Progress Bar indicates that the HEC-ResSim portion is 81% 
complete, and the Overall Progress Bar indicates the entire compute is about 50% completed.  
When an execution is finished, then both progress bars will read 100%, and the Message Bar 
reads Compute Complete. 

The information from the Compute Progress dialog (Figure 13.2) is also available in a log 
report.  This log report contains the same information in the Message Output field of the 
Compute Progress dialog.  Additionally, the report gives detailed information regarding the 
model alternatives that were computed. 

To view the Log File: 

1. The user must be in the Modeling tab in the Watershed Pane. 
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2. To view this report make sure there is an active forecast and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.1). 

3. In the Forecast panel list right-click the forecast run and choose the Compute Log menu 
item from the context menu or click Compute Log from the Reports tab. 

4. The Log File dialog (Figure 13.3) opens. 

 

Figure 13-3  Log File Dialog 

5. The report displays the location and name of the file, which contains the log file.  From 
the Log File dialog, the results of the computation can be viewed. 

13.3 HEC-MetVue Results 
HEC-MetVue is used in HEC-RTS to process observed and forecasted meteorologic data for 
input to HEC-HMS.  Outputs are meteorologic time series formatted for compatibility with 
HEC-HMS.  These meteorologic time series can be viewed in reports.  

13.4 MFP Results 
MFP processes observed and forecasted meteorologic data for input to HEC-HMS.  Outputs are 
meteorological time series formatted for compatibility with HEC-HMS.  These meteorologic 
time series are tabulated in the MFP Summary report.  The MFP Summary displays information 
about the MFP model alternative.  

13.4.1 MFP Summary 
The MFP Summary dialog (Figure 13.4) displays information regarding the MFP portion of the 
forecast run.  The report displays the location and name of the file, which contains the MFP 
Summary.  In addition, the report displays the name of the forecast run, the time window used, 
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the date and time of the execution of the MFP model alternative, and the creation of the 
precipitation grids for observed and future. 

To view the MFP Summary: 

1. The user must be in the Modeling tab in the Watershed Pane 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.1). 

3. Point to MFP and right-click, then click on the summary to view, and the MFP 
Summary dialog (Figure 13.4) opens. 

4. In Figure 13.4, the MFP Summary MFP alternative gageInterp is shown.  The summary 
shows the sequence of precipitation depths entered by zone, and summaries of each grid 
used in the forecast.  Summaries include the maximum, minimum, and average 
precipitation depth values and the number of cells in the grid showing precipitation 
depths greater than zero.  Note that the precipitation depths shown in this log file are 
given in millimeters, regardless of the unit system of the watershed.  

 

Figure 13-4  MFP Summary Dialog 

5. On the File menu, click Close, and the MFP Summary dialog (Figure 13.4) closes. 
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13.5 HEC-HMS Results 
HEC-HMS may be used to compute watershed runoff, given initial system states and watershed 
precipitation.  The HEC-HMS Results Report let you view the individual elements results from 
the forecast alternative run. There are three ways to access results for individual elements in the 
forecast run. All methods show the same results.  

13.5.1 HEC-HMS Reports Tab 
The HEC-HMS Results Reports Tab (Figure 13.5) is the first method for displaying time-
series parameter data and forecast summaries for individual watershed elements as defined by 
the configuration of HEC-HMS. A complete list of the hydrologic elements from the HEC-HMS 
basin model used in the forecast run appears in a tree beneath a parent folder for the forecast run. 
To view details for an element, select it from the tree. With an element selected from the tree 
click on the Reports tab and select the element Graph, Time-Series Table, or Summary Table 
command. The appropriate results will automatically be shown in a new window. Hydrographs 
and other plots (Figure 13.6) present a visual summary of the run for each element. 
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Figure 13-5  HEC-HMS Results Reports Tab 

To view the HEC-HMS Results from the Reports tab: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run is 
selected (checkbox) for viewing results (Figure 13.5). 
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3. Select and expand the HEC-HMS tree branch to display the HMS elements, click on a 
specific element and choose the Reports tab, and click the Graph, Time-Series Table, or 
Summary Table command.  

4. Click on the report to view Graph, Time-Series Table, or Summary Table command 
(Figure 13.5) and the specific HEC-HMS Results Report opens. 

5. For example, Figure 13.6, the selected HEC-HMS Results Report for the forecast run 
Future rain with base models is displayed.  The Lake Mendocino subbasin element has 
been selected. 

6. To close the HEC-HMS Results Report, click the Close button in the upper right corner 
of the dialog. 

 
Figure 13-6  HEC-HMS individual element graph. 

13.5.2 HEC-HMS Shortcut Menu 
From the Modeling Module, the map viewer window may be used to view HEC-HMS model 
alternative results for individual elements: 

1. The user must be in the Modeling tab in the Watershed Pane. 
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2. To use this option make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.5). 

3. On the Map Window, select the Zoom Tool and zoom-in on an area where there are 
HEC-HMS model elements, an example is shown in Figure 13.7. 

4. Then select the Pointer Tool, right-click on the HEC-HMS element of interest.  From the 
shortcut menu (Figure 13.7), click one of the available reports. 

5. The associated summary report dialog opens. 

 
Figure 13-7  HEC-HMS Shortcut Menu Map Window 

6. Click Close, and the plot, time-series table or summary table closes. 

7. In Figure 13.7, there is another blue line; this represents the HEC-ResSim routing reach.  
If the user right-clicks on this one they will get a shortcut menu for HEC-ResSim.  If they 
right-click where the two blue lines intersect, the shortcut menu will contain items for 
both HEC-ResSim and HEC-HMS. 

From the Modeling Module, the HEC-HMS model alternative results for individual elements in 
the Watershed Pane Forecasts HEC-HMS tree branch may be accessed: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To use this option make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.5). 

3. Select and expand the HEC-HMS tree branch to display the HMS elements. 
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4. Then right-click on the HEC-HMS element of interest.  From the shortcut menu (Figure 
13.8), click one of the available reports. 

5. The associated summary report dialog opens. 

 
Figure 13-8  HEC-HMS Shortcut Menu Forecast tree 

6. Click Close, and the plot, time-series table or summary table closes. 

13.5.3 HEC-HMS Individual Elements 
HEC-HMS individual elements can be selected to view results accessed using the Graph, Time-
Series Table, or the Summary Table commands. The appropriate result will open in a new 
window for the selected individual element. The information included in the graph (Figure 13.6) 
varies by element type (Junction, Reservoir, etc.), but always includes outflow.   

The second optional result is a time-series table. The time-series table includes the same 
information as the graph, but in numerical format (Figure 13.9). The information included in the 
summary table (Figure 13.10) also varies by element type, but always includes the peak 
discharge and time of peak discharge for the computed results. 

If selected, the report also displays the element’s parameter values in the lower-left panel of the 
report and flow summaries in the lower-left panel.  The flow summaries are divided into 
simulation totals (start time to end time) and forecast totals, which include only the forecast 
period (time of forecast to end time). 
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Figure 13-9  HEC-HMS Time-Series Table. 

 

Figure 13-10  HEC-HMS Summary Table 

13.6 HEC-ResSim Results 
HEC-ResSim may be used to simulate operation of a water control system, given inflow and 
local flow forecasts from HEC-HMS.  There are several reports available to view HEC-ResSim 
results – Release Decision Report (Figure 13.11), summary results reports, user created reports, 
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network reports, and advanced reports.  In addition, from the Map window HEC-ResSim results 
at HEC-ResSim elements (e.g., reservoirs, junctions) can be viewed graphically.  See the HEC-
ResSim User's Manual for more detail on these results. 

 

Figure 13-11  Release Decision Report 

13.6.1 Release Decision Report 
The Release Decision Report provides the decision information that HEC-ResSim reached 
which are decisions based on operational rules and physical constraints defined in the HEC-
ResSim watershed model.  In addition, the report displays the forecast run name, forecast run 
name and the time window information.  

To view the Release Decision Report: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Forecast panel, select the HEC-ResSim alternative to see data for and choose 
Release Decision Report from the Reports tab (Figure 13.12) and the Release Decision 
Report (Figure 13.11) opens.  
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Figure 13-12  Reports Tab 

4. The user can view a different reservoir’s report or change the time window for the 
information being displayed.  On the Options menu, choose Edit Options, and the 
Release Decision Report Options dialog (Figure 13.13) opens.  The user can change the 
reservoir by using the Reservoir drop-down list.  The user can also specify a different 
time window by selecting the Specify option and enter the start and end dates. 

 

Figure 13-13  Release Decision Report Options Dialog 
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5. From the File menu, the report can be printed.  

6. From the File menu, click Close, and the Release Decision Report closes. 

13.6.2 Results Summary Reports 
The results summary reports provide information for reservoirs, flow locations, hydropower 
facilities, and gates.  Each report displays the average, maximum, and minimum values. 

13.6.2.1 Reservoir Summary Report 
This report summarizes the reservoirs for the active forecast run.  These results include the 
storage, elevation, controlled release, and uncontrolled spill parameters for each reservoir.  
Reported are the average, maximum, minimum values for each parameter. 

To view the Reservoir Summary Report: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Forecast panel, select the HEC-ResSim alternative to see data for.  From the 
Reports tab, click Reservoir Summary and the Reservoir Summary Report (Figure 
13.14) opens. 

4. From the File menu, the report can be printed.  

5. From the File menu, click Close, and the Reservoir Summary Report (Figure 13.14) 
closes. 

 

Figure 13-14  Reservoir Summary Report 
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13.6.2.2 Flow Summary Report 
This report summarizes the flow at reservoirs and non-reservoir locations for the active forecast 
run.  These results include the regulated flow, unregulated flow, and cumulative local flow for 
each location.  Reported are the average, maximum, minimum values for each parameter. 

To view the Flow Summary Report: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Forecast panel, select the HEC-ResSim alternative to see data for.  From the 
Reports tab, click Flow Summary and the Flow Summary Report (Figure 13.15) 
opens. 

4. From the File menu, the report can be printed.  

5. From the File menu, click Close, and the Flow Summary Report (Figure 13.15) closes.  

 

Figure 13-15  Flow Summary Report 

13.6.2.3 Stage Summary Report 
This report summarizes the stage at reservoirs and non-reservoir locations for the active forecast 
run.  These results include the regulated stage, unregulated stage, and cumulative local stage for 
each location.  Reported are the average, maximum, minimum values for each parameter.  If the 
appropriate data has not been entered (rating curves) this report will be blank. 

1. The user must be in the Modeling tab in the Watershed Pane. 
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2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Forecast panel, select the HEC-ResSim alternative to see data for.  From the 
Reports tab, click Stage Summary, and the Stage Summary Report (Figure 13.16) 
opens. 

 

Figure 13-16  Stage Summary Report 

4. From the File menu, the report can be printed.  

5. From the File menu, click Close, and the Stage Summary Report (Figure 13.16) closes. 

13.6.2.4 Power Summary Report 
This report summarizes the hydropower information at a reservoir for the active forecast run.  
These results include generation efficiency, power head, hydraulic losses, energy generated per 
time step, power generated, plant factor, and flow power for each power plant.  Reported are the 
average, maximum, minimum values for each parameter.  If the appropriate data (hydropower 
plant) has not been entered this report will be blank: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Forecast panel, select the HEC-ResSim alternative to see data for.  From the 
Reports tab, click Power Summary, and the Power Summary Report (Figure 13.17) 
opens. 
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Figure 13-17  Power Summary Report 

4. From the File Menu, the report can be printed.  

5. From the File menu, click Close, and the Power Summary Report (Figure 13.17) 
closes. 

13.6.2.5 Gate Summary Report 
This report summarizes the gates defined for the reservoirs in the active forecast run.  Reported 
is the average, maximum, minimum value for the gate opening at each reservoir where a gate has 
been defined.  

To view the Gate Summary Report (if the appropriate data has not been entered this report will 
be blank): 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Forecast panel, select the HEC-ResSim alternative to see data for.  From the 
Reports tab, click Gate Summary, and the Gate Summary Report (Figure 13.18) 
opens.  
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Figure 13-18  Gate Summary Report 

4. From the File menu, the report can be printed.  

5. On the File menu, click Close, and the Gate Summary Report (Figure 13.18) closes. 

13.6.3 Graphical Results 
From the Modeling Module, the graphical results for HEC-ResSim are available from the 
network components for the active forecast run that includes a HEC-ResSim model alternative.  
These network components are reservoirs, diverted outlets, routing reaches, junctions, and 
diversions. 

13.6.3.1 Reservoirs 
To view the graphical results from a HEC-ResSim reservoir: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Map window, select the Zoom Tool and zoom-in on an area where there is a 
HEC-ResSim reservoir, an example is shown in Figure 13.19. 

4. Then select the Pointer Tool, right-click the HEC-ResSim reservoir, the polygon and 
storage reach which will now be highlighted in yellow.  From the shortcut menu (Figure 
13.19), click one of the available options. 
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Figure 13-19  HEC-ResSim Shortcut Menu - Reservoir 

5. If the active forecast run contains HEC-RAS and/or HEC-FIA model alternatives and 
their results overlap the HEC-ResSim results, the shortcut menu will reflect this.  
Therefore, the shortcut menu could contain items for HEC-RAS and HEC-FIA. 

6. Depending on which command was clicked on from the short cut menu (Figure 13.19) 
the appropriate Plot dialog will open.  In Figure 13.20, the different Dialogs associated 
with the appropriate shortcut menu item can be seen.  

7. The user can print, save as a graphic file, and view tabular data of the plot from the File 
menu.  See Appendix I for details on how to manipulate plots. 
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Figure 13-20  HEC-ResSim Plots 

Also, from the shortcut menu (Figure 13.19) the Release Decision Report (Figure 13.11) can be 
viewed. 

8. User Plots are available from the shortcut menu, but these plots are defined beforehand.  
User Plots are discussed further in this section below, and more detail is provided in the 
HEC-ResSim User's Manual. 

13.6.3.2 Routing Reaches 
To view the graphical results from a HEC-ResSim routing reach: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this plot make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. In the Map window, select the Zoom Tool and zoom-in on an area where there is a 
HEC-ResSim routing reach (blue line).  
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4. Then select the Pointer Tool, right-click on the HEC-ResSim routing reach, it will now 
be highlighted in yellow.  From the Routing Reach Shortcut (Figure 13.21), click Plot. 

 
Figure 13-21  Routing Reach Shortcut  

5. If the active forecast run contains HEC-RAS and/or HEC-FIA model alternatives and 
their results overlap the HEC-ResSim results, the shortcut menu will reflect this.  
Therefore, the shortcut menu could contain items for HEC-RAS and HEC-FIA. 

6. The Plot dialog window (Figure 13.22) opens, displaying the graphical results for the 
routing reach. 

 

Figure 13-22  Plot Dialog – Routing Reach 

7. The user can print, save as a graphic file, and view tabular data of the plot from the File 
menu.  See Appendix I for details on how to manipulate plots. 

8. User Plots are available from the shortcut menu, but these plots are defined beforehand.  
User Plots are discussed further in this section below, and more detail is provided in the 
HEC-ResSim User's Manual. 
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13.6.3.3 Diverted Outlets 
 

To view the graphical results from a HEC-ResSim diverted outlet: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this plot make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.12). 

3. On the Map window, select the Zoom Tool and zoom-in on an area where there is a 
HEC-ResSim diverted outlet (line leaving a reservoir pool with an arrowhead); an 
example is shown in Figure 13.23. 

4. Then select the Pointer Tool, right-click on the HEC-ResSim diverted outlet, it will now 
be highlighted in yellow.  From the shortcut menu (Figure 13.23), click Plot. 

 
Figure 13-23  HEC-ResSim Shortcut Menu - Diverted  

5. If the active forecast run contains HEC-RAS and/or HEC-FIA model alternatives and 
their results overlap the HEC-ResSim results, the shortcut menu will reflect this.  
Therefore, the shortcut menu could contain items for HEC-RAS and HEC-FIA. 

6. The Default Plot dialog window (Figure 13.24) will open, displaying the graphical 
results for the diverted outlet. 
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Figure 13-24  Default Plot Dialog Box - Diverted  

7. The user can print, save as a graphic file, and view tabular data of the plot from the File 
menu.  See Appendix I for details on how to manipulate plots. 

8. User Plots are available from the shortcut menu, but these plots are defined beforehand.  
User Plots are discussed further in this below, and more detail is provided in the HEC-
ResSim User's Manual. 

13.6.3.4 Junctions 
To view the graphical results from a HEC-ResSim junction: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view the available junction plots, make sure there is an active forecast, and at least 
one forecast run selected (checkbox) for viewing results (Figure 13.12). 

3. On the Map window, select the Zoom Tool and zoom-in on an area where there is a 
HEC-ResSim junction, an example is shown in Figure 13.25. 

4. Then select the Pointer Tool, right-click on the HEC-ResSim junction, it will now be 
highlighted in yellow.  From the shortcut menu (Figure 13.25), click Plot or Plot 
Inflow/Outflow. 
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Figure 13-25  HEC-ResSim Shortcut Menu - Junction 

5. If the active forecast run contains HEC-RAS and/or HEC-FIA model alternatives and 
their results overlap the HEC-ResSim results, the shortcut menu will reflect this.  
Therefore, the shortcut menu could contain items for HEC-RAS and HEC-FIA. 

6. Click a menu item shortcut menu (Figure 13.25) and the appropriate Plot dialog (Figure 
13.26) opens.  In Figure 13.26, you can see the different Plot Dialogs associated with the 
appropriate shortcut menu item. 

                    

Figure 13-26  HEC-ResSim Plot Dialogs - Junction 

7. The user can print, save as a graphic file, and view tabular data of the plot from the File 
menu.  See Appendix I for details on how to manipulate plots. 

Plot inflow/outflow 

Plot 
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8. User Plots are available from the shortcut menu, but these plots are defined beforehand.  
User Plots are discussed further in section below, and more detail is provided in the 
HEC-ResSim User's Manual. 

13.6.3.5 User Plots 
User-defined plots are only available from a HEC-ResSim model alternative, and therefore are 
only for HEC-ResSim results.  User-defined plots are created from any default HEC-ResSim 
plot.  

To create a user-define plot: 

1. From the Plot Properties dialog (Figure 13.27) for a junction, remove the Flow-CUM 
curve.  The plot now only contains the Flow for a junction (Figure 13.28).  

 

Figure 13-27  Plot Properties dialog 
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Figure 13-28  Revised Plot – Junction location 

2. From the File menu, click Save Template.  The Export Plot Template dialog (Figure 
13.29) opens. 

 

Figure 13-29  Export Plot Template Dialog 

3. There is a choice of making this user-defined plot available to all applications, this 
watershed only, all user watersheds, or all users.  In Figure 13.28, this user-defined plot 
will only be available to the watershed that is currently open because This Watershed 
only has been clicked.  Type a name for the user-defined plot in the Name field.  In 
Figure 13.29 RegulatedFlow has been entered for the name.  Click OK, and the Export 
Plot Template dialog closes. 

4. To apply a user plot, point to File and click Apply Template. 
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5. For more information about user-defined plots, see the HEC-ResSim User’s Manual. 

13.6.4 Live Display 
New to HEC-RTS 3.0 is an option to enable dynamic plotting of HEC-ResSim graphical results.  
Enabling the Live Display option causes HEC-ResSim results plots to update automatically 
when a HEC-ResSim alternative is recomputed. 

To enable live plots open a HEC-ResSim graphical results plot, and select the Live Display… 
option from the View menu as shown in Figure 13.30. 

 

Figure 13-30  Enable Live Display HEC-ResSim results 

13.7 HEC-RAS Results 
HEC-RAS is used to simulate the behavior of channels in a watershed, given flow rates predicted 
with HEC-HMS.  There are two ways to view HEC-RAS results – The Reports tab in the 
Modeling Module or, from the Map window.  From the Map window, you can view 
graphically HEC-RAS results at HEC-RAS elements (e.g., cross sections, flow hydrographs, 
stage hydrographs). 

13.7.1 Standard Table 1 
The Standard Table 1 is the default summary table.  This table gives a summary of some the 
key output variables. 
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To view the Standard Table 1: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run is 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to Summary Output Table - {Profile Name}, and the 
Profile Output Table dialog - Standard Table 1 Report (Figure 13.31) opens. 

 

Figure 13-31  Profile Output Table - Standard Table 1 Report 

4. The report displays a number of hydraulic variables for stream stations.  Certain 
parameters can be changed for reporting from the Options menu.   The user can choose 
which profiles and reaches to display, add a column to the report that includes the profile 
name, and can choose which system units to view the report in. 

5. The user can print, copy, and create an ASCII file of the report; from the File menu. 

6. From the File menu, click Exit, and the Profile Output Table dialog closes. 

13.7.2 Standard Table 2 
The Standard Table 2 (Figure 13.32) is the second of the standard summary tables.  This table 
provides information on the distribution of flow between the left overbank, main channel, and 
right overbank.  This table also shows the friction losses, as well as contraction and expansion 
losses that occurred between each section.  Energy losses displayed at a particular cross section 
are for the losses that occurred between that section and the next section downstream. 

To view the Standard Table 2: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run is 
selected (checkbox) for viewing results (Figure 13.6). 
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3. From the Reports tab, click to Summary Output Table - {Profile Name}, and the 
Profile Output Table dialog with Standard Table 1 Report (Figure 13.32) opens. 

4. From the Std.  Tables menu, click Standard Table 2 and the Standard Table 2 Report 
(Figure 13.32) is opened in the Profile Output Table dialog. 

5. The report displays a number of hydraulic variables for stream stations.  Certain 
parameters can be changed for reporting from the Options menu.  The user can choose 
which profiles and reaches to display, add a column to the report that includes the profile 
name, and can choose which system units to view the report in. 

6. The user can print, copy, and create an ASCII file of the report; from the File menu.  

7. From the File menu, click Exit, and the Profile Output Table dialog closes. 

 

Figure 13-32  Profile Output Table Dialog - Standard Table 2 Report 

13.7.3 Detailed Output Tables 
Detailed output tables show hydraulic information at a single location for a single profile.  

To view a Detailed Output Table: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run is 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to Detailed Output Table - {Profile Name}, and the 
Detailed Output Table dialog for Cross Section Output (Figure 13.33) opens. 

4. By default, the report displays the detailed output for cross sections.  

5. From the File menu, the user can copy to the clip board, print current cross section, and 
print multiple cross sections.  
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6. In the Options menu, the user can choose to include interpolated cross section; include 
errors warning and notes in printout; and change the units system for viewing.  

7. From the Type menu, the user can change the detailed output table type.  For more 
information about the Detailed Output Tables, see the HEC-RAS User’s Manual. 

8. Click Exit, and the Detailed Output Table dialog closes.   

 

Figure 13-33  Detailed Output Table Dialog – Cross Section Output 

13.7.4 Profile Plot 
From the Modeling Module, the only graphical result from a steady flow HEC-RAS model 
alternative is a plot of the water surface profiles.  To view the water surface profile plot: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this plot make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.6). 

3. On the Map window, select the Zoom Tool and zoom-in on an area where there are 
HEC-RAS cross sections (green lines), HEC-RAS bridges (gray lines) and the HEC-RAS 
stream centerline (blue line), an example is shown in Figure 13.34. 
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Figure 13-34  HEC-RAS Shortcut Menu 

4. Then select the Pointer Tool, right-click on the HEC-RAS stream centerline between 
cross sections and the stream centerline will be highlighted in yellow.  

5. From the shortcut menu (Figure 13.34), click Profile Plot, and the Profile Plot (Figure 
13.35) opens. 

6. From the File menu the user can copy the plot and values to the clip board, print, and 
save as a DXF (Drawing Exchange Format) file. 

7. In the Options menu, the user is given the options to zoom, pan, and animate; choose 
what reaches, profiles, and variables that are displayed in the plot; and manipulate the 
plots settings which include axis labels, lines, symbols, scaling, grid, zoom window 
location, fonts, and land markers.  See the HEC-RAS User’s Manual for more 
information. 

8. From the File menu, click Exit, and the Profile Plot closes. 
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Figure 13-35  HEC-RAS – Profile Plot  

13.7.5 Unsteady Flow Results 
From the Modeling Module, the results from an unsteady flow HEC-RAS model alternative are 
the same as those available in HEC-RAS.  For a complete listing of HEC-RAS results se the 
HEC-RAS User’s Manual.  Of particular interest are stage a flow hydrographs.  

To view a flow hydrograph: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this plot make sure there is an active forecast (which includes an unsteady flow 
HEC-RAS model alternative), and at least one forecast run selected (checkbox) for 
viewing results (see Figure 13.6). 

3. Select the HEC-RAS model alternative, and click Stage & Flow Hydrograph Button 
(Figure 13.36) on the Reports tab in the Watershed Pane, this opens the HEC-RAS 
Sage and Flow Dialog plot (Figure 13.37). 

4. For further information on the Stage and Flood Hydrographs Dialog (Figure 13.37), see 
the HEC-RAS User's Manual.  To close the Stage and Flood Hydrographs Dialog, from 
the File menu, click Close. 
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Figure 13-36  HEC-RAS Reports Options 

 

Figure 13-37  HEC-RAS – Flow Hydrograph Plot 
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13.7.6 Rating Curve Plots 
From the Modeling Module, the rating curves can be viewed for the selected HEC-RAS model 
alternative.  You can view a rating curve for any location that a rating curve is defined. 

To view the Rating Curve Plot: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to Rating Curve - {Profile Name}, and the Rating Curve 
Plot (Figure 13.38) opens. 

 

Figure 13-38  Rating Curve Plot 

4. From the File menu the user can copy to the plot and values to the clip board, print, and 
save as a DXF (Drawing Exchange Format) file.  

5. In the Options menu, the user is given the options to zoom and pan; choose what plans 
that will displayed in the plot; and manipulate the plots settings which include axis 
variables, add zero point, datum adjustment lines and symbols, scaling, grid, zoom 
window location and font size.  See the HEC-RAS User’s Manual for more information.  

6. From the File menu, click Exit, and the Rating Curve Plot closes. 
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13.7.7 Cross Section Plots 
From the Modeling Module, the cross section plots can be viewed for the selected HEC-RAS 
model alternative.  You can view any cross section by picking the river, reach and river station. 

To view a Cross Section Plot: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to Cross Section Plot, and the Cross Section Plot (Figure 
13.39) opens. 

 

Figure 13-39  Cross Section Plot 

4. From the File menu the user can copy the plot and values to the clip board, print, and 
save as a DXF (Drawing Exchange Format) file.  

5. In the Options menu, the user is given the options to zoom, pan, and animate; choose 
what plan, profiles, and variables that are displayed in the plot; set the velocity 
distribution; and manipulate the plots settings which include axis labels, lines, symbols, 
scaling, grid, zoom window location, and fonts.  See the HEC-RAS User’s Manual for 
more information. 

6. From the File menu, click Exit, and the Cross Section Plot closes. 
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13.7.8 X-Y-Z 3-D Plots 
From the Modeling Module, the x-y-z 3-D plots can be viewed for the selected HEC-RAS 
model alternative.  The X-Y-Z 3-D Plot (Figure 13.40) is a 3-dimensional plot of multiple cross 
sections within a reach. 

To view an X-Y-Z 3-D Plot: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to X-Y-Z 3-D Plot - {Profile Name}, and the X-Y-Z 3-D 
Plot (Figure 13.40) opens. 

 

Figure 13-40  X-Y-Z 3-D Plot 

4. From the File menu the user can copy the plot to the clip board and print. 

5. In the Options menu, the user is given the options to zoom, pan, and animate; choose 
what plans, profiles, and reaches that are displayed in the plot; set the elevation to lateral 
width ratio; and manipulate the plots settings which include axis labels, lines, symbols, 
grid, zoom window location, and WS order.  See the HEC-RAS User’s Manual for more 
information. 

6. From the File menu, click Exit, and the X-Y-Z 3-D Plot closes. 
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13.7.9 General Profile Plots 
From the Modeling Module, the general profile plots can be viewed for the selected HEC-RAS 
model alternative.  The General Profile Plot (Figure 13.41is used to plot variables other than the 
water surface in profile.  

To view a General Profile Plot: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to General Profile Plot - {Profile Name}, and the General 
Profile Plot (Figure 13.41) opens. 

 

Figure 13-41  General Profile Plot 

4. From the File menu the user can copy the plot and values to the clip board and print. 

5. In the Options menu, the user is given the options to zoom, pan, and animate; choose 
what reaches, profiles, and variables that are displayed in the plot; and manipulate the 
plots settings which include axis labels, lines, symbols, scaling, grid, zoom window 
location, fonts, and land markers. 

6. In the Standard Plots menu, the user is allowed to choose type of plot to be display.  The 
available plots are velocities, flow, area, top width, weighted n, Froude number, hydraulic 
depth, shear, surface area, volume, and steam power.  See the HEC-RAS User’s Manual 
for more information. 
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7. From the File menu, click Exit, and the General Profile Plot closes. 

13.7.10 Hydraulic Properties Tables 
From the Modeling Module, the hydraulic properties tables can be viewed for the selected HEC-
RAS model alternative.  The Hydraulic Properties Table (Figure 13.42) allows you to view the 
computed curves after the Hydraulic Table parameters have been entered for the cross section 
and structures. 

To view the Hydraulic Properties Table: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.6). 

3. From the Reports tab, click to Hydraulic Properties Table - {Profile Name}, and the 
Hydraulic Properties Table (Figure 13.42) opens. 

 

Figure 13-42  Hydraulics Properties Table 

4. From the File menu, the user can copy to the clip board.  

5. From the Type menu,the user can change the type of values that are displayed.  There is a 
choice between cross sections, internal boundaries, and storage area connections.  See the 
HEC-RAS User’s Manual for more information. 

6. Select the Plot tab and the View menu appears.  From the View menu, the user can zoom, 
pan, show symbols on the curves, and compute hydraulics for selected 1B curve. 
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7. In the Options menu, the user can choose the number of decimal point to display in the 
table. 

8. From the File menu, click Exit, and the Hydraulic Properties Table closes. 

13.7.11 RAS Mapper 
RAS Mapper is an extension to the HEC-RAS software package and contains tools to display 
HEC-DSS time-series data, HEC-RAS inundation data, and other model results.  To execute 
RAS Mapper from within HEC-RTS, launch HEC-RAS from the CAVI, and click the RAS 
Mapper button.  

The user can select from multiple map views of project areas, click on gages within these views 
to obtain real-time data in plot or tabular form, and load inundation maps generated through the 
CAVI to spatially overlay with basemap data.  All spatial data supported by ArcGIS®, including 
ArcGIS® Shapefiles, ArcGIS ® coverages (ESRI), DLG and CAD data, remote sensing 
imagery, and scanned photography can be used.  

See Appendix L for more details on using RAS Mapper. 

13.8 HEC-FIA Results 
HEC-FIA may be used to predict the consequences associated with conditions predicted with 
HEC-HMS, HEC-ResSim, and HEC-RAS.  There are two reports available of HEC-FIA results – 
Individual Structure Damage Report and Aggregated Structure Damages Report.  See the 
HEC-FIA User's Manual for more detail on results. 

13.8.1 Individual Structure Damage Report 
This report provides information by individual structure, this information includes structure, 
content, car, other, total damage for each structure,  depth of flooding, population at risk (day 
and night), percent not mobilized, percent caught evacuating, percent clear, and loss of life (day 
and night) information is also available for each structure.  If the alternative is set to run a 
deterministic computation, this will display a single deterministic answer.  However, if the 
alternative is set to run a Monte Carlo computation, this report will display the average for all of 
the iterations. 

To view the Individual Structure Damage Report: 

1. The user must be in the Modeling tab in the Watershed Pane.  

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.43). 

3. On the Reports menu, point to HEC-FIA, click the Individual Structure Damage 
Report button and the Individual Structure Damage Report will open (Figure 13.44). 
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4. The report displays by structure the damages, flooding depth, life loss and other 
consequences associated with the defined forecast. 

5. Click Close, the Individual Structure Damage Report will close (Figure 13.44). 

 
Figure 13-43  Forecast Alternative  

 

Figure 13-44  Individual Structure Damage Report 
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13.8.2 Aggregated Structure Damages Report 
The Aggregated Structure Damages Report allows the user to aggregate results by any 
boundary, or the impact area set used to compute results.  This functionality uses a point in 
polygon test on the results files, so be patient if there are many polygons or many structures, it 
can take a few seconds. 

To view the Aggregated Structure Damages Report: 

1. The user must be in the Modeling tab in the Watershed Pane. 

2. To view this report make sure there is an active forecast, and at least one forecast run 
selected (checkbox) for viewing results (Figure 13.43). 

3. On the Reports menu, point to HEC-FIA, click Aggregated Structure Damages 
Button.  The Aggregated Structure Damages Report will open (Figure 13.45). 

4. In the View By dropdown list, select the boundary category to view results by; the default 
is impact area.  

5. Select the results tab you wish to view.  By default the report will display the Economic 
Damages by impact area tab.  The report also provides a Structure Flooded tab, an 
Agricultural Damages tab, a Critical Infrastructure Damages tab, and a Summary Report 
tab.  The Summary Report tab (Figure 13.46) that provides information on urban 
damages, agricultural damages, total damage, acreage flooded, structures flooded, and 
population impacted. 

6. The user can save the report to a text file or print the report.  

7. Click Close, the Aggregated Structure Damages Report will close. 
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Figure 13-45  Aggregated Structure Damages Report, Economic Damages Tab 

 

Figure 13-46  Aggregated Structure Damages Report, Summary Report Tab 
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CHAPTER 14   
 

Configuring HEC-RTS 
 

Section III of the manual describes how to configure an HEC-RTS watershed.  Here, we describe 
a workflow to configure the models within HEC-RTS.  This workflow description assumes 
previous development of the watershed and the individual models in their native software 
applications (HEC-HMS, HEC-ResSim, HEC-RAS, and HEC-FIA).  We explain how to bring 
the models together into the watershed.  For further information, refer to Chapters 14 through 22 
for additional details. 

14.1 Setting Up Your Models 
In HEC-RTS, a watershed is set up to reflect a collection of data, information, application 
models and images that represent watershed lands, rivers, gages, and water control features with 
the watershed.  The Setup Module is used to create a new (or open an existing) watershed.  To 
get to the Setup Module, from the main window (Figure 14.1) click Setup tab. 

In the Setup Module, the user sets up items that describe a watershed's physical arrangement.  
When a new watershed is created, a directory structure is generated where all files associated 
with the watershed are stored.  Once a new watershed has been created, the user is able to import 
maps from external sources, specify the unit system and time zone for the watershed, add layers 
containing additional information about the watershed such as stream alignments, and configure 
elements such as reservoirs, computation points, and impact areas.  It is also possible to create 
time series icons, and set up model program sequences and forecast runs.  An example Setup 
Module is shown in Figure 14.1. 
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Figure 14.1. Setup Module 
  

Refer to Chapter 15 for additional details for setting up your models. 

14.2 Defining the Order of Application Programs 
The order of program execution is a fundamental part of the watershed setup, which is defined 
from the Setup Module.  Program order must be decided early on in the setup, and if the order is 
changed after a forecast has been configured, then the flow of data will be disrupted and results 
will be invalidated.  Figure 14.2 shows an example sequence for ordering the application 
programs. 
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Figure 14.2  Example Program Order 
 

Refer to Chapter 16 for additional details for defining the order for application programs. 

14.3 Establishing the Stream Alignment 
A common schematic is used to share effectively common data between application software and 
to visually represent the watershed.  The basis of this schematic is the Stream Alignment, upon 
which various elements are placed. 

Background maps can also be used to help in creating the stream alignment.  The stream 
alignment can be manually drawn using background river or stream maps as guides.  Astream 
alignment can be created by importing it from a properly projected GIS layer whose river 
segments are continuous (i.e., no breaks in the stream flow definition), and whose attributes 
include the river names. 

The stream alignment consists of stream nodes, stream segments, and stream junctions.  Stream 
nodes are used for stream stationing, and exist (at a minimum) at the most upstream point and the 
most downstream point of a stream.  By default, the downstream end of a stream is Station 0.  
However, the default stationing can be overridden by editing the station values.  For example, a 
user might want to define their own stationing that represents river miles.  Stream segments are 
defined by multiple vertex points, used for shaping the stream segment.  Stream junctions are 
automatically created when multiple stream segments are joined (i.e., at a confluence of the 
stream’s main stem and a tributary).  As a visual indication of where a stream junction exists, a 
light green halo is displayed around the stream node.  An example stream alignment is shown in 
Figure 14.3 
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Figure 14.3  Example Stream Alignment 
 
Refer to Chapter 17 for additional details for defining a stream alignment. 

14.4 Developing Time Series Icons 
The user develops Time Series Icons in the Setup Module to use in the Map Window of the 
remaining modules to show data and information availability.  The information can be time 
series data, images, web pages, webcams, scripts, and document files.  Time series icons can be 
linked to data from a HEC-DSS file.  Time series icons are used as easy access for analyzing 
incoming data and for providing location specific information. 

Time series icons can be represented as symbols, thumbnail plots, or color-coded data quality 
bars.  The user should define and setup the time series icons early in the watershed model 
development so data can be readily viewed.  Occasionally, changes to the time series icons may 
need to be made to accommodate additional data development.  Refer to Chapters 18 and 19 for 
additional information describing time series icons. 

14.5 Editing Elements 
In the Setup Module, the user can edit a variety of elements that represent watershed data 
visually in a geo-referenced context and interact with associated data.   

14.5.1 Shortcut Menus 
There are several elements that are considered projects in HEC-RTS.  These include reservoirs, 
levees, diversions, channel modifications, off channel storage areas, and other projects.  All 
projects are created in the Setup Module.  Projects configured in HEC-RTS do not effect model 
computations. 
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1. Reservoir elements are pertinent to the HEC-ResSim application.  When a reservoir 
element is created, a storage reach and at least two computation points (upstream and 
downstream) are automatically created, along with a pool triangle and at least one dam 
rectangle.  Multiple upstream points are allowed, as well as multiple dam locations. 
Figure 14.4 shows an example reservoir with multiple inflow points, a storage reach, a re-
shaped pool triangle, and a dam location. 

 

Figure 14.4  Example Reservoir Element 
 
2. Levee elements are drawn to represent earthen barriers built along a stream to provide 

protection from flooding.  A levee can reduce flood damage by preventing flood states 
from reaching a potential damage area.  As such, levees are included as a project element 
for HEC-FIA reference. Figure 14.5 shows an example of how you might draw a levee 
(shown as a thick purple line) that follows closely to the stream alignment in the display 
area of the Map Window. 
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Figure 14.5  Example Levee (represented by thick purple line) 
 
3. Diversions are pertinent to the HEC-ResSim application.  When a diversion element is 

created, there is a single inflow into the diversion and a single outflow from the diversion 
that are automatically created.  The user can choose whether or not to connect the outflow 
point to another element in the display area.  If the outflow point is not connected, then 
the diverted water will be lost from the watershed. 

4. Channel Modifications, Off Channel Storage Areas, and Other Projects elements can 
be placed as visual references in your Map Window.  However, project data and 
corresponding project application of these elements are planned for future versions of 
HEC-RTS. 

14.5.2 Computation Points 
Computation Points are created at all locations where time series information is to be 
exchanged between application programs, and where results to be computed are wanted.  Also, 
some computation points are autmatically created, as previously discussed for reservoirs and 
diversions. 

14.5.3 Impact Areas 
An Impact Area is any distinct portion of the watershed in which rising stage in a stream, river, 
lake, or reservoir has a consequence that is to be assessed.  The boundaries of an impact area are 
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defined by drawing the outline of the area and closing the outlines to form the sides of a polygon.  
The effects of rising stage are indicated by describing the property and population at risk in the 
area bounded by the polygon as input to HEC-FIA. 

Background map layers can be used to assist in placing impact areas at the appropriate locations.  
As with the other elements, impact areas can only be created in the Setup Module. Figure 14.6 
illustrates an example impact area, represented by the green filled-in area. 

 

Figure 14.6  Example Impact Area 
 

14.6 Developing Model Alternatives 
A Model Alternative is a single configuration with a specific set of input and parameters.  A 
second model alternative would be defined by a different configuration or different input or 
parameters.  Since model alternatives do not include time-specific data, you can use a model 
alternative with any time window. 

Initially, alternatives are developed using the software of the native model (e.g., HEC-HMS, 
HEC-ResSim, HEC-RAS, and HEC-FIA).  Then, these alternatives are imported into HEC-RTS.  
Once they have been imported, the Setup Module is used to configure and edit specific model 
alternatives. 

For example, since MFP deals with future precipitation, Model Alternatives can be configured to 
use in conjunction with HEC-HMS to compute a variety of future precipitation scenarios.  Since 
HEC-HMS simulates watershed response to precipitation, then HEC-HMS alternatives can be 
used to forecast future flows.  These future flows can be used with the reservoir application 
HEC-ResSim to compute reservoir releases.  Regulated flows and stages can be input to HEC-
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RAS and HEC-FIA.  Basically, all of the individual model alternatives created in the native 
programs are available to HEC-RTS. 

In the Setup Module, you will create model alternative keys that will be used in creating a 
forecast run.  Each key is a single alpha-numeric identifier that represents a model alternative.  
For example, the Key N might represent normal conditions, the Key W might represent wet 
conditions, and the Key D might represent dry conditions.  

Refer to Chapter 20 for additional information on model alternatives. 

14.7 Creating Forecast Runs 
A Forecast Run is a single forecast scenario defined by a specific set of data, information, and 
model alternatives.  A forecast run is created in the Setup Module.  Use the previously defined 
model alternative keys to create a forecast run key that consists of a collection of the model 
alternative keys.  

As an example, the user might name a forecast run MFP-HMS-ResSim.  For this example, the 
forecast run key might be R0B0N0---- which could reflect Radar precip data for MFP, Base data 
for HEC-HMS, and Normal Operations for HEC-ResSim.  In this example, the dashes indicate 
that HEC-RAS and HEC-FIA are not being run.  

Refer to Chapter 20 for additional information on forecast runs. 

14.8 Linking Models and Configuring Data Extract List 
After a Forecast Run has been created the models need to be linked.  This is completed using 
the Model Linking Editor shown in Figure 14.7.  On this editor, use the Forecast Run 
dropdown list to select the forecast run you wish to configure.  Then select each model in the 
model in the Model Requiring Input dropdown list.  In the table below, specify which model 
alternative the input comes from and the HEC-DSS pathname associated with the model results.  
For example, the precipitation input data for HEC-HMS may be set to come from the MFP 
precipitation grid. 

Refer to Chapter 21 for additional information on model linking. 

Once the models have been linked the next step is to configure the Data Extract List.  The Data 
Extract List specifies the location of the gridded and time series data required be the different 
model alternatives.  For example, this could be gridded precipitation data or observed flow data 
from the database.  Configuring the Data Extract List is completed from the Extract List 
Editor shown in Figure 14.8.  

Refer to Chapter 22 for additional information on the extract editor. 
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Figure 14.7  Model Linking Editor 
 

 

Figure 14.8  Model Linking Editor Extract List Model Alternative 
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CHAPTER 15   
 

Setup Module 
 

In HEC-RTS, a Watershed is a set of data, information, models, and images that represent 
watershed lands and the channels, gages, and water control features within the watershed.  

The Setup Module in the Control and Visualization Interface (CAVI) is the grouping of 
commands for watershed setup.  These are commands for configuring inputs, models, and 
outputs that describe a watershed’s behavior.  A visual representation of the watershed is 
developed to display in the CAVI that is map-based.  This chapter describes the Setup Module, 
including the Setup Module interface, how to create a new watershed, and reports on watershed 
setup. 

The Setup Module is accessed by clicking the Setup Tab.  In the Setup Module, configure the 
watershed’s physical arrangement, including maps and geo-extents (Chapter 5), the stream 
alignment (Chapter 17), time series icons (Chapter 18), and other geo-referenced data.  Once the 
watershed is set up, the user will be able to use the data that has been defined within HEC-
ResSim, HEC-FIA, and other geo-referenced HEC-RTS applications. 

Because the order of program execution (Chapter 16) is a fundamental part of the watershed 
setup, it should be defined early in the process of constructing data sets for the watershed.  The 
program order is established in the Setup Module.  This involves determining the set of 
programs for HEC-RTS to execute, the order of program execution, and the data flow for 
forecasting.  Supplemental Programs may also be defined and added to the program order so 
they are executed from HEC-RTS.  A Supplemental Program is a program or script that is 
developed by the user and is not included with HEC-RTS. 

15.1 Setup Module Interface 
The Setup Module displayed in the CAVI main window is shown in Figure 15.1.   
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Figure 15.1  Setup Module 
 

The following sections summarize commands in the Setup Module. 

15.1.1 Menu Bar 
The following is an overview of the Menu Bar as it appears in the Setup Module.  The Tools, 
Window, and Help menus and their commands are common to all modules and are discussed in 
Section 2.3.1. 

File From this menu, the user can create a watershed, open a watershed, close a 
watershed, save data associated with the watershed, and exit CAVI.  In addition, 
the most-recently-used watersheds are located in the File menu.  Available 
commands are:  New Watershed, Open Watershed, Recent Watersheds, 
Save Watershed, Close Watershed, and Exit. 

View This menu is used to add or remove screen items (Toolbar icons, Watershed 
Pane, Messages Window, Status Bar, and tabs in the Watershed Pane); set 
the Units and Time Zone for the view in regard to plotting and tabulating; and 
save, restore and manage Layouts. Available commands are: Zoom To All, 
Displayed Units, Displayed Time Zone, Toolbars, Messages, Status, Module 
Tabs, Save Layout, Restore Layout, Layout Manager. 
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Maps This menu is used to add and remove map layers (including Internet map 
layers), specify default map properties, and set viewing options. The available 
commands are: Map Layers, Default Map Properties, Add Internet Map, 
Display Map Coordinates, Save Map Image, and Print Map. 

Watershed From this menu, the user can view the watershed properties, access a list of the 
watershed files, add or remove a stream reach alias, view a list of the streams in 
the watershed, upload or download a watershed, import a HEC-RTS / CWMS 
2.1 watershed, and import or export stream alignment files. The available 
commands are: Watershed Properties, Files, Stream Reach Alias Editor, 
List of Streams, Upload/Download Watershed, Import 2.1 Watershed, and 
Stream Alignment. 

Models This menu is used to establish the program order, specify model alternative 
keys, configure forecast runs, setup model linking, access the extract and post 
editors, and manage model alternatives. Available commands are: Program 
Order, Model Alternative Keys, Forecast Runs, Model Linking, Edit 
Extract, Edit Post, and commands related to models configured in the 
watershed.  

Scripts From this menu, the user can run, edit and schedule a script, and access the 
status of a script job. Available commands are: script Editor, Schedule, Script 
Job Status, and Run. 

15.1.2 Map Window Tools 
Map window tools allow the user to access and configure elements within your watershed.  The 
following are descriptions of tools in the Setup Module.  A description of the tools common to 
all modules is included in Section 2.3.2.  

15.1.3 Stream Alignment Tools 
These tools are available when a Stream Alignment is displayed in the Map window of the 
Setup Module.  See Chapter 17 for more information regarding the Stream Alignment.  

 
Select Tool – Use this tool to edit, rename, and delete elements.  To access 
commands, select the Select Tool and right-click on an element.  Commands are 
available from a shortcut menu.  

 
Zoom Tool – Use this tool to enlarge specific locations in the map window.  To 
enlarge a certain extent, left-click and drag tool over area; to zoom out, right-click. 

 
Time Series Icon Tool – Use this tool to create, delete, and edit Time Series Icons.  
See Chapter 18 for more detail on creating, deleting, renaming, and editing Time 
Series Icons. 
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Stream Alignment Tool – Use this tool to create, delete, and edit stream elements 
that make up the stream alignment (Chapter 17).  A stream alignment is a 
representation of the stream network in the watershed. 

 
Stream Node Tool – Use this tool to create and edit stream nodes and junctions that 
make up a stream alignment (Chapter 17).  Stream nodes are the beginning and 
ending points for each stream element.  Stream nodes are also points where stream 
elements meet (stream junctions). 

15.2 Creating a New Watershed 
The first thing that must be done to configure a new watershed is to give it a name and 
description, specify its location, and establish the system of units and the time zone for the 
watershed.  Once the new watershed has been configured, HEC-RTS generates a new directory 
hierarchy in the specified watershed directory.  The new watershed becomes active in the main 
window, and the tools needed to configure watershed elements become available.  At this point 
the user may continue to configure the new watershed by adding layers, setting preferences for 
the map window, creating time series icons, establishing the database connectivity, and 
configuring models and model alternatives. 

To configure a new watershed: 

1. On the File Menu, click New Watershed.  The Create New Watershed dialog (Figure 
15.2) will open.  

2. Enter a name for the new watershed in the Watershed Name Field.  The watershed name 
must be less than thirty-two (32) characters and cannot contain any of the following 
characters: , | / : * ? ” < > - \. 

3. Enter a description for the new watershed in the Description Field that clearly explains what 
it is. 

4. From the Watershed Location, select the watershed location to save the new watershed or 
add a new location. 

5. For system units, select either English (U.S. customary units) or SI (System International) 
(see Section 15.3) from the drop-down list.  This cannot be changed after clicking OK. 

6. The default Coordinate System is set to the X-Y system.  The default coordinate system can 
be changed using the Edit button.  See Appendix C for more information. 

7. Using the Add Map Layers button, map layer files can be selected to add to the watershed.  
After selecting a map layer, the Set Watershed Coordinate System prompt will open.  The 
prompt will ask whether the user would like the watershed coordinate system to match the 
selected map layer’s coordinate system.  The coordinate system of all of the watershed’s 
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layers must be consistent.  HEC-RTS does not have coordinate system transformation tools.  
See Appendix C.1 for more information. 

8. The user can chose to Import CWMS 2.1 Watershed by browsing to a specific 2.1 
watershed. 

9. Select a time zone using the radio buttons in the Settings Field.  By default, U.S.  Time 
Zones are selected and appear in the list.  There are eight choices.  Select the time zone 
appropriate for your watershed.  See Section 15.4 for further discussion on time zones.  Click 
OK in the Create New Watershed dialog.  The watershed will be created. 

 

Figure 15.2  Create New Watershed Dialog 
 

15.3 Specifying Units 
All modeling data and information, time series data, geometric and reservoir information must 
use the same system units.  Therefore, it is crucial that the units are absolutely certain when 
either English or SI is specified as the unit system for the watershed when it is set up.  The 
watershed unit system cannot be changed once watershed setup is complete. 
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15.4 Specifying Time Zones 
When a new watershed is configured, the appropriate time zone representative of the watershed 
must be selected.  This typically would be the time zone for the outlet or major portion of the 
watershed.  Internally, HEC-RTS will store all-time series data using the fixed “standard time 
offset from GMT” for the selected watershed time zone.  Thus, internally, the data will be held in 
standard time only.  However, when viewing data or model results, local or any other time zone 
may be selected for display purposes (which provides standard and daylight time labels, as 
appropriate, throughout the year).  NOTE: The watershed time zone cannot be changed once 
watershed setup is complete.  However, at any time the display of data can be customized using 
the View Menu. 

The default time zone setting is U.S.  Time Zones.  If the watershed is outside the U.S., time 
zone setting can be changed.  In the Create New Watershed dialog (Figure 15.3) in the Settings 
Field, select the International Time Zones Radio Button.  The list will now contain time zones 
for the world. 

15.5 Models 
Models menu allow the user to modify the Program Order (Chapters 14 and 16) and Import 
models. The Models menu also allows the user to setup Model Alternative Keys (Chapter 20), 
Forecast Run(s) (Chapter 20), and Model Linking (Chapter 21) in the Setup Module for a 
watershed.  
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CHAPTER 16   
 

Program Order 
 

16.1 Overview 
HEC-RTS allows for a flexible set of programs, computation order, and data flow for 
forecasting.  The order of execution of programs is a fundamental part of the watershed setup.  
The order is defined in the Setup Module.  Supplemental programs can be defined and added to 
the computation order so that they are executed from HEC-RTS.  This chapter describes the steps 
to do so.  (A Supplemental Program is a program or script that is developed by the user.  
Supplemental programs are not included with HEC-RTS.)  

16.2 Establishing Order Dialog 
Program order must be established early when constructing data sets for the watershed.  If the 
order of programs changes after a forecast has been configured, it may disrupt the orderly flow 
of data and the results and invalidate any existing work. 

16.3 Program Order Dialog 
To change, delete, or add programs to the watershed’s program order, use the Program Order 
dialog (Figure 16.1).  The Program Order dialog also establishes computation order and data 
flow for forecasting.  In addition, the Program Order dialog provides the mechanism for 
defining supplemental programs, adding the supplemental programs to the program order, and 
establishing data flow for supplemental programs.  To access the Program Order dialog, choose 
Program Order from the Models menu in the Setup Module. 
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Figure 16.1  Program Order Dialog 
 

16.4 HEC Programs in the Program Order 
By default, the program order for a watershed is: MFP, HMS, ResSim, RAS, and FIA.  HEC-
MetVue may also be inserted into the program order, along with additional HEC programs. 

16.4.1 Add an HEC Program 
The default program order is displayed in the table on the Program Order dialog (Figure 16.1).  
To add an HEC program: 

1. Click the row in the table where the program should be added. 

2. From the Edit menu, click either Insert Before or Insert After.  The Select Program dialog 
opens (Figure 16.2). 
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Figure 16.2  Select Program Dialog 
 

3. From the Name drop-down list, select the name of the program to insert into the program 
order and click OK.  The selected program appears in the table on the Program Order 
dialog. 

16.4.2 Program Order Change 
To select the Default Input for a HEC Program: 

1. For HEC programs, the Default Input will be selected automatically based on typical model 
input. 

2. Click the program row in the table for the program to move. 

3. From the Edit menu, click Remove. A Confirm Removal dialog box will open. Click Yes. 

4. Select the row in the table where the removed program should be added. 

5. From the Edit menu, click either Insert Before or Insert After.  The Select Program dialog 
opens (Figure 16.3). 

6. From the Name drop-down list, select the name of the program to insert into the program 
order and click OK.  The selected program appears in the table on the Program Order 
dialog. 

7. Click Apply, and a warning message 
appears, stating that this could affect the 
existing setup.  Click Yes. 

8. Click OK, and the Program Order dialog 
closes. 
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Figure 16.3  Example of Changed Program Order 
 

16.4.3 Remove an HEC Program 
To remove an HEC program from the program order: 

1. On the Program Order dialog, click the row in the table corresponding to the program to be 
removed. 

2. From the Edit Menu, click Remove.  A warning message will appear asking if it is OK to 
remove the program from the program order. Click Yes.   

3. Click OK on the Program Order Dialog.  A warning message will appear, stating that this 
could affect the existing setup and asking to continue.  Click Yes, and the Program Order 
dialog closes. 

16.5 Supplemental Programs in the Program Order 
The Program Order dialog (Figure 16.3) allows the user to define supplemental programs into 
the appropriate position in the program order.  A Supplemental Program is a program or script 
that is not included with HEC-RTS.  For example, an office might have a locally developed 
program that is used to model the unsteady flow regime of one or more rivers.  This program, 
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and the river model associated with it, could be used in addition to or in place of HEC-RAS in 
the program order. 

The steps required to utilize a supplemental program in the program order are: 

1. Create a program or script that implements the supplemental program and adheres to the 
supplemental program interface (Section 16.5.1). 

2. Define the supplemental program to RTS (Section 16.5.2). 

3. Add the supplemental program to the program order (Section 16.5.3). 

4. Define one or more model alternatives for the supplemental program (Section 16.5.4). 

5. Create a model alternative for each supplemental program model alternative (Section 23.1). 

6. Create one or more forecast runs that each includes one of the model alternatives for the 
supplemental program (Section 23.13). 

16.5.1 The Supplemental Program Interface 
A program or script that implements a supplemental program must adhere to a specific interface 
for communicating with CAVI during the execution of a forecast.  This interface includes how to 
receive arguments for the supplemental program from CAVI, how to output messages to the 
forecast compute log, and how to inform CAVI about the exit status of the supplemental 
program. 

Receiving Arguments 
During a forecast computation, HEC-RTS executes a supplemental program by running its 
executable with a single command line parameter.  The parameter is the fully qualified name of a 
file that contains the arguments for the supplemental program.  This arguments file contains 
standard arguments in keyword=value format – one keyword/value pair per line – plus any 
alternative-specific arguments defined for the supplemental program model alternative being 
executed (Section 16.5.3).  

The standard argument keywords available in the arguments file are listed below: 

ComputeType Type of computation, "Forecast" for CAVI 

ProgramName Supplemental program name (Section 16.5.2) 

ProgramAlternative Supplemental program model alternative name (Section 16.5.3) 

ModelAlternative Model alternative identifier 
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An example of a Supplemental Program Arguments File is shown in Figure 16.4. 

Alternative Forecast run identifier 

RunTimeWindow Lookback, forecast, and end times of forecast 

IOTimeStep Interval of data in forecast HEC-DSS file 

TimeZoneOffset Offset in hours from UTC to watershed time zone 

InputPosition Number of characters contained in InputFPart name that’s 
provided below 

ModelPosition Number of characters contained in OutputFPart name that’s 
provided below 

ForecastPath Forecast directory of current forecast 

ForecastDSSFile Fully qualified name of forecast HEC-DSS file 

InputFPart The F pathname part of data to be read from the forecast HEC-
DSS file 

OutputFPart The F pathname part of data to be written to the forecast HEC-
DSS file 

User The name of the user executing the forecast 

ClientDisplay The X-Windows server address of the user's display 

ForceRecompute "true" or "false" specifying whether the supplemental program 
must be executed – if "false", the supplemental program can 
decide whether it should execute 
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Figure 16.4  Example Supplemental Program Arguments File 
 

 

Outputting Messages to the Forecast Compute Log 

The supplemental program architecture allows the executable to output normal messages and 
error messages to the forecast compute log by writing these messages to a supplemental program 
log file. 

The supplemental program log file: 

• Has the same name as the arguments file name (passed as the only command line parameter 
to the supplemental program executable) with the ".args" extension replaced by ".log". 

• May contain special message type lines that instruct CAVI how to process the following 
lines: 

• [No Message] specifies that the following lines will not be included in the compute log 

• [Log Message] specifies that the following lines will be treated as a normal compute log 
message 

• [Error Message] specifies that the following lines will be treated as a compute log error 
message 

• The message type lines are case insensitive, but must include the brackets ([ and ]) without 
any adjoining whitespace and may not appear on a line with any other text.  The message 
type remains in force until another message type line is encountered.  An implicit [No 
Message] line is processed at the beginning of the log file, so text in the log file before a 
message type line will not be included in the compute log. 

 

 

ComputeType=Forecast 

ProgramName=SupplementalTest 

ProgramAlternative=NormalTest 

ModelAlternative=20D0N0X0------ 

Alternative=20D0N0X0------ 

RunTimeWindow=26 August 2006, 24:00; 30 August 2006, 03:00; 3September 
2006, 24:00 

IOTimeStep=1 Hour(s) 

TimeZoneOffset=-5 Hour(s) 

InputPosition=4 

ModelPosition=6 
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Informing the Exit Status of a Supplemental Program 

HEC-RTS uses the exit code returned from the executable to the operating system to determine 
the status of the supplemental program execution.  The exit code is interpreted as follows: 

0 The supplemental program completed successfully 

1 The supplemental program skipped computation — the executable should not return 
this value if the ForceRecompute argument is set to "true" 

other An error occurred during execution — the executable should output some diagnostic 
message(s) to the compute log if it returns a value other than 0 or 1 

16.5.2 Create a Supplemental Program 
To create a supplemental program: 

1. Right-click the Supplemental Icon  under the Models Folder on the Setup Tab.  Choose 
New, and the Create New Supplemental Program dialog opens (Figure 16.5). 

 

Figure 16.5  Create New Supplemental 
Program Dialog 
 

2. In the Name Field, enter the name of the supplemental program. 

3. Enter a description in the Description Field and click OK. 

4. The Supplemental Program dialog (Figure 16.6) opens.  In the Supplemental Program 
dialog, specify the location of the program or script that implements the supplemental 
program in the Executable field using the “…” browser button. 

5. If needed, enter command line arguments in the Arguments field.  Click OK, and the 
Supplemental Program dialog closes. 
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Figure 16.6  Supplemental Program Dialog 
 

16.5.3 Add a Supplemental Program 
Once a supplemental program has been defined, it can be added to the program order (Figure 
16.7).  To do this, follow the instructions for adding an HEC program in Section 16.4.1.  Instead 
of selecting an HEC program, select the supplemental program that was created and the 
appropriate input for the program. 

 

Figure 16.7  Supplemental Program Added to Program Order 
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16.5.4 Define Model Alternatives 
After you have added a supplemental program to your order of programs, you must define one or 
more model alternatives for that supplemental program before you can use it.  The Program 
Order Dialog (Figure 16.1 and Figure 16.7) provides the tools to create model alternatives for 
the supplemental program. 

To define a model alternative for a supplemental program: 

1. From the Program Order dialog (Figure 16.7), select the row that contains the supplemental 
program to create a model alternative for.  On the Edit menu, point to Alternative, and click 
New. 

2. The Create a New Alternative for Supplemental Model dialog will open (Figure 16.8). 

 

Figure 16.8  Create a New Alternative for Supplemental Model Dialog 
 

3. In the Name box enter a name for the model alternative, and optionally enter a description in 
the Description field.  Note that model alternative names must be unique across all defined 
supplemental programs (e.g., two supplemental programs cannot each have a model 
alternative named “NormalConditions”). 

4. Click OK.  The Create a New Alternative for Supplemental Model dialog box will close 
and return the program to the Program Order dialog. 

5. On the Program menu, click Save.  A warning message will appear, stating that this could 
affect existing setups and asking to continue.  Click Yes. 

6. To close the Program Order dialog, from the Program menu, click Close.  If changes have 
not been saved, there will be a prompt to save them. 

Note that every model alternative defined for a particular supplemental program will use the 
same executable; only the arguments will differ.  In addition, alternative-specific arguments can 
also be defined for any model alternative. 
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To add alternative-specific arguments to a model alternative: 

1. From the Program Order dialog, in the table, select the row of the supplemental program.  
From the Edit menu, point to Alternative, and click Edit. 

2. The Supplemental Alt Argument Editor dialog will open (Figure 16.9). 

 

Figure 16.9  Supplemental Alt Argument Editor 
 

3. The name of the supplemental program will appear in the Program field. 

4. The table on the editor will contain the names of the model alternatives that have been 
created for the selected supplemental program. 

5. From the table, select the model alternative to setup arguments for.  Once selected, the name 
of the model alternative will appear in the Name field. 

6. If the description of the model alternative needs to be changed, this can be done in the 
Description field. 

7. In the Arguments box, enter the arguments for the model alternative that will be passed to 
the executable.  Arguments are typically – but not required to be – entered in keyword=value 
format. 

8. Click OK, and the Supplemental Alt Argument Editor (Figure 15.9) will close and return 
the program to the Program Order dialog. 

To close the Program Order dialog, choose the OK button.  A warning message will appear, 
stating that this could affect the existing setup.  Click Yes. 
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16.5.5 Remove a Supplemental Program 
The steps to remove a supplemental program from the program order are the same as for 
removing an HEC program (see Section 16.4.2.) 

16.6 Multiple Program Orders 
By default HEC-RTS allows only a single Program Order to be used.  If desired, the user can 
enable use of Multiple Program Orders.  To enable Multiple Program Orders, access the 
CWMS CAVI Options tab via the Tools > Options menu, and check the Advanced Options 
box.  

 
 
Care must be exercised when using Multiple Programs Orders.  When a model alternative is 
linked to a program for its input information, it remembers the position of the model it is 
receiving its data from, not the name or program of the specified Model Alternative.  This can 
lead to potential conflicts if a Model Alternative is used in two different Program Orders.  The 
recommended practice when using Multiple Programs Orders is to configure a different Model 
Alternative for use in each different Program Order. 
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CHAPTER 17   
 

Establishing the Stream Alignment 
 

17.1 Overview 
A common schematic is used to share effectively common data between HEC software (for 
example, HEC-HMS and HEC-ResSim) for a watershed.  The common schematic consists of a 
stream alignment, map layers (Chapter 5), and time series icons (Chapter 18).  Use of this 
common schematic ensures consistency of computation nodes, routing reaches, and so on. 

In the setup module, tools are used to create the common schematic.  Chapter 14 was an 
overview of the setup module and the tools available in the module.  The tools allow the 
depiction of elements of the common schematic—but not changes to the configuration of the 
native models.  Changes made with the tools are not accounted for in the native models’ 
computations. 

The first item to create in the common schematic is the stream alignment.  A stream alignment is 
the backbone for all the other elements that make up a common schematic.  This chapter will 
describe the tools and concepts for creating a stream alignment. 

17.2 Definition of a Stream Alignment 
Stream alignments represent the stream network in the watershed.  The alignment shows flow 
direction and indicates where confluences and bifurcations occur.  It can also provide a sense of 
distance and scale.  Stream alignments are composed of a series of stream elements, stream 
nodes, and stream junctions (Figure 17.1).  A stream element is a segment of the stream 
alignment.  A stream element typically begins or ends at a confluence, bifurcation, or at the 
boundary of the river system.  It is composed of vertex points, with the beginning and ending 
vertex points being stream nodes.  Stream junctions are also stream nodes but are located at 
points where two stream elements meet. 
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Stream Nodes 

Stream Alignment Stream Elements 

Stream Junctions 
 

Figure 17.1  Parts of a Stream Alignment 
 

Stream elements are drawn in segments defined by vertex points.  Each stream element must 
have at least two stream nodes, defining the beginning and end of the stream element.  Stream 
elements, stream nodes, and stream junctions, are illustrated in Figure 17.2. 
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Figure 17.2  Relationships of Stream Elements, Stream Nodes, and Stream Junctions 
 

HEC-RTS creates and labels stream stations (or river stations if the user defines the stationing as 
such) along each stream element.  Stream stationing is a reference system for locating features 
with distance along a stream.  The station at the downstream end of an element is Station 0.  The 
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stationing increases upstream along the element according to the linear distance between vertices 
on the stream element in the watershed coordinate system.  The default stationing can be 
overridden by editing the station values of the stream nodes at the upstream and downstream 
ends of the stream element and by adding additional nodes along the stream element. 

Stream stationing is based on the geographic extents that are defined when a stream element is 
drawn.  If the geo-extents are based on a map layer, the units for the stream stationing are the 
same as the map layer (that is, feet or meters).  There is no indication of what the units are. 

A stream alignment created without an underlying map layer will use the default coordinate 
system of X-Y.  This default system does not have any units associated with it.  Appendix C 
describes how to set up coordinate systems. 

The primary tools used to define the stream alignment are the stream alignment tool and stream 
node tool (Figure 17.3).  The zoom tool (Chapter 2) is also useful.  Use it to magnify the stream 
network.  This makes defining the vertices along the stream easier.  The three tools are located in 
the map window toolbar of the setup module. 

If the stream alignment and stream node tools are not displayed in the map window tool bar, 
click the Setup tab.  Expand the Stream Alignments layer in the layer tree.  Double-click the 
Stream Alignment node. 

 

Figure 17.3  Tools Used For Defining a Stream Alignment 
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17.3 Create a New Stream Alignment 
If the stream alignment is going to be based on a map layer, the map layer must first be added to 
the watershed (Chapter 5).  The map layer should contain watershed features, such as channels 
and reservoirs, so that it can be a guide for creating the stream alignment.  The units of the labels 
on the stream alignment will be the same as the units of the map layer.  That is, if the map layer 
is projected in state plane coordinates (feet), then the labels on the stream alignment will be in 
feet. 

A new stream alignment can either be created by hand or one can be imported from an ArcGIS® 
shapefile (Section 17.9).  The following are steps for creating a new stream alignment. 

To create a stream alignment: 

1. Select the Stream Alignment Tool on the map window toolbar. 

2. Find a location (typically by viewing a background map that you have added as a map 
layer) on the map window where a stream element should start.  Important: Stream 
elements should be created from upstream to downstream.  Hold down the CTRL key 
while clicking the mouse button.  Each click creates a vertex point (Figure 17.4) on your 
stream element.  The first vertex point is the upstream or beginning stream node of a 
stream element. 

 
   

Figure 17.4  Creating a Stream Element 
   

3. For the most downstream or last vertex point, release the CTRL key, and then click the 
mouse button.  This creates the ending stream node of the stream element.  A single 
stream element has been created. 
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4. The Create New Stream dialog will open (Figure 17.5).  Either accept the default name 
or enter a new name.  An optional description can be entered.  Click OK. 

 

Figure 17.5  Create New Stream Dialog 
 

5. Repeat steps 2 through 4 to add more stream elements to the stream alignment. 

6. To connect a stream element to an existing stream element, place the first or last click of 
the new stream element on the existing stream element where the two stream elements 
should join.  After naming the new stream element, a dialog will appear asking to connect 
the new stream element to the existing stream element.  Click Yes. 

7. Once the stream alignment is completed, save the work.  On the file menu, click Save 
Watershed. 

17.4 Edit an Existing Stream Alignment 
After drawing a stream alignment in the map window, a stream element can be renamed, a 
stream element description can be edited, deleted, directionally reversed, disconnected at both 
the upstream or downstream end, and the stream stationing and coordinates of the stream nodes 
on the stream element can be viewed.  All of these tasks are accomplished through the stream 
element shortcut menu (Figure 17.6). 

To access the stream element shortcut menu, use the stream alignment tool (Figure 17.3) 
to select a stream element and right click.  
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Figure 17.6  Stream Element Shortcut Menu 
 

17.4.1 Rename a Stream Element 
To rename a stream element: 

1. Select the stream alignment tool from the map window toolbar. 

2. Right-click on the stream element to be renamed, and click Rename Stream Element 
from the shortcut menu. 

3. The Rename Stream dialog (Figure 17.7) opens.  Enter the new name in the Name field 
(required) and a description in the Description field (optional). 

 

Figure 17.7  Rename Stream Dialog 
 

4. Click OK.  A confirmation dialog (Figure 17.8) opens asking the user if they really want 
to rename the stream. 
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Figure 17.8  Rename Stream Confirmation Dialog 
 

If answering Yes, then an Update Measure Stream References dialog (Figure 17.9) opens. 

 

Figure 17.9  Update Measure Stream References Dialog 
 

If answering Yes on the Update Measure Stream References dialog, then the stream element 
references are updated, and the dialog will close.  Otherwise, if answering No, then the stream 
element references are not updated, and the dialog will close.  In either case, the new name of the 
stream element will be shown in the map window. 

17.4.2 Delete a Stream Element 
To delete a stream element: 

1. Select the stream alignment tool from the map window toolbar. 

2. Right-click the stream element to be deleted, and click Delete Stream Element. 

3. A warning and confirmation message will appear (Figure 17.10).  Click Yes to confirm. 

 

Figure 17.10  Confirm Deletion of Stream Element Message 
 

17.4.3 Reverse Direction of a Stream Element 
If a stream element is drawn in the wrong direction, from downstream to upstream, the direction 
can be reversed instead of having to delete and redraw the stream element. 
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To reverse the direction of a stream element: 

1. Select the stream alignment tool from the map window toolbar. 

2. Right-click the stream element to be reverse, and click Reverse Direction. 

3. A warning and confirmation message will appear (Figure 17.11).  Click Yes to confirm. 

 

Figure 17.11  Confirm Reversing Direction of Stream Element Message 
 

17.4.4 Disconnect a Stream Element 
To disconnect a stream element from another stream element, it may be done at either the 
upstream or downstream end of the stream element. 

To disconnect a stream element from another stream element: 

1. Select the stream alignment tool from the map window toolbar. 

2. Right-click the stream to be disconnected, and click either Disconnect Upstream or 
Disconnect Downstream. 

3. The stream element will be disconnected from the stream element at the chosen location.  
In the map window, the upstream or downstream point will physically move away from 
the connecting stream element, and a stream node will remain on the connecting stream 
element. 

17.4.5 Edit a Stream Element Description 
The stream editor, available from the shortcut menu of a stream element, allows editing of the 
stream element description and viewing of the stream stationing and coordinates of the upstream 
and downstream stream nodes, as well as any stream nodes in between the two.  

To edit the description of a stream element: 

1. Select the stream alignment tool from the map window toolbar. 

2. Right-click the stream element to be edited, click Edit Stream Element, and the Stream 
Editor (Figure 17.12) opens. 
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Figure 17.12  Stream Editor 
 

3. From the name drop-down or the arrow buttons select the name of the stream to be 
edited.  

4. Either a new description can be entered the existing description of the stream element can 
be edited in the Description field. 

5. The table provides the stream stationing and coordinates of the stream nodes that are on 
the selected stream element. 

17.5 Adjusting a Stream Element 
After drawing the stream alignment in the map window, there are many options available for 
adjusting the stream alignment.  The zoom tool can be used to help magnify the stream elements.  
The stream alignment can be refined and reshaped by adding, moving, and deleting vertex points 
from stream elements.  Adjacent vertex points are connected by straight lines.  Thus, when a 
vertex point is deleted, the alignment will adjust so that the two vertex points that had 
surrounded the deleted vertex point are connected by a straight line.  The alignment will adjust 
similarly when vertex points are moved.  

17.5.1 Add Vertices to a Stream Element 
To add vertex points to an existing stream element: 

1. Select the stream alignment tool from the map window toolbar. 

2. Double-click the stream element to add a vertex point to.  The stream element will turn 
red, and vertex points will be displayed in blue. 

3. Place the pointer where a vertex point should be added.  Hold down the CTRL key, and 
click. 

17.5.2 Move the Vertices of a Stream Element 
To move vertex points on an existing stream element: 
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1. Select the stream alignment tool from the map window toolbar. 

2. Double-click the stream element where a vertex point should be moved.  The selected 
stream element will turn red.  The vertex points will be displayed in blue. 

3. Click the vertex point you wish to move, and drag it to a new location.  This is illustrated 
in Figure 17.13. 

 

Figure 17.13  Move a Vertex Point 
 

17.6 Stream Nodes 
Stream nodes are part of the representation of the stream network in the watershed.  The CAVI 
creates a stream node at the beginning and ending of each stream element and where stream 
elements meet (stream junctions).  Stream nodes are used to establish stationing for a stream.  To 
modify the default stream stationing, the stream nodes must be edited. 

Though they appear similar, stream nodes are not the same as computation points.  A 
computation point is a location where time-series data and information is exchanged between 
analysis software.  Stream nodes are useful in placing computation points. 

17.6.1 Add a Stream Node 
As noted above, two stream nodes are created automatically at the beginning and end of a stream 
element.  Stream nodes can be added to a stream element: 

1. Select the stream node tool from the map window toolbar. 

2. Place the pointer on the stream element where a stream node should be added.  Hold 
down the CTRL key, and click. 

17.6.2 Move a Stream Node 
To move a stream node: 

1. Select the stream node tool from the map window toolbar. 
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2. Double-click the stream node that to be moved.  It becomes a yellow circle with a black 
outline and four small black dots (Figure 17.14).  Click and drag the stream node along 
the stream element to its new position. 

 

Figure 17.14  Move a Stream Node 
 

17.6.3 Edit Stream Node to Establish Stream Stationing 
After placing a stream node on the stream alignment, the stream node can be edited to establish 
stream stationing for a stream element.  To edit a stream node: 

1. Select the stream node tool from the map window toolbar. 

2. Right-click on the stream node that you want to edit.  A shortcut menu will appear 
(Figure 17.15).  

 

Figure 17.15  Stream Node Shortcut Menu 
 

3. Click Edit Node.  The Stream Node Editor (Figure 17.16) opens. 
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Figure 17.16  Stream Node Editor 
 

4. The default stream station for the downstream node is 0.  The stream station for the 
upstream node is based on the coordinate system used when digitizing the stream 
alignment.  To change the default stream stationing, clear Use Default Stationing.  Edit 
the station in the Station field. 

5. Click OK.  Based on what station number is entered, the CAVI will automatically adjust 
the stream stationing for the stream element.  This includes the upstream and downstream 
nodes. 

17.6.4 Delete Stream Node 
To delete a stream node: 

1. Select the stream node tool from the map window toolbar. 

2. Right-click on the stream node that to be deleted.  Click Delete Node. 

3. A confirmation message opens.  Click Yes to confirm. 

17.7 Stream Junctions 
When two stream elements are connected, a stream junction is created.  A stream junction is 
where multiple stream nodes exist at one location.  A stream junction is represented by a dark 
green circle with a light green halo around the circle.  A stream junction can be moved and 
edited to adjust its stream stationing. 

17.7.1 Move a Stream Junction 
To move a stream junction: 

1. Select the stream node tool from the map window toolbar. 



HEC-RTS User's Manual  Chapter 17 – Establishing the Stream Alignment 
 

17-13 
 

2. Double-click the stream junction to be moved.  It becomes a green circle with a black 
outline and four small black dots (Figure 17.17).  Click and drag the stream junction 
along the stream element to its new position. 

 

Figure 17.17  Move a Stream Junction 
 

17.7.2 Edit a Stream Junction 
To edit a stream junction: 

1. Select the stream node tool from the map window toolbar. 

2. Right-click the stream junction to be edited.  A shortcut menu (Figure 17.18) will appear. 

 

Figure 17.18  Stream Junction Shortcut Menu 
 

3. Click Edit Junction.  The Stream Junction Editor will open (Figure 17.19). 

 

Figure 17.19  Stream Junction Editor 
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4. The editor displays information about the stream nodes associated with the stream 
junction.  To change the stream stationing for a stream node, clear the checkbox for the 
stream node in the Use Default Stationing column of the table.  The cell in the Station 
column will become active.  Based on what is entered, the CAVI will adjust the stream 
stationing for the stream associated with the stream node automatically.  Click OK. 

17.8 Change Stream Alignment Properties 
Stream alignment properties that can be changed include the color and width of stream elements, 
stream nodes, and stream junctions, font for the stream name, tic mark properties, and 
visualization scaling for the stream alignment. 

To change stream alignment properties: 

1. In the setup module, click Map Layers on the maps menu. 

2. The Map Layers dialog will open (Figure 17.20). 

 

Figure 17.20  Map Layers Dialog 
 

3. Right-click the Stream Alignment layer in the tree.  Click Properties. 

4. The Stream Alignment Properties dialog will open (Figure 17.21). 
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Figure 17.21  Stream Alignment Properties Dialog 
 

5. To change the color of the stream alignment layer, select a color from the Stream Color 
list.  The preview panel to the right of the Edit Properties panel will preview the 
selected color.  

6. Click OK, and the color change will appear in the map window. 

7. Repeat steps 5 and 6 for any other changes to be made to the stream alignment properties. 

8. To set the visualization scale, click the Scale menu. 

17.9 Import a Stream Alignment 
To import a stream alignment an ArcGIS® shapefile (Section 5.2.1) map layer (Section 5.3) that 
represents the stream network of the watershed must be added.  This shapefile must have an 
attribute that is the name of each stream, and each stream must form a contiguous line with one 
upstream point and one downstream point. 

To import a stream alignment: 

1. In the Setup module, on the Maps menu, select Import and then Stream Alignment. 

2. The Import Stream Alignment dialog (Figure 17.22) will open  
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Figure 17.22  Import Stream Alignment Dialog 
 

3. In the Shapefile Name drop-down list, the name of the ArcGIS® shapefile that the CAVI 
has chosen is displayed.  The CAVI automatically selects the first shapefile that contains 
polylines.  If this is not the correct shapefile, on the File menu, click Choose Shapefile. 

4. A browser Choose Shapefile dialog will open (Figure 17.23).  Use the dialog to select 
the shapefile to be imported (typically located in the maps folder of the watershed).  
Click Open. 
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Figure 17.23  File Browser to Select a Shapefile to Import a Stream Alignment 
 

5. Once the correct shapefile has been chosen, the program automatically searches for a 
database field name of Stream_ID.  If there is no Stream_ID in the shapefile chosen, the 
database field name that contains the names of each stream from the Database Field 
Name drop-down list must be selected.  In the example shown in Figure 17.24, for the 
shapefile nbpoto_rivers.shp, the database field name is NAME. 
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Figure 17.24  Selecting a Database Field Name when Importing a Stream Alignment 
 

6. When the correct database field name has been selected, the table will list the stream 
names (Figure 17.25).  HEC-RTS requires a stream to be a contiguous line with one 
upstream point and one downstream point.  If a stream is a contiguous line, the checkbox 
in the Import column of the table will be set.  If the line that represents a stream is non-
contiguous, the checkbox will not be set, and a Warning message (Figure 17.26) will 
appear indicating that the lines are not continuous and that the streams cannot be 
imported.  Click OK to close the message and to continue defining the import options. 
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Figure 17.25  Import Stream Alignment Dialog 
 

 

Figure 17.26  Warning Message Indicating Streams Not Continuous Lines 
and Cannot be Imported 
 

7. The Import All and Reverse Direction buttons can be used to select each of the 
checkboxes in the Import and Reverse Direction columns, respectively. 

8. Gap tolerance is used to connect stream elements that have a gap between the end point 
and the junction with another stream.  By default, the gap tolerance is set to zero, so the 
CAVI can connect streams to other streams.  To allow gap tolerance, check the Gap 
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Tolerance checkbox.  Enter a value larger than zero in the Gap Tolerance field.  The 
CAVI will connect streams that have a gap between them that is equal to or less than this 
value. 

9. The Replace Existing Stream Alignment check box allows replacement of the existing 
stream alignment with one being importing. 

10. Once everything is set, click Import.  The stream alignment will be automatically drawn 
in the map window.  

11. Click OK on the confirmation dialog.  

17.10 Export a Stream Alignment 
If a stream alignment has been digitized, that stream alignment can be saved as an ArcGIS® 
shapefile.  To export a stream alignment as a shapefile, a stream alignment must be displayed in 
the map window. 

To export a stream alignment as an ArcGIS® shapefile: 

1. In the Setup module, on the Maps menu, select Export and then Stream Alignment. 

2. A browser will open to choose where the shapefile should be saved (Figure 17.27).  
Navigate to the appropriate folder.  The default stream alignment is stored in the 
watershed’s main folder, but it is possible to export to a different folder (e.g., the 
watershed’s maps folder).  Enter a name in the File name field.  Click Save. 

 

Figure 17.27  Browser for Exporting Stream Alignment 
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17.11 Save Stream Alignment 
To save your stream alignment, on the File menu click Save Watershed.  This command will 
save all of the stream alignment revisions and all other revisions that have been made to the 
watershed. 

17.12 List of Streams 
Once stream alignment has been defined, the streams included can be reviewed. 

To view the List of Streams report: 

1. In the Setup module, on the Watershed menu, choose List of Streams.  The List of 
Streams report will open (Figure 17.28).  The report provides a list of streams that have 
been input for the stream alignment, along with the stream’s description. 

 

Figure 17.28  List of Streams Report 
 

2. Using the File menu, the report can be printed or exported to an ASCII tab delimited file. 
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CHAPTER 18   
 

Time Series Icons 
 

Time Series Icons, shown in the Map window of the Control and Visualization Interface 
(CAVI), indicate sites for which data and information are available.  The information can be 
time series data, images, web pages, webcams, scripts, spreadsheets, or other files.  Time series 
data for the icons can be linked to data from a HEC-DSS file.  Time series data can appear as 
thumbnail plots or color bars.  The icons provide easy access for analyzing data and providing 
location-specific information (e.g., frequently updated pictures of gages, reports on the location).  

In the Setup Module, the Time Series Icon Tool will be used to create and manipulate time 
series icons.  Section 2.3.2 provides a description of the Time Series Icon Tool. 

18.1 Create a Time Series Icon 
To create a time series icon: 

1. In the Setup Module, click the Time Series Icon Tool on the Map window Toolbar 
(Figure 18.1). 

 

Figure 18.1  Time Series Icon Tool in the Map 
window Toolbar of the Setup Module 
 

Time Series Icon Tool

Display Area 
Toolbar
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2. Find the location on the Map window where a time series icon (Figure 18.2) should be 
placed.  Hold down the CTRL key, and click the left mouse button.  An icon with a 
default name will appear on the Map window. 

 
Figure 18.2  New Time Series Icon with Default Name 
 

18.2 Edit Existing Time Series Icons 
Data sets can be moved, deleted, renamed, and added to Time Series Icons.  Time Series Icons 
can also be organized for display purposes.  All of these tasks are accomplished through the 
Time Series Shortcut Menu (Figure 18.3), accessed by right-clicking the Time Series Icon 
using the Time Series Icon Tool. 

 
Figure 18.3  Time Series 
Icon Shortcut Menu 
 

New Time 
Series Icon
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18.2.1 Move a Time Series Icon 
To move a Time Series Icon: 

1. Using the Time Series Icon Tool, right-click the Time Series Icon to be moved, and 
click Move on the shortcut menu. 

2. The time series icon now has four little black dots (handles) at each corner.  Click and 
drag the icon to its new position. 

18.2.2 Copy/Paste Data from Icon to Icon 
All of the information associated with a time series icon can be copied to another time series 
icon.  This is useful for setting up similar time series icons where only the location name is 
different. 

1. Using the Time Series Icon Tool, right-click the Time Series Icon to be copied from, 
and click Copy on the shortcut menu. 

2. Right-click the Time Series Icon to copy the information to, and click Paste on the 
shortcut menu. 

3. The Paste Icon dialog (Figure 18.4) will open.  In the To Column change the location 
name for the new Time Series Icon.  Click Yes.  The Time Series Icon will appear on 
the Map window with the new name. 

 

Figure 18.4  Paste Icon Dialog 
 

4. This copies the contents of the original icon into the new one, changing the location name 
at the same time.  The icon can be changed and changes can be made to any other 
properties in the Associated Data Sets Table of the Time Series Icon Editor dialog 
(Figure 18.5) of the Time Series Icon that was copied to.  
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Figure 18.5  Time Series Icon Editor Dialog 
 

18.2.3 Delete a Time Series Icon 
To delete a time series icon: 

1. Using the Time Series Icon Tool, right-click the time series icon to be deleted.  Click 
Delete from the shortcut menu. 

2. A warning message will appear asking if the user really wants to delete the time series 
icon.  Click Yes. 

18.3 Configuring Time Series Icon Properties 
After defining Time Series Icons, the properties of each Time Series Icon must be configured 
individually in the Time Series Icon Editor dialog (Figure 18.5).  Properties include the name 
of the icon, the location of the data, and the appearance of the time series icon in the different 
modules.  Here, the user also sets up images, web pages, webcams, documents, and scripting 
information associated the time series icon. 

18.3.1 Name a Time Series Icon 
To give a time series icon a name, description, and icon symbol: 

1. Using the Time Series Icon Tool, right-click the time series icon to be named.  Click 
Rename from the shortcut menu.  The Rename dialog opens. 

2. Enter the new name in the Name field, and click OK. 
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18.3.2 Associate Data with a Time Series Icon 
Within the CAVI, time series data can be accessed from an HEC-DSS file.  Either type in the 
Time Series Identifiers or pathnames associated with the data, or use the data browser available 
from the Time Series Icon Editor dialog (Figure 18.5). 

To associate data from an HEC-DSS file: 

1. Before associating data from an HEC-DSS file, a HEC-DSS file must be available.  A 
good choice is the HEC-DSS file from a forecast run (forecast.dss). 

2. On the Time Series Icon Editor dialog, click Browse on the Data Menu.  The DSS-Vue 
dialog opens.  On the File Menu, select Open… .  The Open HEC-DSS File dialog 
opens. 

3. Use the Open HEC-DSS File dialog to select and open the appropriate DSS file.  Once 
the file has been opened, the table in the DSS-Vue dialog displays the pathnames 
available. 

4. Find the pathname(s) to be added to the time series icon, and select it (them) using the 
Select button.  The pathname displays in the selection area below the table (Figure 18.6).  
Repeat this step until all of the pathnames that are needed have been selected.  

 

Figure 18.6  HEC-DSS-Vue Dialog with DSS File Pathname Selected 
 

5. Once finished selecting pathnames, click Set Selected Identifiers.  If the pathnames are 
from modeling output, a message box will appear asking "Do you want model F parts set 
to %'s (to correspond to the alternatives selected)?".  Click Yes.  This will replace the F 
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parts with percent sign wild characters that will be substituted with the forecast key when 
displaying modeling results.  A single percent sign represents one model output in 
sequence, so "%%" will correspond to HEC-HMS output, and "%%%" will correspond to 
output from HEC-ResSim.  Pathnames with an F part of OBS will not have their F parts 
replaced with percent signs. 

6. On the File Menu, click Close.  The selected pathnames will appear in the Associated 
Data Sets Table of the Time Series Icon Editor dialog.  Click OK. 

18.3.3 Remove Data from a Time Series Icon 
To remove data from a time series icon: 

1. On the Time Series Icon Editor dialog, select a row(s) on the Associated Data Sets 
Table that contains the data that should no longer be associated with the time series icon. 

2. From the Edit menu (Figure 18.7), click Delete Rows.  The selected rows will be deleted 
from the Associated Data Sets table, and the data will no longer be associated with the 
time series icon. 

 

Figure 18.7  Edit Menu 
 

18.3.4 Map Window Attributes for Data 
To organize the display of time series icons, before proceeding with the next steps, define Time 
Series Icon Layers.  The procedure to create layers is described in Chapter 19.  Time Series 
Icon Layers provide the ability to choose which time series icons appear in the Map window.  
Layers make refining the display data faster by allowing selection of the displayed layers by their 
data types.  For example, a gage may report stage, precipitation, and compute flow from stage.  If 
time series layers are created for each one, "Stage", "Flow", and "Precipitation", then the 
appropriate data sets for that location can be placed in the corresponding layer. 

The following steps describe how to assign data sets to a time series layer and associate the data 
sets to CAVI modules: 

1. From the Time Series Icon Editor dialog, click the Icon Types and Layers Tab (Figure 
18.8).  
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2. From the Data Set drop-down list, select the data set to be assigned to a time series icon 
sub-layer.   

3. From the Layers field, select or clear the appropriate sub-layers for the selected data set. 

4. Once the layers for the data set have been established, the display attributes of the time 
series icon for the individual CAVI modules need to be set. 

 

Figure 18.8  Time Series Icon Editor Dialog Icon Types 
and Layer tab. 
 

5. There are six icon types to choose from or the option of none.  Following is a description 
of each of the available types: 

 Graphic Symbol Graphic symbols provide an at-a-glance reference to the type of 
location represented and allow direct access to data associated 
with a location (such as model results).  Selecting this option 
displays the graphic symbol as it was defined for the time series 
icon in the Setup Module. 
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6. To assign a data set to a module and give it an icon type, from the Icon Type drop-down 
list for each individual module, select an icon type for the data set.  Choose the icon type 
None to have the data set not appear in a specific module.  The selected data set will 
appear in the Data Acquisition Module as a quality color bar, in the Data Visualization 
Module as a thumbnail plot, and will not appear in the Modeling Module. 

7. For example, Figure 18.8 indicates that the selected data set will appear in the Setup 
Module as a graphic symbol, in the Acquisition Module as a quality color bar, in the 
Visualization Module as a thumbnail plot, and will not appear in the Modeling Module. 

 Dot Dots allow you to mark gages and time series locations without 
cluttering the Map window.  Selecting this option displays a small 
red dot      along with the icon label in the map window. 

     Thumbnail Plot Thumbnail plots are miniature versions of the full-size plots, 
showing data for the duration of the time window.  As the time 
window updates, the CAVI refreshes the data and updates the plot.  
Thumbnail plots offer a quick overview of current data for the 
selected time window. 

 Quality Color 
Bar 

Quality color bars are linear histograms that offer a quick view of 
the quality of incoming data within the time window you have set.  
A database process (DATCHK) evaluates incoming data and 
assigns a flag to the data.  Color bars reflect this quality check by 
displaying bands of color that display quality information for data 
sets that are configured for the icon.  Color schemes can be 
configured for the quality colors in the Data Acquisition Module.  
Refer to Section 18.7 for additional information regarding quality 
color bar configuration. 

 Threshold Color 
Bar 

Threshold color bars are linear histograms that compare incoming 
data against threshold values set for a location.  For example, at a 
FLOW location, green might be assigned to flow values less than 
5,000, which represent normal flow conditions.  Yellow may 
represent values greater than 5,000, but less than 7,000 to indicate 
flows in a flood warning level, and red may represent values 
greater than 7,000 to indicate flows above flood stage.  Because 
threshold color bars are location dependent, you must set the 
values for each time series icon individually.  See Section 18.5 on 
how to configure the threshold color bars. 

 Cumulative 
Threshold Color Bar 

Cumulative threshold color bars are color bars that display 
accumulated values.  For example, displayed precipitation over 
time or the sum of inflow volumes to a lake are accumulated 
values. 

None By selecting None, it is possible to configure the icon not to 
display in a specific module.  This is useful when only using an 
icon in a specific module, as it keeps the Map window uncluttered 
with unnecessary icons. 
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8. Once finished with the setup of the time series icon, click OK, which closes the Time 
Series Icon Editor dialog (Figure 18.8).  To save the changes to the watershed, from the 
File menu, click Save Watershed. 

18.4 Configuring Thumbnail Plots 
A thumbnail plot (Figure 18.9) is a miniature version of the full-size plots, showing data for the 
duration of the time window.  The thumbnail plots the data.  The color of the curve that 
represents the data can be set. 

 

Figure 18.9 Thumbnail Plots - Visualization Module 
 

Assigning thumbnail plots to specific modules: 

1. The user must be in the Setup Tab in the Watershed Pane. 

2. From the Map window Toolbar, click the Time Series Icon Tool. 

3. Right-click a time series icon and select Edit from the shortcut menu and the Time 
Series Icon Editor dialog (Figure 18.5) opens.  

4. Click Icon Types and Layers Tab (Figure 18.8). 

5. From the Data Set drop-down list, select the data set that a thumbnail plot should be 
displayed for in modules.  

6. For each module that should have a thumbnail plot displayed in the Map window, from 
the Icon Type list for each module, select ThumbnailPlot.  For example, in (Figure 18.8) 
the Visualization Module for the selected data set will display a thumbnail plot. 

7. Click OK, the Icon Data Set Editor dialog closes, and the assignment will be saved.  
Each data set assigned as a thumbnail plot will be assigned a color each of its displayed 

Time Series 
Icon  

T l  
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curves.  However, these colors can be changed, which is described in the following 
section. 

To set the scale of a thumbnail plot:  

1. From the Time Series Icon Editor dialog, click the Icon Types and Layers Tab (Figure 
18.8). 

2. The Thumbnail Scale group box represents the minimum and maximum values 
displayed with in a plot.  To set these values, first check the checkbox next to Min or 
Max, and the fields next to the labels will become enabled.  Once the fields are enabled, 
enter the numeric values for the items you selected. 

3. Click OK, the Time Series Icon Editor dialog closes.  To save the changes to the 
watershed, from the File menu, click Save Watershed. 

A curve is created for each data set assigned as Thumbnail Plot.  In the example in Figure 18.5, 
three data sets are assigned as thumbnail plots, so three curves are listed.  However, depending 
on what parameter set to display in plot, all curves may not display at once.  The colors are 
assigned to the curves in the order they were associated with the Thumbnail Plot. 

 

To set the color of the curve on thumbnail plots: 

1. From the Time Series Icon Editor dialog (Figure 18.5), from the Data menu, click Icon 
Plot Colors.  The Plot Icon Color Editor opens (Figure 18.10). 

 

Figure 18.10  Plot Icon Color Editor 
2. Under the Curve column, a number is assigned to each data set that has been defined for 

the time series icon. 

3. To change the color of a curve, click in a cell under the Color column and a list of 
available colors appears. 
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4. Click the color to be changed, and the color will now appear in the cell of the Color 
column.  Click OK, and the Plot Icon Color Editor closes.  A change will not be seen in 
the Setup Module, but in any of the other modules where the time series icon appears as 
a thumbnail plot, the color change will appear. 

18.5 Configuring Threshold Color Bars 
Threshold color bars (Figure 18.11) are linear histograms that compare incoming data against 
threshold values set for a location.  Because threshold color bars are usually location dependent, 
you typically set the values for each time series icon individually.  The name of the location 
appears adjacent to the threshold color bar, and the length of the threshold color bar represents a 
time line equal to the duration of the time window.  Segments along the color bar reflect time 
intervals, with colors corresponding to the data quality legend you have defined.  The threshold 
color bars are updated dynamically at the time interval that you entered in the Set Time Window 
dialog. 

 

Figure 18.11  Threshold Color Bars 
 

Assigning threshold color bars to specific modules: 

1. The user must be in the Setup tab in the Watershed Pane. 

2.  On the Map window Toolbar, click the Time Series Icon Tool. 

3. Right-click a time series icon and select Edit from the shortcut menu.  The Time Series 
Icon Editor dialog (Figure 18.5) opens. 

4. Choose the Icon Types and Layers tab (Figure 18.11). 

5. From the Data Set drop-down list, select the data set that should display a threshold color 
bar in a module. 

6. For each module that should display a threshold color bar in the map window, from the 
Icon Type list for each module, select ThresholdColorBar. 

7. Click OK, the Time Series Icon Editor dialog closes, and the assignment will be saved.  
Each data set assigned as a threshold color bar will be assigned a color.  However, these 
colors can be set, which is described in the following section. 
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Icon  

T l  



Chapter 18 – Time Series Icons HEC-RTS User's Manual 
 

18-12 
 

To set the threshold values for a threshold color bar: 

1. From the Time Series Icon Editor dialog (Figure 18.8), click Threshold Colors. 

2. The Threshold Color Bar Editor for Time Series (Figure 18.12) opens.  For a regular 
threshold color bar, in the Color Bar Type box, select Regular Threshold. 

3. To edit threshold values, from the table click in the cells under the columns Lower Limit 
and Upper Limit.  Enter values as need, to add rows to the table, from the Edit menu 
click Insert Row. 

4. To associate a color with that threshold value, click in a cell under the Color column, a 
list of available colors appears.  Click the color you wish to change, and the color will 
now appear in the cell of the Color column.   

5. The Applies to group box sets the properties for all similar threshold color bars in the 
watershed.  This Data Set Only is selected by default and sets the properties to only be 
used by the current data.  Parameter (Figure 18.12) sets the property settings to all time 
series icons using the same selected parameter.  Group assigns a name to the properties, 
which can then be used and assigned to additional time series icon properties.  Global 
Default sets the properties for all time series icons. 

6. Click OK, and the Threshold Color Bar Editor for Time Series closes.  Changes will 
not be seen in the Setup Module, but they will be seen in any of the other modules where 
the time series icon appears as a threshold color bar. 
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Figure 18.12  Threshold Color Bar Editor for Time Series 
 

18.6 Configuring Cumulative Threshold Color Bars 
Cumulative threshold color bars (Figure 18.13) are commonly used to display cumulative 
precipitation over time.  The following information describes how to assign cumulative threshold 
color bars to specific modules: 

Assigning threshold color bars to specific modules: 

1. The user must be in the Setup tab in the Watershed Pane. 

2. On the Map window Toolbar, and click the Time Series Icon Tool. 

3. Right-click a time series icon, select Edit from the shortcut menu and the Time Series 
Icon Editor dialog (Figure 18.5) opens. 
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Figure 18.13 Cumulative Threshold Color Bars 
 

4. Click Icon Types and Layers Tab.    

5. From the Data Set drop-down list, select the data set that should display a cumulative 
threshold color bar in a module. 

6. For each module that should display a cumulative threshold color bar in the Map 
window, from the Icon Type drop-down list for each module, select 
CumulativeThreshold. 

7. Click OK, and the Time Series Icon Editor dialog closes.   

To set the cumulative threshold values for a threshold color bar: 

1. From the Icon Types and Layers tab (Figure 18.8), click Threshold Colors, and the 
Threshold Color Bar Editor for Time Series (Figure 18.12) opens. 

2. From the Color Bar Type group box, select Cumulative Threshold. 

3. To edit threshold values, from the table click in the cells under the columns Lower Limit 
and Upper Limit.  Enter values as needed.  To add rows to the table, from the Edit menu 
click Insert Row. 

4. To associate a color with that threshold value, click in a cell under the Color column, and 
a list of available colors appears.  Click the color to be changed, and the color will now 
appear in the cell of the Color column.   

5. The Applies to box sets the properties for all similar cumulative threshold color bars in 
the watershed.  This Data Set Only is selected by default and sets the properties to only 
be used by the current data.  Parameter sets the property settings to all time series icons 
using the same selected parameter.  Group assigns a name to the properties, which can 
then be used and assigned to additional time series icon properties.  Global Default sets 
the properties for all time series icons. 
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6. Click OK, and the Threshold Color Bar Editor for Time Series closes.  Changes will 
not be seen in the Setup Module, but they will be seen in the other modules where the 
time series icon appears as a cumulative threshold color bar. 

18.7 Configuring Quality Color Bars 
Quality color bars (Figure 18.14) allow the user to view the quality of incoming data.  Quality is 
defined as being one of the following: valid, questionable, rejected, missing, no report, or not 
checked.  Quality flags must be associated with the data sets.  The following information 
describes how to configure a Time Series Icon as a Quality Color Bar. 

 

Figure 18.14  Quality Color Bars 
 
Assigning quality color bars to specific modules: 

1. The user must be in the Setup tab in the Watershed Pane. 

2. On the Map window Toolbar, and click the Time Series Icon Tool. 

3. Right-click a time series icon, select Edit from the shortcut menu and the Time Series 
Icon Editor dialog (Figure 18.5) opens. 

4. Click Icon Types and Layers tab. 

5. From the Data Set drop-down list, select the data set that should display a quality color 
bar in a module. 

6. For each module that should display a quality color bar in the map window, from the 
Icon Type list for each module, select QualityColorBar. 

7. Click OK, and the Icon Data Set Editor dialog closes, and the assignment will be saved.  
Each data set assigned as a quality color bar will be assigned a color.  However, these 
colors can be changed, which is described in the following section. 

Time Series 
Icon  

T l  
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18.8 Configuring Photo/Web Images Icon, Documents 
and Scripts 

Photos, web pages, and webcam images (Figure 18.15) can be assigned to the time series icons.  
Documents, such as reports or spreadsheets, can also be assigned.  Once assigned, they can be 
accessed through the icon's shortcut menu in the selected modules and will appear as the icon’s 
image.  The following steps describe how to configure photo, images, and webcams or a script, 
web pages, and documents: 

 

Figure 18.15  Photo from a Time Series Icon 
 

To configure a photo, image, or webcam .jpg file: 

1. The user must be in the Setup Tab in the Watershed Pane. 

2. Click the Time Series Icon Tool from the Map window Toolbar. 

3. Right-click the time series icon you want to modify.  Click Edit from the shortcut menu 
and the Time Series Icon Editor dialog (Figure 18.5) opens. 

4. Click Photos/Images tab (Figure 18.6). 
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Figure 18.16. Photo/Image Settings Dialog 
 

5. From the Edit menu, click Browse and an Enter Image file browser opens.  Select an 
image file, click Open, and the selected file will be added to table.  Alternatively, image 
files can be stored and retrieved from DSS.  If this is the case for your image, click 
Browse DSS from the menu and select the image from the DSSVue pathname selector. 

6. Select the image file through the browser.   

7. The image files name will appear in the Display Name column and the full path to the 
file will appear in the URL or File Name column. 

8. Alternatively an image file may be available through a website, as in the case of a 
webcam.  If so, type in the URL of the website in the URL or File Name column. 

9. To modify the Display Name an image, click the cell under the Display Name column 
that corresponding to the image file to be modified and enter the new name.  The Display 
Name will be the text of the menu option in the time series icon’s shortcut menu, which 
will trigger the image to display.   

10. Select Separate Frame if you would like the image to display in a new window when it 
is triggered. 

11. Specify the Width (or Ratio) and Height (or Ratio) of the displayed image.  By default 
the image will display as the image file size. 

12. The Refresh Interval is specific to webcam images.  The webcam image is refreshed 
with a new webcam image at a rate of seconds.  The rate starts at 0 seconds.  For 
example, if the Refresh Rate is set to 10, the image will be retrieved every 10 seconds.  
To only have the image loaded once, set the rate to -1. 

13. Fade is an on/off switch specific to webcam images.  It transitions each image into the 
next one by showing 10% or more of the next .jpg every 0.05 seconds, until the full 
picture is shown.  This gives a smooth motion like flow to the image. 

14. When all the information is configured, click View to preview the image. 
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15. To add another image to the table, first select Add Row or Insert Row from the Edit 
menu.  Then follow the same steps as outlined above. 

16. To remove an image from the table, select the image in the table and choose Delete Row 
from the Edit menu. 

17. To change the order of image in the table, first select the image in the table then select 
Move Row Up or Move Row Down from the Edit menu. 

To configure a script, web page, or other supported file: 

1. The user must be in the Setup tab in the Watershed Pane. 

2. Click the Time Series Icon Tool from the Map window Toolbar. 

3. Right-click the time series icon to be modified.  Click Edit from the shortcut menu and 
the Time Series Icon Editor dialog (Figure 18.5) opens. 

4. Click Scripts/HTML tab (Figure 18.17). 

 

Figure 18.17. Assign Scripts to Time Series Icons 
 

5. Select Script Editor/Selector from the Edit menu.  The Script Editor will appear.  In the 
Script Editor, highlight the script to be assigned to the time series icon and click OK.  
The Script Editor closes.  The selected script’s name will fill the Display Name column 
and its path on disk will fill the Script File or Other column. 

6. To add a file to the table, select Browse Other from the Edit menu.  A file browser will 
appear.  In the Open file browser select the file you would like to assign to the time 
series icon, and click Open.  The file browser will close and the selected file’s name will 
fill the Display Name column and its path on disk will fill the Script File or Other 
column. 

7. To assign a web page, type in the URL of the website in the Script File or Other 
column. 
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8. To modify the Display Name an image, click the cell under the Display Name column 
that corresponding to the image file you want to modify and enter the new name.  The 
Display Name will be the text of the menu option in the time series icon’s shortcut menu, 
which will trigger the image to display.   

9. Place a check in the module columns (Acquisition, Visualization, or Modeling) the 
script file or other should be available in. 

10. When all the information is configured, click Run to preview the file or script. 

11. To remove a script or other from the table, select script or other in the table, and choose 
Delete Row from the Edit menu. 

12. To change the order of image in the table, select the script or other in the table then select 
Move Row Up or Move Row Down from the Edit menu. 
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CHAPTER 19   
 

Time Series Icons Layers 
 

19.1 Overview 
This chapter describes the creation, configuration, and management of time series icons layers.  
When a new watershed is created, a default layer called Time Series Icons (Figure 19.1) is 
created.  This layer includes all of the time series icons that are defined for the watershed. 

 

Figure 19.1  Time Series Icons Layer in 
the Map Layers Dialog 
 

Additional time series icons layers can be created to separate time series icons by data type.  For 
example, a gage may report stage and precipitation (and compute flow from stage).  Layers can 
be for each of these data types can be created and named, for example, Stage, Flow, and Precip.  
Creating additional layers allows the user to focus on the specific data type they wish to see. 

19.2 Creating Time Series Icons Layers 
To create additional time series icon layers: 
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1. In the Setup module, click the Maps menu.  Select Map Layers.  The Map Layers 
dialog will open (Figure 19.2).  From the Map Layers tree, right-click Time Series 
Icons.  From the shortcut menu, click Add Icon Layer, and the New Time Series Icon 
Layer dialog opens (Figure 19.3). 

 

Figure 19.2  Map Layers Dialog with 
Time Series Icons Layer shortcut 
menu open 
 

 

Figure 19.3  New Time Series Icon Layer Dialog 
 

2. In the Name field, type a name for the sub-layer.  For example Flow, Stage, or Precip. 

3. In the Description field, type an optional description for the sub-layer. 
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4. To add all of the time series icons that you defined for the watershed to the layer, check 
Add all Time Series Icons’ Data Sets to this Layer. To add individual time series icons 
to the sub-layer, clear Add all Time Series Icons’ Data Sets to this Layer. For more 
detail on how to add individual time series icons to sub-layers, see Chapter 18. 

5. Click OK, and the New Time Series Icon Layer dialog will close. 

Another way to access the New Time Series Icon Layer dialog is from the Icons Types and 
Layers tab of the Time Series Icon Editor dialog shown in Figure 19.4.  To access it, use either 
the Select Tool or the Time Series Icons Tool to right-click on a time series icon in the Map 
window of the Setup Module.  Then, select Edit, and click the Icons Types and Layers tab.  
Click the Add button at the lower left, which will open the New Time Series Icon Layer dialog 
(Figure 19.3). 

 

Figure 19.4  Time Series Icon Editor Dialog – Icon Types and Layers 
 

The new time series layer will appear in the Map Layers tree (Figure 19.5) and in the Layers 
list on the Icons Types and Layers tab (Figure 19.4).  Repeat this process for all layers that 
require separate control.  When finished creating Time Series Icons Layers, specify datasets for 
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individual time series icons layers (for more details on how to configure time series icons see 
Chapter 18). 

 

Figure 19.5  Map Layers Dialog Showing 
the New “Flow” Time Series Icons Layer 
 

19.2.1 Removing Time Series Layers 
To remove layers: 

1. From the Layers list on Icons Types and Layers tab (Figure 19.4), select the layer to be 
removed, and click the Remove button at the lower left. 

2. A warning message dialog will open.  Click Yes, and the layer will disappear from the 
Layers list on the Icons Types and Layers tab. 

19.3 Time Series Icon Layer Properties 
The user can configure the appearance of a layer’s time series icons and their labels (Global 
Properties), set the visualization scale (Scale), and associate a template (Template) with the 
Time Series Icon Layer Properties dialog.  To access the Time Series Icon Layer Properties 
shortcut menu, either the Map Layers dialog (Figure 19.1) or the Icon Types and Layers tab 
must be open (Figure 19.4).  



HEC-RTS User's Manual Chapter 19 – Time Series Icons Layer 
 

19-5 
 

To configure Time Series Icons Layer properties: 

1. From the Map Layers tree, right-click Time Series Icons.  From the shortcut menu, 
click Properties. Alternatively, right-click on a layer in the Layers list of the Icon Types 
and Layers tab and select Properties.  The Time Series Icon Layer Properties dialog 
will open (Figure 19.6). 

2. The Layer drop-down list contains the name Time Series Icons (if no sub-layers have 
been defined) or the name of each defined time series icon layer.  A layer can be defined 
to include all time series icons.  Here, for example, the layer All includes all time series 
icon layers. 

 

Figure 19.6  Time Series Icon Layer Properties Dialog—Global 
Properties Tab 
 

19.3.1 Global Properties 
The Global Properties Tab in the Time Series Icon Layer Properties dialog (Figure 19.6) 
allows changes to the appearance of all time series icons and their labels for the time series icons 
layer (specified in the Layer drop-down box) shown in the map windows of the Visualization 
and Acquisition modules. (The icons shown on the Modeling and Setup module map windows 
are not affected by changes to the Global Properties.) There are several ways to control the 
appearance of all time series icon labels from the Global Properties Tab:   
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1. By default, the time series icons appear in the Visualization and Acquisition modules’ 
Map Windows using the Medium Icon format.  From the Icons field, the CAVI allows 
you five options for displaying time series icons – Small Graphic, Small Icon, Medium 
Icon, Large Icon, and Custom. 

2. By default, the labels for time series icons appear in the Visualization and Acquisition 
modules’ Map Window.  If it is undesired for the labels for a specific layer to appear in 
the Map Windows, clear Draw Names, click Apply, and the layer’s time series icon 
labels no longer appear in the Map Window. 

3. To change the color of a time series icon layer’s labels, click Foreground Color.  A 
Color Chooser opens (Figure 19.7), where the color the labels should display in can be 
selected. Click OK, and the Color Chooser closes.  From the Time Series Icon Layer 
Properties dialog (Figure 19.6), click Apply.  The time series icon labels will now 
appear in the chosen color.  For more information on the Color Chooser, see Appendix 
E. 

 

Figure 19.7  Color Chooser 
 

4. By default, all time series icon labels do not have a background color in the map window.  
If you want a time series icon layer’s labels to have a background color, click Draw 
Background, and click Apply.  The specified layer’s time series icon labels will now 
have the default background color (light gray). The background color can be changed by 
clicking Background Color.  A Color Chooser opens.  Select the color you want the 
background of the labels to display in, and click OK. The Color Chooser closes. From 
the Time Series Icon Layer Properties dialog, click Apply. The background color of 
the layer’s time series icon labels will now appear in the chosen color. 
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5. When a module’s Map Window shows the whole watershed, some time series icon 
labels will not appear when they overlap other elements. To display a time series icon 
layer’s labels, click Draw Overlapping Names, and click Apply.  Now all of the layer’s 
time series icon labels will appear in the Map Window when viewing the whole 
watershed. 

6. To change the font of a time series icon layer’s labels, click Name Font. A Font 
Chooser opens (Figure 19.8), where you can select the font type from the Font list, and 
you can select a size using the Size slider.  Click OK, and the Font Chooser closes.  
From the Time Series Icon Layer Properties dialog (Figure 19.6), click Apply. Now all 
of the time series icon layer’s labels will appear in the selected font and size. 

 

Figure 19.8  Font Chooser 
 

19.3.2 Scale 
The Scale Tab (Figure 19.9) of the Time Series Icon Layer Properties dialog allows the user 
to specify the map scale, or zoom level, at which a time series icon sub-layer becomes visible.  If 
the Always show layer radio button is selected, the specified time series icon layer (shown in the 
Layer drop-down) will always be displayed in the Map Window, regardless of zoom level.  
However, the Only show layer in the following scale range options can be used to display a 
time series icon layer only when the Map Window scale is zoomed to the specified scale.  The 
user can specify scales at which the time series icon layer is displayed below, above, or both.  
The scale can either bedirectly into the field, or use the Set to Current button to set the scale 
equal the current display. 
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Figure 19.9  Time Series Icon Layer Properties Dialog — Scale Tab 
 

19.3.3 Template 
Templates are created to save customized plot settings that can be used by other plots and the 
Time Series Icons Layer.  From the Template Tab (Figure 19.10) of the Time Series Icon 
Layer Properties dialog, a template can be associated with the Time Series Icons Layer by 
selecting a template from the Template drop-down list. 
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Figure 19.10  Time Series Icon Layer Properties Dialog — 
Template Tab 
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CHAPTER 20   
 

Model Alternatives and Forecast Runs 
 

A Model Alternative is a single model configuration with a specific set of input and parameters.  
A second model alternative would be defined by a different configuration or different input or 
parameters.  A Forecast Run is a single forecast scenario defined by a specific set of data, 
information, and model alternatives.  A second forecast run would be defined by different data, 
information, or model alternatives.  Model alternatives run sequentially during a forecast.  

Model alternatives and forecast runs are described in this chapter.  The model alternatives and 
forecast runs are manipulated primarily in the Setup Module.  Chapter 15 provides a detailed 
description of the Setup Module and its interface. 

20.1 Model Alternatives 
Model Alternatives consist of input data sets and configurations for each model.  Model 
Alternatives configurations do not include time-specific data.  Therefore, the Model 
Alternatives can be used in conjunction with any time window.  

In general, models and their alternatives are created using the software of the native model, for 
example, HEC-HMS, HEC-ResSim, HEC-RAS, HEC-FIA, and so on.  Once models and their 
alternatives are created and configured initially, they are imported into the watershed using the 
import commands in the File menu of the Setup Module.  The model alternative import process 
is detailed in in Section 20.2.  Once imported, the CAVI can then be used to configure and edit 
specific model alternatives.  

HEC-RTS uses plug-ins that allow the CAVI to interface with the software programs of the 
native model.  This means that all aspects of model alternatives are configurable using the CAVI 
native model interface.  For example, HEC-HMS base model parameters can be edited directly.  

MFP deals with observed meteorological data and future precipitation.  Model Alternatives can 
be configured for use in conjunction with HEC-HMS to compute a variety of future precipitation 
scenarios.  HEC-MetVue deals with observed meteorological data and future precipitation.  
Model Alternatives can be configured for use in conjunction with HEC-HMS to compute a 
variety of observed precipitation scenarios.  HEC-HMS model alternatives simulate watershed 
response to precipitation.  HEC-HMS Model Alternatives are used to forecast future flows.  
HEC-ResSim Model Alternatives assist with reservoir operations, consisting of the physical 
data representing a river-reservoir system and operating rules for all controllable elements in the 
system.  HEC-RAS Model Alternatives describe water surface profile and stages at gage 
locations, geometry information for a river, and defined flow data sets.  HEC-FIA Model 
Alternatives allow for analysis of flood consequences.  Its model forecast alternatives are a 
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combination of impact area and hydrograph time series sets.  The parameters within each Model 
Alternative can be edited to reflect changing conditions.  

20.2 Importing Watersheds and Model Alternatives 
There are two ways to import models and their alternatives into a watershed: (1) the import 
CWMS 2.x Watershed command found in the Watershed menu, or (2) choose commands from 
the Import menu option (Figure 20.1) found in the Models menu. 

 

Figure 20.1  Import Menu 

To use the import CWMS 2.x Watershed command, a watershed must be configured in Version 
2.0 or 2.1.  The individual model import commands do not require a configured watershed. 

20.2.1 Importing an Entire Watershed 
There are two ways to import an entire watershed. The first way uses the Create New 
Watershed dialog by completing the following steps:  

1. Create a New Watershed as detailed in Section 15.2. 

2. On the Create New Watershed dialog, navigate to the Import CWMS 2.1 Watershed 
option.  

3. Click the Browse button to the right of the Import CWMS 2.1 Watershed option to 
open the Select Workspace File browser dialog. 

4. In the file browser dialog, navigate to and select the CWMS 2.1 workspace file (files with 
.wksp extensions) you want to import.  

5. Click Open, and the Select Workspace File dialog closes. 

6. In the Create New Watershed dialog click Ok, and CWMS imports the selected CWMS 
2.1 Watershed in to the current watershed.  The results of the import are shown in the 
Import CWMS 2.1 Watershed dialog shown in Figure 20.2. 

7. Click Close, and the Import CWMS 2.x Watershed dialog closes. 
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Figure 20.2  Import CWMS 2.1 Watershed Dialog 

20.2.2 Importing Individual Models and Model Alternatives 
Individual models and their associated model alternatives can be imported into a watershed.  A 
model can be imported regardless of whether the model is part of the watershed or exists as a 
stand-alone model.  

To create a new watershed from scratch, complete the following steps: 

1. Create a New Watershed as detailed in Section 15.2. 

2. Import an MFP alternative as detailed in Section 20.4.1. 

3. Import a HEC-MetVue alternative as detailed in Section 20.5 

4. Import an HEC-HMS alternative as detailed in Section 20.6.1. 

5. Import a HEC-ResSim watershed as detailed in Section 20.7.1. 

6. Import a HEC-RAS alternative as detailed in Section 20.8.1. 

7. Import an HEC-FIA alternative as detailed in Section 20.9.1. 

8. Create and configure other models alternatives as desired.  Model alternative creation and 
configuration are detailed below. 
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9. Save the watershed. 

20.3 Interacting with Model Alternatives 

20.3.1 Setup Module 
Model alternatives are manipulated primarily in the Setup Module.  The individual model 
editors can be accessed by right-clicking on a specific model alternative in the Watershed Pane 
and using the shortcut menu (Figure 20.3) that appears.  

The short menu contains options associated with that model and alternative.  Click on an option, 
the associated model editor will open with the data for the model alternative associated with the 
selected model. 

 

Figure 20.3  Individual Model Editors 

20.3.2 Modeling Module 
A specific forecast run’s model alternatives can be interacted with in the Modeling Module.  
With a forecast alternative active, from the Models panel of the Modeling Module, the 
individual model editors can be accessed (Figure 20.4).  From the control panel in the Modeling 
Module, right-click on the active model and a shortcut menu will appear.  

The short menu contains options associated with that model and alternative.  Click on an option, 
the associated model editor will open with the data for the model alternative associated with the 
selected model. 
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Figure 20.4  Individual model editors 

20.3.3 Schematic Elements 
From the map window, certain model editors can be accessed from schematic elements on the 
display area.  For example, if the active forecast run has a HEC-ResSim model, on the display 
area there will be HEC-ResSim model elements, such as junctions.  Right click on a junction, a 
shortcut menu (Figure 20.5) will appear, under junction, click on Edit Properties and the model 
alternative and the Junction editor will open. 

 

Figure 20.5  Schematic Shortcut 

20.4 MFP Model Alternative 
An MFP alternative consists of an HEC-HMS meteorologic model, a zone configuration (based 
on an HEC-HMS basin model) and a set of precipitation forecast data.  The HEC-HMS project 
can contain more than one meteorological model with gridded precipitation from different 
sources, such as NEXRAD radar, interpolation from gage reports, or results from a grid-based 
snow model.  A separate MFP alternative will need to be created for each source of lookback 
precipitation grids that are intended to be used in the forecast models. 

20.4.1 Import an MFP Alternative 
To import an MFP alternative: 

1. In the Setup Module in the Model menu, select Import > MFP, and the Choose MFP 
Version dialog (Figure 20.6) opens. 
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Figure 20.6  Chose MFP Version Dialog 

2. Choose the MFP version to import from in the drop-down box.  Available import version 
choices for MFP alternatives are Versions 2.1 and 3.x. 

3. Click OK, and the file browser dialog opens. 

4. For MFP Version 2.1, navigate to and select the MFP project file (.conf extension) to be 
imported, and click the Open.  

5. For MFP Version 3.x, navigate to and select the folder containing the MFP project files 
to be imported, and click Open.  

6. The MFP model alternative is imported into the watershed. 

7. Save the watershed. 

20.4.2 Create an MFP Alternative 
To create an MFP alternative: 

1. In the Setup tab in the Watershed Pane, from the Model folder right-click MFP, and 
select New. 

2. The Create a New MFP Alternative dialog (Figure 20.7) opens. 

3. Enter a name in the Name field and enter a description in the Description field (Figure 
20.7). 

4. Select a basin model from the Basin Model drop-down list.  The choice of basin model 
will determine which precipitation zone configurations will be available for the MFP 
alternative.  Make sure to select a basin model that covers the same area covered by any 
basin models used in MFP alternatives that will combine with this MFP alternative. 

5. Select a meteorologic model from the Meteorologic Model drop-down list.  The 
meteorologic model determines the grids used in the lookback portion of the forecast.  

6. Select a precipitation zone configuration from the Precipitation Zone Configuration 
drop-down list.  See Section 7.2.1 on how to create a new precipitation zone 
configuration. 
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7. Click OK, and the Create New MFP Alternative dialog closes.  To open the MFP 
Alternative editor, right-click on the newly created MFP alternative and select Edit 
Alternative, and the MFP Alternative editor opens (Figure 20.8). 

 

Figure 20.7  Create New MFP Alternative Dialog 

By default, the MFP Alternative Editor dialog is set for manual entry of forecast precipitation 
data by precipitation zone.  If QPF data is available, (extracted from the database into the 
forecast.dss file for the forecast) the data can be entered by choosing one of the QPF options.  
See Section 20.4.4 for an example of using QPF data. 

To add precipitation data for the selected precipitation zone configuration: 

1. From the MFP Alternative editor (Figure 20.8), select the precipitation zone 
configuration to configure precipitation data for from the Zone Configuration drop-
down list. 

2. Setup the time window.  By default Relative Start Time is selected. 

3. Select the duration for future precipitation from the Duration of Future Precipitation 
drop-down list.  This choice sets the number of rows in the table where values will be 
entered for each precipitation zone of the selected precipitation zone configuration. 

4. Enter precipitation data in the table.  Values are entered by time step, with each cell 
representing one time step for the zone.  A running total of the forecast precipitation is 
kept at the bottom of the table.  A set of forecast values may be prepared with a 
spreadsheet program and then copied from the spreadsheet to the MFP Alternative 
editor.  Once precipitation data has been entered, click OK, the MFP Alternative editor 
(Figure 20.8) closes. 

5. From the File menu, click Save Watershed.  
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Figure 20.8  MFP Alternative Editor Dialog 

20.4.3 MFP Precipitation Zone Configurations 
A Precipitation Zone Configuration is required to create a MFP alternative.  A Zone 
Configuration is a set of zones, and a Zone is a set of subbasins in the watershed.  In MFP, 
precipitation forecasts are assigned by zone, with all subbasins in the zone receiving the same 
precipitation increments.  Subbasins should be grouped into zones based on similarity of 
expected precipitation. 

20.4.3.1 Create a Zone Configuration 
To create a precipitation zone configuration: 

1. In the MFP Alternative editor (Figure 20.8), choose Zone Configuration from the Edit 
menu.  The Zone Configuration Manager dialog (Figure 20.9) opens.  

2. Select New to create a new zone configuration.  The Create a New Zone Configuration 
dialog window opens. 

3. From the Create a New Zone Configuration window, enter a name into the Name field 
and a description into the Description field. 

4. From Element Type drop-down list, select either Subbasins or Reaches.  Click Create, 
and the Create A New Zone Configuration dialog closes. 
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Figure 20.9  Zone Configuration Manager 

20.4.3.2 Create Zones 
 

For each zone configuration, you will need to create at least one zone.  To create a zone: 

1. From the Zone Configuration Manager, select the newly created zone configuration.  

2. Click the Zones button from the manager window.  The Zones dialog (Figure 20.10) 
opens. 

  

Figure 20.10  Zones Dialog 

3. Select New and a Create A New Zone dialog opens.  Enter a name into the Name field 
and description into the Description field.  

4. Select Create, and the name of zone just created appears in the Current zones for 
selected zone configuration list on the Zones dialog. 
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20.4.3.3 Add Subbasins to a Zone 
Once precipitation zones have been created, elements can be assigned (subbasins or reaches) to 
the zones.  

1. From the Zone Configuration Manager (Figure 20.9) select the zone configuration to 
be configured. 

2. Click the Elements button and the Elements dialog (Figure 20.11) opens.  From the 
Zones drop-down list, select which Zone to add elements to.  

 

Figure 20.11  Elements Dialog 

3. Select the elements (subbasins or reaches) to add to the zone from the elements 
(subbasins or reaches) listed in the Unassigned Elements list (Figure 20.11).  Select one 
element by clicking; select ranges of subbasins by shift-clicking; select discontinuous 
groups of subbasins by control-clicking.  

4. Click Add and the selected subbasin names will now appear in the list under the Zone 
list.  An element can also be moved into a zone by double-clicking on the element in the 
Unassigned Elements list. 

5. Elements can be moved out of a zone by selecting an element in the box under the Zone 
list and then click Remove or by double-clicking on that element. 

6. When all elements have been assigned to zones, close the Zone Configuration 
Manager. 

20.4.4 Define a QPF Disaggregation Set 
In place of manually entered precipitation forecasts, MFP permits incorporation of a sequence of 
QPF (quantitative precipitation forecast) values into an MFP alternative from an external source.  

Two types of QPF data are available from the National Weather Service or from other sources: 
point QPFs, which consist of a time series of forecasted precipitation depths at a single location, 
or gridded QPFs, which represent a spatially distributed forecast of precipitation depths.  MFP 
can assign point QPF time series to precipitation forecast zones, or assign a sequence of QPF 
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grids to cover the entire watershed.  In either case, QPFs are typically given in six-hour 
increments covering the next twenty-four hours, and a single twenty-four hour total following the 
four six-hour increments.  It is necessary to disaggregate these totals into increments that match 
your modeling time step. 

To use QPFs in your forecast model, select either Time Series or Gridded by clicking the 
corresponding radio button on the MFP Alternative editor (Figure 20.8).  Each option (Manual, 
Time Series, or Grid) presents a different form of the forecast precipitation table.  

If Time Series is selected, the table appears as shown in Figure 20.12, and once QPF data and a 
set of disaggregating weights have been defined, the table will be filled with precipitation 
increments for the zone.  

 
Figure 20.12  Time Series Table - MFP Alternative Editor 

To assign a HEC-DSS pathname for time series, click the Pathname button.  If Gridded is 
selected, the table appears as shown in Figure 20.13 and once QPF data has been defined, the 
table will be filled with the disaggregating weights (not the precipitation values themselves).  To 
assign a HEC-DSS pathname for time series, click Pathname. 

 
Figure 20.13  Grid QPF Table - MFP Alternative Editor 

For either type of QPF data, to define QPF data: 

1. The user must be in the MFP Alternative editor (Figure 20.8).  Select Edit > 
Disaggregation Set > New. 

2. The Create a New Disaggregation Set dialog opens (Figure 20.14).  In the Name field, 
enter a name for the QPF distribution set.  Optionally enter a description in the 
Description field. 
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Figure 20.14  Create a New Disaggregation Set Dialog 

3. Click New, and the Disaggregation Editor dialog (Figure 20.15) opens. 

4. In the Disaggregation Editor you can specify the Output Time Interval and the Input 
Time Interval.  The Disaggregation Editor allows the user to specify weights for two 
adjacent blocks of one, six, or twenty-four hours each (based off the Input Time Interval).  
The weights will be normalized for each block, so the two six hour blocks shown in the 
example will put half of the six-hour QPF in the third and fourth hours of the six-hour 
blocks.  QPF are referenced to UTC so the blocks will shift according to the watershed’s 
time zone. 

5. Once the disaggregation set is defined, a QPF time series record can be associated with a 
zone defined in the precipitation zone configurations associated with the MFP alternative.  
Click OK, the Disaggregation Editor closes. 

6. To associate a QPF time series record with a zone, from the MFP Alternative Editor 
dialog (Figure 20.8), click Time Series, select a row in the table, and click Pathname. 

7. The Set Locations for HEC-DSS Connections dialog (Figure 20.16) opens.  To open a 
HEC-DSS file, click the open folder icon .  
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Figure 20.15  Disaggregation Editor Dialog 

8. Using the file browser, locate and open the HEC-DSS file.  The lower table will fill be 
filled with the HEC-DSS catalog information.  The top table has the list of precipitation 
zones for the selected MFP zone configuration.  Select a precipitation zone in the top 
table by clicking on a row.  Select a QPF HEC-DSS pathname by clicking on a row in the 
bottom table.  Once a row from each table is highlighted, the HEC-DSS pathname will be 
assigned to the precipitation zone by clicking Select HEC-DSS Pathname. 

9. After clicking OK, the MFP Alternative editor (Figure 20.8) will read the HEC-DSS file 
and try to find the QPF data. 
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Figure 20.16  Set Locations for HEC-DSS Connections Dialog 

20.4.5 Edit an MFP Alternative 
To edit an MFP alternative: 

1. In the Watershed Pane, select the MFP alternative to be edited. 

2. Right-click the selected alternative and the MFP Alternative Menu (Figure 20.17) is 
displayed. 

3. Select Edit Alternative, and the MFP Alternative editor (Figure 20.8) opens. 

4. Use the MFP Alternative editor to make changes to the MPF alternative. 

5. Click the OK, and the MFP Alternative editor closes. 

 
Figure 20.17  MFP Alternative Shortcut Menu 
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20.4.6 Copy an MFP Alternative 
To copy an MFP alternate: 

1. In the Watershed Pane select the MFP alternative to be edited. 

2. From the MFP Alternative Menu (Figure 20.17), select Save As, and the Save MFP As 
dialog (Figure 20.18). 

3. Enter the new name in the Name field and fill out the Description field. (It is possible to 
specify the directory where the watershed will be saved in order to to save a copy of the 
alternative to a directory outside of the watershed.) 

4. Click OK, and the Save MFP As dialog closes. 

 

Figure 20.18  Save MFP As Dialog 

20.4.7 Delete an MFP Alternative 
To delete an MFP alternative: 

1. In the watershed pane, select the MFP alternative to be deleted. 

2. From the MFP Alternative Menu (Figure 20.17), select Delete, and the Confirm Delete of 
the MFP alternative dialog appears (Figure 20.19). 

3. Click Yes to delete the MFP alternative. 

 

Figure 20.19  Confirm Delete MFP Alternative Dialog 

20.5 HEC-MetVue Model Alternative 
HEC-MetVue can act as a data provider for the CAVI client as an alternative to using MFP.  
HEC-MetVue can process three different types of data for the CAVI. 
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• Radar data from HEC-DSS files in either SHG or HRAP format.  

• Gage data stored as TIN surfaces in files.  

• Gage data translated to TIN surfaces (GageInterp method).  Within HEC-MetVue, when 
using the GageInterp method, this is a two-step process.  One step generates the gage TINS 
(grids) from HEC-DSS hyetograph data and stores the data back into a HEC-DSS file.  
That data is then utilized within the application like any other TIN surface data.  When 
using the GageInterp method from the CAVI, once the process of creating the surface TINS 
is completed, a secondary task of associating the correct TIN surfaces for the correct time 
window and displaying them in the correct forecast alternative window is done 
automatically.  These two steps appear as one to the forecaster. 

Within HEC-MetVue there are sessions.  Sessions are a convenient way to group a set of map 
panels in a logical way.  This grouping is unconstrained.  A user can choose to group map panels 
for a specific geographic area, a specific storm or possibly even a different set of display 
attributes for different purposes.  It is really analogous to having files in a folder on a computer.  
How those folders and files are organized is up to the individual.  

When operating as a client for the CAVI there are constraints.  Any single forecast can refer only 
to a single session within HEC-MetVue.  Within this session there can be any number of map 
panels.  Each map panel can support a CAVI forecast alternative.  There is a 1:1 relation between 
a map panel and a forecast alternative.  If a forecast alternative is created in the CAVI and there 
is no associated map panel to support it, HEC-MetVue will create a map panel. 

20.5.1 Create a HEC-MetVue Alternative 
To create and edit a HEC-MetVue alternative in the Setup Module, right-click on the HEC-
MetVue item under the Models folder in the Watershed Pane and select Import.  This opens 
the HEC-MetVue dialog shown in Figure 20.20 This dialog contains a Session dropdown, three 
option checkboxes, and the Map Panel selection table.  Remember that each Map Panel 
supports a single HEC-MetVue Alternative for the purposes of configuring a forecast.  Each of 
these elements is detailed below. 

The Session dropdown by default it is filled with all the sessions that are defined within HEC-
MetVue, including hidden sessions.  Remember, each project must associate all its forecast 
alternatives with a single session. (Therefore, more than one session may be defined if there are 
multiple watersheds.) If not choosing to use one of the pre-existing sessions, double-click the 
Session dropdown to make the name editable, and specify a new HEC-MetVue session name.  
Then, move to a different control within the dialog.  The HEC-MetVue client will automatically 
create the session as necessary within HEC-MetVue. 
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Figure 20.20  HEC-MetVue Import Dialog 

The three option check boxes are: 

• Close other sessions.  Select to force other HEC-MetVue sessions (other than the one 
selected) to close when a project is opened.  Multiple sessions with multiple map panels 
open use memory, and this is just an easy way to help minimize memory usage and 
increase performance.  

• Hide closed sessions.  Select to prevent closed sessions from appearing in the HEC-
MetVue explorer tree view, thus reducing “clutter” of unused sessions when using the 
CAVI.  

• Close session map panels that are not alternatives.  Select to close unused session map 
panels and reduce memory usage.  

The Map Panel selection table is located in the lower half of the dialog.  In the first column, 
Map Panel, all the map panels that are defined for a session are displayed in this table.  The 
second column, Use for alternative, contains checkboxes that enable the map panel.  Once 
checked, the Edit… button in the third column, Alternative options, becomes selectable.  

The values in the Map Panel selection table change as the session selection changes.  Similar to 
the editable session dropdown selector, the map panels in the table can be edited to add new map 
panels to associate with alternatives.  The HEC-MetVue client will automatically create the map 
panels for a session as necessary within HEC-MetVue.  There is always a blank line at the end of 
the table where additional map panels/alternatives can be configured.  To create a new Map 
Panel, double-click the blank Map Panel cell, and specify a new Map Panel name.  

20.5.2 Edit a HEC-MetVue Alternative 
To edit a Map Panel (HEC-MetVue Alternative), click the Edit… button in the Alternative 
options column, which will bring up the Map Panel editor dialog.  The Map Panel editor input 
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and output tabs are shown in Figure 20.21 and Figure 20.22.  Configure the HEC-MetVue input 
and output as detailed in the following subsections, specifying as many Map Panels as needed 
for the HEC-MetVue Alternatives.  Then click the OK button to save the changes and close the 
dialog. 

20.5.2.1 HEC-MetVue Alternative Input 
The Map Panel editor Input tab (Figure 20.21), contains three main areas that require input:  

• Maps are the lines, shapes, and points that HEC-MetVue uses as feedback for a 
geographic location.  Maps are not used for any computations.  

• Sub-Areas are the defined polygons that HEC-MetVue uses for sub-area computations. 

• TIN/Grid Input defines the input for acquiring the data. 

Under Maps, choose which option to use for specifying the desired information.  The three 
options are:  

• Use List.  Use this option to explicitly specify the map files (.shp) to use.  When selected, 
the Copy to forecast directory option and the Browse button are enabled.  All the files 
selected appear in the list box.  If the Copy to forecast directory checkbox is selected, all 
the files are copied into the project directory structure when forecasting to aid in 
archiving.  

• Sync with CAVI.  Use this option to keep the maps displayed in HEC-MetVue in sync 
with the maps in the CAVI.  HEC-MetVue has its own display attributes for the maps.  It 
does not inherit colors, line styles, and so on from the CAVI map window.  When this 
option is selected, the sub-options for the Use List option are disabled. 

• Sync with HEC-HMS.  Use this option to have the HEC-MetVue client inspect the 
directory structure looking in the hms/maps subdirectory within the project folders.  When 
it finds the maps subdirectory, it uses all of the shapefiles that are available. 
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Figure 20.21  Map Panel Editor Dialog: Input Tab 

Under Sub-Areas, choose which option to use for defining the polygons used in the 
computations.  The three options are:  

• Use List.  Use this option to specify the polygon files (.shp) to use.  They can be the same 
as the map files, if desired.  When selected, the Copy to forecast directory option and the 
Browse button are enabled.  All the files selected appear in the list box.  If the Copy to 
forecast directory checkbox is selected, all the files are copied into the project directory 
structure when forecasting to aid in archiving and de-archiving. 

• Sync with CAVI.  Use this option to keep the polygon files used by HEC-MetVue in sync 
with the ones specified in the CAVI.  The HEC-MetVue client filters out non-polygon 
shape files for the sub-area list before using the results.  When this option is selected, the 
sub-options for the Use List option are disabled. 

• Sync with HEC-HMS.  Use this option to have the HEC-MetVue client inspect the 
directory structure looking in the hms/maps subdirectory within the project folders.  When 
it finds the maps subdirectory, it uses all of the shapefiles that match the general pattern 
*_subbasins.shp, consistent with HEC-HMS specifications.  Other shapefiles that don’t 
end with the pattern shown are ignored.  

Under TIN/Grid Input, use the dropdown to specify the input data type.  As the selection in the 
dropdown selection changes, so do the fields below, because each type of input has different 
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specification requirements.  The Log File and Log Level are common to all three options and are 
initially populated by default settings.  The three options in the TIN/Grid Input dropdown list 
are:  

• File.  Use this input type to define a triangular irregular network (TIN) as input.  To define 
the File Mask, click the Browse button and navigate to the HEC-DSS file containing the 
gridded input data.  

• DSS.  Use this input type for input stored in HEC-DSS grids.  To define the HEC-DSS 
File, click the Browse button and navigate to the HEC-DSS file containing the gridded 
input data.  Use the Path Mask field to specify a filter for the desired input data.  The 
convention is /A/B/C/D/E/F/, where A, B, C, D, E, and F, are the pathname parts of the 
gridded data record. (For example, in Figure 20.21, we use a Path Mask specifying any A 
part, a B part equal RFC, a C part equal PRECIP, any D and E parts, and an F part equal 
RADAR.) 

• Gage Interp.  Use this input type to define point gage information as the input.  The 
GageInterp File, HEC-DSS Input File, and HEC-DSS Output File must be specified 
here.  To specify these files, use the Browse buttons (to the right of each field) and 
navigate to the required file. 

20.5.2.2 HEC-MetVue Alternative Output 
 

The Map Panel editor Output tab (Figure 20.22), contains three main areas.  At this time, only 
the third, Hyetograph Generation for Sub-Areas requires configuration.  To configure the 
MFP Alternative output: 

1. Define the output interval using the Interval and time increment dropdowns.  

2. Confirm that the Write to HEC-DSS (written to forecast HEC-DSS file) option is 
enabled.  If not, click the check box to enable it. 

3. Confirm that the Tabulate to File option is enabled.  If not, click the check box to enable 
it.  This field should populate automatically. 

4. Confirm the Output Format dropdown is set to legacy.  

5. Click the OK button to confirm your Input and Output configurations. 

6. Click the OK button to close the HEC-MetVue Alternative editor. 
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Figure 20.22  Map Panel Editor Dialog: Output Tab 

20.5.3 Remove a HEC-MetVue Alternative 
To remove a HEC-MetVue alternative from the watershed: 

1. In the watershed pane, right-click the HEC-MetVue node and select Import.  This opens 
the HEC-MetVue Alternative dialog shown in Figure 20.19. 

2. Uncheck the box in the Use for alternative column associated with the HEC-MetVue 
alternative to be removed.  This does not delete the HEC-MetVue alternative from disk, 
just removes if from use in the CAVI. 

3. Click the OK button to close the HEC-MetVue Alternative dialog. 

4. Save the watershed. 

20.6 Create an HEC-HMS Alternative 
An HEC-HMS alternative consists of a basin model, loss parameter, transform parameter, 
baseflow zone configurations, and a set of parameter adjustments for each zone.  Within an 
HEC-HMS alternative, the parameters in the HEC-HMS basin model can be adjusted to try to 
match observed flows at the time of forecast.  Blending of model results to observed flows can 
be controlled where they are available.  If the HEC-HMS project contains more than one basin 
model (for summer and winter conditions, for instance), HEC-HMS alternatives can be built 
around each of them. 
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20.6.1 Import HEC-HMS Model Alternative 
To import HEC-HMS model alternatives: 

1. From the Watershed Panel in the Setup Module, right-click the HEC-HMS icon and 
select Import (Figure 20.23).  The HEC-HMS program and a Select Project File dialog 
open. 

 

Figure 20.23  Import HEC-HMS model 

2. In the file browsing dialog, navigate to and select the HEC-HMS project file (.hms 
extension) you wish to import. 

3. Click Select, and the import process begins. 

4. If importing an HEC-HMS model alternative created in a previous version of HEC-HMS, 
then the Convert HEC-HMS Project dialog (Figure 20.24) opens prompting conversion 
of  the project.  Click Convert Project, and the Convert HEC-HMS Project dialog 
closes. 

 

Figure 20.24  Convert HEC-HMS Project Dialog 

5. Once the import is complete the CAVI message window will show “HMS: NOTE 16161: 
Import finished.” 

6. Save the watershed. 
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20.6.2 HMS Loss and Baseflow Zone Configurations 
After importing the HEC-HMS model alternatives, zone configurations must be created for loss 
parameter, transform parameter, and baseflow parameter adjustments.  A zone configuration is 
a set of zones, and a zone is a set of elements (subbasins or reaches) in the watershed.  Elements 
should be grouped into zones based on similarity of hydrologic properties and the availability of 
observed flows against which to calibrate zone parameters.  For example, the subbasins in a 
headwaters area might be grouped above a reservoir together into a zone.  At forecast time, the 
baseflow and loss parameters for the subbasins in that zone will be adjusted together so that the 
hydrograph calculated by HEC-HMS for the inflow to the reservoir fits the observed inflows to 
the reservoir as well as possible. 

20.6.2.1 Create a Zone Configuration 
To create a zone configuration: 

1. From the Watershed Panel in the Setup Module, select HEC-HMS, and click the HEC-
HMS model alternative. 

2. Right-click the HEC-HMS model alternative and choose Zone Configurations. 

3. The Zone Configuration Manager dialog (Figure 20.25) opens. 

 

Figure 20.25  Zone Configuration Manager Dialog 

4. Select New to create a new zone configuration.  The Create a New Zone Configuration 
dialog (Figure 20.26) opens. 

5. From the Create A New Zone Configuration dialog, enter a name into the Name field 
and description into the Description field. 

6. For element type, select either Subbasins or Reaches.  Click Create, the Create A New 
Zone Configuration dialog closes and the new zone configuration is added to the list of 
current zone configurations. 
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7. Close the Zone Configuration Manager dialog and Save the watershed. 

 

Figure 20.26  Create a New Zone Configuration Dialog 

20.6.2.2 Create Zones 
For each loss or baseflow zone configuration, at least one loss/baseflow zone will need to be 
created.  The zones should be based on similarity of hydrologic properties and the availability of 
observed flows to calibrate zone parameters against.  

To create a zone: 

1. From the Zone Configuration Manager, select the newly created zone configuration. 

2. Click the Zones button from the manager window.  The Zones dialog opens (Figure 
20.27).  

 

Figure 20.27  Zone Dialog 

3. Select New and Create A New Zone dialog (Figure 20.28) opens.  Enter a name into the 
Name field (required) and description into the Description field (optional). 
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Figure 20.28  Create A New Zone Dialog 

4. Select Create.  The name of created zone appears in the Current zones for selected 
zone configuration list on the Zones dialog. 

5. Close the Zones dialog and Save the watershed. 

20.6.2.3 Add Elements to a Loss Parameter Zone 
Once loss parameter zones have been created, elements can be assigned to the zones. 

To assign elements to zones: 

1. From the Zone Configuration Manager dialog (Figure 20.25) select the zone 
configuration to be configured.  

 

Figure 20.29  Elements Dialog 

2. Click Elements, and the Elements dialog (Figure 20.29) opens. 

3. From the Zones drop-down list, select the zone to add elements to. 
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4. Select the elements (subbasins or reaches) to add to the zone from the elements 
(subbasins or reaches) listed in the Unassigned Elements list.  Select one element by 
clicking; select ranges of subbasins by shift-clicking; select discontinuous groups of 
subbasins by control-clicking. 

5. Click Add and the selected element names appear in the list under the Zones drop-down 
list.  An element can also be moved into a zone by double-clicking on the element in the 
Unassigned Elements list. 

6. Elements can also be moved out of a zone by selecting an element in the list under the 
Zones drop-down list and then click Remove or by double-clicking on that element. 

7. Close the Elements dialog.  

8. Close the Zone Configuration Manager dialog and Save the watershed. 

20.6.3 Forecast for an HEC-HMS Alternative 
From Forecast Alternative editor (Figure 20.30), it is possible to select the zone configuration 
for the loss rate, transform, baseflow and routing configuration parameters. 

To set the forecast configuration and zone configuration parameters: 

1. From the Watershed Pane in the Setup Module, select the HEC-HMS model 
alternative. 

2. Right-click on the HEC-HMS model alternative and select Forecast Configuration. 

3. The Forecast Alternative editor (Figure 20.30) opens.  

4. Enter a description in the in the Description field.  Enter date and time values in for the 
Start Date, Forecast Date, and End Date. 

5. From the drop-down lists for Loss Rate Config, Transform Config, Baseflow Config, 
and Routing Config choose the appropriate zone configuration. 

6. Click OK, and the Forecast Alternative editor closes.  Save the watershed. 
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Figure 20.30  Forecast Alternative Editor 

20.6.4 Adjust Parameters Using the Combined Parameter 
Editor 

The Combined Parameter editor (Figure 20.31) allows adjustment of loss rate, transform, and 
baseflow parameters to calibrate your HEC-HMS model to the forecasted event.  It also controls 
blending (the substitution of observed flows for calculated flows in the model) for the HEC-
HMS model.  An HEC-HMS alternative consists of an HEC-HMS basin model, which sets initial 
values for parameters, and a set of adjustments to those initial parameter values.  The methods 
for the parameters are based on what was specified in the HEC-HMS model. 
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Figure 20.31  Combined Parameter Editor 

To open the Combined Parameter editor:  

1. From the Watershed Pane in the Setup Module, select the HEC-HMS model 
alternative. 

2. Right-click on the HEC-HMS model alternative, select Combined Parameter editor and 
the Combined Parameter editor opens. 

3. Adjusted the loss rate, transform, and baseflow parameters as needed.  

4. Click Apply, the Combined Parameter editor closes.  Save the watershed. 

20.6.4.1 Loss Parameters 
 

To adjust loss parameters, select the *Loss tab (Figure 20.32) on the Combined Parameter 
editor.  For this example model, the loss method used was Deficit and Constant.  

The upper panel shows a list of the loss zones in the watershed and the zone-average values for 
the initial soil-moisture deficit, the maximum deficit, and the constant loss rates in the HEC-
HMS alternative.  In the upper panel, for each parameter, there is a Zone Average column and 
an Adjustment column.  The leftmost column displays the area-weighted average value of the 
parameter over the subbasins in the zone as read from the HEC-HMS basin model.  To override a 
zone value, enter the new value in the Adjustment column. 
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In the lower panel of the editor are the parameters for the individual subbasins in the zone.  For 
each parameter there are two columns, the Base Value and Final Value.  To edit a loss 
parameter, select the override box next to the zone subbasin.  The Final Value cell becomes 
editable and the new value can be entered.  The list in the lower panel will contain the subbasins 
in that zone. 

 

Figure 20.32  Combined Parameter Editor – Loss Parameters Tab 

20.6.4.2 Baseflow Parameters 
 

To edit the baseflow parameters, select the *Baseflow tab (Figure 20.31) on the Combined 
Parameter editor.  For this example model, the baseflow method used was Bounded Recession.  
The baseflow panel uses the same parameter adjustment method as the loss tab to adjust the 
baseflow at the time of forecast (this is not the initial baseflow, but the initial baseflow minus the 
recession that occurs between the lookback time and the time of forecast) and the recession ratio. 

20.6.4.3 Transform Parameters Tab 
 

To edit the transform parameters, select the *Transform tab (Figure 20.31) on the Combined 
Parameter editor.  For this example model, the transform method used was ModClark.  The 
transform panel uses the same parameter adjustment method as the loss tab to adjust the 
transform at the time of forecast.  

20.6.4.4 Blending Tab 
 

To edit blending parameters, select the Blending tab on the Combined Parameter editor 
(Figure 20.31).  This contains a list of all locations in the HEC-HMS model where observed 
flows are available for blending.  It is possible to select blending methods (Step or Taper), set 
the taper interval, or turn blending off at each location.  
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20.6.4.5 Slider Adjustments 
 

The Forecast Slider Adjustments dialog (Figure 20.33) from the Combined Parameter editor 
allows adjustment for zonal, subbasin, and reach element parameters for calibration. 

 

Figure 20.33  Forecast Slider Adjustments Dialog 

20.6.5 Adjust Parameters Using Slider Adjustments 
Sliders in HEC-HMS (Figure 20.34) allow the user to adjust loss rate, transform, baseflow, and 
routing parameters easily.  These parameters are adjusted so that the simulated watershed 
response matches observed values (for example stream gages and reservoir stages) more closely 
during the lookback period of the event.  An HEC-HMS alternative consists of an HEC-HMS 
basin model, which sets initial values for parameters, a set of adjustments to those initial 
parameter values, and a metrological model that defines the precipitation input.  The methods 
associated with the basin model parameters are based on what was specified in the HEC-HMS 
model. 

The following sections describe setting up and using slider adjustments.  Sliders depict a range of 
values, increments, or factors on a line and a selector that you can drag across the line to select a 
value, increment, or factor to adjust the parameter by.   

Sliders allow for quick, small adjustments of parameters and allow HEC-HMS to recompute 
runoff for a subset of basin elements instead of the entire watershed.  This allows for faster 
computation when adjustments are made. 
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Figure 20.34  A Slider Configured to Adjust Loss Parameters 

20.6.5.1 Configuring Slider Adjustments 
 

Before slider adjustments can be used, they must first be configured.  This is a two-step process: 
First, it must be specified by zone and/or subbasin/reach which parameters should be adjusted.  
Second, the adjustment type (how the sliders will adjust the parameters) and limits (the 
maximum and minimum adjustments) of each slider must be set. 

20.6.5.1.1  Slider Adjustment Specifications 
 

To specify the parameters to be adjusted: 

1. From the main toolbar, launch HEC-HMS. 

2. In the Watershed Explorer in HEC-HMS (set of tabs on the upper left), click the 
Compute tab. 

3. On the Compute tab, expand the Forecast Alternatives folder, and right-click the 
forecast alternative for which slider adjustments should be configured. 

4. On the shortcut menu (Figure 20.35), select Slider Adjustments to open the Forecast 
Slider Adjustments dialog (Figure 20.36).  On each tab, the zone or subbasin/reach and 
the associated parameters are listed.  The tabs in this dialog are named with the loss rate, 
transform, baseflow, and routing methods used in the basin. (To be able to edit each type 
of parameter, the Loss Rate Config, Transform Config, Baseflow Config, and Routing 
Config zones must be defined in the HEC-HMS forecast alternative as detailed in Section 
20.4.3.) 
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Figure 20.35  Forecast Alternative Shortcut Menu Used for Configuring Slider Adjustments 

 

Figure 20.36  Forecast Slider Adjustments Dialog 

5. Click Select to open the Select Forecast Slider Adjustments dialog (Figure 20.37). 
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Figure 20.37  Select Forecast Slider Adjustments Dialog 

6. Select the tab with the parameters to be adjusted.  For example, click the loss tab (shown 
as the Deficit Constant Loss tab here) to select loss rate parameters for adjustment. 

7. To select zonal adjustment sliders, select a zone in the Zones window.  This will populate 
the available Parameters (on the right) that can be assigned to sliders.  

8. In the Parameters window, choose one or more items to be adjusted using sliders 
(multiple parameters can be chosen by using the CTRL or SHIFT keys), and click 
Select.  After hitting Select, the parameter will move from the Select Forecast Slider 
Adjustments dialog to the Forecast Slider Adjustments dialog. 

9. Repeat steps 7 and 8 to select all desired zonal adjustment sliders. 

10. Next, to select subbasin or reach adjustment sliders (for adjusting parameters for 
individual elements instead of zones), select a subbasin or reach in the Subbasins or 
Reaches window.  This will populate the available Parameters (on the right) that can be 
assigned to sliders.  

11. In the Parameters window, choose one or more items you wish to adjust using sliders 
(you can choose multiple parameters using the CTRL or SHIFT keys), and click Select.  
After clicking Select, the parameter will move from the Select Forecast Slider 
Adjustments dialog to the Forecast Slider Adjustments dialog. 

12. Repeat steps 10 and 11 to select all desired subbasin/reach adjustment sliders. 
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13. Repeat steps 6 through 12 for each of the parameters to be adjusted (loss rate, transform, 
baseflow, and routing methods).When finished selecting slider adjustments, click Close. 

14. Review the selections in the Forecast Slider Adjustments dialog.  If one has been 
selected in error, it can be removed by selecting it in the Parameters column and 
clicking Remove.  When satisfied with the selections, click Close. 

20.6.5.1.2  Slider Settings 
 

In HEC-HMS parameters have minimum and maximum allowable values.  These values are used 
to initialize the limits of the sliders.  To setup the type of adjustment and limits of each slider: 

1. On the HEC-HMS Compute tab, expand the Forecast Alternatives folder, and right-
click the forecast alternative for which slider adjustment parameters have been selected. 

2. On the shortcut menu (Figure 20.35), select Slider Settings to open the Forecast Slider 
Adjustments Settings dialog (Figure 20.38). 

Each tab has two tables.  The upper table shows zonal parameters, and the lower table shows 
parameters for individual elements.  The Zone and Subbasin/Reach columns list the zone 
and subbasin/reach name.  The Parameter column lists the parameter name of the slider.  
The Adjustment Type column lists the adjustment type.  The Units column lists the units for 
the adjustment.  The last two columns list the Minimum and Maximum values for the 
parameter adjustment. 

(To be able to configure loss rate, transform, baseflow, and routing slider settings, they must 
first be configured as detailed in section 20.6.5.1.1.) 

 

Figure 20.38  Select Forecast Slider Adjustments Settings Dialog (Default Values Shown) 
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3. Specify an adjustment type using the dropdown in the Adjustment Type column (Figure 
20.39).  An Adjustment Type can be a new Value, an Increment to be added or 
subtracted from the parameter value, or a Factor to be applied to the parameter value.  
By default, the zonal adjustment type is Factor, and the subbasin/reach adjustment type 
is Value.  If the adjustment type is Factor, the units entry will be blank. 

 

Figure 20.39  Select Forecast Slider Adjustments Settings Adjustment Type dropdown 

4. Specify the minimum and maximum values for each parameter.  These columns are 
populated by default.  However, for practical use of the slider adjustments, the limits 
should be set to a smaller range.  

5. Review the selections in the Forecast Slider Adjustments Settings dialog.  When 
satisfied, click Apply, and then click Close. 

6. Save the HEC-HMS watershed. 

20.6.5.2 Adjusting Parameters Using the Sliders 
 

To access sliders adjustments, first open the combined parameter editor by right-clicking the 
HEC-HMS forecast alternative in the Setup tab of the CAVI and clicking Combined Parameter 
editor (detailed in section 20.6.4).  Click Slider Adjustments.  The slider adjustments will 
display (Figure 20.40). 
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Figure 20.40  Slider Adjustments 

The dialog consists of multiple tabs, each containing sliders by zone. (Again, the tabs in this 
dialog are named with the loss rate, transform, baseflow, and routing methods used in the basin.) 
The zone is selected using the dropdown menu located just under the tabs.  The upper part of the 
dialog shows parameter adjustments for the selected zone.  The lower part of the dialog shows 
parameter adjustments for the individual subbasin or reach within the selected zone (if these 
were configured, Section 20.6.5.1). 

Parameter values can be adjusted by moving a slider or by entering a value in the text box to the 
right of the slider.  If a value is entered in the text box, it should be consistent with the 
adjustment type.  A factor must begin with an asterisk (*), an increment must begin with a plus 
(+) or a minus (-), and a value adjustment needs no initial symbol.  The slider will move to the 
value entered in the text box.  If the value in the text box is outside the slider’s range, the slider is 
disabled. 

In the upper right of the dialog there is a check box labeled Compute with each slider change.  
If this box is checked, any change in a slider will cause the parameter adjustment to be applied, 
and the forecast alternative will be computed. 

If the box is not checked, the parameter adjustment will not be applied until Apply is clicked, 
and the results will not be updated until the forecast alternative is computed.  If preferred, HEC-
HMS can be configured to compute automatically after clicking Apply.  In HEC-HMS, select 
Program Settings from the Tools menu.  In the General tab, check the box next to Compute 
after apply in editors, and click OK.  This setting applies to both the slider adjustments and 
combined parameter editor.  
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Clicking Reset will reset the parameter adjustments to their value when the dialog was opened.  
Close closes the dialog.  

Right-clicking a slider (in the CAVI) brings up a menu with two options.  The first option Reset 
to Original Value will reset the parameter adjustment to the original value when the dialog was 
opened.  The second option Modify Slider Limits opens the Forecast Slider Adjustments 
Settings dialog, so the Adjustment Type and slider Minimum and Maximum limits can be 
changed. 

20.6.6 Edit an HEC-HMS Alternative 
To edit an HEC-HMS model alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-HMS model 
alternative. 

2. Right-click on the HEC-HMS model alternative, select Forecast Configuration (Figure 
20.41) and the Forecast Configuration editor (Figure 20.30) opens. 

3. Edit the HEC-HMS model alternative as desired, and then click the Apply button to save 
you changes.  

4. Click Close, and Forecast Configuration editor closes. 

5. Save the watershed. 

 

Figure 20.41  HEC-HMS Model Alternative Shortcut 

20.6.7 Copy an HEC-HMS Alternative 
To copy an HEC-HMS model alternative: 

1. From the Models menu in the Setup Module, select HEC-HMS > Forecast Alternative 
Manager, and the Forecast Alternative Manager dialog (Figure 20.42) opens.  
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Figure 20.42  Forecast Alternative Manager Dialog 

2. From the Current forecast alternatives list, select the forecast alternative to be copied 
and click Copy. 

3. The Copy Forecast Alternative dialog (Figure 20.43) opens.  Enter a new alternative 
name in the Name field (required) fill out the Description field (optional).  

4. Click Copy to complete the process.  The copied alternative will now be shown in the 
Current forecast alternatives list. 

5. Close the Forecast Alternative Manager dialog. 

 

Figure 20.43  Copy Forecast Alternative Dialog 

20.6.8 Delete an HEC-HMS Alternative 
To delete an HEC-HMS alternative: 

1. From the Models menu in the Setup Module, select HEC-HMS > Forecast Alternative 
Manager, and the Forecast Alternative Manager dialog (Figure 20.42) opens. 

2. From the Current forecast alternatives list, select the forecast alternative to be deleted 
and click Delete. 

3. The Delete Confirmation dialog (Figure 20.44) opens.  Click OK to delete the forecast 
alternative. 
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4. The deleted alternative is removed from Current forecast alternatives list. 

 

Figure 20.44  Delete Confirmation Dialog 

20.7 Create a HEC-ResSim Alternative 
A HEC-ResSim model alternative consists of a watershed schematic, stream and reservoir 
network, and a set of operations for each reservoir.  Within a HEC-ResSim alternative, simulated 
forecasted releases can be overridden to mimic desired operation during the forecast period.  If 
the HEC-ResSim project contains more than one network alternative (for summer and winter 
conditions, for instance), HEC-ResSim model alternatives can be built around each of them. 

20.7.1 Import a HEC-ResSim Watershed 
To import HEC-ResSim watershed: 

1. On the File menu, select Import > HEC-ResSim and the Import Type dialog (Figure 
20.45) opens. 

 

Figure 20.45  Import Type Dialog for Importing HEC-ResSim Watershed 

2. Click Watershed to import the HEC-ResSim watershed (stream alignment, network, 
configurations, and alternatives), this will open a file browsing dialog. 

3. From the file browsing dialog, navigate to and select the HEC-ResSim watershed (files 
with .wksp extensions) to be imported, and click Open.  The import will automatically 
begin and an Import Progress dialog opens indicating that the import is occurring.  

4. The Import Progress dialog closes automatically once the import is complete and the 
Message window will show, “ResSim Import Complete.” 

5. Save the watershed. 
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20.7.2 Import a HEC-ResSim Alternative 
To import HEC-ResSim alternative: 

1. On the File menu, select Import > HEC-ResSim and the Import Type dialog (Figure 
20.45) opens. 

2. Click Alternative and the Import Alternative Wizard (Figure 20.46) opens. 

3. Select “…” and the file browsing dialog opens.  Navigate to and select the HEC-ResSim 
watershed (files with .wksp extensions) to be imported, and click the OK button.  

4. Select Next, and choose an alternative from the Available Alternatives table. 

5. Choose Next, enter a name in the Name field and a description in the Description field 
for the new alternative. 

6. Select Next, enter a name in the Name field and a description in the Description field for 
the new reservoir network. 

7. Select Next, and assign the stream names in the To Stream column in the table. 

8. Select Next, and if needed, resolve network computation points by selecting watershed 
computation points from the Watershed Computation Point column of the table. 

9. Select Next, and view the Import Summary.  If needed, the summary can be copied or 
printed. 

10. Click Finish, choose Yes on the Continue with Import dialog and Save the watershed. 

 

Figure 20.46  Import Alternative Wizard for Importing HEC-ResSim Alternative 

20.7.3 Edit a HEC-ResSim Alternative 
To edit a HEC-ResSim alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-ResSim model 
alternative. 
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2. Right-click on the HEC-ResSim alternative, select Edit Alternatives (Figure 20.47), and 
the Resim Alternative Editor (Figure 20.48) opens. 

 

Figure 20.47  HEC-ResSim Shortcut Menu 

 

Figure 20.48  HEC-ResSim Alternative Editor 

3. Edit the HEC-ResSim alternative as desired.  For further information on how to modify 
HEC-ResSim alternatives, see the HEC-ResSim User’s Manual. 

4. Select Save from the Alternative menu. 
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5. Click Close from the Alternative menu and Resim Alternative Editor closes. 

20.7.4 Copy a HEC-ResSimAlternative 
To copy a HEC-ResSim alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-ResSim model 
alternative. 

2. Right-click on the HEC-ResSim alternative, select Edit Alternatives (Figure 20.47), and 
the Resim Alternative Editor (Figure 20.48) opens.  

3. Select Save As from the Alternative menu and the Save As dialog (Figure 20.49) opens.  

4. In the Save As dialog, enter alternative name in the Name field (required) and a 
description in Description field (optional). 

5. Click OK, and the Save As dialog closes.  The copied alternative is shown in the HEC-
ResSim Alternative Editor. 

6. Click Close from the Alternative menu, and the HEC-Resim Alternative Editor closes. 

 

Figure 20.49  Save As Dialog 

20.7.5 Delete an HEC-ResSIm Alternative 
To delete a HEC-ResSim alternative, launch HEC-ResSim from the CAVI and delete the 
network alternative from the HEC-ResSim network module.  For further information on how to 
delete alternatives in HEC-ResSim, see the HEC-ResSim User’s Manual. 

20.8 Create a HEC-RAS Alternative 
A HEC-RAS alternative consists of model geometry, set of boundary conditions, and a plan file 
linking the two.  If the HEC-RAS project contains more than one plan (for steady flow and 
unsteady flow conditions, for instance), you can build HEC-RAS model alternatives around each 
of them. 

20.8.1 Import a HEC-RAS Alternative 
To import a HEC-RAS model alternative: 
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1. On the File menu, select Import > HEC-RAS, and a file browser dialog called Select 
HEC-RAS project to import from (Figure 20.50) opens. 

2. In the file browsing dialog, navigate to and select the HEC-RAS project file (.prj 
extension) to be imported, and click the Open button.  The import begins and an Import 
Progress dialog opens displaying the import progress.  The Import Progress dialog 
closes when the import is complete and the Message window will show “RAS Import 
Complete”. 

3. Save your watershed. 

 

Figure 20.50  Select HEC-RAS project to import Dialog 

20.8.2 Edit a HEC-RAS Alternative 
To edit a HEC-RAS alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-RAS alternative to be 
edited. 

2. Right-click the selected HEC-RAS alternative and the HEC-RAS Shortcut Menu 
(Figure 20.51) appears. 

3. From the HEC-RAS Shortcut Menu select the HEC-RAS component to be modified.  
Edit the HEC-RAS alternative as desired.  For further information on how to modify 
HEC-RAS alternatives, see the HEC-RAS User’s Manual. 
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Figure 20.51  HEC-RAS Shortcut Menu 

20.8.3 Copy a HEC-RAS Alternative 
To copy a HEC-RAS alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-RAS alternative to be 
copied. 

2. Right-click the selected HEC-RAS alternative and the HEC-RAS Shortcut Menu 
(Figure 20.51) expands. 

3. Click Plan Data, and the HEC-RAS Plan editor opens. 

4. From the File menu, select Save Plan As, and the Save Plan Data As dialog (Figure 
20.52) opens.  

 

Figure 20.52  Save Plan Data As 



HEC-RTS User's Manual  Chapter 20 – Model Alternatives and Forecast Runs 
 

20-45 
 

5. From the Save Plan Data As dialog, specify a new plan name in the Title field. 

6. Click OK, and the Plan Identifier dialog (Figure 20.53) opens. 

7. Enter an identifier in the Plan Identifier dialog.  Click OK to complete the copy process. 

 

Figure 20.53  Plan Identifier Dialog 

20.8.4 Delete a HEC-RAS Alternative 
To delete a HEC-RAS alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-RAS alternative to be 
deleted. 

2. Right-click the selected HEC-RAS alternative and the HEC-RAS Shortcut Menu 
(Figure 20.51) expands. 

3. Click Plan Data, and the HEC-RAS Plan editor opens. 

4. From the File menu, select Delete Plan, and the Delete Plan File dialog (Figure 20.54) 
opens. 

5. From the Delete Plan File dialog, select the plan to delete, and click OK. 

6. A Delete Plan File confirmation dialog opens.  Click OK to complete the deletion 
process. 

 

Figure 20.54  Delete Plan File Dialog 
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20.9 Create an HEC-FIA Alternative 
An HEC-FIA alternative consists of information on consequences for a given hazard.  An HEC-
FIA alternative is a combination of an Inundation Configuration, Impact Areas, Structure 
Inventory, Critical Infrastructure, Impact Response Curves, Agricultural Data, and computation 
settings.  If the HEC-FIA project contains more than one alternative (for summer and winter crop 
conditions, for instance), you can build HEC-FIA model alternatives around each of them.  

For further information on how to develop the information required in defining an alternative in 
HEC-FIA, see the HEC-FIA User’s Manual. 

20.9.1 Import an HEC-FIA Alternative 
To import an HEC-FIA alternative: 

1. On the File menu, select Import > HEC-FIA, and Import Alternatives dialog (Figure 
20.55) opens. 

2. Click Select Project, and a file browsing dialog opens. 

3. From the file browsing dialog, navigate to and select the HEC-FIA 3.0 project file (.prj 
extension) you wish to import.  

4. Click Open, and the file browsing dialog closes.  

5. From the Import Alternatives dialog, click Import, the HEC-FIA alternative is 
imported, and a confirmation dialog opens.  

6. Click OK, and the close confirmation dialog closes. 

7. Click Close, and Save the watershed. 

 

Figure 20.55  Import Alternative Dialog 
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20.9.2 Edit an HEC-FIA Alternative 
To edit an HEC-FIA alternative: 

1. From the Watershed Pane in the Setup Module, select the HEC-FIA alternative to be 
edited. 

2. Right-click the selected HEC-RAS alternative and the HEC-FIA Shortcut Menu (Figure 
20.56) appears. 

3. Click Alternative, and the HEC-FIA Alternative editor (Figure 20.57) appears. 

4. Edit the HEC-FIA alternative as desired.  For further information on how to modify 
HEC-FIA alternatives, see the HEC-FIA User’s Manual. 

5. Click OK, and HEC-FIA Alternative editor closes. 

6. Save the watershed. 

 

Figure 20.56  HEC-FIA Shortcut Menu 

It is recommended to only make changes from the Impact Area Editor (Figure 20.58), for the 
price index values.  To access the Impact Area Editor, right-click a HEC-FIA model alternative 
from either the table in the Modeling Module or from the Watershed Pane in the Setup 
Module, and select Impact Areas.  
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For further information on how to edit HEC-FIA alternatives and impact areas, see the HEC-FIA 
User’s Manual. 

 

Figure 20.57  HEC-FIA Alternative Editor 



HEC-RTS User's Manual  Chapter 20 – Model Alternatives and Forecast Runs 
 

20-49 
 

 

Figure 20.58  HEC-FIA Impact Area Editor 

20.9.3 Copy an HEC-FIA Alternative 
To copy an HEC-FIA alternative: 

1. Launch HEC-FIA from the CAVI taskbar. 

2. In the HEC-FIA watershed pane, select the HEC-FIA alternative to be copied. 

3. Right-click the selected alternative to bring up the HEC-FIA Alternative Shortcut 
Menu shown in Figure 20.59. 

 

Figure 20.59  HEC-FIA Alternative Shortcut Menu 

4. Select Save As from the alternative shortcut menu.  
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5. The HEC-FIA Save As dialog will open (Figure 20.60).  In the dialog, specify a new 
alternative name in the Name field, and fill out the Description field (if desired).  Leave 
the Directory field alone. 

6. Click the OK button to complete the copy process.  The copied alternative will now be 
shown in the HEC-FIA Alternative editor. 

 

Figure 20.60  HEC-FIA Save As dialog 

20.9.4 Delete an HEC-FIA Alternative 
To delete an HEC-FIA alternative: 

1. Launch HEC-FIA from the CAVI taskbar. 

2. In the HEC-FIA watershed pane, select the HEC-FIA alternative to be copied. 

3. Right-click the selected alternative to bring up the shortcut menu shown in Figure 20.59. 

4. Select Delete from Study and click the Yes button in the confirmation dialog. 

For further information on how to delete alternatives in HEC-FIA, see the HEC-FIA User’s 
Manual. 

20.10 Editing a Model Alternative 
A model alternative can be edited by selecting the alternative to be edited in the watershed pane 
and launching the associated software from the CAVI taskbar.  This will open the alternative in 
the native model and allow editing of the model alternative.  If the model alternative is edited in 
this manner and one or more forecast runs have been configured using this alternative it will be 
necessary to make sure the changes propagate through to your forecast run configurations as 
detailed in Chapter 12. 

20.11 Configuring Model Alternative Keys 
To complete configuration of a model alternative, each model alternative must be assigned a 
Model Alternative Key.  The Model Alternative Key is an alpha-numeric identifier that will 
determine the names of the forecast runs. 

To assign model alternative keys: 
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1. From the Models menu, select Model Alternative Keys, and the Model Alternative 
Keys dialog (Figure 20.61) opens. 

 

Figure 20.61  Model Alternative Keys Dialog 

2. Using the Plugin drop-down list, select the model for which to assign a key.  

3. In the Key field, enter a single unique alpha-numeric character that will be used to 
identify the listed Model Alternative. 

4. Repeat steps 2 and 3 for all models and model alternatives. 

5. Click OK, and the Model Alternative Keys dialog closes. 
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Model alternatives for the standard programs might be named similar to the following: 

 MFP deals with future precipitation.  You can configure model alternatives for use in 
conjunction with HEC-HMS to compute a variety of future precipitation scenarios.  For 
example: 

Example Model Alternatives for MFP 

ID Name 

N No future precipitation 

2 2-inches future precipitation 

4 4-inches future precipitation 

Q QPF 

R One-half QPF 

S Twice QPF 

 

 HEC-MetVue deals with observed meteorological data.  Model alternatives can be 
configured for use in conjunction with HEC-HMS to compute a variety of observed 
precipitation scenarios.  For example: 

Example Model Alternatives for  
HEC-MetVue 

ID Name 

N No future precipitation 

2 2-inches future precipitation 

4 4-inches future precipitation 

Q QPF 

R One-half QPF 

S Twice QPF 
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 HEC-HMS model alternatives simulate watershed response to precipitation.  HEC-HMS 
CAVI model alternatives will be used to forecast future flows.  For example: 

Example Model Alternatives for HEC-HMS 

ID Name 

N Normal conditions 

W Wet basin conditions 

D Dry basin conditions 

 

 HEC-ResSim model alternatives assist with reservoir operations, consisting of the 
physical data representing a river-reservoir system and operating rules for all controllable 
elements in the system.  For example: 

Example Model Alternatives for HEC-ResSim 

ID Name 

N Normal operations 

R Restricted downstream channel capacity 

W White water release schedule 

S Fish spawning release schedule 

 

 HEC-RAS model alternatives describe water surface profile and stages at gage locations, 
geometry information for a river, and defined flow data sets.  For example: 

Example Model Alternatives for HEC-RAS 

ID Name 

N Normal river conditions 

H High channel roughness 

L Low channel roughness 

B Bridge out 
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 HEC-FIA model alternatives allow analysis of flood consequences.  Its model forecast 
alternatives are a combination of impact area and hydrograph time series sets.  For 
example: 

 

Example Model Alternatives for HEC-FIA 

ID Name 

N Normal conditions 

E Evacuated with warning 

 

The parameters can be edited within each CAVI model alternative to reflect changing conditions.  
The beginning of this chapter describes how to edit model alternatives for the models. 

20.12 Forecast Run 
A forecast run is the set of model alternatives (Section 20.1) that run sequentially during a 
forecast.  As the with model alternatives, forecast runs exist independent of time.  Therefore, a 
forecast run can be used for any forecast time window. 

Create a forecast run by selecting a model alternative for each program.  There are seven 
standard programs in the CAVI, a typical forecast run will include a combination of the six 
model alternatives.  When a forecast is executed, the CAVI executes the programs in sequential 
order. 

The table shows three suggested forecast runs.  The codes are the names the CAVI automatically 
assigns to each forecast run based on the one-character Model Alternative Keys assigned to the 
model alternatives (Section 20.11).  This coding is program order dependent.  

Example Forecast Run 

Name Code 

No future precip NNNNN 

QPF QNNNN 

Two times QPF SWRBE 
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In the following example, the forecast alternative named Two times QPF has the code SWRBE.  
Each character in this code is the ID of a specific model alternative for each of the six standard 
programs.  The code translates as follows: 

 

Program 1: MFP – twice QPF 

S W R B E 

Program 2: HMS – Wet basin conditions 
Program 3: ResSim – Restricted downstream channel capacity 

Program 4: RAS – Bridge out 
Program 5: FIA – Evacuated with warning 

 

20.12.1 Creating Forecast Run 
Before this step can be done, model alternatives must have been created.  Section 20.11 describes 
how this is done in detail. 

Creating forecast runs: 

1. From the Models menu in the Setup Module, click Forecast Runs, and the Forecast 
Run Editor (Figure 20.62) opens.  

2. Click New, enter a new forecast run name in the Name field (required), a description in 
the Description field (optional). 

3. Select program order from the Program Order drop-down list.  See Chapter 16 for 
information on program order. 

4. From each program listed below the Program Order, select the model alternatives for 
the forecast run. 

5. From the File menu, click Save.  The new forecast alternative appears in the table on the 
Forecast Run Editor (Figure 20.62). 

6. Click OK, and the Forecast Run Editor closes. 

7. Save the watershed. 
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Figure 20.62  Forecast Run Editor 

20.12.2 Delete a Forecast Run 
Delete a forecast run: 

1. From the Models menu in the Setup Module, click Forecast Runs, and the Forecast 
Run Editor (Figure 20.62) opens. 

2. From the table, select the forecast to be deleted. 

3. From the File menu, click Delete and a delete confirmation dialog opens. 

4. Click Yes, and the forecast run will be removed from the table on the Forecast Run 
Editor. 

5. Click OK and the Forecast Run Editor closes. 

6. Save the watershed. 
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CHAPTER 21   
 

Model Linking Editor 
 

After a Forecast Run has been created the model alternatives need to be linked.  For example, 
output from MFP would be used as the input to HEC-HMS, and the output of HEC-HMS as the 
input to HEC-ResSim.  This is completed using the Model Linking Editor shown in Figure 
21.1.  The Model Linking Editor is accessed from the Setup Module via the Models > Model 
Linking menu item. 

 

Figure 21.1  Model Linking Editor 

21.1 Model Linking Editor GUI Overview 
At the top of the Model Linking Editor the Forecast field displays the forecast for which the 
different model alternatives will be linked.  When the model linking is first configured, this field 
will display <Base Data> to indicate that you are configuring model links between the base 
model alternatives. (If an active forecast is open, the Forecast Field displays the name of the 
forecast.) 

Below the Forecast field is the Forecast Run drop-down list.  This dropdown lists all the 
configured forecast runs. (Again, a forecast run is a set of model alternatives.) Use this dropdown 
to select the specific Forecast Run to be configured. 
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Below the Forecast Run dropdown list is the Model Requiring Input drop-down list.  This 
dropdown lists all the model alternatives configured for use in the specified forecast run.  To 
complete the model linking process for a given forecast run, the user will need to step through all 
the model alternatives listed in this dropdown. 

The remaining portion of Model Linking Editor is the table which lists the inputs required by 
the model alternative specified in the Model Requiring Input dropdown list and the source of 
that input. Figure 21.2 shows an example of the Model Linking Editor for the Russian River 
watershed with an HEC-HMS model alternative requiring input. 

This table has four columns as follows: 

• Column 1: Location.  This column identifies the name of the required input.  For example, 
this could be: 

• The precipitation grid name or discharge gage name specified in the HEC-HMS model 
alternative. 

• The local flow name specified in the HEC-ResSim model alternative. 

• The river station and node name specified in the HEC-RAS model alternative. 

• Column 2: Parameter.  This column identifies the type of data or information required by 
the model alternative.  For example, this could be: flow, stage, or precipitation. 

• Column 3: Input From.  This column consists of drop-down lists that identify the source of 
the input.  These dropdowns list each model alternative and Extract List.  The Extract List is 
used to bring data and information from external sources, i.e. the CWMS database or an 
HEC-DSS file, into the watershed.  Refer to Chapter 22 for additional information on the 
extract editor. 

• Column 4: Location/Parameter.  If the Input From column displays the name of a model 
alternative, this column will show a drop-down list that contains all of the model alternative 
results for the parameter specified in column 2.  In the example shown in Figure 21.2 the first 
row in the table indicates that the Interpolation precipitation input should come from the 
MFP model alternative grid named Interpolation-Precipitation.  If the Input From column 
displays Extract List, this column will display the HEC-DSS file and pathname or CWMS 
database pathname. 
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Figure 21.2  Model Linking Editor 

Below the Model Requiring Input drop-down list is the Select Input Model Alternative 
button.  This button can be used to set all of the Input From values equal to a specific model 
alternative or Extract List.  For example, it may be desired to have all the HEC-ResSim model 
alternative input to come from the HEC-HMS model alternative results.  When a selection of 
Model Input Locations and Parameters is made and this button is clicked, the Select Input 
Model Alternative dialog (shown in Figure 21.3) opens.  In the dropdown, selected the model 
alternative (or Extract List) and click the OK button.  This will change all value in the Input 
From column to be the specified Select Input Model Alternative. 

 

Figure 21.3  Select Input Model Alternative Dialog 

At the bottom of the Model Linking Editor is the Browse button that opens the Select Source 
Data Location dialog (shown in Figure 21.4).  In this dialog the user can scroll through the 
entire list of available locations and parameters for the model alternative specified in the drop-
down list at the top of the dialog.  To set a Location/Parameter, highlight a row in the Model 
Linking Editor, and then highlight the desired row in the Select Source Data Location dialog.  
Click the Set Location button at the bottom of the dialog. 
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Figure 21.4  Select Source Data Location Dialog 

21.2 Model Linking 
To link the model alternatives, complete the following: 

1. Open the Model Linking Editor by selecting the Models > Model Linking menu item in 
the Setup Module. 

2. Select the Forecast Run to be configured in the Forecast Run drop-down list. 

3. Select the first model alternative in the Model Requiring Input dropdown list. 

4. In the Model Linking Editor table, specify the Input From for each row as either a model 
alternative or Extract List. 

5. For each row with an Input From specified with a model alternative, specify the 
Location/Parameter of the required input by using the Browse button to open the Select 
Source Data Location dialog. 

6. Repeat steps 3 through 5 for each model alternative in the Model Requiring Input drop-
down list. 

7. Repeat all steps for each Forecast Run to be configured. 
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8. Save the changes using the File > Save menu item. 

21.3 Model Linking HEC-RAS Model Alternatives 
The location listed in the Model Linking Editor for HEC-RAS inputs will be the river station 
and node name of the boundary condition location.  Typically, the HEC-RAS model will not 
have node names configured and the location will display the river station.  To configure node 
names, complete the following: 

1. Open HEC-RAS from the CAVI toolbar. 

2. Open the geometry editor (Edit > Geometric Data) from the HEC-RAS toolbar. 

3. Open the Node Name Table (shown in Figure 21.5) using the Tables > Names > Node 
Names menu item in the Geometric Data editor. 

4. Specify name for each river station with a boundary condition in the Node Name column.  
Hint: it may be useful to open the boundary condition editor to correlate river stations, node 
names, and boundary condition locations. 

 

Figure 21.5  Node Name Table from HEC-RAS Geometry Editor 
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CHAPTER 22   
 

Data Extract Editor 
 

After completing the model linking (refer to Chapter 21 for more detail) the Data Extract List 
will need to be configured.  The data extract list specifies the location of the gridded and time 
series data required be the different model alternatives.  For example, this could be gridded 
precipitation data or observed flow data from the database.  Configuring the Data Extract List is 
completed using the Data Extract Editor shown in Figure 22.1.  The Data Extract Editor is 
accessed from the Setup Module via the Models | *New* Edit Extract… menu item. 

 

Figure 22.1  Data Extract Editor 

22.1 Data Extract Editor GUI Overview 
The Required Input table, located at the top of Data Extract Editor, lists the HEC-DSS 
pathnames of the model alternatives configured to use the Extract List in the Model Linking 
Editor. (Refer to Chapter 21 for more details on the Model Linking Editor.) 

The Mappings Group list and table, located at the bottom of the Data Extract Editor, list the 
configured group names and the associated HEC-DSS or CWMS pathnames of the source data. 
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APPENDIX A   
 

Glossary 
 

The following are definitions of terms used in this manual.  The terms are defined in context with HEC-
RTS.  
 

Term  Definition  
Acquisition module  The Acquisition module in the CAVI is the grouping of commands for 

data acquisition.  These are commands for monitoring receipt of HEC-
DSS files for gridded data, validating the quality of data, and editing the 
data, as required.  

ArcGIS® shapefile  
(GIS stands for  
Geographic Information  
System)  

ArcGIS® shapefiles store non-topological geometry and attribute 
information for the spatial features of a data set.  A “shapefile” is a 
group of files that share a common base name and different extensions.  
At a minimum a “shapefile” has three component files: .dbf,  
.shp, and .shx.  The .shp file contains the shapes  
(point, polylines, or polygons) that are displayed in the layer.  Each 
shape has a record in the .dbf database file containing descriptive data 
called “attributes”.  The .shx file contains an index that links each shape 
to its record in the .dbf file.  

Base data  Base data for a HEC-RTS watershed refers to the original set of data 
from which copies are made to create forecasts.  

Baseflow method  The baseflow method is a model for calculating the subsurface flow 
contribution to total runoff flow in a subbasin.  

Basin model  Basin models are one of the main components in an HEC-HMS project.  
Basin models are composed of subbasins, routing reaches, junctions, 
and other elements.  Their principal purpose is to predict how 
meteorologic inputs are transformed into streamflow at specific 
locations in the watershed.  
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Cache  A cache is a temporary storage area where recently accessed watershed 
and data files are copied and stored.  

 

Calibration  Calibration is the systematic adjustment of model parameters to 
produce model results that more accurately reflect watershed and 
channel behavior.  

Common schematic  A common schematic consists of a stream alignment, map layers, time 
series icons, computation points, impact areas, and projects that allow 
sharing of common data between HEC software (e.g., HEC-HMS and 
HECResSim) for a watershed.  Use of a common schematic ensures 
consistency of computation nodes, routing reaches, and so on.  

Computation point  A computation point is a location where timeseries data are exchanged 
between analysis applications.  

Control and  
Visualization Interface  
(CAVI)  
  

The CAVI is the graphical user interface (GUI) of HEC-RTS.  You command 
HEC-RTS with graphical menus and tools available in the CAVI.  With the 
CAVI you configure watersheds, view and edit data, setup and run 
forecasts, and view results.  

Coordinated Universal 
Time (UTC)  

UTC is a time scale that is the basis for the worldwide system of civil 
time.9  To provide a consistent method of assigning time to data, the 
HEC-RTS database default time zone is UTC.  No matter what time zone 
the data are originally measured in, the data will always be stored in 
UTC in the database.  The time assigned to data can be converted to 
local time or another time zone when storing or retrieving data from the 
database.  

Corps Water  
Management System  
(CWMS)  

CWMS is a real-time decision support system developed by HEC.  CWMS 
makes readily available to USACE staff information about the current 
state of watersheds, likely future state of watersheds, and 
consequences of management actions.  The information helps water 
managers make wise operation decisions.  
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Corps Water  
Management System  
Visual Utility Engine  
(CWMS-Vue)  

CWMS-Vue is a software utility developed by HEC that provides a 
graphical user interface for viewing, editing, and manipulating data in 
DSS files and CWMS databases.  It is the CWMS version of HEC-DSSVue.  

Culvert  A culvert is a conduit that conveys stream flow through a roadway 
embankment or past some other type of flow obstruction.4  

 

Data Storage System  
(DSS also referred to as  
HEC-DSS)  

DSS is a database system developed by HEC to store and retrieve 
efficiently scientific data that are typically sequential.  Such data types 
include, but are not limited to, time series data, curve data, spatial-
oriented gridded data, and others.  HEC designed the system to make it 
easy for users and application programs to retrieve and store data.  DSS 
is incorporated into most of HEC’s major software applications.  (DSS 
also is used widely as an acronym for “decision support system.”)  

Data Storage System (DSS) 
Pathname  

A DSS pathname is a unique reference to a record or time series in a DSS 
file.  The pathname is structured so that it is easy to group related data 
together.  A pathname is separated into six parts (separated by slashes) 
labeled “A” through “F,” as follows:  
/A/B/C/D/E/F/.  

Data Storage System  
Visual Utility Engine  
(HEC-DSSVue)  

HEC-DSSVue is a software utility developed by HEC that provides a 
graphical user interface for viewing, editing, and manipulating data in 
DSS files.  
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Data stream  A CWMS data stream is a group of processes that receive real-time data 
from remote sources and provide those data to the CWMS database and 
other files and processes.  The primary CWMS processing components 
are  
DataSender, DataReceiver, DataCapture, and DataReader, which can be 
combined to process any type of data, but are generally used to capture, 
decode, and load SHEF data and National Weather Service (NWS) 
gridded data products into CWMS.  CWMS data stream components 
typically run together on a CWMS Solaris server, but can be configured 
to operate in a Wide Area Network (WAN) of dispersed Solaris servers 
and PC's.  A typical office using CWMS will have several CWMS data 
streams, allowing the office to separate the data load by data source, 
type of data, or region.   

Data validation  Data validation is the process of reviewing data and editing or deleting 
data that are erroneous.  

Datum  Datum refers to the reference specifications of a measurement system, 
usually a system of coordinate positions on a surface (a horizontal 
datum), or heights above or below a surface (a vertical datum).3  

 

Directory  A directory catalogs the computer files in a nested folder-like structure.  
Files are organized by storing related files in folders in the same 
directory.  

Diversion  A diversion removes and redirects water from its normal course in a 
channel.  

Domestic Satellite  
Receive-Only Terminal 
(DROT)  

DROT is software that facilitates receipt of satellite data.  

Easting  Easting is the x coordinate of a location in the user-selected World 
Coordinate System.  
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Flood Impact Analysis 
(HEC-FIA)  

HEC-FIA is an HEC analysis application that assesses consequences of 
flow or water surface elevations in the system.  Inputs include computed 
or observed flows or water surface elevations at critical locations.  
Outputs include economic, life loss, or other measures of impact, or 
optionally, information on actions to be taken in response to flows or 
elevations that will be experienced.  

Flow blending  Flow blending is the capability of HEC-RTS to transition smoothly from 
observed flows during the “lookback period” to simulated flows during 
the forecast period.  The lookback period is the period of time occurring 
prior to the time of forecast.  

Forecast  An HEC-RTS forecast is a simulation of watershed processes and 
consequences of flooding based on input data and hydrologic, reservoir 
operation, hydraulic, and impact analysis models configured in HEC-RTS.  
Forecast results include flow and stage in the channel from watershed 
runoff, reservoir release schedules, floodplain inundation maps, 
floodplain consequence reports, and reports listing actions for 
emergency responders to take.  These results inform water 
management decision making.  

Forecast alternative  A forecast alternative is a single forecast scenario defined by a specific 
set of data and model alternatives.  A second forecast alternative would 
be defined by different data or model alternatives.  

 

Freeboard  Freeboard is the vertical distance from the water surface to the top of 
the channel, levee, or floodwall at design condition, and serves as a 
factor of safety for containing water in the stream without overtopping 
the channel, levee, or floodwall.1  

Geographic Information 
System (GIS)  

GIS is an integrated collection of software and data used to view and 
manage information about geographic places, analyze spatial 
relationships, and model spatial processes.3  

Geo-referenced grid  A geo-referenced grid is a set of geographic data that are represented as 
a raster and have been linked to a coordinate system for viewing, 
querying, and analyzing with other geographic data.3  
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Gridset  A gridset is a sequence or time series of georeferenced grids that 
describe properties or states of a watershed as they vary spatially and 
through time.  Examples include sequences of precipitation or air 
temperature grids.  

HEC-GridUtil  HEC-GridUtil is a software application developed by HEC that allows you 
to view, process, and analyze gridded data sets stored in HEC-DSS 
format.  

Hydrograph  A hydrograph is a relationship of stage, discharge, velocity, or other state 
of water with respect to time at a certain location.  

Hydrologic Engineering 
Center (HEC)  

HEC is USACE’s designated Center of  
Expertise in the technical areas of surface and groundwater hydrology, 
river hydraulics and sediment transport, hydrologic statistics and risk 
analysis, reservoir system analysis, planning analysis, real-time water 
control management, and a number of other closely associated 
technical subjects.  HEC is the developer of HEC-RTS.  

Hydrologic Modeling 
System (HEC-HMS)  

HEC-HMS is an HEC analysis application that simulates watershed 
response to precipitation.  Inputs may include observed or forecasted 
precipitation, temperature, snowpack, and other environmental 
conditions.  Outputs include flows throughout the watershed, including 
inflows to reservoirs.  

 

Impact area  In HEC-RTS, an impact area is a distinct portion of a watershed in which 
rising stage in a stream, river, lake, or reservoir has a consequence that 
is to be assessed.  The boundaries of an impact area are defined by a 
closed polygon.  You characterize the effects of rising stage by 
describing the property and population at risk in the area bounded by 
the polygon as input to HEC-FIA.  

Inundation  Inundation is a condition in which water covers normally dry land, 
primarily caused by severe events along rivers or the coast.6  

Java Archive (JAR, .jar)  JAR is a platform-independent file format that aggregates many files into 
one.  Multiple Java applets and their requisite components (.class files, 
images and sounds) can be bundled in a JAR file.  The JAR format also 
supports compression, which reduces file size.8  



HEC-RTS User's Manual  Appendix A – Glossary  

A-7 
 

Layers  Layers in the CAVI are like transparencies laid one on top of the other.  
Each includes representations of static physical images such as roads, 
county and state boundaries, rivers, and subbasins.  These are layered in 
the display area as color pictures.  See Chapters 3, 4, and 5 for more 
information about layers.  

Layer tree  A layer tree is a list representing the hierarchical arrangement of layers 
displayed in the CAVI.  

Levee  A levee is a manmade barrier built along a stream to reduce flooding in 
the adjacent floodplain from rising water in the stream.  

Log file  A log file is a file that holds messages produced by the HEC-RTS program.  
The types of messages include information-only messages and error 
messages.  

Lookback period  The lookback period is the period of time occurring prior to the time of 
forecast.  

Loss method  The loss method is a model for calculating infiltration and other 
abstractions of precipitation in a subbasin.  

Map layer  A map layer is a digital map of watershed features that is configured to 
display in the CAVI.  A map layer is displayed as a color picture.  Map 
layers help you visualize your watershed.  

 

Map projection  A map projection uses mathematical formulas to relate spherical 
coordinates on the globe to flat, planar coordinates.2  

Map Window  The Map Window is the window in the CAVI that shows the graphical 
(and usually georeferenced) representation of the watershed.  

Meteorologic Forecast 
Processor (MFP)  

MFP is an HEC analysis application that processes meteorological 
forecasts for input to HEC-HMS.  Inputs are forecasted  
meteorological data such as precipitation and temperature.  Outputs are 
forecasted meteorological time series formatted for compatibility with 
HEC-HMS.  

Meteorologic model   Meteorologic models are one of the main components in an HEC-HMS 
project.  Their principal purpose is to prepare meteorologic boundary 
conditions for subbasin runoff computations.  
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HEC-MetVue  HEC-MetVue is an HEC analysis application that processes observed 
meteorological data for input to HEC-HMS.  Inputs are either point or 
gridded estimates of meteorological data such as precipitation and 
temperature.  Outputs are observed meteorological time series 
formatted for compatibility with HEC-HMS  

Model alternative  A model alternative is a single model configuration with a specific set of 
input and parameters.  A second model alternative would be defined by 
a different configuration or different input or parameters.  

Modeling module  The Modeling module in the CAVI is the grouping of commands for 
model execution.  These are commands for setting up and executing 
analysis applications and viewing results.  

Module  Commands in the CAVI are organized by function: watershed setup, data 
acquisition, data visualization, and model execution.  A module is the 
grouping of commands related to a function.  The CAVI contains the 
Setup module for watershed setup, the Acquisition module for data 
acquisition, the Visualization module for data visualization, and the 
Modeling module for model execution.  Each module has menus, tools, 
and a display area specific to its function.  

Northing  Northing is the y coordinate of a location in the user-selected World 
Coordinate System.  

 

National Weather Service 
(NWS)  

NWS is a Federal agency that makes and issues meteorologic and 
hydrologic forecasts.  NWS forecasts may be used as input for HEC-RTS 
simulations.  

Off-channel storage area  In HEC-RAS, an off-channel storage area is a modeling element used to 
represent ponded water in interior areas, adjacent ponds and lakes, 
urban areas next to rivers, etc.  

Parameter  A parameter is a representation of a watershed condition in a model of 
the watershed.  You can set parameter values using the CAVI.  Varying 
parameters may vary analysis results.  

Precipitation grid  A precipitation grid is a spatial representation of precipitation over the 
whole watershed for an interval of time.  
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Project benefit  A project benefit is a reduction in adverse flood consequences 
attributable to a project or projects.  Project benefit commonly is 
computed as the difference between the without- and with-project 
consequences.  

Projects  Projects are man-made structures such as reservoirs or levees that are 
built to control water.  

Quality color bar  The quality color bar is a thick, segmented line shown in the CAVI display 
area that represents the history of the data quality at a specific location 
within the time window you have established.  

Quantitative  
precipitation forecast 
(QPF)  

QPF is a spatial and temporal precipitation forecast for a specified region 
or area.7  

Raw data  Raw data are data that are collected, transmitted and received, but not 
yet subjected to quality tests and revised. 
 

Regulated flow  Regulated flow is flow that has been changed from its natural state due 
to the influence of hydraulic constrictions or manmade influences.  

Reservoir  A reservoir is a structure built to control water for uses such as flood 
control, hydropower generation, and water supply.  Storing water in a 
reservoir can reduce flood consequences by regulating flow to reduce 
flood stages.  

 

Reservoir System  
Simulation  
(HEC-ResSim)  

HEC-ResSim is an HEC analysis application that simulates behavior of 
reservoirs and linking channels, following user-specified operations for 
reservoir release decision making.  Inputs include flows into reservoirs 
and unregulated flows downstream of reservoirs.  Outputs include 
reservoir releases, downstream regulated flows, and reservoir storage 
conditions.  

Revised data  Revised data are data that are validated and transformed for use in 
modeling.  They are saved to the CWMS database and are identified as 
potentially revised data.  

River Analysis System 
(HEC-RAS)  

HEC-RAS is an HEC analysis application that simulates, in one-dimension, 
behavior of channels and adjacent floodplains.  This permits 
determination of water surface elevations corresponding to flows 
computed by HEC-HMS or HEC-ResSim.  Inputs include flows, and 
outputs include water surface elevations.  
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River Analysis System 
Mapper (RAS Mapper)  

RAS Mapper is an interface included in HECRAS that allows you to use 
and visualize floodplain geospatial information along with HEC-RAS 
analysis results.  

Routing reach  A routing reach is a portion of a stream network.  In HEC-HMS and HEC-
ResSim, a routing reach is a modeling element used to compute 
behavior of flow in a channel.  

Scripting  Scripting is the process of automating the actions of a program, so a 
prescribed sequence of actions can be executed with a single action.  

Setup module  The Setup module in the CAVI is the grouping of watershed setup 
commands.  These are commands for configuring inputs, models, and 
outputs that describe a watershed’s behavior.  

Simulation  A simulation is a mathematical representation of the behavior of a 
system, given inputs and initial conditions.  

Stage  Stage is the vertical distance of a water surface above or below a local or 
national datum.  

Stream alignment  A stream alignment is a representation of the stream network in the 
watershed.  The alignment shows routing reaches and indicates where 
confluences and bifurcations occur and provides a sense of distance and 
scale.  

Stream element  A stream element is part of the representation of the stream network in 
the watershed.  Specifically, a stream element is a segment of the 
stream alignment that is composed of vertex points (points with known 
coordinates).  The beginning and ending vertex points of a stream 
element are stream nodes.  Stream elements typically begin or end at a 
confluence, bifurcation, or at the boundary of the river system.  

Stream junction  Stream junctions are part of the representation of the stream network in 
the watershed.  Specifically, a stream junction is a point where two 
stream elements meet (two stream nodes at one location).  

Stream node  Stream nodes are part of the representation of the stream network in 
the watershed.  Specifically, stream nodes are the beginning and ending 
points for each stream element.  Stream nodes are also points where 
stream elements meet (stream junctions).  
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Time series  A time series is an ordered sequence of values of a property or state at 
equally spaced time intervals.5  HEC-DSS supports time series composed 
of irregularly spaced increments.  

Time series icon  A time series icon is a symbol in the display area that provides quick 
access to time-series data assigned to the icon.  The location of the time 
series icon on the watershed map corresponds to the location to which 
the data pertains.  Time series icons can be used to view data, images, 
web pages, scripts, and document files.  

Time window  A time window is the duration that will be simulated.  A time window is 
defined by starting and ending dates and times.  

Transform method  The transform method is a model for calculating surface runoff from 
precipitation on a subbasin.  

U.S. Army Corps of 
Engineers (USACE)  

USACE is a Federal agency that operates about 700 water control 
projects in the U.S. as part of its water control management mission.  
These projects include reservoirs, navigation locks and dams, and levee 
and bypass systems with closure and diversion structures.  

Stream stationing  Stream stationing is a reference system for locating features with 
distance along a stream.  CWMS creates and labels stream stations (or 
river stations) along each stream element.  The station at the 
downstream end of an element is Station 0 (zero), and the stationing 
increases upstream along the element according to the linear distance 
between vertices on the stream element in the watershed coordinate 
system.  

Subbasin  A division of a watershed typically delineated based on the terrain within 
the watershed.  The entire precipitation within a subbasin drains to a 
common point.  

Supplemental program  A supplemental program is a program or script that is not included with 
HEC-RTS.  The program or script is developed by the user and may be 
added to the program order so it will be executed from HEC-RTS.  

Threshold color bar  The threshold color bar is a thick, segmented line shown in the CAVI 
display area that represents a linear histogram that compares current 
data against threshold values set for a location.  
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UNET (HEC-UNET)  HEC-UNET is a software application that models one-dimensional, 
unsteady, openchannel flow.  HEC-UNET models flow in single reaches or 
networks of interconnected channels.  It is a predecessor of HEC-RAS.  

United States  
Geological Survey (USGS)  

USGS is a Federal agency that collects hydrologic data with a network of 
gages and reports the data in real-time.  

Validation list  A validation list is a way to organize data in the CWMS database for 
editing or validation.  

Vertex point  A vertex point is a point with known coordinates on a stream element in 
the stream alignment.  

Visualization module  The Visualization module in the CAVI is the grouping of commands for 
data visualization.  These are commands for displaying observed and 
forecast data to evaluate the hydrometeorological state of the 
watershed.    

Watershed  In HEC-RTS, a watershed is a set of data, models, and images that 
represent watershed lands and the channels, gages, and water control 
features within the watershed.  

Watershed pane  The watershed pane in the CAVI refers to the set of Visualization, 
Acquisition, Modeling, and Setup module tabs (tabbed menus).  Clicking 
a module tab opens that module in the CAVI.  

World Coordinate System 
(WCS)  

To maintain a geographic reference (also called a geo-reference), HEC-
RTS uses a user-selected and customizable coordinate system, called the 
World Coordinate System.  This superimposes a grid on layer features to 
establish x and y coordinates in WCS for each point on the layer.  The x 
coordinate is referred to as “easting,” and the y coordinate is referred to 
as "northing.”  Possible choices for the WCS include but are not limited 
to State Plane Coordinates and Universal Transverse Mercator (UTM) 
coordinates.  

Zone  A set of subbasins in the watershed.  
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APPENDIX B   
 

HEC-RTS Application Settings 
 

B.1 Working with Watershed Directories and Files 
When a new watershed is created, HEC-RTS generates a directory structure and stores all files 
associated with the watershed inside that structure.  The watershed directory is named according 
to the name given to the watershed; for example, in figure B.1, the watershed directory is Bear 
River Watershed.  Figure B.1 shows schematically how CWMS organizes the directories and 
files it creates in the watershed’s project directory.  The watersheds directory configuration files 
and data for the watershed, including maps schematic elements, and model alternative data. 

 

Figure B.1 HEC-RTS Directory Structure 

When models are imported into the watershed, HEC-RTS creates a new folder (named after the 
program) in the watershed directory and copies the model files into that respective folder. 

Furthermore, when a new forecast is created, HEC-RTS creates a directory named forecasts if it 
does not exist in the watershed directory.  HEC-RTS then creates a dated forecast directory 
named according to the date of the forecast.  For example, the directory named jul2010 
corresponds to a forecast created for July 2010.  HEC-RTS automatically copies all of the 
directories and files for the watershed (except for maps) into the dated forecast directory.  This 
facilitates archiving of forecast information and ensures consistency in the model results. 
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B.2 Setting Application Options 
HEC-RTS allows for the configuration of several application options.  The user can specify the 
cache directory for maps and data files and clear the cache; configure the display for the 
Compute Progress dialog, specify debug levels, and can specify the location of the DBI server 
for the watershed. 

B.2.1 Setting the CWMS_HOME Directory 
The CWMS_HOME Directory is the location where HEC-RTS will look for required files.  By 
default, this location is the CAVI folder where HEC-RTS is installed.  If desired, this location 
can be changed. 

To override the local CWMS_HOME directory location: 

1. On the Tools menu, click Options, and the Options dialog (Figure B.2) opens.  Click the 
CWMS_HOME Directory tab. 

 

Figure B.2 Options Dialog - CWMS_HOME Directory Tab 

2. Check the Override local CWMS_HOME directory environment setting box. 
3. The CWMS_HOME Directory box is now active.  Enter a directory name that specifies 

where HEC-RTS should copy the map layers.  This directory name is entered in the 
CWMS_HOME Directory field.  If the directory entered does not exist, CWMS tells the 
user that the directory does not exist (you must enter an existing directory name). 

4. Another way to enter a directory name is to click Browse.  The Open browser will open 
(Figure B.3).  Navigate to the directory on the computer or network to be the cache 
directory.  Click OK, the Open browser closes and the cache directory appears in the 
Cache Directory box. 

5. Click OK, and the Options dialog box will close (Figure B.2). 
6. The next time the watershed is opened, a directory with the watershed name will be 

created under the cache directory identified. 



HEC-RTS User’s Manual                                          Appendix B – HEC-RTS Application Settings 

 

B-3 
 

 

Figure B.3 Open Browser 

B.2.2 Configuring the Compute Progress Dialog Box 
When computing a forecast in the Models Module, the Compute Progress dialog (Figure 13.3) 
reports on the progress of the forecast and presents warning and error messages generated by the 
forecast.  The display of the Compute Progress dialog can be configured.  There are several 
options available. 

To configure the display of the Compute Progress dialog box: 

1. On the Tools menu, click Options (from any module). 
2. The Options dialog opens.  Click the Compute Colors Tab (Figure B.4). 
3. For the display of the Compute Progress dialog, colors for normal messages, warning 

messages, and error messages can be set.  There are thirty-two color choices in each of 
the lists.  Change the color of messages by selecting a color from the lists. 

4. To save the Compute Log Report (Section 13.2.1) as an HTML file for web page 
viewing, click Use HTML for Logs.  The background color of the HTML file can be set 
to either white or gray by selecting the color from the HTML Background Color list. 

5. Once all of the settings are done, click OK.  The Options dialog will close.  For any of 
the changes to take effect, the forecast must be recomputed. 
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Figure B.4 Options Dialog – Compute Colors Tab 

B.2.3 Specifying Debug Levels 
Debug levels can be set for thirty-two components of HEC-RTS.  These debug levels will control 
the amount of error messages that are written to the CAVI Console (DOS command) window.  
Some of the available debug levels are scripting, HEC-GridUtil, plot defaults, units, HEC-
ResSim operations, map layers (maps), general watershed functions (rmiworkspace), data type 
factory, parameters, file locking, HEC-ResSim reports, and more.  The default debug level is 
three. 

To set debug levels: 

1. On the Tools menu, click Options. 
2. The Options dialog will open, click the Debug Tab (Figure B.5). 
3. To set the level of debugging higher or lower than 3, change the value in the DSS Debug 

Level cell. 
4. Once the debug levels have been set, click OK.  The Options dialog will close. 

 

Figure B.5 Options Dialog – Debug Tab 

B.2.4 Setting General Options 
From the General Tab on the Options dialog box accessed from the Tools menu, options can be 
turned “off and on”.  By default, HEC-RTS will automatically save the project on exit, restore 
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layout, show tooltips, and cascade internal windows.  It is possible to turn these options off.  
Additional options that are available include loading last watershed at startup, show startup 
screen, sync project tree to map window, and setting the watershed save interval. 

To turn these options “off”: 

1. On the Tools menu, click Options. 
2. The Options dialog will open.  Click the General Tab (Figure B.6). 
3. Click one of the option boxes to clear the check mark, thus turning off the option. 
4. Click OK to save the changes and close the Options dialog. 

By default the following options are turned off in HEC-RTS: load last watershed at startup, show 
startup screen, and sync project tree to map. 

To turn an option “on”: 

1. On the Tools menu, click Options. 
2. The Options dialog will open.  Click the General Tab (Figure B.6). 
3. Click one of the option boxes to set the checkmark, thus turning on the option. 
4. Once the options have been specified, click OK.  The Options dialog will close and the 

changes will be saved. 

 

Figure B.6 Options Dialog – General Tab 
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APPENDIX C   
 

Setting Up the Coordinate System 
 
HEC-RTS has introduced “on-the-fly” coordinate system transformation to the CAVI and related 
programs.  This allows the CAVI to display map layers that were created in different coordinate 
systems in a unified view.  For example, a watershed can be displayed with background maps 
from Internet sources such as Google Maps and Open Street Map.  This feature works correctly 
only if a geo-referenced coordinate system is defined for the watershed and include a coordinate 
system definition (*.prj file or equivalent) for each map layer included in the watershed.  
 
The positions of elements in the watershed’s primary layers (Time Series Icons, Stream 
Alignment, and Study layers) are stored in the watershed coordinate system.  The watershed’s 
coordinate system can be set when creating a new watershed or change the coordinate system 
after the watershed has been created.  This superimposes a grid on layer features to establish x- 
and y-coordinates in the World Coordinate System (WCS) for each point on the layer.  The x-
coordinate is referred to as “easting” and the y-coordinate is referred to as “northing” following 
customary use in surveying and mapping.  The user can select the extent of this grid, the units of 
measurement of the grid, and even the location of the origin of the grid.  This appendix focuses 
on how to setup and edit different coordinate systems.  
 

C.1 Geographic Referencing 
To maintain a geographic reference, a coordinate system must be specified for each watershed.   
To establish the grid size and coordinate system:  
 
1. On the Maps menu, click Default Properties Map; the dialog will open (Figure C.1). 
2. The information in the Default Map Properties dialog box includes: 
• Coordinate System: this box identifies the established coordinate system for a watershed.  

To edit the coordinate system, click Edit. 
• Extents – Easting Minimum, Maximum, Northing Min, and Max.  These values indicate the 

location of the left, top, right, and bottom borders of the grid in the display area.  When 
“Zoom to All” is used from the Maps menu, the displayed map extents expand to include the 
full area enclosed by these coordinates. 

• Set Map Extents to Display.  When this button is clicked, HEC-RTS sets the geographic 
extents to match the display area. 

• Grow to Map Extents.  When this check box is selected, HEC-RTS automatically sets the 
geographic extents to define the smallest rectangle that encompasses all the objects in the 
workspace. 
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Figure C.1 Default Map Properties Dialog 

Note that the geographic extents of the layers must be selected carefully to ensure that the entire 
watershed is included.  In HEC-RTS, it’s no longer necessary that all map layers be in the same 
coordinate system.   
 
HEC-RTS can transform coordinates “on-the-fly” if their coordinate systems are defined 
properly in ways that the program can read, for example an ESRI projection (*.prj) file.  
Therefore, the use of GIS tools may be needed to identify or transform the layers from one 
coordinate system to another before using them with HEC-RTS.  Although HEC-RTS has the 
ability to project different coordinate systems “on the fly,” using a consistent coordinate system 
may produce more accurate placement of map elements and may result in better performance in 
displaying large maps.  
 

C.2 Coordinate System Types 
A coordinate system is a method of representing points in a space of given dimensions by 
coordinates.  There are several different types of coordinate systems; including geographic 
coordinate systems, which are based on latitude and longitude coordinates, and projected 
coordinate systems, which  represent the projection of a geographic coordinate system on a plane 
and use linear measures (like feet or meters) for coordinates.  
 
The coordinate systems available in HEC-RTS are shown in Table C.1.  This table also shows 
the units required for each coordinate system.  
 
A spheroid (ellipsoid) is the shape of the earth used in the calculations that transform positions 
on the curved surface of the earth to positions on a flat map.  It is part of the horizontal datum, 
which approximates the curved surface of the earth over part of the globe.  
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Table C.1 Coordinate Systems Available in HEC-RTS 

Coordinate Systems  Units  

X-Y  Linear units (feet or meters)  
Geographic  angular units (radians, degrees of arc, or 

seconds)  
Universal Transverse Mercator  Linear units (feet or meters)  
State Plane Coordinates  Linear units (feet or meters)  
Albers Equal-Area Conic  Linear units (feet or meters)  
Lambert Conformal Conic  Linear units (feet or meters)  
Transverse Mercator  Linear units (feet or meters)  
Albers Equal-Area Conic (SHG)  Linear units (feet or meters)  
Polar Sterographic (HRAP)  Linear units (feet or meters)  

 

C.2.1 X-Y Coordinate System 
The label “X-Y” can be applied to a coordinate system that is either not geo-referenced or for 
which the geo-referencing method is unknown.  When the “X-Y” coordinate system is selected, 
the CAVI cannot project maps to the watershed’s coordinate system.  
 
To set parameters for the X-Y Coordinate System:  
1. On the Maps menu, click Map Default Properties, and the dialog will open (Figure C.1). 

2. Click Edit, and the Map Coordinate Information dialog will open (Figure C.2). 

3. From the System list, select X-Y. 

4. From the Units list, select the units for the X-Y coordinate system. 

5. Click OK, and the Map Coordinate Information dialog will close, and the program will 
return to the Default Map Properties dialog box. 
In the Coordinate System cell, X-Y should be displayed. 
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Figure C.2 X-Y Coordinate System 

C.2.2 Geographic Coordinate System 
To set parameters for the Geographic Coordinate System:  
1. On the Maps menu, click Default Map Properties, and the dialog will open (Figure C.1). 

2. Click Edit, and the Map Coordinate Information dialog will open (Figure C.3). 
 

 
Figure C.3 Geographic Coordinate System 

3. From the System list, select Geographic. 

4. From the Units list, select the units for the Geographic coordinate system.  The only units 
available should be Radians, Degrees of Arc, and Seconds of Arc. 

5. From the Spheroid list, select a spheroid type for the Geographic coordinate system.  (The 
“Sphere of Radius 6371200 meters” should only be used with the HRAP grid coordinate 
system.) 

6. Click OK, and the Map Coordinate Information dialog will close, and the program will 
return to the Default Map Properties dialog.  In the Coordinate System cell, Geographic 
should be displayed. 
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C.2.3 Universal Transverse Mercator Coordinate System 
The Universal Transverse Mercator (UTM) coordinate system is a projected coordinate system.  
UTM is used to define horizontal positions throughout the world by dividing the surface of the 
Earth into six-degree zones, with a central meridian in the center of each zone.  
 
To set parameters for the Universal Transverse Mercator Coordinate System:  
1. On the Maps menu, click Default Map Properties, and the dialog will open. 

2. Click Edit, and the Map Coordinate Information dialog will open (Figure C.4). 

3. From the System list, select Universal Transverse Mercator. 

4. From the Units list, select the units for the Universal Transverse Mercator coordinate system. 

5. From the Spheroid list, select a spheroid type for the Universal Transverse Mercator 
coordinate system. 

6. In the UTM Zone box, enter the UTM zone number.  To use a UTM zone in the southern 
hemisphere, enter a negative value for the zone number. 

7. Click OK, and the Map Coordinate Information dialog box will close.  The program will 
return to the Default Map Properties dialog box.  In the Coordinate System box, Universal 
Transverse Mercator should be displayed. 

 

 
Figure C.4 Universal Transverse Mercator Coordinate System 

C.2.4 State Plane Coordinate System 
The State Plane Coordinate System (SPCS) was established in the 1930's and now covers all 
fifty states.  Zones were established for each state using either the Lambert Conformal or 
Traverse Mercator projections. Units are generally in feet (NAD27) or meters (NAD83).  
 
To set parameters for the State Plane Coordinate System:  
1. On the Maps menu, click Default Map Properties, and the dialog will open. 
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2. Click Edit, and the Map Coordinate Information dialog box will open (Figure C.5). 

3. From the System list, select State Plane Coordinates. 

4. In the Zone box, enter the FIPS code for the state plane zone. 

5. Click OK, and the Map Coordinate Information dialog box will close.  The program will 
return to the Default Map Properties dialog box.  In the Coordinate System box, State 
Plane Coordinates should be displayed. 

 

 
Figure C.5 State Plane Coordinate System 

C.2.5 Albers Equal-Area Conic Coordinate System 
The Albers Equal-Area Conic projection is used by several federal government agencies for 
maps of the conterminous 48 states.  HEC uses an Albers projection for the definition of the 
Standard Hydrologic Grid (see Section C.2.8).  The equal area property of this projection means 
that areas in the map are proportional to the corresponding areas on the earth’s surface.   
 
Directions and shapes distort increasingly away from the central meridian and outside the two 
standard parallels.  
 
To set parameters for the Albers Equal-Area Conic Coordinate System:  
1. On the Maps menu, click Map Default Properties, and the dialog box will open. 

2. Click Edit, and the Map Coordinate Information dialog box will open (Figure C.6).  
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Figure C.6 Albers Equal-Area Conic Coordinate System 

3. From the System list, select Albers Equal-Area Conic. 

4. From the Units list, select the units for the Albers Equal-Area Conic coordinate system. 

5. From the Spheroid list, select a spheroid type for the Albers EqualArea Conic coordinate 
system. 

6. The remaining items to be entered are the angular parameters that are required to fine-tune 
the projection.  When specifying latitudes enter N or S, and for longitudes, enter E or W.  
Use the tab key to toggle between the entries. 

7. Click OK to save the changes and close the Map Coordinate Information dialog box.  The 
Default Map Properties dialog box will display Albers Equal-Area Conic as the Coordinate 
System. 

C.2.6 Lambert Conformal Conic Coordinate System 
The Lambert Conformal Conic projection is used extensively for mapping areas of the world 
with predominantly east-west orientation.  It is similar to the Albers Equal-Conic projection, but 
the projection is not done in an equal-area.  
 
To set parameters for the Lambert Conformal Conic Coordinate System:  
 
1. On the Maps menu, click Default Map Properties, and the dialog box will open. 

2. Click Edit, and the Map Coordinate Information dialog box will open (Figure C.7).  

3. From the System list, select Lambert Conformal Conic. 
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4. From the Units list, select the units for the Lambert Conformal Conic coordinate system. 

5. From the Spheroid list, select a spheroid type for the Lambert Conformal Conic coordinate 
system. 

6. When specifying latitudes enter N or S, and for longitudes, enter E or W.  Use the tab key to 
toggle between the entries. 

7. Click OK to save the changes and close the Map Coordinate Information dialog box.  The 
Default Map Properties dialog box will display Lambert Conformal Conic as the 
Coordinate System. 

 

 
Figure C.7 Lambert Conformal Conic Coordinate System 

C.2.7 Transverse Mercator Coordinate System 
The Transverse Mercator projection is where a sphere is projected onto a cylinder tangent to a 
central meridian.  It is similar to the Lambert Conformal Conic project but is used to portray 
large areas in a north-south orientation.  Many national grid systems are based on the Transverse 
Mercator projection.  
 
To set parameters for the Transverse Mercator Coordinate System:  
1. On the Maps menu, click Default Map Properties, and the dialog will open. 

2. Click Edit, and the Map Coordinate Information dialog will open (Figure C.8). 

3. From the System list, select Transverse Mercator. 

4. From the Units list, select the units for the Transverse Mercator coordinate system. 

5. From the Spheroid list, select a spheroid type for the Transverse Mercator coordinate 
system. 



HEC-RTS User's Manual  Appendix C – Setting Up the Coordinate System  

C-9 
 

6. Enter a scaling factor for central meridian, in the Scale factor at central meridian cell. 

7. When specifying latitudes enter N or S, and for longitudes, enter E or W.  Use the tab key to 
toggle between the entries. 

8. Click OK to save the changes and close the Map Coordinate Information dialog box.  The 
Default Map Properties dialog box will display Transverse Mercator as the Coordinate 
System. 

 

 
Figure C.8 Transverse Mercator Coordinate System 

C.2.8 Albers Equal-Area Conic (SHG) Coordinate System 
This is a special case of the Albers Equal-Area Conic coordinate system.  The projection 
parameters are set to match USGS 48-state maps, which are used for several common data 
sources including precipitation data on the Standard Hydrologic Grid.  If this option is selected 
for the coordinate system, all parameter fields will be filled in the editor.  This coordinate system 
is also used by USACE’s MMC, but with units of US Feet instead of meters.  The watershed can 
be quickly set to MMC’s coordinate system by selecting the SHG system and then switching the 
units to “US Feet”.  
 
To use the parameters for the Albers Equal-Area Conic (SHG) Coordinate System:  

1. On the Maps menu, click Default Map Properties, and the dialog box will open. 

2. Click Edit, and the Map Coordinate Information dialog box will open (Figure C.9). 
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Figure C.9 Albers Equal-Area Conic (SHG) Coordinate System 

3. From the System list, select Albers Equal-Area Conic (SHG). 

4. From the Units list, select the units for the Albers Equal-Area Conic (SHG) coordinate 
system. 

5. From the Spheroid list (Figure C.9), select a spheroid type for the Albers Equal-Area 
Conic (SHG) coordinate system. 

6. The remaining parameters are informational and are not editable. 

7. Click OK to save the changes and close the Map Coordinate Information dialog box.  The 
Default Map Properties dialog box will display Albers Equal-Area Conic as the Coordinate 
System.  Note that the (SHG) label is not part of the displayed coordinate system name, and 
that if the editor is re-opened all parameters of the projection will be editable. 

C.2.9 Polar Stereographic (HRAP) Coordinate System 
The Hydrologic Rainfall Analysis Project grid is used by the US National Weather Service for a 
variety of precipitation products.  The row and column numbers in the grid are based on a Polar 
Stereographic projection of the northern hemisphere.  The parameters are set to match NWS map 
coordinates used for radar grids, so do not change any parameter settings.  
 
To use the parameters for the Polar Stereographic (HRAP) Coordinate System:  
1. On the Maps menu, click Default Map Properties, and the dialog box will open. 

2. Click Edit, and the Map Coordinate Information dialog box will open (Figure C.10). 
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Figure C.10 Polar Stereographic (HRAP) Coordinate System 

3. From the System list, select Polar Stereographic (HRAP). 

4. For Version 3.0, ignore the items in the Axis box; this will be removed from this dialog box 
in a later version of HEC-RTS. 

5. The remaining parameters are informational and are not editable. 

6. Click OK to save the changes and close the Map Coordinate Information dialog box.  The 
Default Map Properties dialog box will display Polar Stereographic (HRAP) as the 
Coordinate System. 



Appendix C – Setting Up the Coordinate System  HEC-RTS User's Manual  

C-12 
 

 

 

 

 

 

 

 

  



HEC-RTS User's Manual  Appendix D – Using Map Editors  

D-1 
 

APPENDIX D   
 

Using Map Editors 
 

There are 10 map layer formats supported by HEC-RTS, and the different map layers are 
described in Section 5.2 of this manual.  In HEC-RTS several options can be configured for each 
type of map layer, except for AutoCAD® DXF files.  Additional customization is in 
development for future versions of the software.  

To access the map layers editor, from the Maps menu, click Map Layers. The Map Layers 
editor will open (Figure D.1).  From the Layer Tree either double-click on a map layer name, or 
right-click on a map layer name and click Properties from the shortcut menu.  An editor specific 
to the type of map layer selected will open.  
 

 
Figure D.1 Map Layers Editor 

D.1 ArcGIS® Shapefiles (.shp) 
Shapefiles store non-topological geometry and attribute information for geo-referenced points, 
lines, or polygons.  The format is native to ESRI’s ArcGIS programs.  Vector GIS layers can be 
exported from ArcGIS databases to shapefiles for display in HEC-RTS watersheds.  

To edit the display properties of a line, polygon, or point shapefile:  
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1. From the Layer Tree (Figure D.1), right-click on an ArcGIS® shapefile from the 
shortcut menu and click Properties or double-click on the ArcGIS® shapefile filename.  

2. If the shapefile chosen is a polygon, the Edit Polygon Properties dialog will open 
(Figure D.2). 

3. Across the top of the dialog is displayed the location and name of the shapefile. 

To edit properties of an ArcGIS® shapefile:  

1. Click the Fill tab of the Edit Polygon Properties dialog (Figure D.2). 

2. The Draw Features using option allows for selection of how the feature will be drawn, 
either using One Fill or the Attribute Values.  If Attribute Values is selected, this option 
will associate the Field for values from the shapefile to a color and label.  In Figure D.2, 
AREA has been selected, which displays the value of the AREA in the shapefile as blue to 
red gradations. 

3. By default, the shapefile will display lines and areas (polygons).  To turn off the fill, clear 
the Display Fill cell. 

4. To change the style of line or polygon areas use the Style selection list 

5. To classify the values in the Field for values check the Use Gradations cell and specify 
the number of classes.  This will group the values in the Field for values into the range 
of classes specified. 

6. The Transparency bar controls to what level the transparency of the shapefile will be 
displayed. 

7. The properties of the color editor are discussed in detail in Appendix E.  From the color 
palette, select a color.  If the feature is being drawn using an attribute value, select a color 
for the start and end value. 
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Figure D.2 Edit Polygon Properties dialog – Fill Tab 

8. Click Apply, and the color for the selected field will appear in the display area.  Click 
OK, and the Edit Polygon Properties dialog will close. 

9. To save any changes, from the File menu, choose Save Watershed.  Changes are saved 
to a file with the extension *.gdr.  For example, if the shapefile name is subbasin.shp, 
and changes have been made and saved, a file subbasin.gdr will be created. 

To change the border color, style and weight of the ArcGIS® shapefile:  

1. Click the Border tab of the Edit Polygon Properties dialog (Figure D.3). 

2. The border display setting can be changed in this dialog. 
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Figure D.3 Edit Polygon Properties dialog – Border Tab 

To format the labels of the ArcGIS® shapefile:  

1. Click the Label tab of the Edit Polygon Properties dialog (Figure D.4). 
 

 
Figure D.4 Edit Polygon Properties dialog – Labels Tab 

2. To display labels associated with the shapefile, click on the Label features using drop 
down window and choose the attribute field which the labeling will be based on. 

3. The Font, Size, and Placement of the label can be changed in this window. 
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D.2 USGS Digital Line Graph (.dlg) 
This layer type is a vector representation of the data.  When HEC-RTS interacts with a dlg file it 
automatically creates a dlgbin file for use.  

To edit a USGS Digital Line Graph file:  

1. From the Layer Tree (Figure D.1), right-click on a USGS Digital Line Graph file.  
From the shortcut menu, click Properties, or double-click on the USGS Digital Line 
Graph filename. 

2. The USGS Digital Line Graph Editor will open (Figure D.5). 

3. Across the top of the dialog is displayed the location and name of the USGS Digital 
Line Graph file. 
 

 
Figure D.5 USGS Digital Line Graph Editor – Properties Tab 

4. The appearance of nodes, line, and areas can be controlled by selecting and clearing 
Draw Nodes, Draw Lines, and Draw Areas, respectively (Figure D.5). 

5. The saturation and brightness level of the selected color can be controlled by entering 
values in the Saturation or Brightness cells.  Values entered for saturation or 
brightness must be between zero (0) and one (1). 

6. To save any changes, from the File menu of the CAVI Main Window, choose Save 
Watershed.  The color for a USGS digital line graph file is stored in the watershed file 
(*.wtshd). 

To set scaling for a USGS Digital Line Graph:  

1. Click the Scale tab of the USGS Digital Line Graph Editor (Figure D.6).  
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2. Both zoom-in and zoom-out scale factors can be set.  By default the digital line graph 
layer is set for Always show layer.  To set visualization scales click Only show layer in 
the following scale range. 

 

 
Figure D.6 USGS Digital Line Graph Editor – Scale Tab 

3. To set the scale so that the digital line graph layer becomes visible while zooming in, the 
scale can be set to the current scale by clicking Set to Current.  To enter a value, from 
the Only visible below 1: cell enter the scale factor. 

4. To set the scale so that the digital line graph layer becomes visible while zooming out, 
the scale can be set to the current scale by clicking Set to Current.  To enter a value, 
from the Only visible above 1: cell enter the scale factor. 

5. Click OK, the USGS Digital Line Graph Editor will close (Figure D.6), and the 
visualization scale is set for the digital line graph layer. 

6. Click OK, the Map Layers editor closes (Figure D.1). 

D.3 Elevation Options Dialog 
For the other map layer formats – USGS DEM, ASCII NetTin, and ArcGIS® DEM; they all 
have the same editor, the Elevation Options dialog.  

To edit an ASCII NetTin file:  

1. From the Layer Tree, right-click on an ASCII NetTin file.  From the shortcut menu, 
click Properties, or double-click on the ASCII NetTin name.  

2. The Elevation Options dialog will open (Figure D.7).  

3. Across the top of the dialog, is displayed the name of the ASCII NetTin file.  
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Figure D.7 Elevation Options Dialog - Properties Tab 

To edit properties of an ASCII NetTin file:  

1. Click the Properties tab of the Elevation Options dialog (Figure D.7).  

2. From the dropdown list, there are available color contour schemes – Aspect Shading, 
Grayscale, Linear, Precipitation, Red-GreenBlue, and Terrain (default).  

3. The Draw Edges check box is specifically for ASCII NetTin files.  If selected, the edges 
of the triangles that make up an ASCII NetTin file will be drawn.  

4. The contour tic interval can be set by entering a value in the Tic Interval cell.  The 
program sets the maximum and minimum limits of the contours automatically.  The user 
can set their own maximum and minimum limits.  Clear System Specified Min/Max 
Values, the Maximum and Minimum cells (Figure D.7) are now available to enter 
values.  

5. The brightness (amount of white), saturation (amount of black), and transparency (level 
of opacity or alpha) for the colors can be controlled.  The values can be adjusted by using 
the Brightness, Saturation, and Transparency slider bars or cells.  

6. By default the Aspect Shading option is on, aspect shading is where the map layer is 
made to appear in relief by placing an imaginary light source above the map and shading 
the contours.  The angle of the light source can be adjusted by using the Angle slider bar 
or the cell.  If aspect shading is not wanted, clear Aspect Shading.  

7. Clipping provides a way to highlight an area based on color choices and values.  For 
maximum clipping, fill the contour with the clip color from the maximum value of the 
map to the value entered for Maximum Clipping.  An example of where maximum 
clipping might be used would be smog levels, cloud cover, or snow level at a particular 
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elevation.  By default, maximum clipping is turned off, to select click Maximum 
Clipping.  Then either enter a maximum clipping value by using the slider bar or enter a 
value in the cell.  The Maximum Clipping color can also be set.  Click Color, the Color 
Chooser will open (see Appendix E for more on the color chooser).  From the color 
palette, select a color, click OK.  The Color Chooser will close and the selected color 
will now appear on the Color button and at the top of the Scale (Figure D.7).  

8. Minimum clipping will fill the contour with the clip color from the minimum value of the 
map to the value entered for Minimum Clipping.  An example of where minimum 
clipping might be used would be to see where a water level would be if it flooded to a 
particular elevation.  By default, minimum clipping is turned off, to select click 
Minimum Clipping.  Then either enter a minimum clipping value by using the slider bar 
or enter a value in the cell.  The Minimum Clipping color can also be set.  Click Color 
and the Color Chooser will open (see Appendix E for more on the color chooser). From 
the color palette, select a color, and click OK.  The Color Chooser will close and the 
selected color will now appear on the Color button and at the bottom of the Scale (Figure 
D.7).  

To set scaling for an ASCII NetTin file:  

1. Click the Scale tab of the Elevation Options dialog (Figure D.8).  
 

 
Figure D.8 Elevation Options dialog - Scale Tab   

2. Both zoom-in and zoom-out scale factors can be set.  By default the ASCII NetTin layer 
is set for Always show layer.  To set visualization scales click Only show layer in the 
following scale range.  

3. To set the scale so that the ASCII NetTin layer becomes visible while zooming in, set the 
scale to the current scale by clicking Set to Current.  To enter a value, from the Only 
visible below 1: cell enter the scale factor.  

4. To set the scale so that the ASCII NetTin layer becomes visible while zooming out, set 
the scale to the current scale by clicking Set to Current.  To enter a value, from the Only 
visible above 1: cell enter the scale factor.  



HEC-RTS User's Manual  Appendix D – Using Map Editors  

D-9 
 

5. Click OK, the Elevation Options dialog will close (Figure D.8), and the visualization 
scale is set for the ASCII NetTin layer.  

6. Click OK, and the Map Layers editor closes (Figure D.1).  
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APPENDIX E   
 

Using Color Chooser 
 

The Color Chooser window (Figure E.1) affords great flexibility when needing to select default 
colors for map layers, labels, and background colors in the watershed display.  The Color 
Chooser window has three tabs: Swatches, HSB, and RGBA, offering three methods for 
choosing a color.  For each method, the preview area allows the user to see their choice before 
applying changes.  

 
Figure E.1 Color Chooser – Swatches Tab 

  

E.1 Swatches Tab 
The Swatches tab provides a palette of pre-defined colors.  From the palette, select a color.  
Once a color has been selected, the Recent field displays that color, as also does the Preview 
field.  Click OK, and the Color Chooser dialog will close.  Depending on where the Color 
Chooser was accessed, click either Apply or OK for the color change to appear in the display 
area.  

For example, for a stream alignment, the Color Chooser would have been accessed from the 
Stream Alignment Properties dialog.  After selecting the color from the Color Chooser dialog 
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and clicking OK, click OK or Apply from the Stream Alignment Properties dialog.  Then 
click OK from the Map Layer dialog for the color change to appear in the Map Window.  

E.2 HSB Tab 
HSB is the Hue, Saturation, and Brightness color model, which allows the user to set the hue, 
saturation, and brightness of the colors.  From the Color Chooser window, select the HSB tab; 
and the HSB tab (Figure E.2) becomes available.  

 
Figure E.2 Color Chooser – HSB Tab 

  
There are several ways to adjust the hue, saturation, value, and transparency of the colors.  The 
slider bar, in conjunction with the Hue, Saturation, and Brightness options will change the 
selected color.  Or a value can be entered directly for Hue, Saturation, and Brightness cells.  
The following rules apply to the values that can be entered for each cell:  

• Hue: Hue is measured in a circle from zero (0) to 359 degrees as follows: 0 = red, 60 = 
yellow, 120 = green, 180 = cyan, 40 = blue, 300 = magenta.  

• Saturation: Saturation is the amount of black measured from zero (0) to one hundred (100) 
percent.  

• Brightness: Is a measurement of the brightness of a color measured from zero (0) to one 
hundred (100) percent.  A value of zero (0) is considered black.  
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The final way to set a color on the HSB tab is from the color palette.  Click and drag the 
crosshair symbol, which will automatically change the hue, saturation, and value, along with the 
red, green and blue color values.  

Click OK, and the Color Chooser window will close.  Depending on where the Color Chooser 
window was accessed from, click either Apply or OK for the color change to appear in the 
display area.  

E.3 RGBA Tab 
RGBA is the Red, Green, Blue, and Alpha color model, which allows the user to set the red, 
green, blue and alpha values of the colors.  From the Color Chooser window, select the RGBA 
tab; and the RGBA tab (Figure E.3) becomes available.  

 
Figure E.3 Color Chooser – RGBA Tab 

  
There are two ways to adjust the red, green, blue, and alpha value of colors. There is a slider bar 
for Red, Green, Blue, and Alpha.  Alpha controls the opacity of the color.  While changing the 
slider bar for each one, the color being produced is shown in the Preview field.  Another way to 
affect the color is to directly enter a value in the Red, Green, Blue, and Alpha cells.  Click OK, 
and the Color Chooser window will close.  Depending on where the Color Chooser window 
was accessed from, click either Apply or OK for the color change to appear in the display area.  



HEC-RTS User's Manual                                                         Appendix E – Using Color Chooser 
 

E-4 
 

 



HEC-RTS User's Manual  Appendix F – Using DSS-Vue  

  F-1  

APPENDIX F   
 

Using DSS-Vue 
 

DSS-Vue (Data Storage System Visual Utility Engine) is a graphical user interface program for 
viewing, editing, and manipulating data in HEC-DSS files.  With DSS-Vue, data may be plotted, 
tabulated, edited, and manipulated with over fifty mathematical functions.  Along with these 
functions, DSS-Vue provides several utility functions, such as entering data sets into a database, 
renaming data set names, copying data sets to other database files, and deleting data sets.  

In HEC-RTS, DSS-Vue will be used mainly as a viewing tool for data.  This appendix will 
review some of the general functions in DSS-Vue (for further detail, see the HEC-DSSVue 
User's Manual).  

F.1 HEC-Data Storage System Concepts 
HEC-DSS is a database system that was designed to efficiently store and retrieve scientific data 
that is typically sequential.  Such data types include, but are not limited to, time series data, 
curve data, spatial-oriented gridded data, textual data, and others.  The system was designed to 
make it easy for users and application programs to retrieve and store data.  

DSS data is stored in blocks, or records, within a file, and each record is identified by a unique 
name called a pathname.  The pathname is formulated in a way that makes it easy to group 
related data together.   
 
Software from HEC has the ability to read from and write to HEC-DSS (DSS) files.  This 
capability facilitates data exchange among applications.  For example, you could use HEC-
ResSim to generate the time series data input for HEC-FIA.  A pathname may consist of up to 
391 characters and is, by convention, separated into six parts, which may be up to sixty-four 
characters each.  Pathnames are automatically translated into all upper case characters.  They are 
separated into six parts (delimited by slashes "/") labeled "A" through "F,” as follows: 
/A/B/C/D/E/F/.  Table F.1 provides an example naming convention for regular-interval time 
series.  A typical regular-interval time series might be:  

 

/RED RIVER/BEND MARINA/FLOW/01JAN1995/1DAY/OBS/  
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Table F.1 DSS Pathname Parts 

Part  Description  

A  Project, river, or basin name  

B  Location  

C  Data parameter (e.g., FLOW, PRECIP)  

D  Starting date of block, in a 9 character military format (ddmmyyyy)  

E  Time interval  

F  Additional user-defined descriptive information  

  

F.2 Overview of DSS-Vue in HEC-RTS 
From the Tools menu, choose HEC-DSS-Vue…, and the DSS-Vue main window opens.  The 
main window and the different components are illustrated in Figure F.1.  

   

 
Figure F.1 HEC-DSS-Vue Main Window  

The Menu Bar contains the menus for the main window of DSS-Vue.  The following list is a 
description of the available menus.  

  

Title Bar 
Menu Bar 

Main Toolbar 
File Information 

Pathname  
Filters 

Status Bar 

Selected  
Pathname List 

Selection Commands 

Pathname  
Table 
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• File: This menu is used for file management and contains the following:  New, Open…, 
Close DSS File(s), Print Catalog Preview, Print Catalog, a list of most recently opened 
files, and Close.  

• Edit: This menu allows editing of data in a tabular format or graphically thru a graphical 
editor, and this menu also provides options for manipulating records in a DSS file: renaming 
records, deleting records, undeleting records, duplicating records, copying records to another 
DSS file, and merging of DSS files.  Also, from this menu, it is possible to select all of the 
pathnames contained in the file.  The menu contains the following commands:  Tabular 
Edit, Graphical Edit, Select All, Rename Records, Delete Records, Undelete, Duplicate, 
Copy To, Merge (copy) into, and Edit in Excel.  

• View: This menu provides options for viewing HEC-DSS pathnames.  Available commands 
are: Pathname List, Pathname Parts, Condensed Catalog, No Pathnames, Unsorted 
List, Search by string, Search by parts, Refresh Catalog, Unit System, Time Zone, and 
Filter By Office/Groups.  

• Display: After a pathname has been selected, this menu provides the ability to display the 
data for that pathname.  Available commands are: Plot, Plot Individual Data Sets, 
Tabulate, Display Data Options, Supplemental Information, Time Window, Charts and 
Tabulate in Excel.  

• Groups: This menu provides management and commands for groups of data.  Available 
commands are: Save Selected, Get, Get (add to list), Plot, Plot Individual Sets, Tabulate, 
Math, and Manage.  

• Data Entry: This menu provides options for entering and adding data.  Available commands 
are: Manual Time Series, Manual Paired Data, Manual Text, Import, and Export.  

• Tools: This menu provides access tools for math operations, comparisons, and scripts.  
Available commands are: Math Functions, Compare, Search for Value, Check File 
Integrity, Squeeze, Script Editor, and Script Selector.  
 

• Advanced: This menu provides options for manipulating records in a DSS file.  Available 
commands are: Condensed Disk Catalog, Abbreviated Disk Catalog, Full Disk Catalog, 
Output, Debug, Program Options, and Console Output.  

• Help: Displays current version information about HEC-DSS-Vue.  

The Toolbar (Figure F.1) contains buttons that provide the capability to open a DSS file, plot the 
data, edit the data in a table, edit the data from a graphical editor, and apply math functions to the 
data.  These buttons provide a shortcut to the respective commands in the Display menu.  

 Open File Button – Opens an Open HEC-DSS File browser, which allows you to select 
a DSS file.  
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Plot Button – Plots the data of the selected pathname(s).  

Tabulate Button – Displays the data of the selected pathname(s) in a tabular form.  

Graphical Edit Button – Displays the data of the selected pathname(s) in a graphical 
editor.  

Math Functions Button – Allows the user to perform math functions on the data of the 
selected pathname(s) from the Math Functions dialog.   

The File Information panel (Figure F.1) displays the filename or database and path of the 
opened file/database, and statistics about the pathnames in the file and the size of the file or 
number of data sets in the HEC-DSS database.  
 

 

Figure F.1 Example HEC-RTS Database 

The Pathname Filters (Figure F.2) are used to sort pathnames by parts.  There is a filter list, A 
through F, for each individual part.  The Pathname Table displays the filtered data set names 
contained in the database.  The pathnames are displayed by the individual parts.  The Selected 
Pathname List displays the pathnames that were selected from the Pathname Table.  

The Select Commands (Figure F.1) are available after selecting the pathnames to view or 
manipulate.  Available commands are Select, De-Select, Clear Selections, Restore Selections, 
and Set Time Window.  These commands will be detailed later on in this appendix.  

After entering time window information, the Status Bar (Figure F.1) will display the time 
window information.  A time window is where a specific time frame is given for viewing or 
manipulating data.  

F.3 Opening a HEC-DSS File 
There are several ways to open a HEC-DSS file from HEC-DSS-Vue.  One way is to type in the 
location and filename of the DSS file in the File Name field of the HEC-DSS-Vue main 
window (Figure F.1).  After entering the correct information, press <Enter>, and the Pathname 
Table will display the pathnames of the selected DSS file, and the File Information (Figure F.1) 
field will display statistics about the DSS file.  
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Figure F.3 Open HEC-DSS File Browser  

Locate the DSS file to be opened and click OK.  The Open File browser will close, and the 
HEC-DSS-Vue main window will display the name of the DSS file, and all of the pathnames 
associated with that DSS file will appear in the Pathname Table (Figure F.2).  

F.4 Set Time Window 
To view the data for a certain block of time, set a time window:  

1. Click Set Time Window, and the Set Time Window dialog opens (Figure F.5).  By 
default, the time window is set to No Time Window.  There is an option of setting an 
exact time window or a time window that is relative to the current time.  

2. To enter a specific time frame, select Specific Time Window.  Enter a Start Date and 
Start Time, in the format ddmmmyyyy (i.e., 26Nov1993).  Do the same for the End 
Date and End Time.  

3. All the window fields can be cleared by clicking Clear.  To use the current date and time, 
click Set Current Time and all time window fields will be filled.  If needed, edit the 
ending date and time.  

4. To set the time frame relative to the current time, select Relative to Current Time.  
Enter the number of time increments to Go Back or Go Forward from the current time.  
Then select the time step increment to Go Back and Go Forward from the current date 
in the drop-down lists.  Choices are: minutes, hours, days, months, or years.  

5. To set the time frame based on water year, select By Individual Water Year and enter 
the Start Date of Water Year in the format dd mmm (i.e., 01 Oct).  Alternately, click on 
the ellipsis (…) to use a calendar tool for selecting the start date of the water year.  
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Figure F.5 Set Time Window Dialog  

6. To save the time window settings select the Retain Between Sessions.  

7. Click OK, and the Set Time Window dialog closes.  The time window is set, and it is 
displayed in the Status Bar of the DSSVue main window (Figure F.1).  

F.5 Pathnames 
HEC-DSS provides a pathname of parts A through F separated with forward slashes, "/".  The 
respective filters will display in the Pathname Filters located on the DSS-Vue main window.  
The following sections describe the basics of the pathname.  

F.5.1 Viewing DSS Pathnames 
The display of DSS pathnames in the Pathname Table shows all of the pathnames by the 
different parts for DSS records (Figure F.1).  This display can be changed from the View menu.  
Available commands are Pathname List, Pathname Parts, Condensed Catalog, and No 
Pathnames.  

The Pathname List command (Figure F.6) displays the pathnames in the  
Pathname Table, while No Pathnames displays nothing.  The Pathname Parts command 
(default) is the same as the Condensed Catalog, except with DSS records’ D part.  In the 
Condensed Catalog, the D part displays the date span for each DSS pathname.  
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F.5.2 Sorting DSS Pathnames by Parts 
Another way to change the display of the DSS pathnames is through sorting by pathname parts.  
Sorting DSS pathnames by parts is the command Search pathnames by part (default).  To sort 
by pathname parts, from the Pathname Filters (Figure F.8), decide which DSS pathname parts 
will be used.  There is a Filter List for each individual pathname part.  
 

 

An example is shown in Figure F.5 where DSS filters are used to see all of the STAGE records 
that are observed data.  From the Filter C list, select STAGE, and from the Filter F list, select 
OBS.  The Pathname Table displays only the pathnames that fit the criteria selected from the 
Filter Lists.  

Another way to sort the pathnames is available from the View menu.  Click Search pathnames 
by string.  The details for this method are described in the HEC-DSSVue User's Manual.  

F.5.3 Selecting Pathnames 
With the appropriate list of pathnames in the Pathname Table, select which pathnames to view 
or manipulate.  To select a pathname, double-click on a pathname in the Pathname Table, and 
the selected pathname will appear in the Selected Pathname List (Figure F.1).  Alternatively, 
click on a pathname in the Pathname Table, and then click Select.  

To select multiple pathnames, in the Pathname Table, click on a pathname the pathname will be 
highlighted.  Find the next pathname to include in a group, hold down the SHIFT key and click.  

  
Figure F.6   DSS Pathname List Display  

  
Figure F.8   Pathname Filters  
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The block of pathnames will be highlighted.  Click Select, and all the pathnames within that 
block will be added to the Selected Pathname List.  

Another way to select multiple pathnames is from the Pathname Table.  Click and drag across 
the pathnames, release the mouse button and the block of pathnames will be highlighted.  Click 
Select, and all of the pathnames within that block will be added to the Selected Pathname List.  

Individual pathnames can be selected to be in a group for selection.  From the Pathname Table, 
select a pathname which will be highlighted.  To select another not in a contiguous group, hold 
down the CTRL key and select the next pathname which will be highlighted.  Continue to do 
this until all of the desired pathnames have been selected.  Release the CTRL key and click 
Select.  All the selected pathnames will be added to the Selected Pathname List.  

All of the pathnames displayed in the Pathname Table can be selected.  From the Edit menu, 
choose Select All.  All of the pathnames will now appear in the Selected Pathname List.  

F.5.4 Clearing Selected Pathnames 
To clear a pathname from the Selected Pathname List (Figure F.1), select a pathname and click 
De-Select.  The pathname will be cleared from the Selected Pathname List.  To clear all 
pathnames from the Selected Pathname List, click Clear Selections.  

Groups of pathnames can be cleared by using the same concepts described in selecting 
pathnames (Section F.6.5) by using the SHIFT and CTRL keys.  Once pathnames have been 
cleared from the Selected Pathname List, the pathnames can be restored to the Selected 
Pathname List by clicking Restore Selections.  

F.6 Visualizing Data 
After a pathname or multiple pathnames have been selected, the data associated with the 
pathname can be visualized.  This can be done through a graphical means – plots, or through a 
tabular form – tabulate.  Further details on plots and tables are discussed in Appendix I.  

F.6.1 Plots 
To view a plot of the pathnames in the Selected Pathname List (Figure  
F.1), either click the Plot button from the Toolbar, or from the Display menu, choose Plot.  
Either way will open the Plot Window (Figure F.10).  
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Figure F.10 Plot Window  

The parameters for the plots are labeled and color-coded, date ranges are specified along one 
axis, and the units of measure are specified along the other axis.  The Plot Window can be 
resized by grabbing the corner of the window and dragging it to the desired size.  

Areas of the plot can also be zoomed in on.  Click the  Zoom Tool; find the area on the plot to 
zoom in on, and click and drag over the area.  The plot will refresh, and the area within the zoom 
rectangle will fill the plot window.  To zoom out, with the Zoom Tool selected, right-click 
anywhere on the plot area.  

F.6.2 Table 
To view a table of the pathnames in the Selected Pathname List (Figure F.1), either click the 
Tabulate button from the Toolbar, or from the Display menu, choose Tabulate to open the 
Tabulate Window (Figure F.11).  

The Tabulate Window displays the ordinate (starting from the start date/time), the date and time 
stamp, and the values for the selected data sets.  From the Tabulate Window, there are several 
options for displaying the tabular data (e.g., displaying commas in the number formatting, setting 
the precision of decimal places for your data).  
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Figure F.11  Tabulate Window  

F.7 Data Management Functions 
DSS-Vue provides several tools for manipulating records.  It provides the capability of creating 
DSS records - time series or paired data.  The user can rename, duplicate, delete, and undelete 
records.  There is the ability to copy records from one DSS file to another and merge two DSS 
file into one DSS file.  The user can also perform maintenance and check the status of a DSS 
file.  The following sections review a few of the available data management functions.  For 
further details see the HEC-DSSVue User's Manual.  

F.7.1 Renaming DSS Records 
To change the pathname parts of a DSS pathname:  

1. Select one or more pathnames.  

2. From the Edit menu, choose Rename Records.  The Rename Record to: dialog (Figure 
F.12) opens.  

3. Each of the fields (A - F) represents the different pathname parts.  Enter one or more of 
the new pathname parts in the appropriate field.  
 

4. Click OK, and the Rename Records to: dialog closes.  A message appears informing the 
user of the number of records renamed.  The selected pathname is no longer displayed in 
the Selected Pathname List (Figure F.1), and the pathname will display in the 
Pathname Table (Figure F.1) with the new pathname parts.  
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Figure F.12 Rename Records to: Dialog  

F.7.2 Duplicating DSS Records 
Duplicating a DSS record allows the user to make a copy of a record, but with a pathname part 
that has been changed.  To duplicate records:  

1. Select one or more pathnames.  

2. From the Edit menu, choose Duplicate Records.  The New pathname parts for 
duplicate records: dialog (similar to Figure F.12) will open.  

3. Each of the fields (A - F) represents the different pathname parts.  Enter one or more of 
the new pathname parts in the appropriate field.  
 

4. Click OK, and the New pathname parts for duplicate records: dialog closes.  A 
message appears informing the user of the number of records that were duplicated.  A 
new pathname is displayed in the Pathname Table (Figure F.1).  

F.7.3 Deleting and Undeleting DSS Records 
To delete DSS records:  

1. Select one or more DSS pathnames.  

2. From the Edit menu, choose Delete Records.  

3. A message appears asking to confirm the deletion.  Click Yes.  

4. A message appears informing the user of the number of records that were deleted.  Click 
OK, and the message closes.  The pathname are removed from the Selected Pathname 
List and the Pathname List (Figure F.1).  

5. If records were unintentionally deleted, before the next operation, from the Edit menu, 
point to Undelete → Select, and the Undelete Records dialog opens (Figure F.13).  

6. To select all the records displayed in the Undelete Records dialog, click Select All.  To 
select individual records, under the Select column, click the checkbox that corresponds to 
the correct record.  



Appendix F – Using DSS-Vue  HEC-RTS User's Manual  

F-12    

7. To restore the selected records, either click Apply or OK.  A message appears letting 
indicating that the records have been undeleted.  Click OK, and the message closes, the 
Undelete Records dialog closes, and the records will be displayed in the Selected 
Pathname List and the Pathname List (Figure F.1).  

8. For further information on deleting and undeleting records in a DSS file, see the HEC-
DSSVue User's Manual for further details.  

  
Figure F.13 Undelete Records Dialog  

F.8 Editing DSS Data 
DSS data can be edited either in tabular form or from a graphical editor (with the appropriate 
permissions).  To edit data in a tabular form:  

1. Select one or more pathnames.  The pathname(s) will appear in the Selected Pathname 
List (Figure F.1).  

2. From the Edit menu, click Tabular Edit.  A Tabular Edit dialog (Figure F.14) opens 
with the data for the selected pathname(s) displayed.  

3. The columns in gray cannot be edited.  The user can edit individual cells, insert 
(beginning of record), append (end of record), and delete rows (this command actual 
deletes the editable value of the selected row).  

4. From the File menu, click Save.  The Saved Data Set message appears, indicating that a 
record has been saved.  Click OK, and the Saved Data Set message closes.  

5. From the File menu, click Close and the Tabular Edit dialog (Figure F.13) closes.  

6. For further details on tabular editing see the HEC-DSSVue User's Manual.  
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Figure F.14 Tabular Edit Dialog  

To edit data using the graphical editor:  

1. Select one or more pathnames and the pathname(s) will appear in the Selected 
Pathname List (Figure F.1).  

2. From the Edit menu, click Graphical Edit, and the Graphical Editor (Figure F.15) 
opens.  

3. The Graphical Editor allows the user to edit the data in a graphical mode.  This editor is 
very similar to the Data Validation Editor from the Acquisition Module.  Review 
Chapter 9 of this User's Manual for similar functionality.  

4. From the File menu, click Save, and the Save Changes message appears asking if the 
changes should be saved.  Click OK, and the Save Changes message closes.  

5. The Saved Data Set message opens indicating which record(s) was saved.  Click OK, 
and the Saved Data Set message closes.  

6. From the File menu, click Close, and the Graphical Editor (Figure F.13) closes.  

7. For further details on graphical editing see the HEC-DSSVue User's Manual.  
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Figure F.15 Graphical Editor  
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APPENDIX G   
 

Using HEC-GridUtil 
 

A precipitation grid contains an estimate of the spatial distribution of precipitation intensity 
over the watershed for an interval of time.  Precipitation grids come from a variety of 
sources, including radar measurements, interpolation between rain gages, and atmospheric 
models.  HEC-GridUtil provides tools for viewing and manipulating precipitation grids.  
Once HEC-GridUtil has been configured to display grids in a watershed, that configuration 
can be used in HEC-RTS for the same watershed.  Gridded data is also produced by MFP as 
output.  Once a Forecast that includes MFP has been computed, the gridded data output can 
be viewed in the Models module.  This appendix provides an overview of HEC-GridUtil, 
the utility for setting up gridded data for use with the CAVI.  For additional information, see 
the HEC-GridUtil User's Manual.  

G.1 Overview of HEC-GridUtil 
In order to view grids of precipitation and snowmelt in HEC-RTS that are not  
MFP output, gridsets must first be created within the watershed using HEC-GridUtil.  A 
gridset can be thought of as a sequence or time series of grids.  A single DSS record of grid 
data contains data for only one time interval, so HEC-GridUtil uses gridsets to group 
gridded records for viewing and calculations on grids that change through time.  

The procedure for starting and logging in to HEC-GridUtil is the same as for the HEC-RTS 
CAVI (Section 2.1).  After clicking OK, the HECGridUtil main window will open (Figure 
G.1).  The components of the HEC-GridUtil main window are described in the following 
sections.  

G.1.1 Menu Bar 
The Menu Bar contains the menus for the HEC-GridUtil software.  The following list is a 
description of the available menus.  

• File: This menu is used for watershed management and contains the following 
commands: New Watershed, Open Watershed, Save Watershed, Save Map As, Exit, 
and lists any previously opened watersheds.  

• View: This menu is used to control the display of maps, time windows, and other 
components in the display area.  Available commands are: Zoom to All, Layers, Unit 
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System, Icons, Restore Windows, Grid Lines, Set Time Window, Time-Series Plot, 
Color Scales, and Cumulative Display.  

 
Figure G.1 HEC-GridUtil Main Window 

  
• Single Grid: This menu is used to create, open, edit, and delete single grids:  Available 

commands are: New, Open, Save, Close, Edit, Info, Import, Export, Delete, Rename, 
and Reload.  

• Grid Set: This menu is used to create, open, edit, and delete grid sets.  Available 
commands are: New, Open, Save, Close, Edit, Info, Import, Export, Delete, Rename, 
Reload, Update, and Previous.  

• Data Analysis: Use this menu to set a time range and access the Analysis Expression 
Builder.  Available commands are: Time Series Functions and Mean Areal Value.  

• Data Management: This menu is contains tools to manage gridded data.  Available 
commands are: Data Mosaic and Extract Region.  

• Tools: This menu provides options for output logs, access to DSS data (using HEC-
DSSVue), allows creating and editing of scripts, provides the ability to send messages to 
other users, and general information.  Available commands are: HEC-DSSVue, Scripts, 
Console Log, Options, and Information.  
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• Help: This menu provides information about HEC-GridUtil.   
Available options are: User’s Manual, Install Example Data, and About.  

G.1.2 Display Area 
The Display Area (Figure G.1) is where elements can be manipulated and results can be 
viewed using tools in the Toolbar.  The following list is a description of the available tools 
for HEC-GridUtil.  

 Zoom Tool - this tool allows zooming in and out of the display area.  To zoom in, 
hold the mouse button down and outline the area to zoom in on.  To zoom out, click 
the right mouse button (right-click).  

Pan Tool – this tool is used to move the display area while zoomed in.  

Extract Tool – this tool is used to extract a region from the available grid data.  

When moving any of these tools over the display area, a tool-tip box will show the 
grid value at the location of the tool.  If the Extract Tool is active, a single click will place a 
fixed box at the location; so that values at that location will continue to be displayed as a 
sequence of grids is stepped through.  Double-clicking with the extract tool removes all 
fixed boxes that have been placed in the display area.  

G.1.3 Gridded Data Configuration Module 
The Gridded Data Configuration Module (Figure G.1) provides controls that execute 
commands and displays information about the active gridset.  This information includes the 
name of the gridset, the location of the DSS file that contains the grids, gridset identification, 
size of the gridset, the minimum and maximum precipitation values in the gridset, and a 
legend for the gridset.  

The Grid Animation Controls are located on the lower-right corner of the Gridded Data 
Configuration Module.  The controls show the time span of the grids.  The time and date 
centered above the controls show the end time of the time interval covered by the currently 
displayed grid.  

G.2 Creating Gridsets with HEC-GridUtil 
The information in this section is an overview of creating a gridset with HEC-GridUtil.  For 
more detail on gridsets, importing and exporting gridsets, and other available function dealing 
with gridsets, review the HEC-GridUtil User's Manual.  

G.2.1 Set the Display Coordinate System 
Before creating gridsets with HEC-GridUtil, the coordinate system of both the watershed's 
maps and the grids to be displayed must be known.  This information includes the 
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coordinate system name, the units, and the spheroid type.  If the coordinate system is UTM 
or State Plane, the zone number must also be known.  (Use the FIPS code to identify a State 
Plane zone.)  

To set the watersheds coordinate system:  

1. From the View menu, click Layers, and the Layer Selector dialog will open.  

2. On the Maps menu, click Map Display Coordinates; and the Display Coordinate 
Information dialog will open.  

3. Click Edit, and the Map Coordinate Information dialog will open (Figure G.2).  If 
the coordinate system is not already correctly set for the map layers, the settings will 
need to be changed.  

 
Figure G.2 Map Coordinate Information Dialog 

4. From the System list, select the coordinate system of the watershed maps.  

5. From the Units list, select the appropriate units.  

6. If the coordinate system uses Spheroids, a Spheroid list will be shown.  From the 
Spheroid list select the appropriate spheroid or datum for the gridset.  

7. Finally, depending on which coordinate system was chosen, information for zones or 
projection parameters will need to be added.  In Figure G.2, State Plane Coordinates 
was chosen, so zone information would need to be entered in the Zone field.  

8. Click OK, and the Map Coordinate Information dialog will close.  

G.2.2 Create a Gridset 
To create a gridset:  

1. From the Grid Set menu, click New.  The Create a New Grid Set dialog (Figure 
G.3) will open.  
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Figure G.3 Create a New Grid Set Dialog 

2. Enter a name in the Name cell and a description in the Description cell.  
Gridset names should describe the source of the data.  For example, a gridset 
made up of grids created by gageInterp might be named Interpolated, and a 
gridset composed of stage III NEXRAD radar scenes might be named StageIII.  
 

3. Click New, and the Select Grid Set dialog will open (Figure G.4).  

4. If Use CWMS file names is checked, then from the Prefix dropdown selection list it 
is possible to sort the DSS files using three hardwired choices: precip, airtemp, or 
snow.  

5. If Use CWMS file names is not checked, then click Add File(s), and an Open File 
browser will open.  Select a DSS file that contains precipitation grid data.  Click OK; 
and the Open File browser will close.  

6. The lists in the Grid Set Identifier cell (Figure G.4) will now contain lists of DSS 
path parts.  These lists are the Grid Type (A part), Location (B part), Parameter (C 
part), Version (F part), and Time Interval.  The time interval list is the difference 
between the grids start and end times, as represented in the D and E parts of its path.  
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Figure G.4 Select Grid Set Dialog 

7. From Grid Type list select SHG, from the Location list select the name of the 
watershed.  

8. From the Parameter list, a user might select PRECIP (for a precipitation grid), and 
from the Version list select the type of grids included in the set (i.e., RADAR, STAGE 
III, INTERPOLATED - selections for a precipitation grid).  

9. The grid coordinate system should automatically set itself to SHG when SHG was 
selected as the grid type.  If it did not, select SHG from the Coordinate System list 
(Figure G.4).  

10. Make sure Set display scale limits is selected.  

11. Enter values in the Minimum Value and Maximum Value cells.  If the gridset is a 
precipitation grid, set the maximum value to a realistic high value for one hour’s 
precipitation in the basin.  Cells in the grid with precipitation depths greater than this 
value will show black on the display.  Set the minimum value to zero.  

12. Click OK; and the Select Grid Set dialog will close.  The precipitation grids will now 
be available (Figure G.1).  The gridset that was created will also be available for 
viewing in the Visualization Module of the CAVI.  Note that gridsets with fixed time 
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windows (those that have the "override default time window for display" box 
checked) cannot be displayed in HEC-RTS.  

G.2.3 Set the Time Window 
To set the time window for displaying the gridset in HEC-GridUtil:  

1. From the View menu, click Set TimeWindow, and the Time Window dialog (Figure 
G.5) will open.  

2. By default, the time window is set to the Specific Time Window.  To set the time 
window to be relative to the current time, select the radio button next to Relative to 
Current Time.  Enter a number in the Go Back cell and then select a unit from the list 
next to the – days, hours, months, or years.  In the example, Figure G.5, the time 
window has been set for eight days.  

 
Figure G.5 Time Window Dialog – Relative to Current Time 

3. No Time Window can also be set.  
4. The Set TimeWindow for Display dialog (Figure G.6) allows the user to enter a 

specific time.  In the Start Date and Start Time cells, enter the beginning time for the 
gridset.  In the End Date and End Time cells, enter the ending time for the gridset.  

5. Either way, once finished with setting the time window, click OK, and the Time 
Window dialog will close.  
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Figure G.6 Time Window Dialog – Specific Time Window 

  

G.3 Viewing Precipitation Grids in HEC-RTS 
Grids are viewed in the Visualization Tab in the Watershed Pane of HEC-RTS.  A single 
gridset (created in HEC-GridUtil) can be viewed.  For further details on viewing 
precipitation grids, see Section 10.4 of this User's Manual.  In addition, more details are 
provided in the HECGridUtil User's Manual.  
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APPENDIX H   
 

Scripting 
 

In HEC-RTS, scripts provide a way to automate the program for the purpose of executing a 
prescribed set of actions with a simple trigger.  Scripting simplifies user operation, ensures 
repeatability and consistency of results, reduces time required to generate results, and permits 
schedules of an operation in the future.    

HEC-RTS uses the Jython scripting language.  Jython is a special implementation of the Python 
scripting language that is able to interact with programs written in Java.   

Some uses of scripting in HEC-RTS:  

● Running an existing forecast with one or more alternatives with a single button click 
(replacing many mouse clicks with one).  

● Creating a new forecast based on the current time, and running it with one or more 
alternatives.  

● Scheduling an action such as creating a new forecast to happen sometime in the future 
(possibly on a recurring basis).  

H.1 Scripts 
Scripts can apply to all HEC-RTS watersheds, or they can be specific to an HEC-RTS 
watershed.  Scripts can be scheduled for execution and users can check on the status of scripts.  
This is accomplished from the Select Scripts dialog, which is accessed in the Visualization 
Module, Scripts box in the Watershed Pane. Right-click in the Scripts box, located in the 
Watershed Pane, and click Edit, the Select Scripts dialog will open (Figure H.1).  

H.1.1 Select Scripts 
• Available: The Available column lists all of the available scripts that can be added to the 

Visualization Module, Scripts box. Use the buttons Add or Add All to add script 
buttons to the watershed Visualization Module. The Remove or Remove All buttons 
will delete script buttons from the watershed Visualization Module.  

• Selected: This column lists all script buttons that are or will be added to the 
Visualization Module, Scripts box.   
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Figure H.1 Select Scripts Dialog 

H.1.2 Edit Existing Script Buttons 
In the Visualization Module, after creating scripts and requesting that a button be created for 
that script, the user can edit the script associated with the button, delete the script associated with 
the button, and schedule a job for that script.  All of these tasks can be accomplished through the 
script button shortcut menu (Figure H.2).   
 

 

Figure H.2 Script Button Shortcut Menu 

H.2 Script Editor 
Create, edit, and delete scripts using the Script Editor.  From the Tools menu click Script 
Editor, and the Script Editor will open (Figure H.3).  Components of the Script Editor include 
the Menu Bar, the Script Context Pane, the API Pane, and the Editor Pane.  The following 
sections describe these components.  
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Figure H.3 Script Editor 

H.2.1 Menu Bar 
An overview of the Script Editor’s Menu Bar:   

• File: From this menu, create and import scripts, open, delete, print, save, and run scripts, 
or make a copy of the script.  Available commands are New, Open, Run, Delete, Save, 
Save As, Print, and Close.  

• Edit: From this menu, modify a script or search a script.  Available commands are: Cut, 
Copy, Paste, Select All, and Find.    

 

H.2.2 Script Context Pane 
The Script Context Pane (Figure H.4) of the Script Editor the user can navigate to folders in 
the HEC-RTS directory structure and access scripts.  The tree structure allows for navigation 
through the directory structure for scripts within HEC-RTS.  Scripts can be stored that are 
applicable to all HEC-RTS modules or to individual HEC-RTS modules. The name of the script 
is also the script name displayed on the associated script button in the Script Selector (Figure 
H.1). To edit a script double-click on the script name and the script opens in the Editor Pane.  

  

Menu Bar 
Main Toolbar 

Title Bar 

Script  
Context  

Pane 

Editor  
Pane 
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Figure H.4 Script Context Pane 

H.2.3 Editor Pane 
Scripts are modified in the Editor Pane of the Script Editor.  The name displayed on the 
associated script button in the Script Selector (Figure H.1) is the same as the name in the Script 
Context Pane and the *.py name (i.e. 1-USGS.py) in the File box of the Editor Pane.  File box 
(Figure H.5) also shows where the user can find the location of the associated file of the script. 
By default, a button for each script created will appear on the Script Selector. If the user wants 
an icon to appear on the script button, then from the Icon list, select an icon. If the user does not 
want a button, they need to clear Display Script to User.    
 

 
Figure H.5 Editor Pane 
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The Test Arguments field (Figure H.5) allows for the initialization of the values of variables 
used by the script.  As many semicolon separated variable assignments can be entered as a script 
requires (e.g., var1=“abc”; var2=7.5) or the area can be left blank.  

The Description field (Figure H.5) allows the user to enter a description of the script.  The first 
line of the description serves as the tooltip for the associated script button.  

The field below the Description field in the Editor Pane (Figure H.5) is where the script text 
will be entered and serves as an editing window.  This field will be referred to as the Script Text 
field.  By right-clicking in the Script Text box, shortcut menu will appear (Figure H.6) that 
contains the following commands:  

• Cut: Copies the currently-selected script text to the system clipboard and removes it 
from the script.  

• Copy: Copies the currently-selected script test to the system clipboard and leaves it in 
the current script.  

• Paste: Copies text from the system clipboard into the script at the current cursor location.  

• Select All: Selects all the text in the script.  
 

 
Figure H.6 Script Text Shortcut Menu 
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H.3 Create a Script 
Create a script by selecting either the General Scripts directory or the Watershed Directory in 
the Script Context Pane of the Script Editor (Figure H.3) and choosing File > New.  Enter the 
name of the script in the subsequent dialog.  
 

H.4 Save a Script 
In the Script Context Pane (Figure H.4), select the script to be saved.  From the File menu, 
click Save or click on the Save button.  The script can also be saved and executed by simply 
clicking on the Save/Run button from the Script Editor (Figure H.3).  The Editor Pane (Figure 
H.5) will become grey and the name of the script will appear in the Script Context Pane (Figure 
H.3) in the appropriate place.   
 

H.5 Delete a Script 
In the Script Context Pane (Figure H.4), select the script to be deleted.  From the File menu, 
click Delete.  A Confirm Deletion message will appear asking the script should really be 
deleted, click Yes.  The confirmation message will close, and the script will no longer appear in 
the Script Context Pane.  

H.6 Edit a Script 
There are three ways to edit a script from the Script Editor (Figure H.3).  When editing is 
enabled, the Editor Pane (Figure H.5) will change from grey to white.  From the Script 
Context Pane (Figure H.4), double-click the script.  From the shortcut menu, click Edit Script.  
From the Script Editor (Figure H.3), click the Edit button.  

Another way to edit a script is to select a script from the Script Context Pane, and from the File 
menu, click Open.  

H.7 Running a Script 

H.7.1 Manually Running a Script 
There are three ways to manually run a script: the first way is from the Script Selector (Section 
H.1.1).  From the Script Selector, select the script you wish to run, and click Run.  

The second way is to manually run a script is from the Script Editor  
(Section H.2).  From the Script Editor, from the Script Context Pane (Figure H.4), select a 
script. From the File menu, click Run, and the script will execute.  

The last way to trigger a script is to assign the script to a Time Series Icon and trigger the run 
through the icon’s shortcut menu.  See Chapter 18 on Time Series Icons for more details.  
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H.7.2 Automatically Running a Script 
Running scripts automatically in HEC-RTS is accomplished by scheduling script jobs.  From the 
Script Selector (Section H.1), from the Script menu, click Schedule Script Job.  The Schedule 
Script Job dialog will open (Figure H.7).  Another way to launch the Schedule Script Job 
dialog is from the Script Selector dialog:  Right-click on a script button, and from the shortcut 
menu (Figure H.2), click Schedule Script Job.  

 
Figure H.7 Schedule Script Job Dialog Box 

  

H.7.2.1 Schedule Script Job Dialog Box 
To setup a script to run automatically:  

1. The Job Name field (Figure H.7) contains the name of the job that will run the script.  
The job name contains the name of the script, and the start date and start time that will be 
entered.  This name can be changed, but it is recommended that it is not changed.  

2. From the Script name list (Figure H.7), the script that should run automatically can be 
selected.  

3. In the Location box (Figure H.7), a script can be scheduled to run only on the client in 
HEC-RTS.   

4. Enter a starting date in the Start Date cell (i.e., DDMMMYYYY format), and a start 
time in the Start Time cell (Figure H.7).  The date and time reference is local time of the 
computer running the CAVI client (usually the PC), as indicated the time zone ID next to 
the Start Time box.  

5. The script that is being set up can be run automatically one or be recurring.  By default 
the job is setup to run once - Single Job (Figure H.7) is selected.  To make the job 
recurring, select Recurring Job, and enter the interval for the job to recur at in the 
Recurrent Interval box, and from the list select Minute(s), Hour(s), or Day(s).  
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6. Once everything is setup, click OK, and a confirmation message will open indicating that 
the script has been scheduled.  Click OK, and the confirmation message will close, and 
the Schedule Script Job dialog will close (Figure H.7).  

H.7.2.2 Checking the Status of a Scheduled Script 
To check the status of an automatically schedule script, from the Script Selector dialog (Figure 
H.1), from the Script menu, click Status; the Script Job Status dialog will open (Figure H.8).  
The following gives an overview of what information is being provided:  

1. The Job Name column (Figure H.8) displays the name assigned to the script job when it 
was initially scheduled.  

 
Figure H.8 Script Job Status Dialog Box 

  
2. The Script column (Figure H.8) displays the name of the script that is executed with the 

scheduled job runs.  A script can be used in more than one script job at a time.  

3. The User column (Figure H.8) displays the name of the user that scheduled the script.  

4. The Status column (Figure H.8) displays the status of the scheduler (not the script itself).  
This column will display three states:  

• Pending: The scheduler is waiting to start the script job for the first time.  

• Successful: The scheduler started the script job successfully.  

• Error: The scheduler did not start the script job successfully.  

5. To see whether the job was a single execution or a recurring execution, the Interval 
column (Figure H.8) displays this information.  

6. From the Location column (Figure H.8) it is indicated whether the job executed on the 
client or the server.  

7. If the job is recurring, the Date/Time column (Figure H.8) will display the date and time 
of the next scheduled execution.  
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H.7.2.3 Deleting a Scheduled Script 
 

From the Script Job Status dialog box (Figure H.8), from the table, select a schedule script.  
From the Job menu, click Delete; and a message will open asking if this scheduled script should 
really be deleted.  Click Yes, and the message will close, and the scheduled script will no longer 
appear in the table.  
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APPENDIX I   
 

Plots 
 

 

Plots are highly customizable and offer an array of information to assist with reviewing data in 
HEC-RTS.  This appendix covers some of the capabilities of plots within HEC-RTS.  For more 
detail, see the HEC-DSSVue User's Manual.  

I.1 Plot Window 
The Plot window provides tools that facilitate the viewing of HEC-RTS data. The main plot 
window and the different components are illustrated in Figure I.1.  The Title Bar contains the 
name of the location that the data represents.  For example, in Figure I.1, the plot is illustrating 
the power and flow data at a reservoir location named Lake Sonoma.  
 

 
Figure I.1 Plot Window 

I.1.1 Menu Bar 
Following is an overview of the Menu Bar (Figure I.1) for the Plot window. The commands 
available from the menus will facilitate the viewing and customizing of plots.  

  

Menu Bar 
Title Bar 

Select Tool 
Zoom Tool 
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• File: From this menu the user can view the plotted data in a tabular format, save the plot 
as a graphics file, save a template, use a template, copy the plot to the clipboard, and print 
the plot.  Available commands are: Tabulate, Save As, Save Template, Apply 
Template, Save Specification, Copy to Clipboard, Print, Page Setup, Print Preview, 
Print Multiple, and Close.  

• Edit: From this menu the user can customize the plot.  Available commands are: Plot 
Properties, Default Line Styles, and Default Plot Properties.  

• Plot: From this menu the user can select variable to plot, open and save plot type.  
Available commands are: Select Variables, Open Plot Type, and Save Plot Type.  

• View: From this menu the user can have the plot window always on top of your desktop, 
and you can choose to use line styles.  Available commands are: Always On Top, Use 
Line Styles, Zoom to all, Legend Placement, Hide Legend, Refresh, and Live Display.  

I.1.2 Tools 
The Tools appear in a toolbar on the left side of the Plot window (Figure I.1).  The tools change 
the appearance of the mouse, as well as the functionality of the mouse.  

 Pointer/Select Tool: With the Pointer/Select Tool, shortcut menus can be accessed that 
allow for the customization of features of plots using the plot editing tools.  

 Zoom Tool: The Zoom Tool allows the user to view data closely at a specific time.  To 
zoom in, hold the mouse button down and outline the area to be enlarged.  To zoom out, 
click the right mouse button (right-click).  The zoom out is done by a factor of two and 
positions the clicked location at the center of the display area.  

I.2 Customizing Plots 

I.2.1 Overview 
From the Plot window, several editors allow for configuration of default properties for all plots, 
as well as customize individual plots.  Figure I.2 shows the features plot area that can be 
configured.  
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Figure I.2 Elements of the Plot Window 

  
• Title of Plot: Add a title to all plots or to individual plots.  

• Marker: Add markers on the X- and Y-axes and customize the appearance of these 
markers.  

• Panel Background Color: Specify the background color of the plot window (light grey is 
the default) for all plots only.  

• Curve/Line Properties: Choose the line and point styles, add labels, and specify symbols 
to indicate quality.  

• Label: Add borders and backgrounds to axis and legend labels.  

• Spacer: Specify the distance between viewports, between a viewport and the legend, and 
the width of side margins.  

• Viewport: Customize the border around the viewport, the background color and pattern, 
and the appearance of gridlines. You can also specify the number, size, and content of 
viewports.  

• Callout: Add descriptive callouts at specific points along a line.  

• Axis: Specify either a linear or log axis type, specify the axis scale, and customize tic 
marks.  

• Legend: Add titles to the plot legend and specify whether the legend appears below or to 
the right of the plot.  
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I.2.2 All Plots 
All the plots for an entire watershed can be customized.  From the Plot window (Figure I.1), 
from the Edit menu, there are two commands - Default Line Styles and Default Plot 
Properties.  These commands will allow for customization of all new plot windows that will be 
accessed for a watershed.  

I.2.2.1 Default Line Style Options 
The Default Line Style Options dialog (Figure I.3) is for adjusting the curves (lines) in all of 
the plots.   

 
Figure I.3 Default Line Style Options Dialog 

It allows the user to add curve (line) types, change the color and fill of the curves (lines), and add 
labels for the curves (lines) for all plots.  For more detailed information on Default Line Style 
Options dialog, refer to the HEC-DSSVue User's Manual.  

From the Line tab (Figure I.3) the color, style, and weight for the curves (lines) in all plots can 
be set.  If the curves have points, the style, color, and fill color for the points on the curves in all 
plots can be set.  

From the Default Line Style Options dialog (Figure I.3) labels can be added to the curves and 
their position can be adjusted (Label tab) for all plots.  The user can manually adjust the 
maximum and minimum values for your X-axis, set viewport weight, and reverse the X-axis 
(Defaults tab) for certain curve types such as Precip.  
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I.2.2.2 Default Plot Properties 
The Default Plot Properties dialog (Figure I.4) allows the user to configure the other properties 
of the plots.  The tabs for this dialog allow the user to make adjustment to the viewport, add a 
title for all plots, adjust grids, labels, axes, marker lines, and legend, change the color of the 
panel background, change the layout of the legend, and adjust the size of the spacer.  

 
Figure I.4 Default Plot Properties Dialog 

  
To add a title for all plots:  

1. Open a Plot window (Figure I.1).  

2. From the Edit menu, click Default Plot Properties.  

3. The Default Plot Properties dialog (Figure I.4) opens.  

4. Select the Title tab (Figure I.5).  

5. To add a title, click Show Plot Title.  In the Text field enter a title that will appear on all 
of the plots in the watershed.  The title can be aligned, font size adjusted, a border with 
color can be added, and a color background can be added to the title.  

6. Click Apply, and the title will appear on all plots.   

7. Click OK, and the Default Plot Properties dialog closes.  
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Figure I.5 Default Plot Properties Dialog – Title Tab 

  
To change the panel background color for all plots:  

1. Open a Plot window (Figure I.1).  

2. From the Edit menu, click Default Plot Properties.  

3. The Default Plot Properties dialog (Figure I.4) opens.  

4. Select the Layout tab (Figure I.6).  

5. To change the panel background color of the plot, from the Panel Background Color 
list, select a color.  

6. Click Apply, and the new color will appear in the background panels for all the plots  

7. Click OK, and the Default Plot Properties dialog closes.  
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Figure I.6 Default Plot Properties Dialog – Layout Tab 

  

I.2.3 Individual Plots 
To customize individual plots that are being displayed (Figure I.1) two dialogs can be used, or 
shortcut menus may be used to make changes through individual editors.  The dialogs include 
Plot Properties accessible from the Edit menu and Select Plot Variables accessible from the 
Plot menu.  

I.2.3.1 Individual Plot Properties 
The Plot Properties dialog (Figure I.7) allows for configuration of multiple display properties of 
an individual plot.  This includes the border and background patterns of the viewport; adding a 
title to the plot; adjusting the gridlines of the plot; editing the titles, tic marks, and scale of an 
axis; adjusting the style, adding points, and adding quality symbols for curves; adjusting the 
color, adding labels, and positioning of marker lines; adding a title, icon, and moving the legend; 
changing the color of the panel background; adjusting the layout of the legend; and the size of 
the spacer.  

To change the gridlines of an individual plot:  

1. Open a Plot window (Figure I.1).  

2. From the Edit menu, click Plot Properties.  

3. The Plot Properties dialog (Figure I.7) opens.  

4. The Title Bar displays the name of the location that data is being plotted.  

5. If the plot has multiple viewports, the Select Viewport list displays the viewport where 
the editing is taking place.  
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Figure I.7 Individual Plot Properties Dialog – Curves Tab 

  
6. Choose the Viewport tab (Figure I.8).  

7. From the Major X Grid panel, click Draw Major X Grid.  Select from the Color, 
Style, and Weight drop-down lists to modify the major X-axis gridline properties.  Also, 
the Minor X Grid can be modified by clicking the Draw Minor X Grid and modifying 
the minor X-axis gridlines properties.  

8. From the Major Y Grid panel, click Draw Major Y Grid.  Select from the Color, 
Style, and Weight drop-down lists to modify the major Y-axis gridline properties.  Also, 
the Minor Y Grid can be modified by clicking the Draw Minor Y Grid and modifying 
the minor Y-axis gridlines properties.  

9. Click Apply, and the color, style, and weight changes that were made will reflect on the 
gridlines of the plot.  

10. Click OK, and the Plot Properties dialog (Figure I.8) closes.  
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Figure I.8 Individual Plot Properties Dialog – Viewport Tab 

I.2.3.2  Select Plot Variables 
 

The Select Plot Variables dialog (Figure I.9) allows the user to customize the layout of an 
individual plot.  The user can add and remove axes, arrange the order of viewports, add and 
remove viewports, and set the weight of viewports.  The plot components are displayed in a tree 
structure.  

To add a viewport to an individual plot:  

1. Open a Plot window (Figure I.1).  

2. From the Plot menu, click Select Variables.  

3. The Select Plot Variables dialog (Figure I.9) opens.  

 
Figure I.9  Select Plot Variables Dialog 
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4. From Edit menu, click Add Plot Region, and a new plot region (viewport) is added to 

the bottom of the Selected tree.  

5. Data now needs to be added from the Available Variables tree to the new plot region.  
Select a curve from Available Variables tree and click Add.  

6. In this example (Figure I.10), Zone Storage is added to the Reservoir tree from the 
Available Variables by selecting Plot Region 3 in the Selected tree and clicking Add.   

7. Click Apply, and the plot region displays the curve that was added.  

8. Click OK, and the Select Plot Variables dialog (Figure I.10) closes, and the plot will 
display the changes that were made.  

 
Figure I.10 Select Plot Variables Dialog – Added Data to Viewport 

  

I.2.3.3 Shortcut Menus 
 

To edit a specific property of a plot without using the Individual Plot Properties dialog 
(Figure I.7), use individual plot property dialogs instead.  To access these dialogs, select the 
Pointer/Select tool, right-click the element of the Plot window (Figure I.2) to be edited, and 
from the shortcut menu that appears, click Edit Properties.  
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I.2.3.4 Edit Title Properties 
 

To add a title to an individual plot:  

1. Right-click the Plot window where the title is (or will be) displayed (Figure I.11).  

 

Figure I.11 Plot Title Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Title Properties dialog (Figure I.12) opens.  

4. Check Show Plot Title, and in the Text field, enter the title for the individual plot.  From 
this dialog the user can also set the alignment, the size of the font, and add a border and 
background colors to the title.  

5. Click Apply, and the title is displayed on the plot.  

6. Click OK, and the Edit Title Properties dialog (Figure I.12) closes.  

 
Figure I.12 Edit Title Properties Dialog 
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I.2.3.5 Edit Marker Lines Properties 
 

To edit the marker lines of an individual plot:  

1. Right-click the Plot window where the marker line is (or will be) displayed (Figure I.13).  

 
Figure I.13 Marker Line Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Marker Line Properties dialog (Figure I.14) opens.  

4. To change the style of the marker line, click the Draw Line checkbox.  The color, style, 
and weight of the marker line can be changed.  Fill can be added if needed.  

5. To add a label to the marker line, click the Draw Label checkbox.  The user can add a 
label, the alignment of the label, and the placement of the label along the marker line.  

6. If the plot has more than one viewport, marker line properties must be set for each 
viewport.  

7. Click Apply, and the changes to the marker line are displayed on the plot.  

8. Click OK, and the Edit Marker Line Properties dialog (Figure I.14) closes.  
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Figure I.14 Edit Marker Line Properties Dialog 

I.2.3.6 Edit Curve Properties 
 

To edit the curves of an individual plot:  

1. Right-click on the curve in the Plot window (Figure I.15).  

 

Figure I.15 Curve Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Curve Properties dialog (Figure I.16) opens.  

4. To change the style of the curve, select the Style tab.  The user can change the color, 
style, and weight of the curve.  Fill can be added below or above the curve if needed.  

5. To display the quality of the data that the curve represents, select the Quality Symbols 
tab, and click the Draw Quality Symbols checkbox.  Then, set the symbol color and size 
for each type of quality.  
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Figure I.16 Edit Curve Properties Dialog – Style Tab 

  
6. If the plot has more than one curve, properties for each curve will need to be edited 

individually.  

7. If the plot has more than one viewport, curve properties will need to be set for each 
viewport.  

8. Click Apply, and the changes to the marker line are displayed on the plot.  

9. Click OK, and the Edit Curve Properties dialog (Figure I.16) closes.  

To add a callout to a curve of an individual plot:  

1. Right-click the Plot window where a curve is displayed (Figure I.15).  

2. From the shortcut menu, click Add Callout.  

3. The Add Callout dialog (Figure I.17) opens.  

4. Enter the callout you want in the Callout Text field.  

5. Click Apply, and the changes to the marker line are displayed on the plot.   

6. Click OK, the new callout is displayed on the plot, and the Add Callout Dialog (Figure 
I.17) closes.  
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Figure I.17 Add Callout Dialog 

I.2.3.7 Edit Axis Title Properties 
To edit the appearance of axis titles for an individual plot:  

1. Right-click the Plot window where the axis title is displayed (Figure I.18).   

 

Figure I.18 Axis Title Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Axis Properties dialog (Figure I.19) opens.  

4. To give an axis title a border, click the Axis Label tab.  In the Border panel, click Draw 
Border.  The user can set the color, style, and weight of the border around the axis title.  

5. To give an axis title a background color, in the Background panel, click Draw 
Background.  The user can set the color and the pattern of the background for the axis 
title.  

6. Click Apply, and the axis title is displayed with your changes.  

7. Click OK, and the Edit Axis Properties dialog (Figure I.19) closes.  
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Figure I.19 Edit Axis Properties Dialog – Axis Label Tab 

I.2.3.8 Edit Spacer Properties 
 

To edit the spacer properties for an individual plot:  

1. Right-click the Plot window where the spacer is (Figure I.20) located on the plot.  
Spacers are between viewports, on either side of each viewport, and at the top of the plot.  

 

Figure I.20 Spacer Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Spacer Properties dialog will open (Figure I.21).  

4. Enter the size of the spacer in pixels in the Size in Pixels cell.  

5. Click Apply, and the changes you made to the spacer will appear on the plot.  

6. Click OK, and the Edit Spacer Properties dialog (Figure I.21) will close.  
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Figure I.21 Edit Spacer Properties Dialog 

I.2.3.9 Edit Viewport Properties 
 

To edit the viewports of an individual plot:  

1. Right-click in the Plot window where a viewport is displayed (Figure I.22).  

 
Figure I.22 Viewport Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Viewport Properties dialog (Figure I.23) opens.  

 
Figure I.23 Edit Viewport Properties DIalog 

  
4. To change the viewport border’s color, pattern or transparency click Draw Border under 

the Border panel.  

5. To change the viewport background’s color, pattern or transparency click Draw 
Background under the Background panel.  
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6. To change the color, style, or weight of the gridlines of the viewport, click the Draw 
Major X Grid, Draw Major Y Grid, Draw Minor X Grid, or Minor Y Grid 
checkboxes under the grid section.   

7. If the plot has more than one viewport, curve properties will have to be set for each 
viewport.  

8. Click Apply, and the changes to the viewport are displayed on the plot.  

9. Click OK, and the Edit Viewport Properties dialog (Figure I.23) closes.  

I.2.3.10 Edit Axis Tics Properties 
 

To edit the X-axis scale of an individual plot:  

1. Right-click in the Plot window where the X-axis is displayed (Figure I.24).  

 
Figure I.24 Axis Tics Properties Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Axis Properties dialog (Figure I.25) opens.  

4. Select the Scale tab.  In the select table the user can choose to automatically set the 
maximum, minimum, view maximum, view minimum, and view range.  Also, the user 
can set the number of label levels and reverse the X-axis.  

5. To change the tic marks of the X-axis, select the Tics tab.  The user can add minor tics 
marks, do minor tic marks only, and change the color of the tic mark and tic mark label.  

6. If the plot has more than one viewport, axis tics properties will have to be set for each 
viewport.  

7. Click Apply, and the changes to the X-axis are displayed on the plot.  

8. Click OK, and the Edit Axis Properties dialog (Figure I.25) closes.  

    



HEC-RTS User's Manual  Appendix I – Plots  
 

I-19 
 

 
Figure I.25 Edit Axis Tics Properties Dialog – Scale Tab 

  

I.2.3.11 Edit Legend Panel Properties 
 

To edit the legend panel of an individual plot:  

1. Right-click the Plot window where the legend panel is displayed (Figure I.26).   

 
Figure I.26 Legend Panel Shortcut Menu 

2. From the shortcut menu, click Edit Properties.  

3. The Edit Legend Properties dialog (Figure I.27) opens.  

4. Give the legend panel a title by checking the Draw Legend Title and entering 
information in the Text field.  

5. Add icon information to the left and right areas of the legend bock from the Left Block 
and Right Block tabs.  For example, to add a description to display on the left side of the 
legend panel, click the Left Block tab and enter the description in the Text field.  

6. To add an icon, enter the path and filename of icon to be display in the Icon panel for 
either the left or right sides of the Legend panel.  

7. Click Apply, and the changes to the legend panel are displayed on the plot.  

8. Click OK, and the Edit Legend Properties dialog (Figure I.27) closes.  
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Figure I.27 Edit Legend Properties Dialog – Legend Title Tab 

  

I.3 Exporting and Importing Templates 
After customizing a plot, its settings can be saved as a template for use in other plots.  
Generally, templates would be used when scripting plots.  For example, every day the user 
might want to generate a plot of flow, stage, and precipitation via a script, and then apply a 
template that has all of the correct formatting, such as viewport placement, size, line colors, and 
fills.  

To create a template from a plot:  

1. Open a Plot window (Figure I.1).  

2. From the File menu, click Save Template, and the Export Plot Template dialog will 
open (Figure I.28).  

3. Specify whether the template should be available for All Applications, This Watershed 
only, All Users Watershed, or All Users.  Then enter a name for the template in the 
Name field.  

4. Click OK, and the Save Template dialog c1oses saving the template.  
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Figure I.28 Export Plot Template Dialog 

  
To apply (import) a template that was previously created to another plot that is currently open:  

1. Open a Plot window (Figure I.1).  

2. From the File menu, click Apply Template.  

3. The Import Plot Template dialog (Figure I.29) opens.  

4. Specify whether the template should be available for All Applications or This 
Watershed only.  

5. Choose the desired template from the list.  

6. After selecting a template, its name will display in the Name field.  

7. Click OK to apply the template to the current plot, and the Import Plot Template dialog 
closes.  
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Figure I.29 Import Plot Template 
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APPENDIX J   
 

Printing and Copying HEC-RTS Data 
 

Plots and tables in the Visualization, Acquisition, and Modeling modules offer detailed views 
of data and model results that can be printed or copied and pasted into other applications.  In 
addition, reports generated by the individual models can be printed.  

J.1 Plots 
Plots provide a graphical representation of the data.  From the Plot window (Figure J.1) the 
user can view the plot, as well as print, save as a graphics file, copy the contents of the Plot 
window to the clipboard, and save the properties of the plot to a template to be used by other 
plots. Following is an overview of the menu bar of the Plot window.  The commands available 
from the menus are:  

• File: View the plotted data in a tabular format, save the plot as a graphics file, save a 
template, use a template, copy the plot to the clipboard, and print the plot.  Available 
commands are: Tabulate, Save As, Save Template, Apply Template, Save 
Specification, Copy to Clipboard, Print, Page Setup, Print Preview, Print Multiple, 
and Close.  

• Edit: Customize the plot.  Available commands are: Plot Properties, Default Line 
Styles, and Default Plot Properties.  

• Plot: Select variable to plot, open and save plot type.  Available commands are: Select 
Variables, Open Plot Type, and Save Plot Type.  

• View: Have the plot window always on top of the desktop, and choose to use line styles.  
Available commands are: Always On Top, Use Line Styles, Zoom to all, Legend 
Placement, Hide Legend, Refresh, and Live Display.  

    
The Tools appear in a toolbar on the left side of the Plot window (Figure J.1).  The tools change 
the appearance of the mouse, as well as the functionality of the mouse:  

 Pointer/Select Tool. With the Pointer/Select Tool, the user can access shortcut menus 
that allow them to customize features of your plots using the plot editing tools.  

Zoom Tool. The Zoom Tool allows the user to view data closely at a specific time. To 
zoom in, hold the mouse button down and outline the area you to be enlarged. To zoom 
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out, click the right mouse button (right-click). The zoom out is done by a factor of two 
and positions the clicked location at the center of the display area.  

 
Figure J.1 Plot Window 

  

J.1.1 Save As 
The Save As command allows the plot to be saved as a graphics file. HEC-RTS has four 
possible formats: Windows Metafile (*.wmf), Postscript (*.ps), JPEG (*.jpg, *.jpeg), and 
Portable Network Graphics (*.png). To create a graphics file:  

1. On the File menu, click Save As, and the Save browser (Figure J.2) opens.  

2. Select the location the file will be saved to from the Save in drop-down list.  

3. Enter a name for the file in the File name field.  

4. From the Files of type list, select the type of graphics file that will be created.  

5. Click Save, and the Save browser closes, and the plot is saved as the selected graphics 
file type.   
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Figure J.2 Save Browser 

  

J.1.2 Copy to Clipboard 
The Copy to Clipboard command copies the contents of the Plot window to the clipboard.  
Once the copy is complete, the plot can be pasted as an image into other applications.  

J.1.3 Print Commands 
The Plot window (Figure J.1) provides the user with several different commands to setup the 
printing process and to print.  

J.1.4 Print 
The Print command opens a standard system Print dialog (Figure J.3).  From the Print dialog 
select the printer, choose to print to a file, and the number of copies to print.  Click OK, and the 
Print dialog closes and the plot will print to the selected printer.  
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Figure J.3 Print Dialog 

  

J.1.5 Page Setup 
The Page Setup command opens the Page Setup dialog (Figure J.4).  The page display can be 
formatted from this dialog.  Following is a list of the available options:  

 
Figure J.4 Page Setup Dialog 

  
• Orientation: To set the orientation, select Portrait or Landscape from the Orientation 

panel. By default, the pages are printed in Portrait.  
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• Margins: The default margin settings are displayed in the Margins panel of the Page 
Setup dialog.  To set the margins, click Set Margins, and the Printer Margins dialog 
(Figure J.5) opens.  From the Printer Margins dialog, it is possible to adjust the top, left, 
bottom, and right margins.  

 
Figure J.5 Printer Margins Dialog  

• Additional Options: To include page numbers on the printed page, select the Page 
Numbers checkbox (Figure J.4).   

• Printer Scale: The default option is Maximum Plotting Area.  

J.1.6 Print Preview 
The Print Preview command opens the Print Preview dialog (Figure J.6).  From the Print 
Preview dialog, the user can view the plot, adjust the scaling of the plot, and print the plot.  
The Print command automatically prints the plot to the default system printer.  

 
Figure J.6 Print Preview Dialog 
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J.1.7  Print Multiple 
The Print Multiple command opens the Print Multiple dialog (Figure J.7).  To be able to 
print multiples plots multiple individual plot windows must be open.  The opened plots are 
listed in the Available Plots list of the Print Multiple dialog.  

 
Figure J.7 Print Multiple Dialog 

  
To select plots to be printed on one page, double-click on a plot name in the Available Plots 
list.  The plot name will move to the Selected Plots list.  Adjustments can be made to the way 
the plots are arranged on a page, horizontally or vertically.  Use the Number Across or 
Number Down sliders. The grid to the right of the sliders reflects the user’s choices.  From 
the File menu, the Page Setup and Print Preview commands are available.  

J.2 Tables 
Tables provide a tabular format of the data.  From the Tabulate window (Figure J.8) the user 
can view the data and results, as well as print the table, copy the selected contents of the 
Tabulate window to the clipboard, adjust the display of the data, and save the data to an ASCII 
file.  Following is an overview of the menu bar of the Tabulate window.  

The commands available from the menus are:  

• File: Print the data in a tabular format and view a plot of the data.  Available 
commands are: Save, Save As, Print, Print Preview, Export, Plot, and Close.  

• Edit: Select data to be copied to the clipboard.  Available commands are: Allow 
Editing, Cut, Copy, Paste, Select All, Find, and Compare Data Sets.  

• View: Control the appearance of the data displayed in the Tabulate window.  
Available commands are: Commas, Reverse Order, Date and Time Separately, 
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Date with 4 Digit Years, Show Decimal Places (up to 6 decimal places), and Show 
Missing As (blank, -901.00, M, -M-).  

 
Figure J.8 Tabulate Window 

  

J.2.1 Copying to the Clipboard 
To copy data from the Tabulate window (Figure J.8) to the clipboard, there are several ways.  
To use the Copy command from the Edit menu, first select the cells in the table to be copied 
to the clipboard.  To select the whole table, from the Edit menu choose Select All.  If only a 
certain area is needed, from the table click and drag over the cells to be copied, and the 
selection will be highlighted.  Then, from the Edit menu, choose Copy.  The contents will be 
copied to the clipboard so the data can be pasted into other applications.  In addition, right-
clicking on the table will open a shortcut menu which will also allow data to be copied to the 
clipboard.  

J.2.2 Displaying Data 
By default, data is displayed with commas and two decimal places.  There are several options to 
change the way the data is displayed using the View menu.  To disable the display of commas, 
from the View menu, click Commas.  

For time series data the date and time are displayed in the following default format: 
ddmmmyy hhmm.  The way the date and time are displayed can be changed.  From the View 
menu, click Date and Time Separately; and the date and time are now displayed in two 
separate columns in the table.  Another way is from the View menu, click Date with 4 Digit 
Years; and the date displays a four-digit year instead of a two-digit year.  
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Numbers by default are displayed with two decimal places.  To see more or less number of 
decimal places, from the View menu, point to Decimal Places, and click on the number (up to 6 
decimal places) of decimal places to be displayed.  

J.2.3 ASCII Files 
The table of data can be saved to an ASCII file.  Right-click on the table, and from the shortcut 
menu, click Export.  The Table Export Options dialog will open (Figure J.9).  From this 
dialog, set certain options for the ASCII file.  

 
Figure J.9 Table Export Options Dialog 

 
The delimiter for the file can be set from the Field Delimiter drop-down list.  The field 
delimiter choices are TAB (default), SPACE, COMMA COLON, and SEMI-COLON.  The 
user can also make choices on whether the file contains fixed width columns, strings are set in 
quotes, whether to include column headers in the file, include gridlines in the file, and 
whether to include the a title in the file.  

When all of the options are set, click OK, and a Save browser (Figure J.2) opens.  Find the 
location where the file should be saved and provide a filename.  Click Save and the file is 
created without a filename extension.  Since this is an ASCII file, the file should have an 
extension of .txt.  

J.2.4 Printing 
The Print command opens a standard system Print dialog (Figure J.3).  From the Print dialog 
the user can select the printer, choose to print to a file, and the number of copies to print.  Click 
OK, and the Print dialog closes, and the table will print to the selected printer.  

Another way to print is to right-click on the table.  From the shortcut menu click Print, and the 
Properties dialog (Figure J.10) opens.  From this Properties dialog, the format of the table for 
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output can be set up.  From the Page tab, the user can set the orientation; fit the table to a page, 
and decide whether to include the entire table or only a selection.  

In addition, the user can also choose to print the table in ASCII, add headers, add background 
color to headers (non-ASCII option), and add gridlines.  

 
Figure J.10 Properties Dialog 

To add header or footer information to the table report, click the Header/Footer 
tab.  From the Header/Footer tab enter header or footer information.  
The title of the table report defaults to the pathname tag associated with the data.  To change 
this title, click the Table Title tab.  From the Table Title tab, enter or change the title, and 
decide if the title should print on each page of the report.  When everything is set, click Print, 
and the Print dialog (Figure J.3) opens.  

To preview the table report, right-click on the table, and from the shortcut menu, click Print 
Preview.  The Properties dialog (Figure J.10) opens.  Setup the options for the table report, 
click Print, and the Print Preview dialog (Figure J.11) opens.   

From this Print Preview dialog, the user can view the table report, adjust the scaling of the 
report, and print the report.  The Print command automatically prints the report.  
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Figure J.11 Print Preview Dialog 

J.3 Printing Reports from HEC-RTS 

J.3.1 Setup Module 
In the Setup Module, from the Reports menu there are several reports that are available that 
display information about the watershed elements.  To print these reports, from the File menu 
of the report window, click Print, and the Properties dialog (Figure J.10) opens.  See Section 
J.2.4 for further details on the printing these reports.  

J.3.2 Modeling Module 
In the Modeling Module, from the Reports tab there are several reports that provide 
information by model about the active forecast run.  Chapters 11 and 12 describe the available 
reports in detail.  

J.3.3 Results 
When a forecast run is selected, the Extract and Post Reports can be viewed by choosing them 
from the Forecast menu Log secondary menu options.  The extract report (Figure J.12) can be 
opened and printed.  Choose Print from the File menu.  See Section J.1.3 for further details 
about printing.   
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Figure J.12 Extract Report 

  

J.3.4 Forecast Run 
When a forecast run is selected the log file can be viewed from the Reports tab in the 
Modeling Module.  Click Extract Log and a log extract report opens displaying the report 
(Figure J.12).  This report can be printed by clicking Print from the File menu.  See Section 
J.1.3 for further details about printing.   

J.3.5 HEC-ResSim 
All of the HEC-ResSim reports are printable, and the reports can be exported to an ASCII text 
file.  To print HEC-ResSim reports, from the File menu of a HEC-ResSim report, click Print, 
and the Properties dialog (Figure J.10) opens.  See Section J.2.4 for further details on printing 
these reports.    

J.3.6 HEC-RAS 
The HEC-RAS reports can be copied to the clipboard and are printable.  To copy to the 
clipboard, choose Copy Plot to Clipboard or Copy Values to Clipboard from the File 
menu.  To print HEC-RAS reports, from the File menu of a HEC-RAS report, click Print, 
and the Print Options dialog (Figure J.13) opens.   
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Figure J.13 Print Options Dialog – HEC-RAS 

From this Print Options dialog, the format of the report can be set up for printing.   

Following is a list of the available print options:  

• Setup: Click Setup, and the Print Setup dialog (Figure J.14) opens.  From the Print 
Setup dialog, the user can select a printer and change the printer properties, change the 
paper size and source, and set the orientation.  

  
Figure J.14 Page Setup Dialog – HEC-RAS 

• Orientation: As with the Print Setup dialog, set the orientation using the Print 
Options dialog (Figure J.14).  To set the orientation, select Portrait or Landscape from 
the Orientation panel.  By default, the pages are printed in Portrait.  

• Margins: The default margin settings are displayed in the Margins panel of the Page 
Setup dialog.  To set the margins, from the Print Options dialog (Figure J.13), click Set 
Margins, and the Printer Margins dialog (Figure J.15) opens.  From the Printer 
Margins dialog, adjust the left, right, top, and bottom margins.  
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Figure J.15 Printer Margins Dialog – HEC-RAS 

• Additional Options: From the Additional Options panel in Figure J.13, the user can 
choose to Print Grey Headings, Print Grid Lines, include Page Numbers, and set the 
Starting Page.   

• Table Options: From the Table Options panel in Figure J.13, set the Max Font Size 
and choose whether to print the Entire Table or a Selected Range of the table.  

J.3.7 HEC-FIA 
The HEC-FIA Result Reports are printable, and the reports can be exported to an ASCII text 
file.  From the HEC-FIA reports, click Print, the Properties dialog (Figure J.10) will open.  
See Section J.2.4 for further details on printing these reports.  To export to an ASCII text file, 
click Save To File and the Table Export Options dialog (Figure J.9) will open.  See Section 
J.2.3 for further details on exporting these reports.   
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